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1 Introducing LCMS 4.31

The Learninglogics® Learning Content Management System (LCMS) is a content

development tool that allows Instructional Systems Designers (ISDs), courseware

developers and Subject Matter Experts (SMEs) to build state-of-the art web-based

lessons and tests.

Using a SCORM architecture based on reusable learning objects, the LCMS makes it easy

to develop, assemble, reuse, update and maintain content. Learning objects are

essentially “chunks” of training that contain content and assessment based on specific

learning objectives. The size and level of granularity of Sharable Content Object Reference

Model (SCORM) learning objects packaged for a Learning Management System (LMS)

varies, depending on project requirements. The SCORM learning object may be an entire

activity, part of an activity or the multimedia assets for an activity.

Different types of activities can be created, called:

Independent Study (a CBT lesson)

Test (a CBT test)

Instructor Led Lesson

The Independent Study and Test activities may both be used for independent study. They

can be used as stand-alone lessons that can be copied and reused in many different

courses. The ability to copy content between Independent Study lessons and Instructor

Led lessons provides additional flexibility to reuse content. The Instructor Led Lessons are

used for the delivery of facilitated training. All provide web-based training with a powerful

and flexible content development tool.

The LCMS automates the process of content creation by using a wide range of predefined

templates for instruction and question screens, and allows the integration of a range of

web-compatible multimedia. It lets trainers build glossaries and test banks, create a media

library, manage prompts and training documentation, track copyright permissions and

perform production analysis.

The LCMS also enables trainers to register the course(s) in a compatible LMS. Once the

activities have been created, the LCMS enables users to build or design courses for use in

a compatible LMS. Activities may be reused to construct multiple versions of courses.

When course activities are accessed from the LMS, a user’s progress and performance are

tracked.
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There are nine different types of system-generated user roles that may be assigned rights

within the LCMS:

Administrator

Manager

Developer

Senior Developer

Reviewer

Review Manager

Review Monitor

Approval Authority

Media Developer

1.1 LCMS System Highlights

The Learninglogics® LCMS 4.31 is a fully integrated content management system (CMS)

that is designed for high performance and simple user management. 

Highlights include:

Web-Based System - Learninglogics® LCMS offers a completely web-based,

Sharable Content Object Reference Model (SCORM) conformant system that

provides both power and flexibility.

Standards Based - Learninglogics® LCMS supports all of the standards of the

SCORM for web-based learning. These evolving standards ensure a high degree of

system durability, accessibility and interoperability within a worldwide training

environment.
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Reusable Learning Objects - Learninglogics® LCMS architecture, based on

reusable “learning objects,” makes it easy for trainers to assemble, reuse and

update content.

Automated Authoring - Learninglogics® LCMS automates the process of content

creation by providing trainers with templates based on sound instructional design

principles. Using these templates, trainers can develop new learning objects or

convert existing content.

Personalized Learning - Courses can be customized for individuals or groups of

users. Learning objects can be reused to construct multiple versions of courses.

Fully-Customizable Interface - The LCMS interface can be customized to reflect

an organization’s desired look and corporate image. 

1.2 Key LCMS Development Features

The LCMS provides Developers with a range of tools and features, including:

Predefined Screen Styles - Choose from a wide range of predefined screen styles

that emphasize sound instructional design and allow the trainer to integrate a range

of web-compatible multimedia. 

Comprehensive Tests - Create a wide range of test questions including multiple

choice, drag and drop, animated graphic selection and clickable images. Users can

also create question banks that can be stored and the questions may be reused

within learning objects in multiple courses.

Media Auditing and Media Library - Track the progress of graphic development

using Learninglogics® Media Library, a powerful media monitoring tool. Users can

search for multimedia files, track and assess usage, and reuse media from a central

media library.

Multimedia Integration - Integrate any web-compatible multimedia content such

as streaming video, animation, audio and simulation. The LCMS supports embedded

images, Adobe Flash and any other media that can be embedded in HTML screens.

Glossary - Create a glossary of key terms that can be grouped by category and

searched by users from the courseware interface.

Reusable Content:
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o Easily copy activities to other courses for flexible and cost-effective content

development.

o Easily reuse topics within lessons to maximize reuse of lesson content.

o Easily reuse multimedia files to maximize reuse of graphics, movies, animations,

audios and simulations. 

1.3 Deliver Activities

Delivery options for developed activities are available in different formats. Activities may

be exported as SCORM packages, offline packages or ZIP files that can be imported into

another LCMS.

The LCMS allows users to automatically register an activity in one or more Learning

Management System(s). Once registered, the activity is available to instructors for course

design and assignment to users as active courseware.

1.4 Getting Started

This manual consists of topics structured according to  the  layout  of  menus  in  the  LCMS

user interface. It also includes a section containing overviews of key Example Processes.

The following chapters deal with getting started after a new install of the LCMS:

Add new users

Create a new project

Assign users to a project

Add a project interface
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Create a new activity

Create Test Questions

As you work in the LCMS, you will find web help available at  any time by clicking the Help

button.
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2 Process Examples

This section provides examples and explains the user interface for the following processes:

Review and Approval 

Survey 

Translation - Multilingual Support

2.1 Review and Approval

The review process can take different forms, depending in part on how the LCMS has been

configured. However, the most common scenario is described below.

Settings

1. In the Application Settings screen, Min # of Reviewers should be 1 and Review

Manager Required should be checked.

2. Users should be assigned the roles of Developer, Senior Developer, Reviewer,

Review Manager and Approval Authority in the Project Management screen.

3. In the project, under the Home menu, the Manager should select Review Types

and Responsibilities and set the Review Types, assigning a pool of Reviewers,

Review Managers, Review Monitors and Approval Authorities to each one.

4. In the Activity Profile for the activity to be reviewed, the manager must select a

pool of Developers and assign the Activity to the current Developer. 

5. The manager may also select pools of Reviewers, Review Managers, Review

Monitors and/or Approval Authorities in the Responsibility tab for each Review

Type, or allow the Activity to use the default pools set at the project level above.

Developer Submits for Review

1. The Developer (or Senior Developer) begins the review process by submitting the

activity for review, clicking the Review/Approval drop-down in the Topic List

screen and selecting Submit for Review or Submit for Batch Processing. 

2. The Developer selects the Review Type, and may need to select one or more
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Reviewer(s), Review Manager(s), Review Monitor or Approval Authority(ies),

depending on the configuration of the Review Type selected.

3. The activity is now automatically locked so that the Developer cannot make

further changes, and its status is shown as "Submitted for Review".

Reviewer Responds

1. The Reviewer sees the activity listed in their Review Inbox.

2. They can launch it in the viewer and add comments at the project, activity or

individual screen level.

3. Once a comment has been added by the Reviewer, the activity status changes

from "Submitted for Review" to "Review in Progress".

4. The Reviewer then finalizes their review, handing it over to the Review Manager. 

Note: If more than one Reviewer is assigned, then the activity status remains

"Review in Progress" until all the Reviewers have finalized their reviews.

Review Manager Finalizes Review

1. After checking the Reviewer's comments, the Review Manager finalizes the review,

if appropriate, and sets its status to either "Needs Re-Work" or "Ready for

Approval". 

2. If re-work is required, the Developer can now unlock the activity, make changes,

add comments, change its status in Activity Profile to "In Production", and

resubmit it for review from the Review/Approval drop-down in the Topic List

screen. Note: Changes made by the Developer are not visible to the Reviewer or

Review Manager until they have resubmitted the activity for review.

3. If the activity is ready for approval, the Developer can make a final check and then

select Submit for Approval from the Review/Approval drop-down in the Topic

List screen. Note: If no Review Manager is assigned, then once finalized by the

Reviewer, the activity is handed back to the Developer to be submitted for

approval.

Note: If the Review Manager finalizes the  review  before  the  Reviewer has  made  any

comments,  the  activity  is  removed  from  the  Reviewer's  inbox  and  the  status  is

changed  to  whatever  the  Review  Manager  selected.  The  Developer  is  now  able  to

unlock the activity and make changes before submitting it again for review.
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Developer Submits for Approval

1. Once all changes have been finalized, the Developer can submit the activity for

approval, which will change its status to "Submitted for Approval".

2. The Approval Authority can then check the activity and make additional change

requests before clicking Finalize Approval and changing the status to either

"Rejected" or "Approved".

3. If the activity is approved, it should remain locked to prevent changes. The Lock

this activity? checkbox is only enabled when the Activity Production Status is

set to "In Production".

4. If the activity requires further changes, the Developer changes the Activity

Production Status to "In Production", unlocks the activity and makes the

changes. They can then resubmit it for review and subsequent approval (i.e.

returning to the start of the process for another cycle).

Note: If no Approval Authority has been assigned, the project Manager or site

Administrator can select Submit for Approval and will be given the message:

"Warning! No Approval Authority has been assigned to this Activity. By clicking

'Continue', you will be changing the status of this Activity to 'APPROVED'."  By doing

so, they may force an activity to be changed to "Approved" status without the need

to submit it to an Approval Authority.

2.2 Survey

1. From the Project Menu, click the drop-down arrow and select Survey for the

activity.
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2. Add a title and any other initial details in the same way you created a test or

independent study.

3. Click New Page to add a page or “topic” to the survey.

4. Click Add Question to add a survey question to a particular page. There are four

types to choose from:
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5. Survey questions are shown by default in the order they are added. The order can

be changed by clicking Re-Order Screens. To publish or preview the survey without

the question numbers, go to Additional Options > Activity Profile > Course

Publish Settings and deselect "Show Question Numbers". 

6. The survey can be previewed in the same fashion as any other activity type. Click 

Preview Activity to launch the survey in a new window. 
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Note: The survey has its own "viewer", therefore when submitting for review, the

Interface and Glossary do not apply. This is also the case when the survey is

published with the Course Designer.

This  is  an optional  feature.  For  more  information,  please  contact  learninglogics-

support@bluedrop.com. 

2.2.1 Screen Styles

These  are  the  screen styles  available  to  use  in  a  survey.  There  are  multiple  options  to

pose a variety of questions to instructors or users.

Thumbnail Description

7.01 HTML/Media. Allows selection between different  layouts: "No

Text,  100%  Media",  "40%  Text,  60%  Media",  "50%  Text,  50%

Media", "60% Text, 40% Media",  or "100% Text,  No  Media" (static

media). Note: Default layout size is 40% Text, 60% Media. 

mailto:learninglogics-support@bluedrop.com
mailto:learninglogics-support@bluedrop.com
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7.02 Multiple  Choice.  Options  for single  choice  (radio  button)  or

multiple choice (checkbox).

7.03 Comment Box.  Allows for HTML text to add comment(s).

7.04  Rating  Scale.  Option  for  a  single  choice  with  a  weighted

value.

2.2.2 Types and Uses

These are a few different purposes for the survey. It can be used to get answers for:

1.  Customer Satisfaction (Rating)

a.  Customer Service

b.  Information Technology

2.  Form (Text Input)
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a.  Personal Information

b.  Previous Experience

3.  Mixed

a.  Survey
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2.3 Translation - Multilingual Support

1.  The  Multilingual Support  feature  can be  enabled  from Project  Preferences  from the

Configuration and Preferences (sprocket) options.

2.  From  the  Project  Preferences  window,  click  the  Enable  Multilingual  Support

checkbox. 
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3. You will receive the following message box. Click Close. 

4.  If  enabled,  select  the  alternate  language  from  the  drop-down  list  and  then  click

Submit.

Enabling multilingual support will turn on such features as:

Alternate language input fields for Prompts and Glossary

Identification of screens in the Question Bank as being one language or the other, as

well as being able to match up related screens indicating if an activity is based on the

Default or Alternate language

Exporting activities for translation
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Importing translated activities

Typical Work Flow (using a translation service)

Once all existing content has been approved and finalized (recommended the activities be

in a locked state to avoid accidental modification):

Export all necessary content from the LCMS to various formats (xml & html) that  can be

sent  off  to  a  translation  service  (Activities,  Glossary,  Screen  Prompts  and  Question

Bank)

Copy  and  paste  activities  (with  Make  this  copy  a  French  {alternate  language}

version of the selected Activity option checked) into desired folders

"Add to Batch for Translation" on the folders containing the alternate language activities

Submit Translation Batch

Collect all exported files and send to service for translation.

At  this point, it  would be a good idea to ask your IT  department  to  back up  your  LCMS

database for this project. The database name can be found by looking at  the LCMS Home

screen. The database name will be prefixed with "ll_lcms_" and  the  code  displayed  next

to your project name.

Upon return of translated files, repeat  the reverse of the process and import  the files for

Glossary,  Screen  Prompts,  Question  Bank  and  Activities  (Additional  Options  >  Import

Translated HTML or LCMS Menu > Translation Batch Import).
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3 Basic Navigation and Features

This information applies to all user roles, and will help you understand how to navigate and

use the LCMS in general.

3.1 System Roles

The following system roles are available:

Administrator

Manager

Developer

Senior Developer

Reviewer

Review Manager

Review Monitor

Approval Authority

Media Developer

These roles have different privileges sets, which cannot be modified. 

Note:  Certain  system roles  perform important  functions  within  the  LCMS,  particularly  in

relation to the review process.

3.1.1 Administrator Role

The Administrator role is unique because it is site-wide rather than restricted to a specific

project. 

Administrators have all privileges, except  the ability to read Review Inbox and Approval

Inbox and the ability to generate the My Responsibilities report.
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3.1.2 Manager Role

The  Manager  role  has  full  (read,  edit,  delete)  privileges  under  the  following  module

headings:

Content Repository

Question Bank

Snippet Bank

Media Library

Glossary

Tag Manager

Content Packaging

The Manager may also generate the following reports:

Courseware Summary Report

Changes Required Report

Review Audit

Question Bank Report

Courseware Workflow Report

Detailed Project Metrics Report

Production Analysis

Media Distribution Report

Project Media Audit

They also have privileges for the following Miscellaneous Features:

Screen Prompts
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3rd Party Content (SCO Search)

Tag Search

Document Management

3.1.3 Developer Role

The  Developer  role  has  full  (read,  edit,  delete)  privileges  under  the  following  module

headings:

Content Repository (assigned activities only)

Question Bank

Snippet Bank (if owner)

Glossary

The Developer role has read and edit privileges under the following module headings:

Media Library

They also have privileges for the following Miscellaneous Features:

3rd Party Content

Tag Search

Document Management

The Developer also has access the Course Summary Report. Only assigned activities

return to them.

3.1.4 Reviewer Role

The Reviewer role has no privileges except  read permission for Document Management,

full  permission  for  Review  Inbox  and  the  ability  to  generate  the  My  Responsibilities

report.
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The Reviewer role is used in the review process when an activity is submitted for review.

3.1.5 Review Manager Role

The  Review  Manager  has  no  privileges  except  read  permission  for  Document

Management,  full  permission  for  Review  Inbox  and  the  ability  to  generate  the  My

Responsibilities report.

The Review Manager role is used in the review process to finalize reviews once they have

been checked by Reviewers.

3.1.6 Review Monitor

The Review Monitor is similar to a Review Manager but with read-only access.  The Review

Monitor  therefore  has  no  privileges  except  read  permission  for  Document  Management,

read permission for Review Inbox and the ability to generate the My Responsibilities report.

The  Review  Monitor  role  is  used  in  the  review  process  to  observe  reviews  without

commenting on them or altering anything.

Note: The availability of this role can be turned on or off in Application Settings.

3.1.7 Approval Authority Role

The  Approval  Authority  role  has  no  privileges  except  read  permission  for  Document

Management and full permission for the Approval Inbox, and the ability to generate the

following reports:

Courseware Summary Report

My Responsibilities

The  Approval  Authority  role  may  be  used  in  the  review  process  when  an  activity  is

submitted for approval.

3.1.8 Media Developer Role

The  Media  Developer role  has  full  (read,  edit,  delete)  privileges  for  the  Media  Library.

They also have the privilege of unlocking media-related screens in the Activity. 
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3.1.9 Senior Developer Role

The Senior Developer role has full (read, edit, delete) privileges under the following module

headings:

Content Repository

Question Bank

Snippet Bank

Media Library

Glossary

Content Packaging

The Senior Developer can generate the following reports:

Courseware Summary Report

Changes Required Report

Review Audit

Question Bank Report

Courseware Workflow Report

Detailed Project Metrics Report

Production Analysis

Media Distribution Report

Project Media Audit

They also have privileges for the following Miscellaneous Features:

3rd Party Content

Tag Search
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Document Management

3.2 Log In

1. Navigate to the LCMS User Login screen, which will appear automatically if you

enter the correct url in a browser and are not logged in.

2. Type your username in the Username field. 

3. Type your password in the Password field. 

4. Click the Login button.

Note: The Username and Password fields are case sensitive. 

Note: If Enforce Strong Passwords is enabled in the Application Settings screen, user

passwords must be eight characters consisting of all of the following: at least one number,

at  least  one  uppercase  character,  at  least  one  lowercase  character  and  at  least  one

special character.

3.3 Log Out

From the LCMS Home screen, click the red Logout button to exit the LCMS. 
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Note:  This  image  shows  the  full  range  of  top-level  menu  options  available  to  an

Administrator. Other users, with fewer privileges, will see fewer menu options.

You can also log out by clicking the Logout link in the top bar.

3.4 Return to LCMS Home

To return to the LCMS Home screen, click the LCMS Menu button from the Project

Menu above the navigation tree within in the current activity. Choose LCMS Home from

the drop-down list.
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3.5 Help

Throughout the LCMS, a Help button is available. Clicking the Help button gives you

access to a full index of topics at any time. In addition to this index, Help topics are also

displayed based on the specific LCMS features you are currently viewing. 

To access a Help topic, click the Help button.



Basic Navigation and Features 37

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

3.6 Export Functions

When export functions are available, a series of export buttons will be displayed. A

glossary example is displayed below.

To export, click the button for CSV or PDF.

Note: The CSV, or comma-separated value, format can be opened by Microsoft Excel.

3.7 Sort Items in a Table

To sort items in a table between ascending and descending order, click the desired column

heading.

3.8 The HTML Editor

The Main Text field on the question and instruction screens and many other areas of the
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LCMS use a sophisticated WYSIWYG rich-text  editor,  which saves  your content  in  HTML

format. Unlike plain text, this allows you to include basic  formatting such as  bold,  italics,

and  underline,  as  well  as  functionality  such  as  hyperlinks,  and  provides  many  more

features.

Note:  The  content  of  HTML fields  is  displayed  on  screen.  When  you  click  on  it,  HTML

Editor will open in a new modal window, containing the content  for editing purposes. Click

the Submit button to save your changes or Cancel to close the window without saving.

The HTML Editor has  a  toolbar at  the  top  containing  a  range  of  buttons  most  of  which

enable common editing functions. Most of these will be familiar to users from similar editing

features available in modern word-processors or HTML editors.

Note:  The  toolbar can be  collapsed  or expanded  by  clicking  the  small  arrow  on  the  far

right.

If you are uncertain about any of the toolbar features, just hover your mouse cursor over

each button and the function will automatically be displayed on the screen in a tooltip. 

Note: The toolbar in the editor has many features and is highly-customizable. It may

appear slightly different if the configuration has been changed for your installation of the

LCMS.
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3.8.1 Toolbar Buttons: Top Row

Note: These buttons may vary slightly depending  on the  configuration of  your software.

The example given here deals with the current standard configuration for the HTML editor.

The  top  row  buttons  in  the  standard  configuration,  in  order  from left  to  right,  are  as

follows:

Source: Toggles between HTML source-code and rich-text editing views. When you

click this button for the first time it will reveal the underlying HTML mark-up on the

screen you're editing, whereas you normally see the rendered HTML in the editing

area. For example, bold text would appear as this is bold in rich-text view but as

<b>this is bold</b> in the HTML source view. You can insert all HTML entities using

their entity name and number when the editor is in source view. 

Cut (CTRL+X): Cuts out the selected content and copies to the clipboard. This

does the same as pressing CTRL+X in most browsers.

Copy (CTRL+C): Copies the selected content to the clipboard. This does the same

as pressing CTRL+C in most browsers.

Paste (CTRL+V): Pastes the contents of the clipboard directly into the HTML

editor, including some formatting markup, which the editor will try to automatically

convert to valid HTML. Note: Pasting content from the clipboard in response to a

button-click is disabled in most browsers for security reasons. This will normally

open a dialogue box that asks you to paste content manually by pressing CTRL+V.
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Paste as Plain Text (ALT+Q): Formatting can be stripped out in the same way by

first pasting content into a plain text editor like Microsoft Notepad and copying it

again from there. In the Chrome and Firefox browsers, the same thing can be done

more quickly by holding down the SHIFT key while pasting, i.e., pressing ALT+Q

pastes the contents of the clipboard as plain text, removing all formatting. This is

an important practice because pasting content into an HTML editor from HTML

documents or other document formats, especially MS-Word, can lead to unexpected

results if formatting is not removed. Note: Pasting content from the clipboard in

response to a button-click is disabled in most browsers for security reasons. This

will normally open a dialogue box that asks you to paste content manually by

pressing CTRL+V. This does the same as Remove Formatting to the content in

the clipboard before pasting it into the current text area. 

Paste from Word (ALT+W): Attempts to preserve some of the formatting from

MS-Word documents, while converting the contents of the clipboard to valid HTML.

It's important to be careful when pasting content copied from MS-Word documents

into an HTML editor because it can lead to unexpected results. Note: Pasting

content from the clipboard in response to a button-click is disabled in most

browsers for security reasons. This will normally open a dialogue box that asks you

to paste content manually by pressing CTRL+V.

Undo: Reverses the last edit made in the HTML editor using the mouse or keyboard.

Redo: Redoes the last undone edit.

Find: Opens a dialogue for performing a text search.

Replace: Opens a dialogue for performing a text search and replace.

Select All: Selects all content in the text area, like pressing CTRL+A in most

browsers.

Insert Link: Opens a dialogue to insert a hyperlink. See the section titled Add/Edit/

Delete Hyperlink for more information.

Insert Text Build: Used to insert a break between sections in a text build, allowing

sections of content within a single screen to be revealed progressively to the user.

Insert Bullet: Inserts a single bullet-point symbol. Note: This should never be used

to create a bullet-point list as this will potentially create an inconsistent

appearance if other screens contain bullet-lists formatted using the HTML <ul>
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element.

Table: Opens a widget for designing HTML tables. See the section titled Insert

Table for more information.

Horizontal Rule: Inserts a horizontal line for separating sections of text.

Image: Opens a dialogue for inserting an inline image in the HTML.

Special Characters: Opens a widget for inserting special characters. 

Advisory Notices: Opens a widget for creating special advisory notices such as

warnings, notes, and cautions.

Styles Drop-down: Allows user to use pre-defined styles for formatting selected

text.

Paragraph Format Drop-down: Allows the user to select different HTML mark-up

for blocks of text, such as paragraph (normal), heading 1, heading 2, etc. Note:

The screen title is normally H1 so H2 should usually be used for sub-headings. If

they look too big, the font size should be changed in the theme.

Snippet: Allows user to create or insert a snippet. See Create Snippet for more

information.

3.8.2 Toolbar Buttons: Bottom Row

Note: These buttons may vary slightly depending on the  configuration of  your software.

The example given here deals with the current standard configuration for the HTML editor.
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The bottom row buttons in the standard configuration, in order from left  to  right,  are  as

follows:

Bold: Makes the selected text bold by using the <strong> HTML element, as if

pressing CTRL+B in most browsers. Note: Technically, this marks up the text as

"strong"; the bold styling is arbitrary, and could be rendered differently in different

viewers.

Italic: Makes the selected text italicized by using the <em> HTML element, as if

pressing CTRL+I in most browsers. Note: Technically, this marks up the text as

"emphasized"; the italicized styling is arbitrary, and could be rendered differently in

different viewers. 

Underline: Makes the selected text underlined by using the <u> HTML element, as

if pressing CTRL+U in most browsers. Note: Sometimes underlining can make the

text appear like a hyperlink to users.

Strike Through: Makes the selected text struck through by using the <s> HTML

element.

Subscript: Makes the selected text subscript by using the <sub> HTML element.

Superscript: Makes the selected text superscript by using the <sup> HTML

element.
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Text Color: Changes the selected text to the selected color by using the <span>

HTML element. Note: Text colors may be restricted to predefined colors.

Text Highlight: Highlights the selected text with the selected color by using the

<span> HTML element. Note: Text highlight colors may be restricted to predefined

colors.

Remove Format: Using this button strips out most (but not all) formatting from

the selected text. Similar to pasting content as plain text.

Insert/Remove Numbered List: Adds or removes a numbered list, using the <ol>

HTML element. 

Insert/Remove Bullet List: Adds or removes a bullet list, using the <ul> HTML

element. Note:  To change the colour of the bullet, right-click the list, open the

Bulleted List Properties window, and enter the desired colour in the Color field.

Decrease Indent: Decreases an indent by changing or removing the style HTML

attribute and the margin-left CSS property. Note: Using this button inserts inline

CSS code into the HTML, which can interfere with styles defined in the theme.

Increase Indent: Increases an indent by changing or removing the style HTML

attribute and the margin-left CSS property. Note: Using this button inserts inline

CSS code into the HTML, which can interfere with styles defined in the theme.

Block Quote: Inserts a block quote, using the <blockquote> HTML element.

Align Left: Aligns the selected text to the left by using an HTML style attribute

with the text-align: left rule. Note: This is sometimes avoided because it inserts

inline CSS code into the HTML, which can interfere with styles defined in the theme.

Centre: Aligns the selected text to the centre by using an HTML style attribute

with the text-align: centre rule. Note: This inserts inline CSS code into the HTML,

which can interfere with styles defined in the theme.

Align Right: Aligns the selected text to the right by using an HTML style attribute

with the text-align: right rule. Note: This inserts inline CSS code into the HTML,

which can interfere with styles defined in the theme.

Justify: Aligns the selected text with full justification by using an HTML style

attribute with the text-align: justified rule. Note: This inserts inline CSS code into
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the HTML, which can interfere with styles defined in the theme.

Transform Text to Uppercase: By using this button the selected text transforms

to UPPERCASE.

Transform Text to Lowercase: By using this button the selected text transforms

to lowercase.

Capitalize Text: By using this button the selected text transforms to title case

(Capitalizes Each Word). 

Transform Text Switcher: By using this button change the selected text to either

UPPERCASE or lowercase depending on the original format.

Maximize: Increase the size of the HTML editor text area to fill most of the

available screen space in the LCMS browser window by using this button. Note:

This is a very useful feature if you are editing a large or complex screen.

Show Blocks: By using this button, some HTML elements will be visible in the rich-

text editor window by displaying a dotted border around them and the element

name. Note: This can be a useful feature for spotting anomalies in the HTML, which

would otherwise be invisible to the developer, and correcting them.

About CKEditor: Display information about the HTML editor including the version

number by using this button.

3.8.3 Mathematical Notation (LaTeX)

Mathematical notation is available in the LCMS, through a library called MathJax, which is

managed by the American Mathematical Society. This allows markup written in the LaTeX

format  to  be  entered  in  the  HTML editor and  rendered  as  mathematical  symbols  in  the

viewer. You can find detailed documentation on the MathJax and LaTeX websites. There's

an excellent  Wikibook on LaTeX,  and  you can find  information  about  formula  editors  on

Wikipedia. Note: You will not be able to view your mathematical notation within the HTML

editor; you must preview the activity or course to render it in the viewer. 

LaTeX uses plain text that is marked-up using a special notation, which is then rendered in

the  browser using  mathematical symbols.  LaTeX  markup  can  therefore  be  easily  copied

and pasted from other sources, or from one screen to another, using plain text format.

1. Create a new Activity and from the Screen List screen, click the Add Screen

https://en.wikipedia.org/wiki/MathJax
https://en.wikipedia.org/wiki/LaTeX
http://docs.mathjax.org/en/latest/
http://www.latex-project.org/
https://en.wikibooks.org/wiki/LaTeX/Mathematics
https://en.wikibooks.org/wiki/LaTeX/Mathematics
https://en.wikibooks.org/wiki/LaTeX/Mathematics
https://en.wikipedia.org/wiki/Formula_editor
https://en.wikipedia.org/wiki/Formula_editor
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button to create a new screen; click on any screen-style containing HTML text.

(See Manage the Content Repository for more information on creating new

Activities and Screens.)

2. Cut and paste the following two sample pieces of LaTeX markup into the HTML

editor and click the Save button. Note: Make sure you enter LaTeX in plain text

format; you can ensure this by using the Paste as Plain Text button on the HTML

editor toolbar.

\[\left|\sum_{i=1}^n a_ib_i\right|\le\left(\sum_{i=1}^n a_î 2\right)^{1/2}

\left(\sum_{i=1}^n b_î 2\right)^{1/2}\]

\begin{align} (a+b)^3 &= (a+b)^2(a+b)\\ &=(a^2+2ab+b^2)(a+b)\\ &=(a^3

+2a^2b+ab^2) + (a^2b+2ab^2+b^3)\\ &=a^3+3a^2b+3ab^2+b^3 \end{align}

3.Click the Return to the Screen List link at the top of the screen.

4. Click on the Preview icon (shaped like a magnifying glass) to the right of the new

screen in the Screen List. This will open the screen in the viewer and you should

see the LaTeX markup rendered correctly as mathematical notation. (You may need

to select a viewer from the list of ones available.)  
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Note: In Storyboard view, LaTeX notation will not be rendered as mathematical

symbols; choose another viewer to access this feature.

3.8.4 Add Inline Image

The image button allows the user to insert inline images. If you use the image button from

inside the Media Description, it is associated with the Reference Media Library, which

contains images used as draft or reference content, visible to reviewers alongside other

media description information but not intended for inclusion in the final packaged version

of the activity. However, elsewhere, this button accesses the main Media Library. See

the section on Managing Media Files for more information on the Media Library.

1. In the HTML editor, click the Image button on the toolbar. 

2. You will see the Image Properties pop-up. Click the Browse Server button. You

will be taken to the Media Library from which you can search for and select an

image. Note: If you are editing the Media Description field, you will be taken to

the Reference Media Only library. You can upload new images here or select
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existing images from the repository. Images uploaded to the main Media Library will

not be visible here, and vice versa. 

3. Once you have selected a reference image from the library, you will return to the 

Image Properties window. You will now see the chosen image in the Preview

window. Here you can set the Alignment, Width and Height to make it fit better

alongside the text, if any. Note: The Width and Height fields are locked to each

other to maintain the image proportions, so changing one will change the value in

the other field automatically.
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4. Click OK to insert the image inline in the HTML or Cancel to exit without saving.

Note: Images inserted in the Media Description field will be visible anywhere the Media

Description is displayed, including in previews where no final graphic is available, and in

Storyboard and Lesson Outline views.

Note: It is also possible to attach hyperlinks to inline images, including links to modal pop-

up windows.

3.8.5 Keyboard Shortcuts

The following shortcut keys work in the HTML editor:

Working with a Document

Escape – Closes a dialogue window, drop-down list, or context menu in the editor.

Enter – Selects a function in the toolbar, drop-down list, or context menu.
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Shift+F10 – Opens the current element's context menu.

Navigation

Home – Jumps to the beginning of the line.

Ctrl+Home – Jumps to the beginning of the document.

End – Jumps to the end of the line.

Ctrl+End – Jumps to the end of the document.

PgDn – Scrolls down the document, approximately by the length of the editing area.

PgUp – Scrolls up the document, approximately by the length of the editing area.

Writing

Enter – Ends a paragraph and starts a new one (by inserting HTML <p> paragraph tags).

Shift+Enter – Adds a line break, by inserting the HTML <br/> tag.

Shift+Ctrl+3  –  Enables  entering  content  (by  adding  a  new  paragraph)  before  a

problematic  element  such  as  an  image,  table  or  <div>  element  that  starts  or  ends  a

document, list, or even adjacent horizontal lines.

Shift+Ctrl+4 – Enables entering content (by adding a new paragraph) after a problematic

element such as an image, table or <div> element that  starts or ends a document, list, or

even adjacent horizontal lines.

Backspace, Del – Deletes a character.

Ctrl+Backspace, Ctrl+Del – Deletes a word.

Shift+Space  –  Non-breaking  space  (inserts  the  &nbsp;  HTML  entity).  Note:  This

character is indistinguishable from a normal (breaking) space  in  rich-text  view  but  it  can

affect line wrapping so be careful to avoid inserting these characters unintentionally.

Undo and Redo

Ctrl+Z – Performs the undo operation.
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Ctrl+Y, Shift+Ctrl+Z – Performs the redo operation.

Cut, Copy and Paste

Ctrl+X, Shift+Del – Cuts the selected content to the clipboard.

Ctrl+C – Copies the selected content to the clipboard.

Ctrl+V, Shift+Insert – Pastes a text fragment from the clipboard.

ALT+Q  –  Pastes  the  contents  of  the  clipboard  as  plain  text  (stripping  all  formatting).

Note: This works in most web browsers except Internet Explorer.

ALT+W  –  Paste  from  MS-Word,  converting  some  basic  formatting  into  HTML  and

discarding other mark-up. 

Text Selection

Ctrl+A – Selects all document contents.

Shift+Arrow – Selects content by letters.

Ctrl+Shift+Arrow – Selects content by words.

Shift+Home – Selects content from the cursor to the beginning of the line.

Shift+End – Selects content from the cursor to the end of the line.

Ctrl+Shift+Home – Selects content from the cursor to the beginning of the document.

Ctrl+Shift+End – Selects content from the cursor to the end of the document.

Shift+PgDn  –  Selects  content  of  approximately  the  length  of  the  editing  area  starting

from the cursor and going down.

Shift+PgUp  –  Selects  content  of  approximately  the  length  of  the  editing  area  starting

from the cursor and going up.

Text Styling

Ctrl+B – Applies bold formatting to a text fragment.
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Ctrl+I – Applies italics formatting to a text fragment.

Ctrl+U – Applies underline formatting to a text fragment.

Rich Text

Ctrl+L – Opens the Link dialog window.

Tab – Indents a list.

Shift+Tab – Outdents a list.

Note:  Clicking  the  right  mouse-button  in  the  HTML  editor  will  open  a  special  context

menu.  You  can  override  this  and  open  the  standard  browser  context-menu  by  holding

down the CTRL key and right-clicking with the mouse.

3.8.6 Advisory Notices

The HTML editor has a special widget  that  allows users to  insert  information that  will  be

formatted  according  to  predefined  styles  for advisory  notices,  such as  warnings,  notes,

and  cautions.  Note:  The  icons  used  in  this  special  widget  are  either  ISO  3864-1:2011

Standard or OSHA/ANSI Z535.6 2013 Standard.

1. Click on the Advisory Notice icon in the HTML editor toolbar. You will see a new

window with a list of icons, from which you can choose the type of notice to be

created.
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2.Click on an icon and the corresponding notice will be inserted inline in the HTML

editor.

3. Enter the text you want the notice to contain, just by typing it in directly in the

editor.
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3.8.7 Insert Dynamic Variable

The HTML editor also has a Insert Dynamic Variable button that  allows users  to  insert

dynamic  variables into the E-Mail Templates. This feature is only active in when the E-

Mail Template is open. 

1.  To insert  a dynamic  variable  into  the  text  body,  click inside  the  text  field  where  the

dynamic variable will be inserted.

2.  Select  the  desired  dynamic  variable  from the  Insert  Dynamic  Variable  drop-down

menu. Note: For the Subject, enter the variable name inside the square brackets (i.e.

[VARIABLE_NAME]).

3. Click the Submit button to save. See E-Mail Templates for more information.
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3.8.8 Create Snippet

Snippets are created in the Main Text field or Instructor Notes field using  the  Snippet

icon. Note: Snippets are unclassified. Content  considered to be Controlled  Goods  (CAT

1-3)  or  Classified  (Restricted,  Confidential,  or  Secret)  should  not  be  included  in

snippets.

1.  Enter text into the Main Text field or Instructor Notes field.

2.  Select the desired text to include in the snippet and click the Snippet icon. Note: The

desired text  becomes the snippet  and displays with a grey  background.  Right-click the

snippet  and  select  the  Remove  Snippet  option  to  remove  the  snippet  (grey

background removed). The text remains (breaks the link to the snippet). Note: It  is not

possible to create a snippet  inside of a snippet  (you must  create  a  separate  snippet).

Snippets can be edited in the Snippet Bank by  an Administrator,  Manager,  Senior

Developer, or the Developer who created the snippet. When a snippet  is  modified  in

the  Snippet  Bank all  instances  of  the  snippet  will  be  updated.  See  Snippet  Bank  for

more information. 
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3. Click the Submit button to save.

3.8.9 Insert Snippet

Snippets can be inserted into a Main Text or Instructor Note field by placing the cursor

inside the field (without selecting text) and clicking the Snippet icon. 

1.  Select  the  desired  Snippet  from the  list  by  clicking  the  link icon in  the  last  column.

Note: Right-click the Snippet to break the snippet link but retain the text or to edit  the

snippet metadata.
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2. Once the snippet link is removed, right-click the text and click cut, copy or paste.

3. Click the Submit button to save.

3.8.10 Insert Table

1.  In the Main Text field, click the pencil icon to open the HTML editor.

2.  Click the Table icon in the top row.

3.  When the  Table  Properties  window  opens,  enter the  desired  number of  rows  in  the

Rows field. Enter the desired number of columns in the Columns field. Note: To insert

or delete rows or columns  in  an existing  table,  right-click on the  table  and  select  the

desired action from the list. You can also  insert,  delete  or merge  cells  and  delete  the

table.
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4.  Enter the desired width and height  of the table in the Width and Height fields. Note:

The  table  will  automatically  adjust  to  the  content  if  these  fields  are  left  blank.  The

column width can also be adjusted by dragging to the desired width.

5.  Select the desired header option (None, First Row, First Column or Both). 

6.  To insert  a border around the table, enter the desired border size in  the  Border Size

field. Note: No border displays when the field is left blank.

7.  To insert  cell padding and spacing  for the  table  cells,  enter the  desired  cell  padding/

spacing in the Cell padding and Cell spacing fields.

8.  Select  the text  alignment  within  the  cells  from the  Alignment  drop-down menu (Left,

Center or Right).

9.  Enter a table title in the Caption field. Note: The table caption displays at  the top of

the table.

10. Enter a  brief  description of  the  table  content  in  the  Summary  field  or leave  blank.

Note: This field does not display in the Main Text field. 

11. Click OK to save. Note: Right-click on the table and select  Table Properties to view

or modify the table properties.

12. Click the Advanced tab to assign an Id  and  Stylesheet  Class  attribute  that  can be
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used  in  a  specified  CSS  stylesheet.  Additionally,  you  can  assign  the  language  text

direction from the  Language  Direction  drop-down  menu  (Left  to  Right  or  Right  to

Left).
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4 LCMS Home Page (Admin Menu)

Depending on the rights you have been assigned, you may have access to some or all of

the LCMS development functions. Developers and Managers have access to most

development functions by default.

This image shows an Administrator's view of the LCMS Home screen.

Developers and Managers have My Profile as their only option in the left menu, as shown

below. The option to choose a role for each activity using the drop-down menu is also

available.



Learninglogics® LCMS 4.31 User Guide60

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

4.1 My Profile

All users can change their own profile settings by clicking the My Profile link at  the top of

the Admin Menu on the LCMS Home screen. This will open the Details window below.

Clicking the Reset Preferences button will reset the configuration of the navigation tree.
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This may be useful if you encounter technical problems with the rendering or functionality

of the navigation tree.

Note: If Enforce Strong Passwords is enabled in the Application Settings screen, user

passwords must be eight characters consisting of all of the following: at least one number,

at least one uppercase character, at least one lowercase character and at least one

special character.

4.2 User Management

The User Management feature allows the Administrator to control access to the LCMS,

register users and change user profile information. Other user roles with the User

Management privilege will also be able to access this feature.

1. Click the User Management link on the LCMS Home screen. 

2. The User Management window will appear with tabs for Administrators, Users

and Inactive Users. Click any tab to see a list of these users. In the image below,

the Users tab is selected.
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4.2.1 Add New User

1. To add a new user, click the Add New User button. 

2. The Add New User window will open.

3. Type the new user information in the fields, including First Name, Last Name, User

Name, Password, Confirm Password and Email. Note: If Enforce Strong

Passwords is enabled in the Application Settings screen, user passwords must be

between 8 to 64 characters consisting of all of the following: at least one number, at

least one uppercase character, at least one lowercase character and at least one

special character.

4. Select the organization that the user belongs to from the drop-down list. If the

organization is not displayed in the drop-down list, enter the name of the new
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organization in the corresponding field.

5. Click the checkbox beside Send user their login information. The new user will be

notified by e-mail about the account creation.

6. Click the checkbox beside Include login credentials, when the User Name and

Password will also be included in the email. Note: Hover the mouse over the text Send

user their login information or Include login credentials to view the help tip.

7. Click Submit.

8.Once the new profile is created, the user can be added to a project. See the

instructions to Assign Users to a Project.

4.2.2 Deactivate User

1. From the Users tab, click the Make User Inactive icon on the right to move a

user to the Inactive Users list. 

2. A dialogue box will appear. Click Yes to confirm the deactivation or No to cancel

and return to the list of Users. 
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4.2.3 Unlock User Account or Modify User Profile (Profile Tab)

User  accounts  may  be  automatically  "locked"  as  a  result  of  repeated  login  failures.

Account status must be set to "unlocked" to allow users to work within the LCMS again. 

To unlock a user account or update user information: 

1.  Click the User Management link on the LCMS Home screen. The User

Management window will appear with a list of all registered users.

2.  Click the User Name link to access the user details. 

3.  Click the Profile tab.

4.  To modify the user profile, edit each field as required.

5.  To unlock the user's account before the Lockout on Fail time has expired, click

the Select to unlock account immediately checkbox for the Failed Login Lock

field. 

6.  Click the Submit button to unlock the user account. Note: Unlocking the user

account will also clear any failed attempt timeouts that may have occurred. See 

Logins for more information.
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4.2.4 Set User Roles

Administrators can now easily see which project(s) a user is  assigned  to,  as  well  as  the

role(s) the user has within the project. 

1.  Under the User Management section, select  the Users tab. Select  a user within the

available list to bring up their user profile.

2.  Click the Roles tab to see which project(s) the user is assigned to and their role(s) on

each.

3.  To modify this list, click Assign User to  Project(s)/Role(s),  which opens  the  drop-

down lists  of  projects  and  roles  in  a  new  pop-up  window.  Click  Save  to  record  the

changes, or click Done when finished.
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4.2.5 Set Security Levels

Administrators  can set  security  classification and  controlled  goods  levels  of  security  for

users.

To set or edit user security information: 

1.  Click User Management on the LCMS Home screen. The User Management

window will appear with a list of all registered users.

2.  Click User Name to access the user details. 

3.  Click the Security tab.

4.  Options from the Security Classification drop-down are:

5.  Options from the Controlled Goods drop-down are:

6.  Once you have set the required security levels, click Submit.

If a user tries to access content that has a security or controlled goods level higher

than their assigned clearance in the LCMS, they will receive a Security Notice as

follows:
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4.2.6 Access Log Report

The Access Log Report feature records user access to the LCMS and provides
Administrators with reporting and download functions to evaluate the data (e.g. when
users log in and out, as well as when a screen was last updated).

1. Click the User Management link on the LCMS Home screen. 

2. Click the Access Log Report button at the top of the screen to view a report on

user access to the LCMS.

3. From the Access Log Report window, data can be filtered by Role, Date Accessed

and Project. The report can be opened in Excel or CSV format.

4. This feature can be enabled or disabled via LCMS Home > Application

Preferences > General, as shown below. If it is disabled, the Access Log Report

button will not appear on the User Management screen.
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5. Administrators can download the current access log in a CSV format by clicking 

Download Log (CSV), and can reset the data by clicking Reset Logging Data. If

the Reset button is selected, the following message will appear:

4.2.7 Import LDAP Users

When Active Directory Authentication or Hybrid Supporting Both authentication is

enabled, administrators can import users from the LDAP server. The import can be

immediate or automated to occur at a a later time.

To import immediately:

1. Click the User Management link on the LCMS Home screen, and then click the

Import LDAP Users button.

2.  On the Import LDAP Users screen, modify the Group Query field or use the default
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value, and then click the Search button. Note: All users on the LDAP server that

match the Group Query will display. In the Status column next to each user, an icon

will depict the user’s LCMS status:

 This icon displays when a user has not been added to the LCMS. 

 This icon displays when a user with a matching first and last name, or email

address exists in the LCMS. It could also mean the user exists but their

information has been updated. Note: When these users are selected, they will

link to the existing LCMS account.

 This icon displays when a user exists in the LCMS.

3.  Select a default from the drop-down menu for the Organization, Security

Classification, and Controlled Goods fields. These defaults will be applied to the

imported users.

4.  Click the checkbox beside Send user their login information to email the

imported users their LCMS login (optional).

5.  Click the checkbox beside Also apply these defaults to accounts being linked

to apply the defaults to existing LCMS users that are being linked to LDAP accounts

(optional). Note: If this is not selected, the users will retain their assigned

Organization, Security Classification, and Controlled Goods.

6.  Click the checkbox beside each user to be imported, and then click the Import
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Selected Now or the Automate Import button. Note: When the Import

Selected Now button is clicked the import will finish and a list of imported users will

display. When the Automate Import button is clicked the Create Import

Schedule window opens.

7.  On the Create Import Schedule window, select the Frequency (Daily, Weekly

or Monthly) and Start Date/Time for the import. Note: When Weekly or Monthly

is chosen, the subsequent imports will occur on the same day of the week and

time.

8.  Enter an email address in the Email field to send the email recipient notifications

about the automated imported (optional).

9.  Click the Create button to create the automate import or click Cancel to return to
the Import LDAP User screen without saving.

4.3 Password Management

Administrators and other roles with the Password Management privilege enabled, may

manage the passwords of other users. The password management function tracks the

date that a user password was changed, and allows the Administrator to email selected

users to prompt them to change their password. 

1. Click the Password Management link on the LCMS Home screen. The Password

Management screen displays with a list of users and the dates their passwords

were last changed.
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2. To email a selected user, click the checkbox for that user. 

3. Click the Email Selected Users button. Your default email application will open.

4. Edit the email contents as required. 

5. Send email to the selected users. 

Note: If Warn User is configured in the Application Settings, users receive a message

when their password is about to expire.

Note: If Enforce Strong Passwords is enabled in the Application Settings screen, user

passwords must be between 8-64 characters consisting of all of the following:at least one

number, at least one uppercase character, at least one lowercase character and at least

one special character.
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4.4 Project Management

The Project Management administrative functions include adding new project titles to

the LCMS, modifying existing project titles and assigning users to a project. 

4.4.1 Add New Project

1. Click the Project Management link from the LCMS Home screen.

2. The Project Management screen will appear with a list of all active projects. Click

the Add New Project button.

3. The Add New Project window will appear. Type in the project name and the

project code.
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4. Click in the Project Directory field. The project directory and the reference

collection information will be automatically entered for you.

5. If required, type the "manage footer" information in the Manage Footer field. This

is placed on the bottom of reports generated by the LCMS Report Manager feature.

6. Click the Submit button to save the changes.

7. The new project title will be added to the Project Management screen. A

database will also be created for the new project.

4.4.2 Edit Project Information

1. On the LCMS Home screen, click the Project Management link. The Project

Management window will appear with a list of all active projects. 

2. Click the title of the project you wish to make changes to. You will see tabs for 

Details, Interfaces and Preferences.

3. Click the Details tab to see fields for Project Name, Project Code, Project

Directory, Reference Collection and Manage Footer. From here, you can make

changes to Project Name and Manage Footer information only. 

4. Click the Submit button to save changes. 
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5. Click the Interfaces tab to see a list of interface options for the project. Ctrl-click

to select each interface you would like the project to have access to. 

6. Click the Submit button once all selections are made.

7. Click the Preferences tab to see a list of available Components, for the project.

8. Click the Submit button to save changes.
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4.4.2.1 Activity Types

1. On the Preferences tab, click Activity Types from the Components menu.

2. Click the Activity Type checkbox to choose it from the Activity Types list. The

activity types allowed to be created by users are: Independent Study, Test,

Instructor Led Lesson and Survey.

3. Click Submit to save the changes.

4.4.2.2 Course Export/Publish Options

1. On the Preferences tab, click Course Export/Publish Options from the

Components menu. 

2. Click the checkbox beside the Activity Production status to include in the course
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export. Several activity production statuses can be selected that allow the activity

to be included in a course export. Note: To not have any restrictions on when an

activity can be exported, leave the list unchecked. 

3. Click the Include Offline Course in Published SCORM Package checkbox to

toggle between including or excluding an offline version of the course in the

published course package. Note: The default setting is to include an offline version

of the course. 

4. Click the On Publish update the Activity Production Status to Published and

lock the Activity checkbox to toggle (on or off) changing the activity production

status to Published and locking the activity after it is published. Note: When this

option is selected, the corresponding changes will be made automatically.

5. Click Submit to save the changes.

4.4.2.3 Developer Options

1. On the Preferences tab, click Developer Options from the Components menu.

 Choose from the list to assign the media related permissions a developers can have

for the project. 

2. On the Media Related pane, click the checkbox to choose the media related

Developer Options from the list. The following media related developer options

may be enabled for the project: Add/Update Media, Delete Media and Update/

Delete Media (Only if uploader).

3. On the Tags pane, click the checkbox beside Can create new tags to grant

developers the permission to add new tags. Note: When the checkbox is selected,
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developers may add, select and deselect tags. When the checkbox is left

unchecked, developers will only be able to select or deselect tags. 

4. Click Submit to save the changes.

4.4.2.4 Editor

1. On the Preferences tab, click Editor from the Components menu.

2.  Click the grey area beside the dialog box to open the color palette, or enter the

color by name (white, black) or hex color value (bbbbbb, ff0200, 002200). Note: Up

to ten custom colors can be defined in the CK editor. The defined colors will be the

default colors for the font color and highlight color ( ) drop-down menus.

Clicking the Clear Color Entries button will delete all of the color entries.

3.  Select the checkbox beside the Disable more color options to restrict the user

from choosing additional colors. Note: Users may only select from the defined

default colors.

4.  Click the Submit button to save the changes. 
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4.4.2.5 E-Mail Templates

1. On the Preferences tab, click E-Mail Templates from the Components menu. 

2. Select the desired email Template from the drop-down menu. Note: The templates

in the drop-down menu are LCMS defaults. 

3. To create a custom template, click the Use Custom Template checkbox and

enter the desired information in each field. Note: Any templates created will

override the templates defined Application Preferences. To continue to use the

default templates, leave the Use Custom Template checkbox blank.

4. To edit the Template, select the desired template from the drop-down menu. 

5. Click the Load System Default button and modify the text in the text field.
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5. On the template window, click the text body window to open the Editor. Note:

Insert template dynamic variables into the text body by clicking the Insert

Dynamic Variable drop-down menu in the toolbar. For the Subject, type the

variable name inside [square brackets]. 

6. Click the Submit button and close the window to return to E-Mail Templates

window.

6. On the E-Mail Templates window, click the Submit button to save the changes. 

4.4.2.6 Multilingual Support

1. On the Preferences tab, click Multilingual Support from the Components menu.

2. Assign the default language and alternate language by selecting it in the drop-

down menu. 

3. Click the Enable Multilingual Support checkbox to enable multiple language

supports.
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4. Click Submit to save the changes.

4.4.2.7 Plotter Tool

See Configure Plotter Tool for more information.

4.4.2.8 Quiz Defaults

To add Quiz Defaults see Configure Quiz Defaults.

4.4.2.9 Security

1. On the Preferences tab, click Security from the Components menu.

2. Select the desired security classification from the Security Classification drop-

down menu. Note: This will set the security classification default for new screens

created within the project.

3. Select the desired controlled goods category from the Controlled Goods drop-

down menu. Note: This will set the controlled goods category default for new

screens created within the project.

3. Click the Submit button to save the changes. 
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4.4.2.9.1  Edit Security Classif ication Description

1. On the Preferences tab, click Security from the Components menu.

2. Click the Edit List Description button beside the Security Classification field.

3. On the Edit Security Classification Defaults window, click the Description field

for the classification default you wish to edit.

4. Enter the desired changes in the Description field.

5. Click the Save button to save the description.

6. Click the Submit button to save the changes.
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7. Click the Revert to System Defaults button to reset the security classifications

to the system default classifications.

8. Click the Submit button to save the changes.

9. Click the Revert to Application Preferences button to reset the security

classifications to match those set in Application Preferences. See Security for

more information.

10. Click the Submit button to save the changes.

4.4.2.9.2  Edit Controlled Goods Description

1. On the Preferences tab, click Security from the Components menu.

2. Click the Edit List Description button beside the Controlled Goods field.
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3. On the Edit Controlled Goods Defaults window, click the Description field for

the controlled goods default you wish to edit.

4. Enter the desired changes in the Description field.

5. Click the Save button to save the description.

6. Click the Submit button to save the changes.

7. Click the Revert to System Defaults button to reset the controlled goods

categories to the system default categories.

8. Click the Submit button to save the changes.

9. Click the Revert to Application Preferences button to reset the controlled goods

categories to match those set in Application Preferences. See Security for more

information.

10. Click the Submit button to save the changes.

4.4.3 Delete a Project

1. On the Project Management page, click the Delete icon   beside the name of
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the project you wish to remove.

2. A window will appear asking if you are sure you wish to delete the project. Click 

Yes to delete.

4.4.4 Assign Users to a Project

Once you have added a project to the LCMS, you must assign users who will have rights

to the project. Administrator is a sitewide role. In addition, there are several system-

generated user roles for projects: 

Manager

Developer

Senior Developer

Approval Authority 

Reviewer

Review Manager

Review Monitor

Media Developer



LCMS Home Page (Admin Menu) 85

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

Note: It is possible to assign one user to more than one role in a project. In this case,

they will be presented with a drop-down menu from which to select their chosen role

when entering the project from the home screen. Assigning the user to multiple roles or

projects does not change the seat count for the license. One user equals one license.

1. On the LCMS Home screen, click the Project Management link.

2. The Project Management screen appears. To assign rights to the project, click

the links for the rights you wish to assign. For example, to assign Developer rights

to a project, click the Developer link.

3. A window appears listing all users assigned to the LCMS. Resource names are listed

alphabetically by last name, first name. Use the Filter field to type in a user's name



Learninglogics® LCMS 4.31 User Guide86

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

to speed up your search. 

4. Select the name or names of the users in the Available Resources column that

you would like to add to the project. Click the right arrow button to move the

name(s) to the Currently Assigned column. To remove a user from the Currently

Assigned column, select the user and click the left arrow button to move the name

back.

5. Click the Submit button. The selected users are now assigned Developer rights to

the project.

Note: You can assign or remove all users at one time by simply clicking the left or

right double arrow buttons.

6. Repeat steps 1 – 5 to assign the required users to the project. 

Note: To manage the review/approve activities process within the LCMS, a

Reviewer or Review Manager and Approval Authority must be assigned to the

project.

4.5 Interface Management

Once an interface has been added to the LCMS through the Interface Management

feature, you have the option of choosing an interface when you preview an activity. You

can add or delete interfaces from within the Interface Management screen.

Note: New projects automatically have the system "Default Interface" made available to

them.
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4.5.1 Add Interface

1. On the LCMS Home screen, click the Interface Management link.

2. The Interface Management screen will appear. Click the New Interface button.

3. On the New Interface window, you will see the tabs: General, Advanced, and

Custom Styling tabs. Each tab is described on the following pages.
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4.5.1.1 General Tab

1. In the General tab, on the New Interface window, enter the necessary

information in the fields or select a prototype from the Based On drop-down list

and click the Fill in Fields button to copy its default values.

2. Enter a title for the new interface in the Interface Name field.

3. Enter values for the initial Width and Height of the viewer window in pixels. The

default values are 1904 (W) and 950 (H).

4. In the Projects selection box, choose the projects where you want the interface

to be made available.
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6. Click the Submit button to save. Note: Once the new interface is created, the

window will reload to display the Pop-out Content Buttons tab. See Pop-out

Content Buttons for more information.

4.5.1.2 Advanced Tab

1. The Advanced tab, on the New Interface window, contains settings for the

Engine Path and Root Directory. Note: These should normally be left at their

default settings.

2. You can also choose which Windows Options to enable/disable for a preview.

There are checkboxes for "resizable, Status Bar, Tool Bar, Menu Bar and Location

(Address Bar). 
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3.  The Pop-out Content Buttons tab opens. Note: The Pop-out Content Button

information can only be entered after the interface has been created. Configure

the Pop-out Content Buttons (if required). See the Pop-out Content Buttons

section for more information.  

4.  Click the Submit button. The new interface will be listed in the table on the

Interface Management screen.

4.5.1.3 Custom Styling Tab

1. From the Custom Styling tab, on the New Interface window, you can enter CSS

to customize the styling of generated content.

2. Use the Validate CSS button to check for problems in your markup. 
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3. Click the Submit button. The new interface will be listed in the table on the

Interface Management screen.

4.5.2 Edit Interface Field Information

1. Click the name of the interface from the Interface Name column on the Interface

Management screen. 

2. On the Edit Interface screen, General tab you may edit the interface information

(name, width, height, and projects). You may also edit the information on the 

Advanced and Custom Styling tabs.

3. Change the desired field information and click the Submit button. 

4.5.2.1 Custom Logic

1.  On the  Edit  Interface  screen,  click the  Custom  Logic  tab  to  configure  the  viewer

interface. 

2.  On  the  Video  pane,  enable  the  desired  options  (Always  Show  Controls,  Rewind

When  Finished  Playing,  Auto  Play  On  Show,  Show  Full  Screen  Button,  and/or
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Show PIP Button) by clicking the corresponding checkbox.

3.On  the  Tests  pane,  enable  the  desired  options  (Show  Evaluate  Button  When  All

Answered, Show Evaluate  Button Immediately  and/or Confirm  Dialog  Questions

Not Answered) by clicking the corresponding checkbox.

4.On  the  Media  pane,  enable  the  Hide  Media  Assets  by  clicking  the  corresponding

checkbox.

5.On the Gating pane,  enter a  value  in  seconds  in  the  Delay  Navigation by  Seconds

field. 

6. Click the checkbox beside Disable Next Button Only to enable the option.

7. Enable  the  desired  options  (Allow in LMS,  Allow in LCMS Previews,  Allow in  LCMS

Reviews,  Ignore  Tree  Menu,  HTML Media  Loading Auto  Gate  Next,  and/or  HTML

Media Ignore Questions) by clicking the corresponding checkbox.

8. Click the Submit button to save the changes.

Pane Option Description

Always

Show

Controls

When  this  option  is  enabled,  the  player  control  bar  at  the

bottom of the video will always appear.

When  this  option  is  disabled,  the  player  control  bar  at  the

bottom of the video will only show on mouse over.
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Video

Rewind

When

Finished

Playing

When this  option is  enabled,  the  play  head  will  move  to  the

beginning of the video when the video ends.

When this option is disabled, the play head will stay at  the end

of video. This is the default option for the play head.

Auto Play

On Show  

When this option is enabled, the video is shown on screen and

will start playing right away. 

When this option is disabled, the video is paused at the

beginning and the user must click the play button. This is the

default option for videos.

Show Full

Screen

Button  

When this option is enabled, the full screen button will display

on the player controls to show the video in full screen mode.

When this option is disabled, the full screen button will not

display.

Show PIP

Button  

When this option is enabled, the picture-in-picture (PIP)

button will display on the player controls to show a pop out of

the video that can be dragged around the monitor. 

When this option is disabled, the PIP button will not display.

Tests

Show

Evaluate

Button

When All

Answered 

When this option is enabled, the Evaluate button will display

once the user has answered all the questions. The user clicks

the button to obtain a score for the test. 

When this option is disabled, the Evaluate Button will display

on the last question. The user does not have to answer the

questions to see the button. This is the default option.

Show

Evaluate

Button

Immediatel

y  

When this option is enabled, the Evaluate button will display at

the beginning of the test and remain on screen. 

When this option is disabled, the Evaluate Button will display

on the last question. The user does not have to answer the
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questions to see the button. This is the default option.

Confirm

Dialog

Questions

Not

Answered  

When this option is enabled, if the user clicks the Evaluate

button but does not answer all the questions a Yes/No window

will display asking the user if they still want to evaluate the

test. The user can click No and navigate through the test to

answer each question. If the user clicks Yes the unanswered

questions are scored as incorrectly answered.

When this option is disabled, if the user clicks the Evaluate

button but does not answer all the questions, the unanswered

questions are scored as incorrectly answered.

Media

Hide Media

Assets  

When this option is enabled, the media assets will not load in

any screen. Only the media descriptions will load if available.

When this option is disabled, the media assets will load in any

screen.

Gating 

Delay

Navigation

by Seconds

 

When this option is enabled, the navigation buttons will be

disabled for the value entered in the Delay Navigation by

Seconds field. 

Disable

Next

Button

Only  

When this option is enabled, the only the Next button will be

disabled. This option is only enabled when the value entered in

the Delay Navigation by Seconds field is greater than zero.

When this option is disabled, the Previous and Next buttons will

be disabled by default.

Allow in

LMS

When this option is enabled, any type of navigation gating will

work in the LMS.

Allow in

LCMS

Previews

When this option is enabled, any type of navigation gating will

work in the LCMS preview screens.
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Allow in

LCMS

Reviews

When this configuration is enabled, any type of navigation

gating will work in the LCMS review screens.

Ignore Tree

Menu

When this configuration is enabled, the navigation in the tree

menu is not disabled when gating is enabled in LCMS reviews.

HTML

Media

Loading

Auto Gate

Next

When this configuration is enabled, the next button will be

automatically disabled when loading HTML media.

Media assets may have code to enable the next button but not

the code to disable the next button, if this is the case use this

configuration to automatically disable the next button in the

viewer, when loading HTML media.

HTML

Media

Ignore

Questions

When this  configuration is  enabled,  if  the  media  has  code  to

disable  navigation  the  code  will  be  ignored  when  the  HTML

media  is on a question screen.

4.5.2.2 Pop-out Content Buttons

1. On the Edit Interface screen, click the Pop-out Content Buttons tab to

configure buttons for pop-up content. Note: Up to five buttons can be configured

(text only, icon only or icon and text). Buttons can be deleted by clicking the

corresponding delete icon.
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2. To configure a button, select the Pop-up Style (New Window or Inline). Note:

When Inline is selected, a Pop-up Style Dimensions window opens. 

3. Enter the desired dimensions and click the Submit button.

4. Enter the desired button text in the Button Text field or leave it blank. Note: Up

to a maximum of 40 characters can be entered in the Button Text field. 

5. Enter a Font Awesome class in the Fontawesome Classes field or click the

Select button to upload a desired icon or leave blank. Note: Font Awesome classes

can be sourced on the internet. Only free Font Awesome classes are supported.

6. Click the Submit button to save. 

4.5.3 Delete Interface

1. Select the ID box beside the interface you want to delete.
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2. Click the Delete button.

3. A pop-up window will appear and ask if you are sure you want to delete the

interface. Click OK or Cancel.

If you click OK, the interface will be deleted from the Interface Management screen.

4.6 Application Preferences

Users with the Administrator role may change Application Preferences such as date/time

formatting,  login  attempts  allowed,  versioning  settings,  review  settings  and  other

configuration settings. Changes made here will affect all projects.

1. Click Application Preferences from the LCMS Home screen.
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2. You will see the Application Preferences screen and a list of Components.

3. Click on the different component types to configure their settings for all projects.

4.6.1 General

1. On the Application Preferences screen, click General from the Components

menu.

2. The Detected URL field displays the current application URL. Note: There are

times when the LCMS may not detect the application URL properly, especially when

installed behind a load balancer. 
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3. To ensure the background features function properly, you may need to enable the 

Always use https function by clicking the Always use https checkbox.

4. Enter the desired email address in the Support E-Mail field. This email address

displays on the LCMS Home page. Note: Leave this field blank to use the default

email address.

5. Enter the desired email address in the E-Mail From Address field. This email

address will display in the From field on system-generated emails such as user

notifications and review reminders. 

6. To render HTML into PDF, the LCMS uses wkhtmltopdf, which is an open source

(LGPLv3) command line tool. This tool is installed during the installation. Note: The

default location where the tool installs is C:\Program Files\. To change the location,

enter the new path (actual location). Ensure the path name ends with a back slash

(\) (i.e., C:\NewPath\).

7. Click the Enable Screen Titles checkbox to toggle screen titles on or off. By

enabling screen titles, an extra input field is shown on the various screen style

input screens. In the past, this was used for SEACOT and Anark activity types only.

The Screen Title shows when viewing the Topic Screen listing. It is currently not

displayed via the Engine interfaces.

8. Click the Track Phases of Activity Development checkbox to enable users to set
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development phases for activities (i.e. Lesson Outline, Storyboard, Lesson, etc.).

9. Click the Enable Access Logging checkbox to enable tracking of user access to

the LCMS. The Access Log Report button will be available on the User

Management screen once this checkbox is selected. Administrators can download

the current access log in a CSV format by clicking Download Log (CSV), and can

reset the data by clicking Reset Logging Data. If the Reset button is selected,

the following message will appear:

10. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.2 Background Services

Background  Services  enables  an  Administrator  to  customize  the  domain  for  background

services used for tasks such as course publishing. 

Important Note: Only modify this field if it is a requirement  of your network environment.

This field should be left blank to use the LCMS calculated value.  

1. On the Application Preferences screen, click Background Services from the

Components menu.
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2. Enter the desired services domain in the Services Domain field. Note: This field

should be left blank to use the LCMS calculated value.

3. Click the Test button to verify the entry.

4. Click the Clear button to clear the entry.

5. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.3 Course Packaging

The Course Packaging path is a local or network location shared by the Learninglogics®
LCMS and the Learninglogics® LMS (or other LMS). This is the path location that SCORM
packages will be saved to. 

1.  On the Application Preferences screen, click Course Packaging from the

Components menu.
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2.  Click the Test button to verify that the server has access prior to submitting a

change. If you receive an error, the path entered is most likely incorrect or     the

IIS_IUSRS user does not have permission to perform one of the copy, create or

delete tasks.

3.  Click the Clear button to clear the path entry.

4.  Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.4 Date/Time Formatting

1. On the Application Preferences screen, click on Date/Time Formatting from

the Components menu.

2. Click the drop-down menu to choose a different Date Format for screens and

output.

3. Click the drop-down menu to choose a different Time Format for screens and

output.

4. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.
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4.6.5 Editor

1. On the Application Preferences screen, click on Editor from the Components

menu.

2.  Click the grey area beside the dialog box to open the color palette, or enter the

color by name (white, black) or hex color value (bbbbbb, ff0200, 002200). Note: Up

to ten custom colors can be defined in the CK editor. The defined colors will be the

default colors for the font color and highlight color ( ) drop-down menus.

Clicking the Clear Color Entries button will delete all of the color entries.

3.  Select the checkbox beside the Disable more color options to restrict the user

from choosing additional colors. Note: Users may only select from the defined

default colors.



Learninglogics® LCMS 4.31 User Guide104

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

4.  Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.6 E-Mail Templates

The E-Mail templates provide customized or standardized messages to  send  to  the  users

for various notifications such as overdue notices.

1. On the Application Preferences screen, click E-Mail Templates from the

Components menu.

2. Select the desired email Template from the drop-down menu. Note: The templates

in the drop-down menu are LCMS defaults. 

3. To create a custom template, click the Use Custom Template checkbox and

enter the desired information in each field. Note: Any templates created will

override the templates used by the LCMS. To continue to use the LCMS defaults,

leave the Use Custom Template checkbox blank.
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4. To edit the Template, select the desired template from the drop-down menu. 

5. Click the Load System Default button and modify the text in the text field. Note:

Insert template dynamic variables into the text body by clicking the text body

window, and then the Insert Dynamic Variable drop-down menu in the toolbar.

For the Subject, type the variable name inside [square brackets].

6. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.7 Forgot Password

1. On the Application Preferences screen, click Forgot Password from the

Components menu.

2. Click the Enable Forgot Password Link checkbox to enable (display) the Reset

Password link on the login screen.

3. Enter a value (in minutes) into the Email Interval field. Note: This field represents

the length of time a user must wait before submitting another password reset.

Entering zero minutes in the field means there is no interval of time.

4. Enter a value (in minutes) into the Link Expiration field. Note: This field

represents the length of time the reset link will remain valid. Entering zero minutes
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in this field means the link remains valid indefinitely.

5. Click the Submit button to save the changes or click Cancel to return to the

previous screen without saving.

4.6.8 Logins

1. On the Application Preferences screen, click Logins from the Components

menu.
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2. Select an Authentication Method by clicking the radio button beside the option

Internal Authentication, Active Directory Authentication (LDAP) or Hybrid

Supporting Both. The three methods allow customization of the maximum number

of login attempts, number of failed attempts and the failed attempt lockout period.

Session and application timeouts are also customizable. Note: To enable Active

Directory Authentication (LDAP) or Hybrid Supporting Both, a Lightweight

Direct Access Protocol (LDAP) server must be configured and the administrator

must have the credentials for query access on the LDAP server. When either 

Active Directory Authentication (LDAP) or Hybrid Supporting Both is chosen,

administrators will be able to import users from the LDAP server. See Import LDAP

Users. 

3. Enter a maximum number of failed login attempts (up to a maximum of 999) a user

is permitted before being temporarily locked out of the system in the Login

Attempts field. If the field is set to 0, users will have unlimited login attempts.

4. The Timespan for Failed Attempts field is optional. This field determines the

timespan for consecutive failed login attempts to be considered. Entering a value of

1 to 60 minutes indicates the desired timespan to check for failed login attempts

prior to the current failed login attempt. If 0 is entered in this field, all previous

failed login attempts will be considered in determining if the account should be

locked. 

5. Enter a lockout period (up to a maximum of 9999 minutes) for failed logins in the 

Lockout on Fail field. This determines how long a user must wait to try logging in

again after exceeding the maximum number of failed login attempts. If the field is

set to 0, no lockout occurs after users exceed the maximum number of failed login
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attempts.

6. Enter a session timeout period (up to a maximum of 2880 minutes) in the Session

Timeout field. This indicates how long the LCMS will remain logged in without user

interaction. 

7. Enter a application timeout period (up to a maximum of 24 hours) in the 

Application Timeout field. This indicates how many hours a user may remain

logged into the system before they have to verify their credentials again. If the

field is set to 0, applications timeouts will be disabled.

8. Click the Show Timeout Info checkbox to have the application timeout information

display in the header. Note: The application timeout information will not display in

the header if the Application Timeout field is set to 0.

4.6.8.1 Internal Authentication

1. On the Application Preferences screen, click Logins from the Components

menu.

2. Click the radio button beside Internal Authentication to select this authentication

method. Note: When this method is chosen, users can only login using their LCMS

username and password. Users may be prompted to change their password after

the initial login. The Active Directory Authentication (LDAP) tab will also be

disabled.
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3.  Enter the values for the Login Attempts, Timespan for Failed Attempts,

Lockout on Fail, Session Timeout, and Application Timeout fields.

4.  Select the Enforce Strong Passwords checkbox to force users to have a

password of 8 to 64 characters consisting of:

At least one number

At least one lower case letter

At least one upper case letter

At least one special character

5.  Enter a period in days that a password is valid for (up to a maximum of 999) in the 

Password Expiry field. This determines how long a password can be used before

the user must change it. If the field is set to 0, passwords will not expire. Note:

Users will be prompted to change their password.
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6.  Enter a number of days before password expiry (up to a maximum of 999) to display
a warning to users in the Warn User field. If the field is set to 0, users will not be
warned that their password is going to expire.

7.  Enter a minimum password length in the Min. Password Length field. The minimum
password length must be between 8 to 64 characters.

8.  Enter the number of previous passwords (up to a maximum of 999) that cannot be
reused in the Password Reuse field. When a user changes their password, the new
password will be compared against the set number of previous passwords to ensure
it has not been used before. If the field is set to 0, no limit will be enforced on
password reuse.

9.  Select the require password reset checkbox to prompt new users to change their
password after the initial login.

10. Click the Submit button to save the changes or click Cancel to return to the
previous screen without saving. 

4.6.8.2 Active Directory Authentication (LDAP)

1. On the Application Preferences screen, click Logins from the Components

menu.

2. Click the radio button beside Active Directory Authentication (LDAP) to select

this authentication method. Note: When this method is chosen users (except

administrators)can only login using their LDAP username and password. The

Internal Authentication tab will also be disabled.
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3.  Enter the IP address or hostname (fully qualified domain name) of the LDAP server

(domain controller) in the Server field.

4.  Enter the port number of the LDAP server (389 or 636) in the Port field. If the

Security field is set to None, enter 389 in the Port field. If the Security field is

set to CFSSL_BASIC, enter 636 in the Port field. Note: 389 is the default port of

LDAP and 636 is the default port of LDAPS.

5.  In the Authentication Username field, enter the username of a domain user

account. This must be a domain user account and the username must be in the

userPrincipalName format. Note: This account will be used to query Active Directory

via LDAP. 

6.  In the Password field, enter the password of the specified domain user account.

7.  In the Start field, enter the path to search for users in Active Directory. For

example: If you wish to retrieve users that are located in the Organization Unit

(OU): Contoso.com (domain), Users (OU), then the value you would enter in the 

Start field would be OU=Users,DC=Contoso,DC=com.

8.  In the Group Query field, enter the default query that will be used to search for

users. In order for users to log into the LCMS using their Active Directory accounts,

their account must be included in the query results. For example: If you wish to

only grant access to users in the lcms-users group, you can use the group query: 

(&(objectClass=user)(memberOf=CN=lcms-users,OU=Groups,DC=Contoso,DC=com)). If

you wish to grant access to all users that match the Start query, we can use the

group query: (&(objectClass=user)).

9.  In the Username field, select the desired username format from the drop-down

menu.  

10. In the Suffix field, enter the suffix of the usernames. The suffix must include the

@ symbol (i.e., @contoso.com). The Suffix field is case sensitive.

11. In the Security field, select (None or CFSSL_BASIC) from the drop-down menu.

Note: CFSSL_BASIC must be selected for LDAPS. If CFSSL_BASIC is selected,

the Domain SSL certificate must be imported into ColdFusion keystore.

12. When all the fields are configured, click the Test Configuration button to test

the configuration. When the LDAP Configuration Test modal opens:
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a. Enter the username and password of a LDAP user, or enter the configured 

Authentication Username and Password (domain user account).

b. Enter a Group Query or enter the default Group Query configured.

c. Click the Test button. The results display in the Result field.

d. Click the Close button.

13. Click the Submit button to save the changes or click Cancel to return to the
previous screen without saving.

4.6.8.3 Hybrid Supporting Both

1. On the Application Preferences screen, click Logins from the Components

menu.
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2. Click the radio button beside Hybrid Support Both to select this authentication

method. Note: When this method is chosen users can login using their LCMS  or

LDAP username and password. This method works best when some of the LCMS

user accounts are accounts that are not included in the active directory (i.e.,

external contractors).  

3. The Internal Authentication and Active Directory Authentication (LDAP) tabs

will remain enabled. Configure the fields under both tabs. Note: The configuration

fields under the Internal Authentication tab will only apply to LCMS logins. Click

the Test button (if required).

4.  Click the Submit button to save the changes or click Cancel to return to the
previous screen without saving.

4.6.9 SAML

When the Security Assertion Markup Language (SAML) option is enabled on the LCMS,

users will be presented with a Single Sign On (SSO) option on the login screen. The SAML

option is only available to LCMS clients using ColdFusion 2021 and up. Consult with your
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System Administrator for more information about SAML and/or your ColdFusion license.

4.6.9.1 Enable SAML

To enable SAML:

1. On the Application Preferences page, click SAML from the Components menu.
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2. On the SAML window, click the On radio button from the Turn On/Off field. The default

for this field is Off.

3. Select the desired default organization from the Organization drop-down menu or

enter a new organization in the Name field.

4. Click the Submit button to enable SAML.

4.6.10 Reviews

1. On the Application Preferences screen, click on Reviews from the Components

menu.
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2. Click the checkbox labeled Include French text in notification e-mails to toggle

on or off the default French translation included in notification emails sent by the

LCMS as part of the review process.

3. Click the checkbox labeled Review Manager Required to toggle on and off the

requirement for a Review Manager in the Review process. A review manager must

sign off on reviews before the reviews can move on to the next phase of the

process.

4. Click the checkbox labeled Review Monitor Enabled to toggle on and off the

availability of the Review Monitor role.

5. Enter the Length of Review Period in days to indicate the default period of time a

reviewer is given to complete their review. The default value for this field is 30

days.

6. Enter the Min # of Reviewers required to satisfy the approval requirements. The

default value for this field is 1 reviewer.

7. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.11 Screen Labels

1. On the Application Preferences screen, click Screen Labels from the

Components menu.
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2. Enter a custom label for the Other Details tab in the Other Details field. Note:

This will change the name of the Other Details tab in all projects. Up to 100

characters may be entered in the field. Do not use " or #.

3. Enter the desired review instructions in the Review Instructions field. Note: This

will change the name of the Review Instructions field in all projects. Up to 100

characters may be entered in the field. Do not use " or #.

4. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.12 Security

1. On the Application Preferences screen, click Security from the Components

menu.
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2. Click the checkbox beside Cookies use SameSite=strict to enable greater

security against potential click-jacking attempts. Note: Enabling this feature may

cause issues if the LCMS is launched through a portal. 

3. Click the checkbox beside Strict HTML Validation to enable strict HTML validation

using a modified version of OWASP AntiSamy. Note: Visit OWASP.org for more

information.

4. When Strict HTML Validation is enabled, the user will receive warnings whenever

unsafe HTML is entered in a text field. A warning window will open to display the

current HTML causing the warning along with a clean version of the HTML. The user

may click the Clean & Save button to have the LCMS clean the HTML

automatically or click the Close button to clean the HTML themselves. Note: Users

will not be able to save the HTML until it is deemed to be clean. 
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5. Deselect the Allow 3rd Party Content checkbox to disable the import/upload of

3rd party content. Note: This option is enabled by default.

6. Deselect the checkbox for the roles who will not have access to 3rd party content.

 Note: All roles have access to 3rd party content by default.

7. Set the New Screen Security Defaults by selecting the Security Classification

and Controlled Goods category from the corresponding drop-down menu. Note:

This will set the security classification and controlled goods category defaults for

new screens within a new project.

8. Set the New User Security Defaults by selecting the Security Classification and

Controlled Goods category from the corresponding drop-down menu. Note: This

will set the security defaults used when a new user is created.

9. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.12.
1

Edit Security Classification Description

1. On the Application Preferences screen, click Security from the Components

menu.

2. On the New Screen Security Defaults pane, click the Edit List Description

button beside the Security Classification field.
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3. On the Edit Security Classification Defaults window, click the Description field

for the classification default you wish to edit.

4. Enter the desired changes in the Description field.

5. Click the Save button to save the description.

6. Click the Submit button to save the changes. 

7. Click the Revert to System Defaults button to reset the controlled goods

categories to the system default categories.

8. Click the Submit button to save the changes.

4.6.12.
2

Edit Controlled Goods Description

1. On the Application Preferences screen, click Security from the Components

menu.

2. On the New Screen Security Defaults pane, click the Edit List Description
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button beside the Controlled Goods field.

3. On the Edit Controlled Goods Defaults window, click the Description field for

the controlled good default you wish to edit.

4. Enter the desired changes in the Description field.

5. Click the Save button to save the description.

6. Click the Submit button to save the changes. 

7. Click the Revert to System Defaults button to reset the security classifications

to the system default classifications.

8. Click the Submit button to save the changes.

4.6.13 TDM Integration

Learninglogics Training Document  Manager (TDM) is  a  product  in  the  Learninglogics  suite
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that can be used in conjunction with the LCMS. TDM enables Subject Matter Experts (SMEs)

to create  schemas and document templates such as: Qualification Standards and  Plans  (QSPs)  or

Qualification  Standards  (QSs)  and  Training  Plans  (TPs)  to  support  competency  and  skills

documentation. 

1. Click Application Preferences from the LCMS Home screen.

2. Click TDM Integration from the Components menu. 

3. Click the checkbox beside the Enable TDM Integration field. This will enable the

access to TDM. Once enabled, TDM Integration will be available at the Activity

and screen level. See the TDM Integration section for more information.

4. Enter the desired domain URL in the External TDM RESTful Web Service URL field.

Note: Only enter a domain URL if TDM resides on a different server than the LCMS.

5. Click the Test URL button to verify the entry. The message TDM found at the

specified URL displays when the test is successful. Note: If the test is

unsuccessful, verify the TDM domain to ensure the URL has been entered correctly.

6. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.6.14 Versioning

1. On the Application Preferences screen, click on Versioning from the

Components menu.
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2. Under Document Versioning, enter a value for Default Version to set the initial

version number assigned in Document Management.

3. Under Document Versioning, enter a value for Version Increment to set the

increment used for version numbering in Document Management.

4. Under Activity Versioning, enter a value for Default Version to set the initial

version number assigned when creating new activities.

5. Click the Submit button to save your changes or click Cancel to return to the

previous screen without saving.

4.7 LCMS Licensing

The LCMS Licensing is a feature available to Administrators, in which an activation key is

provided by BTSI. This notifies the Administrator of the status and validity of the license,

as  well  as  the  allowable  number  of  seats  (active  users)  within  the  system.  Note:  An

active user only counts as one seat; meaning the user may be assigned multiple projects

or roles without  changing the seat  count. The roles that  count  towards  the  license  are:

Administrator, Senior Developer, Media Developer, Developer or Manager. Some roles, such

as Reviewer type roles,  do  not  count  towards  the  license.  Assigning  or removing  a  user

(role dependent) from a role or project may not change the seat count for the license.
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5 LCMS Menu (Project Menu)

A  number  of  options  are  available  to  Administrator  and  Manager  users  for  managing

individual project options. Some of these are also available to senior Developers, and other

roles. 

The LCMS Menu (Project  Menu) in  the  navigation tree  includes  the  sprocket  drop-down

menu.  The  sprocket  drop-down  menu  contains  the  project  Configuration  and

Preferences options. Click the down arrow to choose the desired option.

5.1 Question Bank

Depending on the privileges set  for their role, users may be able to access the Question

Bank  and  view,  edit  or  delete  entries.  Administrators,  Managers  and  Developers  have

these privileges, and they may also be assigned to custom roles.

All questions for a project are developed and stored in the Question Bank. Once
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questions are developed, they can be added to Independent Study, Instructor Led Lesson

or Test activities. 

To access the question bank, click Question Bank from the Project Menu.

If Multilingual Support is enabled, at the top of the main Question Bank screen you will

see:

A Translation section in the Additional Options dropdown with Export and Import

options. 

A search filter with language drop-down.
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For more information, refer to Configure Multilingual Support.

5.1.1 Feedback Defaults

Feedback Default  values  can  be  assigned  by  the  Manager  or  Admin  in  the  Question

Bank.

1.Click the Additional Options drop-down menu, and select Feedback Defaults.

2. Enter the desired feedback for the Correct Feedback, Incorrect Feedback 1,

and/or Incorrect Feedback 2 fields. 

3. Click the Submit button to save. These will be used to automatically populate the

fields in new question screens. Note: The developer will still be able to edit to

replace or modify them in any way.

 

5.1.2 Create New Question

See the section titled Edit Question and Instruction Screens for more general information

on editing both Question Screens and Instruction Screens, and the section titled The

HTML Editor for more information on entering text and HTML content.

1. Select Question Bank from the LCMS Menu.
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2. On the Question Bank screen, click the Create New Question button. 

3. A screen appears showing all available question screen styles. Select the screen

style that you wish to use. 

4. The question style you selected, with all applicable fields for content, is then

displayed. All information entered in these screen fields is available in the activity

storyboard. To save the information you enter in the screen fields, click the Save
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button at the top of the screen.

5. Once you have saved your question, click Return to Question List. You will now

see your newly created question, with the question ID appearing in the Search

Criteria field.

Note: You can add already-created question(s) from within a topic by clicking the Add

Question button at the top of the window.

5.1.2.1 Question Screen ID

Each time a question screen is created, it is automatically assigned a screen identification
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number (ID). This number is displayed in the activity storyboard and the question list in

the Question Bank. It is used when referring to specific screens.

5.1.2.2 Add Main Text

1. To add question stem text to any of the instruction screens, type the words in

the Main Text field on the first tab below the Screen Title.

Note: For more information see the section entitled Question Screen Styles.

5.1.2.3 Add Text Options

Text  Options  are  completed  differently  for  different  question  screen  types.  See  the

screen type information in Question Screen Styles for more information.
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5.1.2.4 Add Feedback

By entering values on the Feedback tab, the developer can assign optional feedback to a

question screen, which will be displayed when the user submits their response.  Note:

Default values for feedback fields can be set at the project level, and these will be used

to automatically populate the feedback fields in individual question screens, although in

such a way that they can still be edited by users. 

1. Enter a value for Correct Feedback. This will be displayed when the user submits

the correct response.

2. Enter a value for Incorrect Feedback 1. This will be displayed the first time a user

submits an incorrect response. Note: The Incorrect Feedback 1 text displays if

individualized feedback has not been entered in the Text Options field.

3. Enter a value for Incorrect Feedback 2. This will be displayed the second time a

user submits an incorrect response. Note: If this field is blank the user will only be

permitted to have one attempt at answering the question, whereas if it includes

text, the user will be given two attempts. Should additional feedback fields be

required (i.e., Incorrect Feedback 3, Incorrect Feedback 4), click the Add More

Feedback button and enter the feedback in the corresponding text field.

Note: If these fields are left blank, the user will be given one attempt to answer the

question correctly and will be shown default feedback.

5.1.2.5 Add Other Details

See Other Details (tab) for more information.



Learninglogics® LCMS 4.31 User Guide132

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

5.1.2.5.1  Mandatory and Critical Questions

Add  an  Answer  Constraint  to  set  a  question  to  Mandatory,  Mandatory  Critical  or

Critical. This allows individual questions to be set  as  essential  to  answer and/or answer

correctly in order to pass the exam. The user could potentially get  a passing grade based

on questions answered, but  if  they do not  successfully answer the questions denoted  as

Mandatory, Mandatory Critical or Critical, they will not pass the test or exam.

Mandatory:  The  user must  answer the  question.  If  the  question  is  not  answered,  the

exam will not be evaluated and the user will be directed to the question that  is mandatory

to answer.

Mandatory  Critical:  The  user  must  answer  the  question,  and  it  must  be  answered

correctly to pass the exam.

Critical: The answer must be correct to pass the exam. For example, the passmark is 50%

and  the  user  reaches  90%,  but  one  of  the  questions  they  answered  incorrectly  was

critical. The user will receive a failed status for the exam.

5.1.2.5.2  Assign Point Value

The  Point  Value  field  displays  only  when a  question is  added  to  a  Test  Activity.  This

allows  a  question in  a  test  to  be  assigned  a  Point  Value  (0-999)  that  can be  used  to

calculate the final mark of a test. 

1. To add a Point Value to a Question, click the Other Details tab and enter a value 0–
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999. 

2. Click the Save button.

5.1.2.5.3  Estimated Question Time

Questions may be assigned an estimated time to complete. Note:  The  estimated  time  to

complete  a  question will  help  to  calculate  the  overall  time  it  takes  to  complete  a  quiz

when a time limit is imposed. 

1.  To add an estimated time to complete to a Question, click the Other Details tab and

enter the estimated time (in seconds) in the Est. Time field. 

2. Click the Save button.

5.1.2.5.4  Enable Partial Scoring

Questions with multiple answers may be weighted to allow a partial mark for the question

(i.e.  2  of  3  answers  are  correct).  The  Enable  Partial  Scoring  checkbox  displays  only

when a question is added to a Test Activity. Partial scoring can be used to calculate the

final mark of a test. 

1. To enable the partial scoring of a Question, click the Other Details tab and click

the Enable Partial Scoring checkbox. 
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2. Click the Text Options tab and enter a value in the Weighted Value fields. The

default value is 1. Note: Weighed Value fields will only display when partial scoring

is enabled.

3. Click the Save button.

5.1.3 Manage Categories

Categories are used to manage questions in the Question Bank. Before developing

questions, set up the categories for all questions in the project. The categories must be

named and organized to manage all questions used throughout the project activities. 

5.1.3.1 Add a Category

1. Click the Manage Categories link on the Additional Options menu in the

Question Bank screen. The Manage Categories window will appear.
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2. Click the Add Category button. The New Category page will appear. 

3. Type the name of the new category in the Category field.

4. Click the Submit button.

5. The new category will appear on the Manage Categories window.

5.1.3.2 Edit a Category

1. Click the Manage Categories button on the Question Bank screen. The Manage

Categories window will appear, listing all existing question bank categories.

2. Click the category you wish to edit.

3. Make the required changes in the Category field.

4. Click the Submit button.
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5.1.3.3 Delete a Category

Click the Delete icon  beside the category you wish to delete on the Manage

Categories screen.

Note: If questions are assigned to the category selected for deletion, a window will

appear stating that the category cannot be deleted.

5.1.4 Automation Rules

Questions for a project are created using the Question Bank. When a test is created,

questions may be added to the test one at a time, or all at once using the automated rule

feature. You can use one or both options to enter questions in the same test. 

Before the questions are automatically added to the Test Activity, a rule must be created

that defines the specifications for the automatic generation of the questions. To use this

feature, each question that was developed must have a level of difficulty specified.
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5.1.4.1 Create New Rule

1. On the Question Bank screen, click Automation Rules from the Additional

Options menu.

2. The Manage Automation Rules page will appear. Select the New Rule button.

3. The Manage Automation Rules: New Rule window will appear. Enter a Rule Name

in the Rule Name field. 

4. If the current project includes older flash-style screens, the Ignore Flash Screen

Styles checkbox will appear. The checkbox is selected by default. To exclude flash

question screens from the automation rule, leave this checkbox selected, or

deselect the checkbox to include flash screen styles.

5. Click the Filter Type button. A drop-down list of available filter types will appear.
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6. Choose from Category, Tag or Screen Style in the Filter Type drop-down.

7. From the dialog box, select the desired category, tag or screen style you wish to

include in the automation rule.

8. Click the Ok button to close the dialog box.

9. A new row will appear in the automation rule. The total count of screens that

match the row filter will display beneath the row's input fields. If Multilingual

Support is enabled, the screen count will be shown for both languages. Note: To

reorder filters, use the drag-handles on the top-left of the Filter Name field.

10. Enter the number of questions required for each level of difficulty within each

filter. The number in brackets [ ] beside each field indicates the number of

questions assigned that level of difficulty. Sub totals will show the number of

questions required from each filter; totals will show the total number of questions

required from all categories at the low, medium and high level of difficulty. Note:

If the number required exceeds the number of Questions available in the level

categories a (low, medium or high) a Validation has failed message displays. A
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validation error can occur if Multilingual Support is enabled and the screen

count for the alternate language questions is zero.

11. Click Submit. The new rule will be displayed on the Manage Automation Rules

screen.

5.1.4.2 Edit Rule

1. From the Manage Automation Rules screen, select the Rule Name you wish to

edit.

2. Enter the information in the appropriate fields. Note: Filters may be reordered using

the drag-handles on the top-left of the Filter Name field.

3. Click the Submit button.

5.1.4.3 Verify Rule

When each question was created using Question Bank, it was assigned a category

(mandatory) and a level of difficulty (optional). In order for the automation rules feature

to be used, questions must be assigned a level of difficulty.
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1. Click the Verify Rules button on the Question Bank: Manage Automation Rules

screen. The results will be displayed in the Verification Result fields. If the rule is

verified, this will be indicated. Verification means that the number of questions

chosen for a level of difficulty within a category did not exceed the number of

questions available.

2. If the number of questions chosen for a level of difficulty within a category

exceeds the number of questions available, the rule will not be verified. Note: Try

reordering the filters in the rule if the validation fails. Filters may be reordered using

the drag-handles on the top-left of the Filter Name field. To find out why the rule

did not verify, click the Rule Name. 

3. The Rule Name window will open stating the reason(s) why the rule was not

verified. 

5.1.4.4 Delete Rule

1. On the Manage Automation Rules screen, select the box beside the rule you

wish to delete.



LCMS Menu (Project Menu) 141

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2. Click the Delete button. The Manage Automation Rules screen will be displayed

and the rule will be deleted.

5.1.5 Search Question Bank

You can search the Question Bank using different search categories and criteria. 

The basic search options available from the Types drop-down list are: Answer

Constraint, Content, ID, Tags, Last 25 Added, Last 50 Added, Main Text and

(Screen) Style. Depending on the type of search chosen, you may then enter a specific

value in the Criteria field. Click the Search button. Note: If you leave the Criteria field

blank and all categories are selected, all items in the Question Bank will be returned by

default.

A list of questions corresponding to your search criteria will be displayed underneath.

Clicking the Advanced link will display additional search options. Question categories can

be selected from the drop-down list before clicking Search.  
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If Multilingual Support is enabled, a filter will be available under Advanced Search with

language drop-down.

To view only basic search options, click the Basic link.

By default, only active questions are shown in the search results. Click the Inactive or All

radio button at the top right of the search results to change the filter.

Note: Question searches default to search by last 25 questions added.

Note: When searching by content, an Information icon appears next to each search

result. When you hover over the icon, a pop-up message displays telling you exactly

which part of the content matched the search Criteria.  Content searches accept partial

or whole words only, not multiple words. Screen content searches include the Screen

Title text.

Note: Inactive questions cannot be viewed in the search results when adding questions to

a lesson or test.

To download a CSV file of the selected search, click Download Results. 

5.1.6 Preview Question Screen

Questions may be previewed in Question Bank or in the activity to which they have been

added. 
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1. On the Question Bank screen, locate the question you wish to preview using the

Question Bank search features.

2. Click the Preview icon beside the question you wish to preview.

3. Select the interface you wish to preview the question from the drop-down list. The

question will be displayed.

4. When you have finished previewing the screen, click the Close icon   in the top

right corner of the window.

Note: When previewing individual screens using the Storyboard Interface, the functioning

screen will  be  rendered  in  the  browser,  rather  than  the  storyboard  layout  used  in  the

Storyboard Report or when the whole activity is opened in the Storyboard Interface.

5.1.7 Copy Question Screens

Once you have searched and are viewing a list  of results in the Question Bank, you can

copy questions.

1.  In the list of results in the Question Bank, click the Copy icon beside one or

more questions you wish to copy.
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2.  Click the Paste Question(s) button that appears at the top of the screen to

create copies of the question(s) selected.

3.  You can now see your copied question(s) onscreen. Click the Edit button to make

changes to the copy (changes will not be reflected in the original question).

Note: You may also copy questions from the Question Bank and paste them into an

activity from the Clipboard. Questions can also be copied from one activity to

another using the Clipboard feature. 



LCMS Menu (Project Menu) 145

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

A prompt needs to be added to the pasted question. A warning appears next to the

screen number indicating there is no prompt selected.

5.1.8 Edit Question Screen

1. On the Question Bank screen, locate the question you wish to edit using the

Question Bank search features.

2. Click the Edit icon beside the question you wish to edit. Note that you cannot edit

a question that is assigned to a locked activity.
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3. Make any changes to the required fields, then click the Save button at the top

right corner of the screen.

 If Multilingual Support is enabled:

- A Language toggle button takes you to the alternate language screen, disconnecting

you from the original screen. 

If the question screen is not connected to an alternate language, from the Language

Options drop-down, you can Create 'Alternate Language' Version (copy/paste) or

Connect to 'Alternate Language' Version (search for screen and link the two).
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5.1.9 Question Usage

1. On the Question Bank screen, locate the question you wish to use by using the

Question Bank search features.

2. If the question is being used in another location(s), a Usage icon is visible beside

it. Click the icon to see usage details.

3. The Question Screen Usage window appears containing all of the learning objects

in which the question is used. 
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5.1.10 Delete Question

1. On the Question Bank screen, use the search features to locate the question you

wish to delete.

2. Click the Delete  icon beside the question.

3. The Question Screen Usage pop-up window appears, indicating if the question is

being used in other activities. If you still wish to delete the question, click Delete;

otherwise, click Close.
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If the question you are deleting has a linked translated version, a dialogue box appears

with two possibilities:

1. A translated version of the question exists and you now have the option to also delete

the alternative language version.

2 A translated version of the question exists, but it is located in an activity that is

currently locked. In this case, clicking Delete will only delete the selected question,
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breaking the link with the translated version. 

Note that if the question is assigned to a locked or archived activity, the Delete icon is disabled.

5.1.11 Deactivate Question

Inactive questions will still appear in the Question Bank and in any lessons or tests they

were added to prior to deactivation. These questions can be edited or deleted just like

active questions. Once a questions is inactive, however, it cannot be added to lessons or

tests. Deactivating is useful when you wish to discontinue a question without impacting

existing activities.

1. On the Question Bank screen, use the search features to locate the question you

wish to deactivate.

2. Click the Active toggle icon next to the active question.
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3. To reactivate an inactive question, use the search features to locate the question

you wish to deactivate, ensuring that the Inactive or All status filter radio button

is selected.

4. Click the Active toggle icon next to the inactive question.

5.1.12 Translation

If Multilingual Support is enabled, in the Additional Options menu of the main Question

Bank screen there is a Translation section with Export and Import options. 

5.1.12.
1

Export

1. To export questions from the Question Bank, click Additional Options and select

Export in the drop-down menu.

2. From the Question Bank Translation: Export window, use the Filter field to choose

the questions you wish to export.   
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3.When the filter Only include Questions that belong to a specific Test is selected,

the Select Test for Export pop-up window opens. Chose the specific test by clicking

on the row.

4.Click Create Translation File button. In the Translation Options window, deselect

any fields you do not want translated. 

5. Click Submit. 

6. After the export is complete, click the Download button (if your are using IE, right-

click and select Save Target As) to download. The downloaded file is an HTML

document. 
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5.1.12.
2

Import

1.Click Import. 

2. In the Question Bank Translation Import window, browse for the file you wish to

import. 

3. Click the checkbox beside Update question, if already exits? to update questions.

Note: Existing Questions will be ignored if this is left unchecked.

4. Click the checkbox beside Update Snippets? to update snippets.  Note: Snippets will

be ignored if this is left unchecked.

5. Click the Submit button. 
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6. Several details will display in a status report. Check off items with an Import Status of

Ready and click Import Selected. Note: You should not navigate away from this

screen during import. 

5.1.13 Import Questions

Administrators, managers and senior develops can import existing questions into the

Question Bank from a CSV file using the Import Questions tool.

To import existing questions:

1. From the Question Bank screen, click the Additional Options menu.

2. Click the Import Questions link in the Additional Options menu.

3.Click the Browse button to select the file you wish to import.

4. If Multilingual Support is enabled, select a language from the Language drop-

down.

5. If desired, enter keywords in the Tags field. Note: By default, the field is

automatically populated with a unique identifier for the import. This tag can be used

later to locate all questions associated with the import.
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6.Select one or more categories from the Categories field.

7. Select a security classification from the Classification drop-down.

8. Select a controlled goods classification from the Controlled Goods drop-down.

9.Click the Submit button.

10.An Import Preview dialog box will display a preview of the questions to be

imported. The preview will include the question Line number, Type, Style, Title,

Question Text and Additional Data. A green checkmark will appear next to valid

questions. A red x will appear next to invalid questions. Note: if invalid questions

are found, the import will be unable to proceed. Issues identified with invalid

questions are displayed in red text to help users correct the problem.

11. Click the Import Questions button in the Import Preview dialog box to proceed

with the import.

12. Once the import is complete, the Question Bank will display all imported

questions.
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5.1.13.
1

Question Formatting

All  questions  imported  into  the  Question  Bank  must  adhere  to  a  specific  format.  The

required  format  will  vary  based  on the  question type.  The  table  below  lists  all  question

types currently supported and the format for each type:

Questi

on

Type

C

od

e

Scree

n

Style

Format Notes

Multipl

e

Choice

M

C

2.52 Question Type  (code),  Title,

question text,  text  option 1,

correct/incorrect, text  option

2, correct/incorrect, etc. 

Up to 9 text options are
supported.

Multiple answers can be
correct.

Matchi

ng

M

AT

4.55 Question Type  (code),  Title,

question text,  text  option 1,

matching  target  text,  text

option  2,  matching  target

text, etc.

Up to 9 answers and matching
text are supported.

The 'randomize target text at
run-time' option will be selected
for any imported questions of
this type.

Multiple text options may use
the same target text.

Fill  in

the

Blank

FI

B

2.56 Question Type  (code),  Title,

question  text,  input  mask,

answer 1, answer 2, etc.

Input mask can be blank.

Multiple valid answers
accepted.

If an input mask is specified, all
valid answers must match the
input mask.

An example document  is displayed in table format  below. This format  must  be followed or

the import will fail. Note: The Title column can remain blank if question titles are not  used.
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M

C

Knowle

dge

Check

1

What is 22 + 40? 52 incorrect 62 correct 72 incorrect

M

A

T

Knowle

dge

Check

2

Match  the  word

to its definition.

Auto

dida

ct

A  person  who

has  learned  a

subject  without

the  benefit  of  a

teacher

Syno

nym

ous

Equivale

nt  in

meaning

Defen

estrat

e

To  throw

out  a

window

F

I

B

Knowle

dge

Check

3

What  animal  is

like  a  writing

desk?

***

**

Raven rave

n

Note: When creating questions in Microsoft  Excel or similar spreadsheet  software, ensure

the file is saved in CSV format.

5.2 Snippet Bank

A snippet is a small piece of text  that  can be inserted and reused throughout  an Activity

or  Project  such  as  boilerplate  text,  cautions  and  warnings.  When  created  or  inserted

Snippets  display  as  text  with  a  grey  background.  The  ability  to  edit  a  Snippet  is  role

specific  with assigned permissions (Administrator, Manager, Senior Developer,  or the

Developer who created the snippet). Once a snippet is created, it resides in the Snippet

Bank where it  can be selected for reuse, edited (role specific), or deleted. Snippets are

created or inserted in the Main Text field and Instructor Notes. See Create Snippet  for

more information. 

Note: When Multilingual Support is enabled, Snippets are translated as part  of the Main

Text. Language option radio buttons display to toggle between English and  the  alternate

language. See Translated Snippet for more information.

To access the snippet bank, click Snippet Bank from the LCMS Menu.
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5.2.1 Create New Snippet

See Create Snippet for more information.

5.2.2 Manage Categories

Categories are used to manage and organize snippets in the Snippet Bank. Before

developing snippets, set up the categories for all snippets in the project. 
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5.2.2.1 Add a Category

1. Click the Manage Categories button in the Snippet Bank screen. The Manage

Categories window will open.

2. Click the Add Category button. The New Category window will open. 

3. Type the name of the new category in the Category field.

4. Click the Submit button.

5. The new category will appear on the Manage Categories window.

5.2.2.2 Edit a Category

1.Click the Manage Categories button on the Snippet Bank screen. The Manage

Categories window will appear, listing all existing Snippet Bank categories.

2. Click the category you wish to edit.

3.Make the required changes in the Category field.

4. Click the Submit button.
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5.2.2.3 Delete a Category

1. Click the Delete icon  beside the category you wish to delete on the Manage

Categories screen. Note: If snippets are assigned to the category selected for

deletion, a warning window opens and provides the opportunity to reassign the snippets

to another category. Deleting a category without reassigning will leave the snippets

orphaned.

2. Snippets are reassigned by clicking the down arrow and selecting the desired category

from the drop-menu.

3. Click the Delete button to delete the category.

5.2.3 Search Snippet Bank

You can search the Snippet Bank using different search categories and criteria. 

The basic search options available from the Types drop-down list are: Last 25 Added,

Last 50 Added, My Snippets, Name, Text, and Tags.  Depending on the type of search

chosen, you may then enter a specific value in the Criteria field. Click the Search button.

Note: If you leave the Criteria field blank and all categories are selected, all items in the

Snippet Bank will be returned by default.
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A list of snippets corresponding to your search criteria will display. Note: Snippet searches

default to search by Last 25 Added. Inactive snippets will not display in the search

results when adding snippets to an activity or test.

Clicking the Advanced link will display additional search options. Snippet categories can

be selected from the drop-down menu before clicking Search. To view only basic search

options, click the Basic link.

By default, only active snippets are shown in the search results. Click the Inactive or All

radio button in the Filter on field to change the filter.

When Multilingual Support is enabled, filters for the languages will also be available. 

5.2.4 Copy Snippet

Once you have searched and are viewing a list of results in the Snippet Bank, you can
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copy snippets. 

1. In the list of results in the Snippet Bank, click the Copy icon beside one or more

snippets you wish to copy.

2. Click the Paste Snippet(s) button that appears at the top of the screen to create

copies of the snippet(s) selected.

3. You can now see your copied snippet(s) onscreen. Click the Edit button to make

changes to the copy (changes will not be reflected in the original snippet).

5.2.5 Edit Snippet

1. On the Snippet Bank screen, locate the snippet you wish to edit using the Snippet

Bank search features.

2. Click the Edit icon beside the snippet you wish to edit. You cannot edit the snippet's

text when the snippet is assigned to a locked Activity. A warning displays at the

bottom of the screen to notify you that the snippet is in a locked Activity. The

snippet's metadata can be modified when the snippet is in a locked Activity. Note:

Users with the Developer role will only be able to edit their own snippets.
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3. Modify the text, then click the Submit button to save. Note: When a snippet is

modified all instances of the snippet will be updated. If you are editing an English

snippet and it has been translated, the Go to French button displays at the bottom of

the screen. For French snippets the Go to English button displays.

5.2.6 Snippet Usage

1.On the Snippet Bank screen, locate the snippet you wish to use by using the Snippet

Bank search features.

2. If the snippet is being used in another location(s), a Usage icon is visible beside it.

Click the icon to see usage details.
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3. The Snippet Usage window appears containing all of the learning objects in which the

snippet is used. 

5.2.7 Delete Snippet

1.On the Snippet Bank screen, use the search features to locate the snippet you wish

to delete.

2. Click the Delete  icon beside the snippet.
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3. The Snippet Usage pop-up window appears, indicating if the snippet is being used in

other activities. If you still wish to delete the snippet, click Delete; otherwise, click

Close.

5.2.8 Deactivate Snippet

Inactive snippets will still appear in the Snippet Bank and in any lessons or tests they

were added to prior to deactivation. These snippets can be edited or deleted just like

active snippets. Once a snippet is inactive, however, it cannot be added to lessons or

tests. Deactivating is useful when you wish to discontinue a snippet without impacting

existing activities.

1.On the Snippet Bank screen, use the search features to locate the snippet you wish

to deactivate.

2. Click the Edit icon next to the active snippet.



Learninglogics® LCMS 4.31 User Guide166

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

3.Click the Metadata tab and select the radio button Inactive. 

4. Click the Submit button to save.

5. To reactivate an inactive snippet, use the search features to locate the snippet you

wish to activate, and then click the Active radio button.

5.2.9 Translated Snippet

Snippets are translated as part of the Activity, when the Activity is exported for

translation. See Export for Translation for more information.

When Multilingual Support is enabled, toggle the language filters to view English,

French or All snippets. 
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5.3 Media Library

Administrators, Managers, Developers and other users with the Media Library privilege

enabled can manage media files.

The Media Library is a multimedia storage and retrieval tool that allows users to build a

catalogue of multimedia files that can be searched, tracked and reused whenever

necessary. 

Note: Some of the file formats accepted by the Media Library are

.jpg, .gif, .png, .zif, .mp3, and html. They may or may not display as thumbnails. Packaged

or zipped content can also be added to the Media Library.

Once the multimedia files have been added to the Media Library database, users can

search for files, assign keywords (tags), add detailed descriptions and categorize files to

provide an extensive media production library. The Media Library can store both source

files and final files that are used in activities. 

1. To access the Media Library, click Media Library from the Project Menu drop-down

list. You can also access the Media Library from an activity screen by clicking Select

from the Media tab.



Learninglogics® LCMS 4.31 User Guide168

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2. The Media Library welcome screen appears, showing the main menu and search

controls. Note: The Find Duplicates, View References Library and Batch Delete

Media icons toggle are not available for Developers (Administrators, Managers and

Media Developers only).

3. To exit the Media Library, click the Close button or the X at the top right corner of

the screen.

5.3.1 Add Media to Library

1. To add one media file (mov, html, jpg, jpeg, gif, PDF, png, zif, mp3), click the Add

Media button at the top left of the Media Library window.

2. Click the Browse button, then locate the file you wish to upload. 
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3. Click Upload if this is the correct file or Remove, if not.

If the media filename already exists, you will receive an Upload Error message. If you

choose "click here to continue with upload", you will upload a second file with the

same name. 
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4. In the Media Details window, enter any required metadata, then click the Save

button to add the media asset to the Media Library. You can find the asset by

doing a Media Library search. 

Note: If you have uploaded a Unity 3D or Modest Tree file, select Unity3D or

ModestTree (currently using 5x option) from a drop-down menu in Media Details. If

you do not select the correct file type the, model may not render properly in the

viewer. 
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5.3.1.1 Add Giga Image Viewer File

To add a Giga Image Viewer file:

1. Click the Add Media icon. 

2. Click the Browse button and select the Giga Image Viewer file you wish to upload. 

3. Make sure the Media Type field has Giga Image Viewer checked if that's the

correct file type.

4. Enter the Title, which is mandatory for this file type.
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5. Manually enter the Height and Width fields. Note: These fields must be entered

correctly for the Giga Image Viewer to render properly.

6. The Description field is optional.

7. Click Submit to save or Cancel to quit without saving.

Note: If you select a Giga Image Viewer file for the Default Graphics field of a

screen, you will see a Settings button on the Graphics tab, which can be used to

configure the Giga Image Viewer for that screen. See the Add Graphics topic for more

information.

5.3.1.2 Batch Add/Update Media

Batch add or update multiple media asset files in the Media Library by uploading them in a

single zip file. 

1. Click the Batch Add/Update Media icon.

2. Click the Browse button, then select a zip file containing the media assets you

want to batch add or update.  
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3. Click Upload to continue or click Remove if this is not the file you want to batch

add or update. 

3. You will see a Confirm Batch Contents dialogue box listing all batch files uploaded.

If you want to upload new files that exist in your zip file (not currently in the Media

Library), click the Add Media if Not Found? checkbox. This checkbox must be

clicked to batch add new media. Click Submit to continue, or Cancel to exit

without updating.

4. You will see a Batch Update Status dialogue box, listing the files and showing

whether they were successfully updated/added or not.  Green checkmarks indicate
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that a media asset has been updated/added successfully; red crosses indicate the

file was skipped because a corresponding filename was not found in the Media

Library, so it could not be updated (only occurs if the checkbox for Add Media if

Not Found? was not selected).

5. Click Show Updated Media to see the updated media in the Media Library.

Note: Filenames in the Media Library are not unique.  It's possible to have more than

one media asset with the same filename. In this case, the Batch Update Media feature

will warn the user that duplicate filenames exist in the Media Library and you will have

the option to continue.

5.3.2 Manage Categories

Categories within the Media Library can be managed by Managers and Administrators.

5.3.2.1 Add Category

To add a category:

1. Click the Manage Categories icon.
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2. Click the Add Category button.

3. Enter the new category name in the Category field. Click Submit.

4. The new category name will be displayed in the category search results table. 

Note: You will now be able to assign this category to any SCORM component of your

choosing through the metadata form and also search for all SCORM components assigned

to this category from the Category Search drop-down list.

5.3.2.2 Edit Category

To edit a category name:

1. Click the Manage Categories icon.

2. Click the name of the category in the category search results table that you want to

change.

3. Edit the category name in the Category field and click Submit. 



Learninglogics® LCMS 4.31 User Guide176

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

The updated category name will be displayed in the category search results table.

5.3.2.3 Delete Category

To delete a category:

1. Click the Manage Categories icon.

2. Click the Delete Category icon  beside the name of the category that you wish

to delete.

3. Click Delete to confirm the deletion.

5.3.3 Find Duplicates

Click the Find Duplicates icon in  the  Media  Library  to  search for duplicate  media.  From

here, duplicates can be merged into one asset. This feature is available to Administrators,

Managers and Media Developers.

If  duplicates  exist,  they  will  be  displayed  in  the  Media  Library  -  Find  Duplicates

window. 
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Several  icons  are  located  to  the  right  of  the  duplicate  files.  Each  is  described  in  the

following sections.

5.3.3.1 Edit Metadata

Click the Edit metadata icon if you want to make changes to the asset's metadata.

This  will  open  the  Edit  Metadata  Details  window  where  you  view  metadata  or  make

changes to it. Click Cancel to close without saving changes or Save to save changes and

close the window.



Learninglogics® LCMS 4.31 User Guide178

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

5.3.3.2 Copy Metadata

Click the Copy metadata icon to copy metadata information to the clipboard. 

Click the  Paste  to  Group  button to  paste  metadata  to  all  duplicates  or use  the  Paste

icon beside an asset to paste metadata to only that file.

5.3.3.3 Delete media

The Delete icon is greyed out if the media is in use. Hover over the icon to see how many

locations the media is currently used in. 

If  the  media  is  not  in  use,  the  Developer  who  uploaded  it  may  also  delete  it  from the

repository. 

5.3.3.4 Merge Approval

Select Merge Approval checkbox if you think this asset can be merged with a duplicate.
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5.3.3.5 Keep Media

Click  the  Keep  media  icon  once  you  have  decided  which  media  to  keep  (the  Merge

Approval checkbox must be selected on the other media asset) 

This message box will appear, asking you to confirm that you wish to merge the duplicates

of this group. Click Yes to continue.

If you have not selected the Merge Approval checkbox on another asset, you will see this

message:
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If media is merged, it will be logged in the History tab to show what has happened.

5.3.4 View Reference Library

Administrators,  managers  and  media  developers  are  able  to  toggle  between  the  Media

Library and Reference Media Library:

Click  the  View  Reference  Library  icon  to  switch  from  the  Media  Library  to  the

Reference Media Library.

 Click the View Media Library icon to return to the Media Library  from the Reference

Media Library.

5.3.5 Search Media Library

The Media Library search options (File Name [or path], Original Media, Title,

Description, Tags, Category, Classification, or Controlled Goods) are available from

the Field drop-down menu. You may use one of these search options to define a search

or click the Advanced link to define a search using multiple search options.
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5.3.5.1 Search by File Name, Original Media or Title

1. Select File Name, Original Media, Title or Description from the Field drop-down

menu. 

2. Select the Condition "contains" or "does not contain". 

2. Type the full name or partial name of the file or text you wish to locate in the

Criteria search field.

3. Click Search. The search results will appear underneath.

5.3.5.2 Search by Tags

1.Select Tags in the Field drop-down menu. Enter the desired tag(s) to use for the

search in the Criteria search field. Separate the tags by a comma.

2.Click the Search button. The search results will appear underneath.

5.3.5.3 Search by Category

1.  Select Category in the Field drop-down menu. Select the desired category from

the Criteria drop-down menu. Note: If All Media (categorized) is selected, the

search results will be restricted to include only media assets that are currently

assigned to ANY category. If All Media (not categorized) is selected, the search

results will be restricted to include only media assets that are currently NOT

assigned to ANY category. If a specific named category is selected, the search

results will be restricted to media assets that are assigned to that category only.
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2. Click the Search button. The search results will appear underneath.

5.3.5.4 Search by Classification

1.  Select Classification in the Field drop-down menu. Select the desired

classification (Unclassified, Restricted, Confidential, or Secret) from the

Criteria drop-down menu. 

2. Click the Search button. The search results will appear underneath.

5.3.5.5 Search by Controlled Goods

1.  Select Controlled Goods in the Field drop-down list. Select the desired

classification (CAT1, CAT2, CAT3, or CAT4) from the Criteria drop-down list. 

2. Click the Search button. The search results will appear underneath.

5.3.5.6 Results (Hide/Show Columns)

Once you have submitted your search, the Search Results table lists all media that

satisfies your search criteria. For each media asset, you will see a thumbnail image,

File Name, Title, Width and Height (pixels), File Size, Date Added, Uploader, Date

Updated, Updated By, Classification, Controlled Goods and Metadata.
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Click Hide/Show Columns for a list of available columns. Select the check box by each

to hide or show that column. Click Apply to save your changes. 

To navigate through the Search Results screens (if there is more than one), use

Previous, 1, 2, 3 and Next at the bottom of the screen.

5.3.6 Delete Media File

To delete a media file from the Media Library:
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1. Locate the desired media file by using the search options.

2. Click the Delete icon  beside the desired file in the Search Results table.

3. Click Yes to confirm the deletion.

To delete a batch of files from the Media Library:

1.  Locate the desired media file by using the search options.

2.  Select the button for Batch Delete Mode.

3.  The Delete icon is replaced by a check box next to each file. Select the files you

wish to delete by selecting the appropriate boxes.

4.  Click the Delete Selected Media button.

5.  Confirm Yes or No to delete the files.

5.3.7 Media Details (Metadata)

Metadata is used to describe the multimedia assets and SCORM components to help

locate and identify media files at a later date. To view Media Details (view, add or

edit metadata):

1. Click the media file name on the Search Results screen. 
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2. A separate Media Details window opens for this file. The file name, file ID, media

size, and file size populate automatically. All other metadata must be added or

updated manually in each tab - General, Technical, Rights, Security, Update

Media (not available for Developers), Locate Media and History. Each tab is

described in the following sections. 

3. To download the file to your computer, click Download. If the media asset is a

.giga or .zoom, the button appears as Download As Zip.

4. To save any changes you have made in this window, click the Save button. If you

do not wish to save any changes, click the Close button to return to the media

library. 

5.3.7.1 Summary

The Summary  tab  displays  the  media's  File  Name,  File  ID,  Width,  Height,  Tags  and

File Size. This information cannot be edited from this tab.

There is also an Update Media button available that to opens the Update Media tab.
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Note: If the image is 2,000 pixels or greater in width or height, a Convert To Giga Image

button is available to change the current media to a Giga image. 

5.3.7.2 General

From the General tab, you can view the  media  filename  and  can add  or update  general

information about the file, including:

Original Media

Type the name of the original file, i.e. the source file that was used to create this file.

Title

Type a descriptive name for the content of the file.

Description

Type a narrative description of the file.

Tags

Type the tag(s) in this field. Press Enter after typing each tag or group of tags.

Categories

Use the drop-down list to assign one or more categories to the file. Choose Select All to

assign all categories to the media file.
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5.3.7.3 Technical

The Technical tab contains information about the technical requirements and

characteristics of the file. You can add or update this information, including:

Format

Type the file format in the Format field. (e.g. video/mpeg; text/html; animation)

Platform Requirements

Type any information about other software and hardware requirements for the SCORM

component in this field. (e.g. sound card; Min. RAM: 16 Mb; video card and display: at

least 800x600 pixels x 256 colours)

5.3.7.4 Rights

The Rights tab contains information about  the intellectual property rights  and  conditions
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of use for the file. You can add or update this information, including:

Cost

 Select Yes or No.

Copyright

Select Yes or No.

Description

Type a description of the copyright requirements.

5.3.7.5 Security

The  Security  tab  contains  information about  the  security  required  for the  file.  You can

choose information from drop-down lists for:

1. Classification

2. Controlled Goods
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5.3.7.6 Target File

The Target File tab is available only when media contains multiple files. It  allows the user

to select the applicable file that  packages everything together when uploading a .zip or a

multi-asset  file.  This  is  usually  a  .html  file  that  loads  the  interface  for  the  video  (play

controls), as well as the video itself to be displayed.

5.3.7.7 Update Media

The  Update  Media  tab  is  available  for  Managers,  Administrators  and  Media  (not

Developers). 

From the  Update  Media  tab,  you  can  update  existing  media.  Instructions  on  how  to

update media are provided on the tab, as shown below.
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5.3.7.8 Locate Media

The Locate Media tab shows where the media file is being used in all activities. Click the

View  Media  button  to  see  media  location  details,  including  Activity,  Version,  Topic,

Screen and Screen Location.

Note: You will be alerted if the media is used in a tabbed screen.

If there is an issue finding the location of the particular piece of media within the library,

the  Validate  Locations  button allows  you  to  search  further,  or  to  find  other  possible

locations for the media.
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5.3.7.9 History

The  History  tab  shows  details  about  when  a  media  file  has  been  added,  updated  or

merged. Details include Date, User and Description.

5.3.7.1
0

Custom Thumbnail

The Custom Thumbnail tab appears on the Media Details screen only with non-image

file types (.mov, .unity, .unity3d, .zoom). This functionality allows users to upload an

image to appear as a thumbnail for the non-image asset.

5.3.8 Copy and Paste Metadata

Metadata  values  can  be  copied  from one  asset  to  another  (others)  from  the  Search
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Results screen. To copy and paste metadata, follow these steps:

1. Click the Copy Metadata icon in the Metadata column to copy the metadata to a

clipboard.

2. Click the  Paste  Metadata  icon beside  another asset  to  paste  the  metadata  into

that  media  asset's  records.  Alternatively,  to  paste  the  same  metadata  into  multiple

assets, click the Paste To All Results button. 

3. A window will appear, asking you to confirm which pieces of data should be pasted

from the original record.

5.3.9 Add Media to Screen

Once multimedia files have been uploaded to the Media Library, developers can populate
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the media fields in an activity in two ways:

1. Selecting a single media file to add to a screen in the activity.

2. Using Update Media Links to place all available media files in the activity at once.

5.3.9.1 Add Individual Media

To add a media file to an individual screen:

1. Click the Media tab, then click the Select button.

2. Search for the desired media  by  using  one  of  the  search options  described  earlier

(File Name (or path), Original Media, Title, Description, Tags  or Category).  If  you are

searching by file name, enter it in the Criteria field and click Search.

3. Your results will now appear on the Search Results screen. If this is the file you

wish to upload, click the Select button. 

Note: If you are unsure if this is the file you want and wish to see the Media Details,

click the file name to see the file information. This is described in the Media Details

(Metadata) section. 

Once you choose Select, the Media Library window closes and the media file name

automatically populates the file name field. Click Clear if you wish to remove this file

name.
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5.3.9.2 Add Multiple Media

To add all available media to an activity at one time:

1. Add all filenames to the Requested Filename field in  the  Media  tab  Description

field for each screen in  the  activity.  Once  you add  a  filename  to  this  field  and  click

Save, the filename will appear in the Media Filename field with "Requested Filename

-" in front of it.

2. Choose Update Media Links from the Additional Options drop-down list.

3. To proceed, click OK on the dialogue box.
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4.  Once  all  available  media  has  been  added  to  the  activity,  you  will  see  a  window

listing all media files with Skipped, Updated or Not Found beside each filename.

5.4 Glossary

Administrators, Managers, Developers and other users with the Glossary privilege enabled,

can manage glossaries.

The LCMS provides the tools to build a database of glossary terms that can be accessed

by the student in the courseware. If a glossary is required for the courseware, the

interface must provide glossary functionality. LCMS users with the relevant privileges can

view, edit or delete entries using the Glossary link from the LCMS Menu. Glossary terms

and categories can also be exported from one project into another. One or more glossary

categories can be created for all activities; however, each activity can display only one

category. The procedure for creating a glossary is outlined on the following pages.
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Note: If Multilingual Support is enabled additional fields for the alternate language term

and definition appear below the English term and definition fields.When adding or editing a

prompt, you will see an input field for the alternate language

Refer to the Translation - Multilingual Support topic.

5.4.1 Add Glossary Terms

1. Click Glossary from the Project Menu.

2. Click the Add Glossary Term button from the Glossary screen. 
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3. An Add Glossary Term screen will appear. Type the term in the Glossary Term

field. Note that if multilingual support is enabled, you will also see fields for the

alternate language term and definition.

4. Type the glossary term description in the Definition field. Use the text editor

toolbar to add bullets, make font changes, etc.

5. Click the checkbox beside each Glossary Category you wish to assign to the

term. 

6.  Click the Submit button. The glossary term will now be added to the selected

category(ies).

Note: Glossary links can be turned on or off for the following areas of courseware: 

Main screen text

Option text

Instructor notes

If the terms added to the glossary are from within these areas, the terms in the glossary

have to match exactly with these terms in the lesson. They  have  to  be  the  same  case,

context, one word, two words,  etc.  for the  links  to  be  created  properly  when exporting

content. You do not  have to add plural forms  of  terms  to  the  glossary  as  the  LCMS  will
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automatically pick these up when creating linkage. Glossary links can also be configured to

only link up to the first  occurrence of the glossary term, rather than all  instances  of  the

term, on every screen within all the applicable areas (main text, instructor notes, etc.).

5.4.2 Create a Glossary Category

1. Select Glossary from the Project Menu.

2. The Glossary screen will appear. To create a glossary category, start by clicking

the Manage Categories button.

3. The Manage Categories window will appear, listing the glossary category titles.

Click the Add Glossary Category button to add a new category. 

4. Type the title of the glossary category in the Category Title field and click

Submit. The title of your glossary will now be listed on the Manage Categories

window.

5. Repeat steps 2-5 for each glossary category you wish to create. Once the glossary

category has been created, you can enter the glossary terms in the database.

5.4.3 Search for a Glossary Term

There are two ways to search for glossary terms from the Glossary screen:
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1. Type a keyword into the Criteria field.

2. Click a letter of the alphabet to see all glossary terms starting with that letter.

5.4.3.1 Search by Tag

1. Type the keyword in the field. 

2. Select the glossary category you wish to search from the Filter by category drop-

down list.

3. Click the Search button. A glossary list will appear, listing all the terms that have

been assigned that keyword. The glossary term and the definition will be searched.
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5.4.3.2 Search by Letter

1. To search for a specific glossary item from the Glossary screen, click the letter of

the alphabet that corresponds to the first letter of the term.

2. Select the Glossary Category from the Filter by category drop-down list on the

Glossary screen. A glossary list will appear, listing all the terms that have been

added for that letter.

5.4.3.3 Search all Glossary Terms

1. To view all glossary terms, select the Glossary Category from the Filter by

category drop-down list on the Glossary screen. 

2. Click All. When this option is selected, it will show all glossary terms for either a

category or all categories, depending on the category(s) selected from the drop-

down list. A glossary list will appear, listing all the terms for the Glossary

Category(s) selected.

5.4.4 Edit a Glossary Term

1. Using one of the search functions, find the glossary item you wish to edit on the 

Glossary screen. 

2. Click the name of the glossary term. Make any changes on the Edit Glossary Term

window. Note: If Multilingual Support is enabled, the alternate language term and

definition fields display.
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3. Click Submit. The revised glossary term will be displayed on the Glossary screen. 

5.4.5 Delete a Glossary Term

1. Using one of the search functions, find the glossary item you wish to edit or delete

on the Glossary screen. 

2. Click the Delete icon   beside the glossary term you wish to remove.

3. A window will appear asking for confirmation to delete the glossary term. Click OK.

4. The glossary term will be deleted from the list of terms on the Glossary screen.

5.4.6 Export Glossary

Glossaries can be exported for use in another project, by  Admins,  Managers,  Developers,

and other users who can access the navigation tree.
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1.Click the Export Glossary button.  The Export Glossary screen will be displayed.

2. Click the Export button to begin the export process.

3. An XML file will be created and a download link displayed on the screen. Right-click

on the link and select the Download or Save target as... option from your

browser's context menu to save the XML file to your local Downloads folder.

5.4.7 Import Glossary

Admins  and  Managers  are  the  only  users  who  can  import  glossaries  that  have  been
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exported from another project.

1. Click the Import Glossary button. The Import Glossary screen will be displayed.

2. Click the Browse button and select the exported XML file to upload from your local

drive.

3. Select the Options radio button for Erase Existing Terms or Merge.

4. Click the checkbox for Include Categories to toggle on or off.

5. Click the Import button to begin the process. A brief report will be displayed

showing how many terms and categories were added.

5.5 Tag Manager

The LCMS provides the tools to build a database of tags.

To access the Tag Manager, click Tag Manager from the Project Menu drop-down list. 
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5.5.1 Add Tags

1. Click the Add Tag button from the Tag Management screen. Note: The ability to

add a tag is role specific (Administrator, Manager and Senior Developer). The

permission to add tags may be granted to Developers, see Configure Developer

Options for more information.

2. Enter the desired name in the Tag field.

3. Click the checkbox beside the desired category from the Categories drop-down

menu. Note: The tag may be assigned to multiple categories. 

4. Click the Submit button to save the tag or Cancel to exit without saving. 

5.5.2 Create a Tag Category

1. Select Tag Manager from the Project Menu.

2. On the Tag Management screen, click the Manage Categories button.
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3. On the Manage Categories window, click the Add Category button to add a new

category. 

4. Enter the desired name of the tag category in the Category field. 

5. Click the checkbox beside Available to reviewers to make the desired category

available to reviewers. Note: Tag categories provide the reviewer with a filtered list

of tags they can use to categorize their review comments (i.e., media, interface,

internal, etc.).

6. Click Submit. The new tag category will be listed on the Manage Categories

window. Note: There must be at least one category defined as being for reviews.

By default the Reviews category is available to reviewers. Once the tag category

has been created, you can enter the tag name in the database.

5.5.3 Search for a Tag

There are two ways to search for tags from the Tag Management screen:

1. Enter a tag into the Filter field and select a Category from the drop-down menu.

Note: Select All Categories to view all tags with the search criteria.
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2. Select a category to display the associated tags. Note: Clicking the Search icon

to the left of the tag name shows all instances of where the tag is used. The count

to the right of the tag name displays the number of times the tag had been used. 

Note: Counts and instances/locations may differ because questions and master

linked screens only exist once. Therefore, the tags are only counted once. Note: If

more than 5000 tags exist in the system, a warning message displays and an initial

search is required when looking for tags to select or manage.

5.5.4 Edit a Tag

1. Using one of the search functions, find the tag you wish to edit on the Tag

Management screen. 

2. Double-click the name of the tag. Modify the name in the Tag field. 
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3. Click Submit. The revised tag term will be displayed on the Tag Management

screen. 

5.5.5 Delete a Tag

1. Using one of the search functions, find the tag you wish to delete on the Tag

Management screen. 

2. Click the Delete icon  beside the tag name you wish to remove.

3. A window will appear asking for confirmation to delete the tag name. Click the Yes

button.

4. The tag name will be deleted from the list of tags on the Tag Management

screen.

5.6 Reports

The Report feature provides a series of reports for a project that may be accessed in

Excel, PDF and CSV formats. Different user roles have access to specific report types

depending on their privileges. Administrators and Managers can access most of the

available report types. The only option available to Developers in Reports is Screen

Content Search.

To access reports:

1. Click Reports in the Project Menu. A list of available reports is displayed on the

Report screen.
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2. Click the name of the desired report type.

5.6.1 Access Log Report

1.  Click Access Log Report from the Reports screen menu.
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2.  You  have  the  option  to  choose  specific  Role(s),  Action(s)  and  User(s)  from the

drop-down lists. If  you make no selections, all will be  automatically  selected.  You may

also filter by Date. 

3.  Click Submit to view the report. 

The report  lists the  Date/Time,  Action,  User,  Role,  Organization,  IP  and  Project  to

match your search criteria.
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4.  Click the Excel, CSV or PDF buttons to see the report in any format.

5.6.2 Activity Log Report

The Activity Log Report provides Administrators and Managers with a quick way to view

the history of all activities.

1.  Click Activity Log Report from the Reports window menu.

2. The  information  can  be  filtered  by  Folder,  Type,  Activity  Development  Phase,

Status,  User,  Log Activity  Development  Phase  and  Status  in Log  from the  drop-

down lists. If  you make no selections, all will be automatically selected. There are  also

fields for Current Version and Log Version. To/From dates can be adjusted from this

screen as well.

3.  Click Submit to view the report. 
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For all activities that match your search criteria, the report lists Activity, Code, Current

Production Status, Current Version, Current Activity Development Phase, Date,

User, Log Production Status, Log Version, Log Activity Development Phase, Parked

Status, Parked Description and Note. 

4.  Click the Excel or CSV buttons to see the report in either format.

5.  You also have the option to Hide/Show Columns, if you wish. 

Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.
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5.6.3 Change(s) Required Report

When activities are sent to assigned Reviewers/Approvers, the Reviewer/Approver

provides comments which may be documented in the Change(s) Required Report. The

Change(s) Required Report allows you to view all of the comments and responses in full

for all versions of the selected activity.

1. Click the Change(s) Required Report link from the Reports screen menu.

2. All activities within the project are listed on the Change(s) Required Report

screen. Click the activities for the report from the list.

3. If required, click the Clear button to clear your selection or click the Select All

button to select all the activities in the list.

4. Click the Calendar icon to select the start date for the reporting period.

5. Select the calendar year, month and date for the reporting period start date. The

date appears in the Start Date field.

6. Click the Calendar icon to select the end date for the reporting period.

7. Select the calendar year, month and date for the reporting period end date. The

date appears in the End Date field.



LCMS Menu (Project Menu) 213

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

8. Select the Developer or Reviewer from the drop-down lists. 

9. Select the Status of the comments from the drop-down list. Options include

Pending, Resolved, Accepted, Needs Rework, Input Required and All for display

in the report.

10. Select the Activity Development Phase from the drop-down list. Options include

Lesson, Outline and Storyboard.

11. Select the Review Type from the drop-down list. Options include Content, Client,

Media, Peer, QC, Senior ID and SME.

12. Click the Submit button. The Changes(s) Required Report is then displayed.

For each comment made by the assigned Reviewer/Approver, the report provides

the following information: Activity Title, Change ID, Scope, Screen, activity

Version, Review Type, Comment Author, Date and time comment was made,

Status of comment, Response Author, Date, Comment and the Response Made

to the comment. 

Note: If there are more than 25 entries on the screen, a filter appears at the top of the

report to allow for a more precise search within the report.

If you select Display Summarized Version on the Report Filter screen, you will see a

summarized version of the report.
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5.6.4 Courseware Summary Report

1. Click Courseware Summary Report from the Reports screen.

2. If desired, use one or more filters to narrow down your search.

3. Select a folder from the Folder drop-down list.

4. Type the name of the activity in the Activity field.

5. Select the type of activity from the Type drop-down list.

6. Select the status of the activity from the Status drop-down list.

7. Type the version of the activity in the Version field.

8. To clear filters, click the Clear button.

9. Click the Submit button.

The Activity, Status, Type, Version and the names of the Developer,

Reviewer(s)/Review Manager, Manager and Approval Authority are displayed.
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Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.

5.6.5 Courseware Workflow Report

This report is used to track the flow of activities through the review process. Once an

activity is submitted for review, the date that the review must be completed by and the

number of days left for the review are tracked.

1. Click Courseware Workflow Report from the Reports screen. If desired, use one

or more filters to narrow down your search (Folder, Type, Status, Activity

Development Phase and/or Review Type).

2. Click Submit. 

For all activities that match your search criteria, the report lists the Activity Title, Code,

Activity Development Phase, Status, Review Days Remaining, Review Due Date and

Reviewer/Approver authorities. Click the Excel, CSV or PDF buttons to see the report

in those formats.
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Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.

5.6.6 Deleted Activities Log Report

The Deleted Activity Log Report provides Administrators and Managers with a quick way

to view all deleted activities.

1.  Click Deleted Activity Log Report from the Reports screen menu.

2.  The information can be filtered by Type from the  drop-down list.  If  no  selections  are

made, all will be automatically selected. Deleted Between dates can be adjusted from

this screen as well.

3.  Click Submit to view the report. 

For all activities that match your search criteria, the report will list Activity, Code,

Current Version, Activity Type, Developer, Creation Date, Deletion Date, Deleted

By, and Log. 

4.  Click the Excel or CSV buttons to see the report in either format.

5.  You also have the option to Hide/Show Columns, if you wish. 

Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.
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5.6.7 Detailed Project Metrics Report (Include All Versions)

The Detailed Project Metrics Report (Include All Versions) provides information on all

versions that exist for an activity, including the versions that were archived when new

versions were created. Note: Versions are managed in the Version field of the Activity

Profile function. 

1. Click Detailed Project Metrics Report (Include All Versions) from the Reports

screen.

2. The Detailed Project Metrics Report screen is displayed. Information for each

activity includes the Version, whether it is archived, number of topics, number of

instruction screens, number of question screens, number of Depreciated screens,

number of Graphics, number of Video files, number of Audio files, number of

Reference files, number of Change comments and number of Outstanding

Comments. The totals are also given for all activities included in the report.

Click the Excel, CSV or PDF buttons to see the report in those formats.

5.6.8 Detailed Project Metrics Report

The Detailed Project Metrics Report provides information on all versions that exist for an

activity, but does not include archived versions of that activity.

1. Click Detailed Project Metrics Report from the Reports screen.

2. The Detailed Project Metrics Report screen is displayed. Information for each

activity includes the Version, number of topics, number of instruction screens,

number of question screens, number of Depreciated screens, number of Graphics,

number of Video files, number of Audio files, number of Reference files, number

of Change comments and number of Outstanding Comments. The totals are also

given for all activities included in the report.
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Click the Excel, CSV or PDF buttons to see the report in those formats.

5.6.9 Production Analysis

The frequency of use for the different instruction or question screen styles and the level

of difficulty assigned to questions can be located using the Production Analysis feature. 

To view production analysis statistics:

1. Click Production Analysis from the Reports menu. The Production Analysis

reports window will appear.

2. Click the Screen Distribution link to view screen distribution statistical information

for a project or for a specific activity. 
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3. Click the Questions - Level of Difficulty Distribution link to view the question

level of difficulty distributions for a project or activity.

5.6.9.1 Screen Distribution - Project

1.Click Screen Distribution beside Project on the Production Analysis screen to see

a Project: Screen Distribution screen showing the various screen styles used in the

project.  Their  use  is  shown  as  a  bar  graph,  expressed  as  a  percentage  (%)  and

identified by the number of times each screen style is used. 

A screen distribution Summary for the activity is provided at the bottom of the

screen.
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2. To return to the Production Analysis screen, click the Cancel button in the top

right corner or the Browser's back button. There is also a Print button located

here. 

5.6.9.2 Screen Distribution - Activity

1. Click Screen Distribution beside Activity on the Production Analysis screen.

2. Select the activity folder you wish to analyze from the drop-down list. 

3. Select the activity you wish to analyze from the drop-down list. An Activity:

Screen Distribution window will appear that displays the various screen styles

used in the project. Their use is shown as a bar graph, expressed as a percentage
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(%) and identified by the number of times each screen style is used. A screen

distribution summary for the activity is provided at the bottom of the screen.

4. To return to the Production Analysis screen, click the Cancel button in the top right

corner or use the Browser's back button. There is also a Print button located here. 

5.6.9.3 Questions - Level of Difficulty Distribution

1. Click Questions - Level of Difficulty Distribution beside Project/Activity on the

Production Analysis screen. A screen will appear, indicating the distribution of

questions with low, medium or high difficulty ratings for a specific project. Their use

is shown as a bar graph, expressed as a percentage (%) and identified by the

number of times each screen style is used.

2. To further refine your analysis, select an activity folder from the drop-down list,

then select an activity from the next drop-down list. Results will be displayed on

the Difficulty Distribution window.
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3. To return to the previous screen, click the Browser Back button or Cancel.

5.6.10 Production Development Status Report

The  Production Development  Status  Report  provides  an  overview  of  the  production

status for each activity  in  the  project.  The  report  also  provides  the  number of  days  an

activity  has  spent  in  each  status,  which  can  be  used  in  analyzing  the  project's

performance metrics.

1.  Click Production Development Status Report from the Reports screen.

2.  Select one or more folders from the Folder drop-down or leave the selection

empty to search all project folders.

3.  Select one or more activity types from the Type drop-down or leave the selection

empty to search all activity types.

4.  Select one or more activity development phases from the Activity Development

Phase drop-down or leave the selection empty to search all phases.
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5.  If desired, enter the full or partial name of an activity in the Activity field to filter

by activity.

6.  Select Activity Creation Date or Use Inputted Date and enter a valid date in

the Activity Since Field to choose how the activity stats will be calculated.

7.  Select one or more activity statuses from the Status drop-down or leave the

selection empty to search all statuses.

8.  Select one or more developers from the Developers drop-down or leave the

selection empty to search all developers and activities with no developers assigned.

9.  If desired, enter the full or partial version number in the Version field to filter by

activity version.

10. Once all desired filters have been entered, click the Submit button to generate

the report.

The Activity, Code, Created Date, Activity Development Phase, Status, Type,

Version and Current Developer will be displayed, along with the number of days the

activity has spent in each of the following: Development, Review, Parked and Waiting.

Click the Excel, CSV or PDF button to download and view the report in the relevant

format.

Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.

5.6.11 Media Distribution Report

This report is used to view all the media files associated with a project.
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1. Click Media Distribution Report from the Reports screen. The Media

Distribution Report screen is displayed. 

2. Select the box beside each available selection desired for the report.

3. Click the Submit button. The Media Distribution Report is displayed. There is a

Print option provided, along with buttons to allow you to review the report in

Excel, CSV or PDF formats.

Note: The information provided in the report is dependent on the fields completed for

individual screens and the boxes selected on the previous screen.
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5.6.12 Project Media Audit

This report is used to report the status of all media files associated with a project. It lists

the number of files specified, in place and missing.

1. Click Media Distribution Report from the Reports screen. The Media

Distribution Report screen is displayed, listing all available activities.

2. Click an activity to select it for the report. To select more than one activity, hold

Ctrl and click the desired activities. To choose all activities, click the Select All

button. 

3. Under Filter by Media Type, select the media type you would like to see in the

report.

4. Click the Submit button. The Project Media Audit Report is displayed, showing

Files specified, Files in place, Files Missing and Overall Completion.
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Click the Excel, CSV or PDF buttons to see the report in those formats.

5.6.13 Question Bank Report

1.Click Question Bank Report from the Reports screen.

2. All question categories within the project are listed. Select the question categories for

the report from the Category drop-down, or leave the selection blank to search all

questions.

3. If desired, use one or more of the other filter options to narrow your search (Screen

Style, Difficulty, Answer Constraint, Time Limit, Tags, Main Text Contains,

Status (Active, Inactive or All), and Format).

4. Click the Submit button. The Question Bank Report is displayed, showing all

questions in the selected categories and a summary of the assigned levels of difficulty.

The details provided for each question depend on the fields completed on each
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individual question screen when the questions were developed in the Question Bank.

Details for each question include the Question ID, Screen Style, Level of Difficulty,

Answer Constraint, Time Limit, Question Stem, Options, Correct Answer,

Feedback, Media Descriptions, Tags, and Category. Note: If Multilingual Support is

enabled on the project, an Activity Language drop-down menu will appear in the

report filter options.

5.6.14 Review Audit Report

This  report  provides  a  summary  of  the  statuses  of  different  Activities,  showing  their

Version,  Activity  Phase,  Review  Type,  Date  Submitted,  Date  Finalized,  Author

(Reviewer) and Comments.  

1. Click Review Audit Report from the Reports screen and the Review Audit
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Report Filter is displayed.

2. Select a value from the drop-down for Activity Status, Activity Development

Phase or Review Type to limit results to those values, or leave blank to select all. 

3. Select Date Submitted From and To dates to limit results by submission date.

Note: Click the "Include Review Monitors in results?" check-box to include/

exclude Review Monitors from the report results.

4. Click the Submit button. The Review Audit Report is displayed. Print is available,

along with a CSV button if you wish to view the report in this format.

Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.

5.6.15 Review Assignments by Type

This report provides a list of Review Types and the users assigned to various roles within

the Reviews assigned to those Review Types.

1. Click Review Assignments by Type from the Reports screen and the Review

Assignments by Type Filter is displayed.
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2. Select a value from the drop-down for Activity Status, Activity Development

Phase or Review Type to limit results to those values, or leave blank to select all. 

3. Select Date Submitted From and To dates to limit results by submission date.

Note: Click the "Include Review Monitors in results?" checkbox to include/

exclude Review Monitors from the report results.

4. Click the Submit button. The Review Assignments by Type report is displayed.

The report may also be viewed in Excel, CSV or PDF formats.

Note: If Multilingual Support is enabled on the project, an Activity Language drop-

down will appear in the report filter options.

5.7 Course Packaging

Depending on the privileges you have been assigned, you may have access to some or all

of the LCMS Content Packaging functions for developing and managing activities in a

project. You can design a course made up of activities using this function. Once your

course is created, you can export the course for use in the Learninglogics® LMS. 
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To access the Course List, click Course Packaging from the LCMS Menu. This screen

lists all of the created courses by name, code, description and version. It also includes the

date of course creation, along with its date of last modification.

From the Content Packaging: Course List screen, you can:

Create a new course structure

Modify an existing course structure

Edit the course properties (archive versions of a course structure)
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View published courses

Select an archived course structure as the master 

Copy an existing course structure

Delete an existing course structure

Toggle List Courses Generated from Activity On or Off

Open Course Designer

5.7.1 Create New Course

1. From the Content Packaging screen, click the New Course button.

2. Enter the Name, Code, Description, Version and Language (if required) of the

course on the Course Properties screen.
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3. Click the Submit button. A dialogue box appears asking if you would like to add

activities to the course.

4. Click Yes to continue creating your course structure within Course Designer.

Note: Click No to create your course structure later. You will return to the Course

List screen. 
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5.7.1.1 Course Designer

You will add and edit activities and course structure within Course Designer. This is

also where you will create your SCORM or Off-Line package.

5.7.1.1.1  Add Activity to Folder

If a course contains many modules, you may wish to add activity folders to the course for

organizational purposes. You may add activities (SCOs) to the course folder or the activity

folders, depending on the desired course structure. This course structure will be used by

trainees and instructors to access the course and all of its activities within the LMS.

Note: 

1. Select the course or activity folder within Course Designer.

2. Right-click the Activity, and then select Create to add a child node. Note: The

Activity can also be renamed or deleted. 
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3.Click the Assign Activity to choose an Activity module to add to the course

structure. Select the Activity module from the list, and then click the Assign

button or click the Cancel button to return to the Course Designer screen. The

selected Activity module will display in the course structure. You may select an

activity module from the Active, Archived, or Imported/3rd Party scrolling list. If you

wish to narrow your search, type a full or partial activity name in the search field,

and then click Search. Note: Any archived activities included in a course structure

will be identified in blue. 

4.Once the activity module is selected, the activity name will be displayed in the 

Name for activity field. If you wish to change the name of the selected activity

module, right-click the activity module and select Rename. Enter a name in the

activity name field. 
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5.Click the General tab to assign course parameters such as, Is Visible, Instructor

Authentication, Identifier, URL Parameters (i.e., reference material), Passmark,

Attempt Count Limit, Attempt Time Limit (hours, minutes, and seconds) and

Time Limit Action. Note: If desired, click the checkbox beside Allow LMS to

automatically launch the first Activity (Control Mode Flow) to enable this

feature in the LMS.

Note: When instructor authentication is enabled, the user may launch the activity

from within My Courses (Learninglogics® LMS), but will not be able to view screens

until the instructor has entered a username and password.

5. On the new Activity module, the Options tab will also be enabled. From the

Options tab, select an Interface (viewer) and/or a Glossary from the drop-down

menu. 
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6. On the SCORM 2004 Sequencing pane, select the desired close/relaunch

behaviour for the activity by clicking the corresponding checkbox. These

sequencing options are activity specific and will set the expected results when an

activity is closed and relaunched by the user in the LMS. Support for the SCORM

2004 Sequencing options is dependent on the LMS SCORM player. Note: The

SCORM 2004 Sequencing panes will only display if the activity is published as a

SCORM 2004 3rd or SCORM 2004 4th package. 

7. On the SCORM 2004 Sequencing Macros pane, Click the Continue to next

Activity on end checkbox. When this feature is enabled, the next activity in the

sequence will launch automatically in the LMS. 

SCORM

2004

Sequencing

Option

Description

Completion

Set by

Content

The Completion Set by Content option indicates the activity is

responsible for communicating whether or not the activity is complete.

If the Completion Set by Content is defined as False and the activity

does not communicate completion information, the LMS will assume the

activity has been completed when the current attempt on the activity

ends.

Objective

Set by

The Objective Set by Content option indicates the activity is

responsible for communicating whether or not the activity's objective is
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Content satisfied. If the Objective Set by Content is defined as False and the

activity's associated content object does not communicate success

information, the LMS will assume the activity's objective has been

satisfied when the current attempt on the activity ends.

Skip when

satisfied/

completed

The Skip when satisfied/completed option will choose satisfied if the

activity is a Test and completed if the activity is a Independent Study.

If the activity is either satisfied or completed the activity is not

considered a candidate for delivery during a flow sequencing request.

The activity may still be chosen with a choice sequencing request.

Disable when

satisfied/

completed

The Disable when satisfied/completed option will choose satisfied if the

activity is a Test and completed if the activity is a Independent Study.

If the activity is either satisfied or completed the activity may not be

the target of any sequencing or delivery request.  The presentation is

normally greyed in the course tree. If needed, also choose Skip when

satisfied/completed option to not interrupt any flow sequencing.  

5.7.1.1.2  Edit Activity/Activity Folder Name/Contents

1. Select the activity folder or activity you wish to edit within Course Designer.

2. Right-click the activity, and select Rename from the option list.
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3.  Edit the name in the Name for activity field if desired. 

4. To re-order the activities, click and drag the activity to the desired location.

5. Click the Save icon.

5.7.1.1.3  Re-Order Activity Folder/Activity

1. Select the folder or activity you wish to re-order within Course Designer.

2. Click and drag the folder or activity

3. The folder or activity will move to the desired location.

4. Click the Save icon.

5.7.1.1.4  Delete Activity or Activity Folder

1. Select the activity folder you wish to delete within Course Designer.  

2. Right-click and select Delete from the option list. The selected folder or activity

will be deleted.
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3. Click the Save icon.

4. To delete an activity from the course structure. Click Course Packaging from the

LCMS Menu, and then click the delete icon beside the activity. Note: The activity

and all the associated modules will be deleted.

 

5.7.1.1.5  Create SCORM Package

Once a course is created in Course Designer, you will create a SCORM package for the

course. This function wraps the course, making it SCORM conformant for delivery via a

SCORM conformant LMS. 

To create the SCORM package within Course Designer:
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1. Select the desired course or activity. You may assign SCORM package requirements

at the course level or at the activity level.

If the requirements are the same for all (or the majority) of activities in the

course, select the course and then click the Publish tab.

If the requirements must be customized for an individual activity, select the

activity and then click the Publish tab.

2. Select the desired Interface for the course or activity from the drop-down menu. 

3. Select the desired Glossary for the course or activity from the drop-down menu. 

4. Select the desired SCORM version for the SCORM package. Note: When one of the

SCORM option is selected, click the Include Offline Download checkbox to include

the offline course in the SCORM package. This feature needs to be enabled in 

Project Preferences Course Export/Publish Options.

5. Click the Include Alternate Language checkbox, if required. Note: Multilingual

Supports must be enabled in Project Preferences for this checkbox to display.

6. Click the Include Content Viewer checkbox to include the content viewer, if

required.

7. Click the Include screens with Tags checkbox, choose the tags from the Select

Tags window and then click the Submit button (if required). 

8. Click the Exclude screens with Tags checkbox, choose the tags from the Select

Tags window and then click the Submit button (if required). 

9. Click the Create button to create your SCORM or Offline package. Note: All illegal

file characters (\ / : * ? " > < |) will be removed from the course or activity name

when creating the .zip file.
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10. After a few minutes, the package will been created. 

11. Click the course link to download the SCORM package.

12. When the file is downloaded, save the file in the desired location.

13. Now that you have wrapped the desired course in a SCORM package and

downloaded it, it is available for import into the LMS. This import is done from within

the LMS.

5.7.1.1.6  Create Offline Package

This feature is used within Course Designer to create an offline package as a .zip file for

a course that will run outside of the LMS. It shows the tree structure and allows a user to

launch and view a course. Since it is outside of the LMS, there are no tracking

capabilities.

To create the offline package within Course Designer:

1. Select the desired course or activity. You may assign offline package requirements
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at the course level or at the activity level.

If the requirements are the same for all (or the majority) of activities in the

course, select the course and then click the Publish tab.

If the requirements must be customized for individual activities, select the

activity, then click the Publish tab.

2. Select the desired Interface for the course or activity.

3. Select the desired Glossary for the course or activity. 

4. Select Offline for the package.

5. Click the Include Alternate Language checkbox, if required. Note: Multilingual

Supports must be enabled in Project Preferences for this checkbox to display.

6. Click the Include Content Viewer checkbox to include the content viewer, if

required.

7. Click the Include screens with Tags checkbox, choose the tags from the Select

Tags window, and then click the Submit button (if required). 

8. Click the Exclude screens with Tags checkbox, choose the tags from the Select

Tags window, and then click the Submit button (if required). 

9. Click the Create button. 

10. Click the course link to download the offline package.

11. Click the Save button in the “Do you want to open or save this file?” window.
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12. Save the file in the desired location.

13. Now that you have wrapped the desired course in an offline package and

downloaded it, it is available to run from the downloaded location.

5.7.2 Edit Course Properties

1. From the Content Packaging: Course List screen, locate the desired course. 

2. Click the pencil icon (Edit). 

3. Edit the existing properties for this course. Note: Changing the version number will

automatically archive the previous version.
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4. Click the Submit button. If the version number has changed, you will be prompted

to enter an archive comment for the previous version.

5. Click the Submit button. The new version number will show up beside the course

under the version column of the Content Packaging: Course List screen.

5.7.3 Select Archived Course Structure as Master

1. From the Content Packaging: Course List screen, locate the desired course. 
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2. Click the link under the Version column (which is only available when there is at

least one version archived) to select an archived version of the course structure as

the master (active version). 

3. Select the radio button next to the version you want to set as the master (active

version).

4. Click the Set as Master Version radio button. Note: You can also delete an

archived version from this screen.

5. Enter a comment for the current master (active) version.
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6. Click Submit.

The version selected as the master will show beside the course under the version column

of the Content Packaging screen.

5.7.4 Copy Existing Course Structure

1. From the Content Packaging: Course List screen, locate the desired course. 

2. Click the Copy icon beside the pencil icon.
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3. Enter the Name, Code, Description, Version and Language of the new copied

course on the Copy Course window.

4. Click Submit.
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The new copied course will be added to the course list on the Content Packaging:

Course List screen.

5.7.5 Delete Existing Course Structure

1. From the Content Packaging: Course List screen, locate the desired course. 

2. Click the Delete icon beside the Copy icon.

3. Click OK. The course will be removed from the course list on the Content

Packaging screen.

5.7.6 View Published Courses

Each time a course is published, an archived version of the course is saved so users can

re-download it if needed.

1.  Click the Published Courses button to see a list  of these courses. Note: Users can also

see the  list  of  courses  from within  an activity  by  clicking  Additional Options/Published

Courses.
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2.  For each published course listed, there are options for Administrators and Managers to:

Indicate that the course has been pushed to an LMS

Download the published course

Delete the published course

Note: Developers will see the list of courses, but will not have access to these options.

5.7.6.1 Published to LMS Indication

For each published course listed, you may indicate that the course has been pushed to an

LMS. This is not automatic functionality.

1.  Click Published Courses.

2.  Click the Sent to LMS? checkbox.
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5.7.6.2 Download Published Course

You have the option to download each published course listed. 

1. Click the Published Courses button.

2. Click the Download icon on the right to download the selected course. 
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5.7.6.3 Delete Published Course

You have the option to download each published course listed. 

1.  Click Published Courses.

2.  Click the Delete icon on the right.

3. A dialogue box appears, asking if  you are sure you want  to delete the record. Click OK

to delete the course, or Cancel.

5.8 Translation Batch Import

1. To access the Translation Batch Import window, click Translation Batch Import

from the LCMS Menu.
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2.  From the Translation Batch Import screen, browse to and select the .zip file

containing your translated HTML files, then click Submit. 

3. A status report window appears with a list of activities ready for import. Activities that

cannot be imported will be indicated under the Import Status column. Click Import

Selected once you have selected the desired activities.

Note: While the import is in process, you should not navigate away from the screen. 

The Import Status column will change to a check mark once the activity is successfully
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imported. The Production Status column will change to "submitted for translation" once

import is complete. The Activity Status will also be updated to "translated", but the

activity will remain locked. 

When imports are complete, the repository tree will refresh to show the translated

content.

5.9 Screen Prompts

Administrators, Managers, Developers and other users with the Screen Prompts privilege

enabled can manage prompts.

All screen prompts are managed through the Screen Prompts screen. The development of

prompts is often the responsibility of those assigned LCMS Manager rights, although any

user with the privilege set may access the Screen Prompts screen. The prompts used will

depend on the screen styles and the activities in which they are used. Prompts may be

added, edited or deleted. The revision of a prompt will update all screens where the

prompt is used.

Note: If Multilingual Support is enabled an additional column for the alternate language

appears beside the prompt list. When adding or editing a prompt, an input field for the

alternate language displays.

Refer to the Translation - Multilingual Support topic.

5.9.1 Add a Prompt

1. From the Project Menu click Screen Prompts.
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2. The Screen Prompts screen will appear. Click the Add Prompt button. Note that

if multilingual support is enabled, you will also see a field for the alternate language

prompt.

3. Enter the prompt in the Prompt field.

4. Click the Submit button and the new prompt will be added to the prompt list on

the Prompt Manager screen.
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5.9.2 Edit a Prompt

1. From the Project Menu click Screen Prompts.

2. The Screen Prompts screen will appear. Click the prompt you wish to edit from

the prompt list. Note that if multilingual support is enabled, you will also see a field

for the alternate language prompt.

3. Edit the prompt in the Prompt field.

4. Click Submit. The revised prompt will be displayed in the prompt list.

5.9.3 Delete a Prompt

1. From the Project Menu click Screen Prompts.
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2. The Screen Prompts screen will appear. Click the Delete icon  beside the

prompt you wish to remove.

3. A window will appear asking if you wish to delete the prompt. Click OK. The prompt

will no longer appear in the prompt list.

4. If the prompt is assigned to a screen(s), a window will appear stating that the

prompt cannot be deleted. Click OK. The prompt will remain in the prompt list.
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5.9.4 Set Question Defaults

This feature allows the Manager to define a default screen prompts for certain screen

styles.

1. From the Project Menu click Screen Prompts.

2. The Screen Prompts screen will appear. Click Set Question Defaults.

3. Click the drop-down menu for the screen on which you would like to set the default

screen prompt. Select the screen prompt to apply to that screen style, then click 

Save Defaults.
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5.9.5 Export Prompts

This feature allows you to create an XML file, which can also be easily translated and

exported. This allows for prompts to be copied into other LCMS projects.

1. From the Project Menu click Screen Prompts.
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2. The Screen Prompts screen will appear. Click Export Prompts to open the

Export Prompts window.

3. Click the Export button to create an XML file of all prompts. 
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5.9.6 Import Prompts

This feature allows you to import an XML file of prompts to allow for prompts to be

copied from other LCMS projects.

1. From the Project Menu click on Screen Prompts.

2. The Screen Prompts screen will appear. Click Import Prompts to open the

Import Prompts window.
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3. Click the Browse button to locate your XML file of prompts, then click the Import

button to import the file.

5.10 3rd Party Content

Depending on the privileges you have been assigned, you may have access to import

compressed (.zip) files containing Shareable Content Objects (SCOs). SCOs consist of

HTML screens and associated assets, such as images, audio and video files, etc., for use

within a course. Once your file is imported, you can use Course Designer to add it to a

course structure.

5.10.1 Import Content Objects

To import a Shareable Content Object (SCO):

1. From the Project Menu, click the 3rd Party Content link.
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2. Click the Import Content Object(s) button on the Imported Content Objects

screen.

3. Click the Browse button on the Select Import File screen.

4. Locate and select the file to be imported. 

5. Click the Open button.

6. Click the Submit button on the Select Import File screen to import the selected

file. The LCMS will attempt to detect the use of SCORM calls and the version of

SCORM (2004 or 1.2) being used on every imported file.
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7. Change the name of the imported SCO if desired and/or select that it uses SCORM

calls, if the calls are needed and were incorrectly detected at the time of import.

You will also have to choose what version of SCORM (2004 or 1.2) is used for these

calls.

Note: If you imported a zip file that is not part of a SCORM package, but contains multiple

files, you will be prompted to select a target file. A target file is the one file that will be

launched to open up some or all of its dependent files listed on this screen.

8. Click the List All button or perform a search on the Imported Content Objects

screen to view the newly imported file.

5.10.2 View List of All Imported SCOs

To view a list of all the imported SCOs:

1. Click the List All button on the Imported Content Objects screen. All imported

SCOs will be displayed. Each will have a name, an identifier and an import date.
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5.10.3 Search for Imported SCOs

To search for an imported SCO:

1. Enter a full or partial name of the SCO to be found.

2. Click the Search button. The search results will be listed below in a table.

5.10.4 Edit Properties of Imported SCOs

To edit certain properties of imported SCOs:

1. Search or list all to find the desired SCO.

2. Click the name of the desired SCO. 

3. Edit the name of the imported SCO if desired and/or select that it uses SCORM

calls, if the calls are needed and were incorrectly detected at the time of import.

You will also have to choose what version of SCORM (2004 or 1.2) is used for these

calls.
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Note: If you are editing a SCO containing multiple files, you will also have the option to

change the target file. A target file is the one file that will be launched to open up some

or all of the other dependent files listed on this screen.

4. Click the Submit button.

5.10.5 Delete Imported SCOs

To delete an imported SCO:

1. Search or list all to find the desired SCO.

2. Click the red x Delete icon beside the name of the SCO you wish to delete. 

3. Click the OK button to confirm deletion.
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5.11 Find & Replace

The Find & Replace function may be used by the Administrator, Manager, or Senior

Developer to find and replace content globally.

1. Click Find & Replace from the LCMS Menu drop-down list or click the expand icon to

display the Find & Replace window. 

2. On the Find & Replace window, enter the desired content to search for in the Search

For field. 

3. Select the desired search option (Word or Phrase, All Words) to refine the search.

4. If desired, click the checkbox beside Case-sensitive to further refine the search.

5. Enter the desired content in the Replace With field. Note: The content entered in the

Replace With field will replace the content entered in the Search for field.

6. Click the checkbox beside the desired fields to include in the search. Note: If media

related fields are chosen, the Pop-Ups option should also be chosen if the pop-up

media also needs to be included in the search. Click the Select All button to include all

of the options or the Select None button to exclude all of the options.
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7. Select the desired tags by clicking the Tag field to access the Select Tags window,

and then click the Submit button. Note: Clicking the Clear Tags button will remove all

the tags from the search.

8. Enter the desired screen style to include in the search in the Screen Styles field.

Note: Separate the entries by a comma (3.02, 3.10, 3.14).

9. Enter the desired screen ID(s) separated by a comma in the Screen ID field. Note:

When searching by screen ID no other inputs are valid.

10. Select the desired language from the Screen Language drop-down menu. 

11. Select the desired developer from the Developer drop-down menu or leave blank to

include all developers in the search.

12. Select the desired activity status from the Activity Status drop-down menu or leave

blank to include all activity statuses in the search.

13. Select the desired activity development phase from the Activity Development

Phase drop-down menu or leave blank to include all activity development phases in the

search.

14. Enter the desired activity version in the Activity Version field and select the desired

option Include Activities at Version or Exclude Activities at Version.

15. Click the Find button to begin the search. Note: The search may take a few moments

to complete.
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16. On the Search Status window, click the View Results button to display the list on

the Find & Replace screen or click the Search Again button to repeat the search. 

17. Click the Change icon beside the desired list item to review the requested change on

the Replace window or click the Replace All button. A confirmation window displays

when the Replace All button is clicked. Click the Continue button to execute the

replace all function for all occurrences listed or click the Cancel button to return to

the Find & Replace screen. Note: Click the View icon to view the corresponding

screen.
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18. On the Replace window, click the Replace button to replace the highlighted old text

with the highlighted new text. Note: When clicked, the Replace button changes to an

Undo button, allowing the user to immediately undo the replace function. The Undo

button is no longer available once the user clicks the Previous, Next or Close button. 

19. Click the Previous or Next button to view additional occurrences.

20. Click the Close button to return to the Find & Replace screen. Note: A checkmark

displays beside the list item when the content has been replaced. 
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5.12 Tag Search

All activities,  topics  and  screens have  a  Tags  field.  Tags  generally  refer  to  specific

metadata  associated  with  individual topics  or  screens.  These  Tags  can  be  tracked  to

locate  activities,  topics  and  screens  to  which  they  have  been  assigned  by  using  the

LCMS Tag Search function. 

Users can search the LCMS for activities, screens, topics, or snippets containing  specific

tags. Note: If  more than 5000 tags exist  in the system, a warning message displays  and

an initial search is required when looking for tags to select or manage.

1. Select Tag Search from the Project Menu.

2. Enter a desired tag and select activities, screens or topics from the drop-down

menu, then click the Search button to do a search. You will be shown a list of

results.
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Note: On the Results screen for each item, you will see a Preview icon, click the icon. If

no previous interface has been selected, a menu will appear allowing you to select the

interface you wish to view the screen or topic. The screen or topic will open for viewing.

When launching a topic, the entire activity will open. It will not open directly to the first

screen of that topic, but it will open to the topic menu of the activity. 

5.13 Document Management

The Document Management feature is used to manage documents associated with a

project. These documents may be accessed or edited by users during the production and

review of activities, depending on how the relevant privileges are configured for their user

role.

5.13.1 Add Document

1. Click Document Management from the Additional Features in the Project Menu.

2. To add a new document you must have at least one category. Click New

Category to add a new category.
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3. Click the New Document button.

4. On the Add New Document window, enter the name of the document in the

Document Name field.

5. Click the Browse button to select the document.

6. Enter the version number you wish to assign to the document in the Version field.

7. Select the category you wish to assign to the document to from the drop-down

list.

8. Click the Submit button. The document will be displayed on the Document

Manager: Categories screen.

5.13.2 Add Document Category

Categories are created to organize documents. To create a document category:

1. Click Document Management from the Additional Features in the Project Menu.
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2. Click the New Category button.

3. Type the name of the category in the Category Name field.

4. Click the Submit button. The category will be displayed on the Document

Manager: Categories screen.

5.13.3 Add New Version of Document

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the document you wish to add a new version to.

3. Click Add New Version on the Document Management: Details screen.

4. Click the Choose File button to locate the new version.

5. Enter the version number in the Version field.

6. Click the Submit button. The new version will be displayed.
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5.13.4 Change Document Category

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the document you wish to change the category for.

3. Select the new category from the Category drop-down list. 

4. Document is automatically updated.

5. Click Return to Document List in the top right hand corner to return.

5.13.5 Delete Document

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the document you wish to delete on the Document Management:

Categories screen. The Document Management: Details window will be

displayed.

3. Click Delete Version(s).
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4. Select the box(es) beside the version(s) you wish to delete or click the Select All

button to select all the versions.

5. Click the Submit button. A Delete Document window will be displayed.

6. Enter Yes in the Delete this document? Field.
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7. Click the Delete button.

5.13.6 Delete Document Category

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the Delete icon (-) beside the category you wish to delete.

3. A window will be displayed stating that the category and all related documents will

be deleted. To accept this option, click the Submit button.
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5.13.7 Edit Document Category

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the category link you wish to edit.

3. Edit the category name.

4. Click the Submit button.

5.13.8 Select Master Version of Document

The master version is used to control the document version seen by LCMS users. To

select the master version:

1. Click Document Management in the Project Menu.

2. Click the document name you wish to make the master version. 

3. The document versions will be displayed. The version identified with a checkmark is

the current master version.

4. To change the master version, hover over the row of the version you want to make

the Master, then click the Make Master button that appears.
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5.13.9 View Document

1. Click Document Management from the Additional Features in the Project Menu.

2. Click the document link on the Document Management: Categories window. The

document will be displayed.

5.14 Configuration and Preferences Menu

See LCMS Menu (Project Menu) for more information.

5.14.1 Project Preferences

Users with the Administrator or Manager roles may change Project Preferences such as

the  activity  types,  question  screen  styles  and  instruction  screen  styles  available  to

Developers, as well as other Developer options within individual projects. 

Select Project Preferences from the sprocket drop-down menu. You will see the Project

Preferences  screen and  a  list  of  Components  on  the  left.  The  Project  Preferences

screen opens to the Activity Types option.
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5.14.1.
1

Configure Activity Types

1. On the Project Preferences screen, click Activity Types under the Components

menu.

2. Click the checkboxes to toggle availability on and off for different activity types.

The activity types allowed to be created by users are: Independent Study, Test,

Instructor Led Lesson and Survey.
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3. Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
2

Configure Course Export Options

1. On the Project Preferences screen, click Course Export Options under the

Components menu.

2. Click the drop-down menu to set restrictions for a course before it can be

exported.

3. Select any or all options on the list of Activity Production Statuses. To not put

any restrictions on when an activity can be exported, leave the list unchecked. 

4. Click the checkbox beside Include Offline Course in Published SCORM Package

to include an offline version of the course. Note: This feature will enable the offline

course option in the Course Packaging publish settings. See Course Packaging for

more information.
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5. Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
3

Configure Developer Options

1. On the Project Preferences screen, click Developer Options under the

Components menu.

2. On the Media Related pane, click the Media Related developer options to toggle

each on and off. The following options can be enabled for the project: Add/

Update Media, Delete Media, and Restrict Update/Delete Media to original

uploader.

3. On the Tags pane, click the checkbox beside Can create new tags to grant

developers the permission to add new tags. Note: When the checkbox is selected,

developers may add, select and deselect tags. When the checkbox is left

unchecked, developers will only be able to select or deselect tags. 
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4. Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
4

Configure Editor

1. On the Project Preferences screen, click Editor under the Components menu.

See Editor for more information.

5.14.1.
5

Configure E-Mail Templates

1. On the Project Preferences screen, click E-Mail Templates from the

Components menu. 

2. Select a Template from the drop-down menu or create a custom template. See E-

Mail Templates for more information. 
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5.14.1.
6

Configure Interfaces

1.  On the Project Preferences screen, click Interfaces under the Components

menu to see a list of interface options for the project. Ctrl-click to select each

interface you wish to be available for the project. 

2.  Click the Submit button to save your changes or return to the previous screen

without saving.
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5.14.1.
7

Configure Multilingual Support

The purpose of this feature is to support content that needs to be displayed with an

additional language. Currently the LCMS supports two languages at a time within a

project, i.e. English and French.

With Multilingual Support enabled, features such as Translation options are available.

This allows for exporting of content for translation. It may then be imported back into your

project, overwriting the existing content with a translated copy. Future versions of the

LCMS will be able to use this feature when publishing to an LMS, to include both languages

and enable "hot-swapping" within the viewer.

Other features that show additional language support are:

Glossary

Screen Prompts

Question Bank

Navigation Tree folder options for batch translation:

o Translation Batch Import

o Add to Batch for Translation

o Submit Translation Batch

Navigation Tree Paste option now gives the ability to mark the Activity as the

opposite language of the Activity being copied, creating a link between the two.

This is used as part of the Translation work-flow.

1.On the Project Preferences screen, the Multilingual Support under the

Components menu is the default screen.



LCMS Menu (Project Menu) 285

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2. Click the Default language drop-down arrow and choose the preferred default

language from the list.

3. Click the checkbox beside Enable Multilingual Support to enable multilingual

support. When the multilingual support is not enabled, the Alternate language

section is grayed out.

4. Click the Alternate language drop-down arrow and choose the preferred alternate

language from the list. Note: If the language required is not listed in the drop-

down, please contact your support service to have the language of choice

enabled.
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5. Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
8

Configure Plotter Tool

1.On the Project Preferences screen, click Plotter Tool under the Components

menu. This option allows you to configure the Plotter tool labels for your specific

project. You may configure the project Plotter tool labels to use Legacy or Modern

labels. Note: The Modern option is not compatible with Internet Explorer (IE) 11 or

older browsers.

2.  Select the version for the Plotter tool labels (Legacy or Modern) from the Label

Version drop-down menu. Selecting the Legacy option limits the CKEditor options

available for formatting the labels. Note: This selection is compatible with all

browsers. Selecting the Modern option enables more CKEditor options and HTML for

formatting the labels than what is available for the Legacy option. 

3.When Legacy is selected, you may click the checkbox beside Allow Hybrid Labels

to enable both Legacy and Modern labels. With Allow Hybrid Labels enabled, you

will be able to create legacy or modern labels. You will also be able to change

existing legacy labels to modern labels in the project using the Upgrade Label

button. Note: Modern labels are not compatible with IE 11 or older browsers and

cannot be changed to legacy labels.
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4.Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
9

Configure Quiz Defaults

The Quiz Defaults assigned on this screen will be used to calculate the average time to

complete a quiz, when the Enforce Time Limit Option is enabled for the Activity.

Note: These defaults will only be used when a Question screen does not have an

estimated time to complete value entered. The ability the assign Quiz Defaults is role

specific, you must have the required role/rights.

1. On the Project Preferences screen, click Quiz Defaults under the Components

menu.

2. Enter the time (in seconds) to complete default in the field beside each Question

difficulty level. The default values (in seconds) are: Low = 30, Medium = 40, and

High = 60. Note: If the fields are left blank, no default values are assigned. These

defaults will be used to calculate the quiz time if the Level of Difficulty, Point

Value and Est.Time fields are blank on the Question screen. 

3. Enter the Estimated time to be spent on instructional/information screens (in

seconds). The default value is 60 seconds. Note: If the field is left blank, no

default value is assigned. This default will be used only when a completion time has

been not entered on the Question screen.
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4. Click the Submit button to save your changes or return to the previous screen

without saving.

5.14.1.
10

Configure Security

1. On the Project Preferences screen, click Security under the Components menu.

See Security for more information.

5.14.2 User Role Assignment

Managers can assign users to specific  roles within the project  by selecting the User Role

Assignment option from the Configuration and Preferences menu.
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1.  Click the Select Role drop-down and choose to which role to assign users.

2.  Select one or more users from the Available Resources selection box on the left

and click the single right-arrow button to add them to the Currently Assigned

column.

3.  Select one or more users from the Currently Assigned selection box on the right

and click the single left-arrow button to remove them from the Currently

Assigned column.

4.  Use the double left and double right arrow buttons to add or remove all users.
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5.  Click the Save button to save your changes.

Note: Use the Filter to quickly find users.

5.14.3 Activity Development Phases

Administrators, Managers, and Developers can manage activity development phases

available if that ability is enabled in the Application Preferences area under the General

tab.

All phases are managed through the Activity Development Phase Management screen.

New projects have the default phases: 

Lesson

Lesson Outline

Storyboard

Note: The activity development phase can be changed by the developer in the Activity

Profile screen, and it will be displayed to the reviewer and review manager in their inbox.
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5.14.3.
1

Add Activity Development Phase

1. From the Project Menu click on Activity Development Phases.

2. The Activity Development Phase Management screen will appear. Click the

New Activity Development Phase button.

3. Enter a value for the Activity Development Phase field.

4. Click the Submit button and the new activity development phase will be added to

the list of options available in the Activity Profile screen.

5.14.3.
2

Edit Activity Development Phase

1. On the Activity Development Phase Management screen, click on the title of

an existing Activity Development Phase.

2. Enter a value for the Activity Development Phase field.
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3. Click the Submit button to save your changes or Cancel to return to the

preceding screen without saving.

5.14.3.
3

Delete Activity Development Phase

1. From the Project Menu click on Activity Development Phases.

2. The Activity Development Phase Management window will appear. Click the

Delete icon  beside the development phase you want to remove. Note: The

delete icon will be gray if the development phase is being used in an activity,

otherwise it will be red.

3. A window will appear asking if you wish to delete the development phase. Click OK.

The development phase will be deleted.

4. If the activity development phase is assigned to an activity, a window will appear

prompting you to select a new development phase, from the list available, to be

assigned in its place. Choose an activity development phase from the drop-down list

and click the Delete button to reassign, or click the Cancel button to exit without

making any changes. Note: If deleting the only remaining activity development

phase, or if you choose "Leave Activities Unassigned" from the drop-down, the 

Activity Development Phase for the current activity will be set to unassigned.
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5.14.4 Activity Parked Statuses

Different statuses can be defined for Activities that are parked.  A drop-down menu will be

displayed in  the  Activity  Profile  screen when an Activity  is  parked,  populated  with  the

options defined in this setting.

1. Click on the Activity Parked Statuses link in the Project Menu, and the Activity

Parked Status Management screen will be displayed.

5.14.4.
1

New Parked Status

1.Click the New Parked Status button on the Activity Parked Status Management

window to add a new parked status.

2. Enter a value for the Label field, to be used to name the Activity Parked Status.

3. Click the checkbox labeled Comment Required if you want users who select this

status to have to add a text comment as explanation.
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4. Enter a Description for the Activity Parked Status.

5. Click Submit to save the changes or Cancel to return to the preceding screen

without saving.

5.14.4.
2

Edit Parked Status

1.Click the Label (name) of an existing Activity Parked Status on the Activity

Parked Status Management window to edit its fields.

2. Enter a value for the Label field, to be used to name the Activity Parked Status.

3. Click the checkbox labeled Comment Required if you want users who select this

status to have to add a text comment as explanation.

4. Enter a Description for the Activity Parked Status.

5. Click Submit to save the changes or Cancel to return to the preceding screen

without saving.
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5.14.4.
3

Delete Parked Status

1.Click the Delete icon beside an existing Activity Parked Status on the Activity

Parked Status Management screen to remove it.  A confirmation window will

appear asking "Delete Parked Status.  Are you sure you want to delete [Label]?"

2. Click the Delete button to delete or Cancel button to exit without deleting.

5.14.5 Review Type & Responsibilities

Administrators and Managers can manage review types.

All review types are managed through the Review Type & Responsibility Management

screen. New projects have a default review type, named Content.  

Note: If multiple review types exist, the review type selected can be changed by the

developer when the review is being submitted, and it will be displayed to the reviewer and

review manager in their Inbox.

5.14.5.
1

Add Review Type

1. From the Configuration and Preferences (sprocket) menu, click on Review Type &

Responsibilities.

2. On the Review Type & Responsibility Management screen, click the New

Review Type button.
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3. Enter the desired name for review type in the Review Type field.

4. Click each checkbox to toggle the feature on or off for the current Review Type.

Note: If Only Managers can submit for Review is selected, then Managers will

receive an automatic email notification when the corresponding Review Type is

finalized.

5. Select a pool of one or more users from the drop-down menus for the following

roles: Reviewers, Review Managers, Review Monitors, Approval Authorities. 

Note: The pool of users set at this level will become the default for each Activity,

but a subset of these users can then be assigned to the individual Activity.

6. Click the Submit button and the new review type will be added to the list of

options available when setting the review type in an activity.

7. Click the Re-Order button to re-arrange the order in which Review Types appear

in the drop-down menu displayed to developers.
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5.14.5.
2

Edit Review Type

1. From the Configuration and Preferences (sprocket) menu, click on Review Type &

Responsibilities.

2. On the Review Type & Responsibility Management screen, click the name of an

existing Review Type to edit.

3. Enter the desired change in the Review Type field, if required.

4. Click each checkbox to toggle the feature on or off for the current Review Type.

Note: If Only Managers can submit for Review is selected, then Managers will

receive an automatic email notification when the corresponding Review Type is
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finalized.

5. Select a pool of one or more users from the drop-down menus for the following

roles: Reviewers, Review Managers, Review Monitors, Approval Authorities. 

Note: The pool of users set at this level will become the default for each Activity,

but a subset of these users can then be assigned to the individual Activity.

6. Click the Submit button and the new review type will be added to the list of

options available when setting the review type in an activity.

7. Click the Re-Order button to re-arrange the order in which Review Types appear

in the drop-down menu displayed to developers.

5.14.5.
3

Delete Review Type

1. From the Configuration and Preferences (sprocket) menu, click on Review Type &

Responsibilities.

2. On the Review Type & Responsibility Management screen, click the Delete

icon  beside the review type you want to remove. Note: The delete icon will be

gray if the review type is being used in an activity, otherwise it will be red.

2. A window will appear asking if you wish to delete the review type. Click OK. The

review type will be deleted.

3. If the review type is assigned to an activity, a window will appear prompting you to

select a new review type, from the list available, to be assigned in its place.

Choose a Review Type from the drop-down list and click the Delete button to

reassign, or click the Cancel button to exit without making any changes. Note: If

you delete all of the review types the value of the Review Type field will be blank

in all Activities in the project.
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5.14.6 TDM- Manage Training Documents

1.  On  the  Activity  screen,  select  TDM  -  Manage  Training  Documents  for  the

Configuration and Preferences sprocket drop-down menu.

2.  On the TDM Integration -  Manage Courses screen, select  the  desired  schema  from

the list in the drop-down menu. 

3.  On  the  Course  Schema  field,  select  the  desired  Course  from the  list.  Note:  The

Course list also displays the version, status (No change, New, Updated, No Updates,

Imported or Deleted), date of last edit, and tags associated with each Course. 

4.  Click the  New  Course  icon beside  the  desired  new  Course.  Note:  The  New  Course

Details window displays the Course Tree for the chosen course. Click the expand icon

to  view  the  entire  course  tree.  For  courses  with  the  Updated  status,  changes  are

identified  in  the  Course  Tree  with  the  New  icon.  Review  Courses  with  the  Updated

status as they may generate rework for the Activity. 

5.  Click the Import Course button to make the desired TDM course available in the LCMS

or click the Back button to return to the previous screen.

6.  The imported course displays in the Course list with the status Imported.



Learninglogics® LCMS 4.31 User Guide300

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved



Navigation Tree (Content Repository) 301

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

6 Navigation Tree (Content Repository)

On the LCMS Home screen, you will see a list  of available projects. Note: Administrators

can  see  all  the  projects  but  other  users  will  only  see  those  to  which  they've  been

assigned.

1. If you are assigned to a project under more than one user role, you will see a drop-

down menu beside the project name from which you can select the role you want

to use. Note: If you have been assigned only one type of role within a project, the

name of that role will be visible and cannot be changed.

2. Click the name of a project to open it. The first time you do this, you will see a

welcome screen on the right, beside a navigation tree. The navigation tree displays

the hierarchy of folders, subfolders, activities, topics, and screens that constitute

the current project's content repository. 

There may be one or more levels of subfolders, nested hierarchically within one another.

6.1 Icons in Navigation Tree

When working within a project, you will see the following icons  in  the  navigation tree  on



Learninglogics® LCMS 4.31 User Guide302

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

the  left-hand  side  of  the  screen.  The  following  icons  represent  folders  and  subfolders,

followed by activities, then topics and screens.

There are four different  activity types in the LCMS, each represented by a different  icon

design in the navigation tree.

The following icon designs indicate the state of certain elements in the tree:

A superimposed pencil icon on an activity,  topic,  or screen indicates  that  it  is  currently

being edited. Activities or screens will also  be  marked  in  bold  if  they  are  currently  being

edited.

A  plus  sign  to  the  left  of  a  folder,  activity,  or  topic,  indicates  that  it  contains  other

elements and is in a collapsed state. Clicking the icon will toggle it  between collapsed and

expanded states. When expanded, the plus sign is replaced with a minus sign.

A superimposed chain link icon on a topic or screen indicates that it is linked from a master

topic or screen elsewhere in the Content Repository.

The chain link icon can also appear in the pane to the right  of the navigation tree in the
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Topic List and Screen List screens, to indicate that a topic or screen is linked.

6.2 Expand/Collapse

1. Click the title of an existing project to open its Content Repository. Note: When

you first open an existing project, the folders in the navigation tree will be collapsed

by default. 

2. Click a folder, activity, or topic to toggle it between collapsed view and expanded

view, in which its contents become visible. You can expand and collapse folders in

the tree, and you can also expand and collapse activities and topics. The LCMS will

remember the state of the tree so that when you return later the same folders,

activities and topics will remain expanded or collapsed, as you left them.
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3. To reset the state of the tree, click the Reset Preferences button in the My

Profile screen available from the menu in the LCMS Home screen.

6.3 Add Subfolder (Top Level)

New folders are created in the navigation tree of the Content Repository. Administrators

and Managers have this privilege, but not Developers.

1. To create a new folder at the top level, click the Add Subfolder icon above the

Navigation Tree.
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Note: You can also create a new folder by clicking the drop-down arrow beside a

folder or subfolder and choosing Add Subfolder from the list.

2. The New Activity Folder screen will appear with an Activity Folder Name field.

Enter the new activity folder name in the field.
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3. Click the Submit button. The assigned folder will now appear on the Content

Repository navigation tree. 

6.4 Reset Tree

Click the Reset Tree icon above the Navigation Tree to reset the tree to its default

state.

Note: This can fix most temporary issues with the Navigation Tree.

6.5 Show Filters

The navigation tree can be filtered in several different  ways by clicking the Show Filters

icon at the top of the tree to set Filter Options.

1. Enter a value for Activity Title to display only activities matching that search.

2. Enter a value for Activity Code to display only activities matching that search.

3. Check the Independent Study, Test, or Instructor Led Lesson boxes to display

only activities of those types.

4. Select a language from the Activity Languages radio buttons to display only

activities assigned to that language.

5. Select one or more developers from the Developers drop-down to display only

activities assigned to them.

6.Select one or more values for Production Status to display only activities meeting

that criterion.

7. Select a classification from the Classification drop-down to display only activities

meeting that criterion.
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8.Select a controlled goods category from the Controlled Goods drop-down to

display only activities meeting that criterion.

9. Click the Reset button to clear the filter or the Submit button to apply it to the

tree. 

6.6 Show Only my Activities

Developers can click the Show Filters icon to toggle a filter on and off, which will hide all

activities in the current project except the ones assigned to the current user.

Note:  This  is  useful  if  you're  working  in  a  project  with  a  large  number  of  activities

assigned to other Developers.

6.7 Activity Management Icons

From the tree navigation view, users can perform basic functions such as adding new

activities, copy/cut and paste activities, lock/unlock activities, delete activities, and
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opening the Topic List to access other Activity Management functions.

6.7.1 Copy/Cut/Paste Activity

1. Hover over an activity title in the Content Repository tree menu to see Copy,

Cut, Delete and Lock icons on the right.

2. Click the Copy or Cut icons to copy an activity to the clipboard.

3. Click the drop-down arrow beside the folder you wish to paste the activity into.

Choose Paste Activity from the drop-down list. A copy of the activity is then

created in the folder selected. The new activity has the same name as the original,

but is followed by (2) to show that it is a copy of the activity.
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Note: If Multilingual Support is  enabled  for the  project,  a  dialog  box appears  asking  if

you would like to to make a {French} copy of the activity. The type of copy will depend

on the source language, automatically picking the opposite. Upon paste, the new activity

will be the opposite language of the source. This is identified in the Activity Profile.

Note: If you used  Cut,  the  original activity  will  be  deleted,  whereas  if  you used  Copy,
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you will now have two copies of the same activity.

Note: When Activities are copied or cut, an icon appears to the right  of the LCMS menu.

This allows you to clear the clipboard, as required.

6.7.2 Lock/Unlock Activity

1. In the navigation tree, hover the mouse over the name of an activity until the

icons display to the right.

2. Click the Lock icon to toggle lock on and off. When an activity is locked, users are

temporarily prevented from making changes to it.

Note:  Locked  activities  are  indicated  by  a  closed-padlock symbol  which  appears  beside

them in the navigation tree.

6.7.3 Delete Activity

1. In the navigation tree, hover the mouse over the name of an activity until the

icons display to the right.

2. Click the Delete Activity icon to remove an activity.
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3. A prompt  is displayed to ensure that  you want  to delete the  item and  move  it  to  the

Trash.

4.  The  Trash Bin  icon appears  next  to  the  LCMS Menu  button,  containing  any  deleted

activities.
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5.  To  restore  a  deleted  activity,  click the  Trash  Bin  icon.  The  list  of  deleted  items  is

shown. Click Restore next to the activity you would like to bring back for development.

6.7.4 Edit Activity

Click on the name of an activity in the navigation tree  to  open the  Topic  List  screen in

the right-hand pane.
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From this screen you can:

Manage activity topics

Preview the activity in a viewer

Edit the Activity Profile

View a storyboard report

Submit the activity for review

Perform other functions

6.7.5 Folder Menu

Before developing any course activities, you must first create one or more folders where

the activities can reside. Each folder you create must be assigned a name, such as the

title of the course, the name of a developer or some other organizing reference. This

folder structure is created for production purposes, while the course structure created in 

Course Designer is created for delivery of the courseware in the LMS. These structures

may differ as they have different purposes. 

Folders can be created, edited, or deleted in the navigation tree of the Content

Repository by users with the relevant privileges.
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6.7.5.1 Add Activity

There are three Activity types in the LCMS that can be added from the Folder Menu:

Independent Study

Test

Instructor Led Lesson

If Multilingual Support is enabled for a project, you may select the language of the

activity from the Activity Profile.

Enabling Multilingual Support is described in the Configure Multilingual Support topic.
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6.7.5.1.1  Independent Study

Independent Study is basically a computer-based training (CBT) lesson.

1. Click the down arrow button beside a folder from the Content Repository

navigation tree.

2. Select the desired activity type (i.e. Independent Study, Test, etc.) from the

drop-down list. Once the activity type is selected, a New Activity screen will

appear. 
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3. Under the Profile tab, enter the following information under the Activity Profile

tab:

Information Fields Meaning

Activity Title Type the name of the activity.

Language If Multilingual Support is enabled for the

project, select the language of the activity.

Description Provide a brief description of the activity.

Activity

Development

Phase

Select the phase of development from the

drop-down list.

Activity

Production Status

Production status of activity. Read-only at time

of creation.

Version Type the version of the test (e.g. 0.1).

Classification The test classification is set to "Unclassified"
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Information Fields Meaning

by default. The security classification level

changes based on the content within the

activity. Read-only at time of creation.

Controlled Goods The Controlled Goods category is set to "CAT 4

- Not applicable - No Technical Content" by

default. The category changes based on the

content within the activity. Read-only at time

of creation.

4. Enter the following information in the data entry fields under the Additional

Details tab:

Information Fields Meaning

Tags Enter and separate tags with a comma. Tags

must be representative of the activity’s

content for accurate search capability.

Cost/Details Select “Yes” or “No” from the drop-down list,

depending on whether or not the activity is

available on a pay-per-use basis. Provide a

brief description of the cost details.

Copyright/Details Select “Yes” or “No” from the drop-down list,

depending on whether or not there is a

restriction on the specific activity. Provide a

brief description of the copyright details.

TDM Integration The activity can be linked to a training

document and enabling objective from the

Training Development Manager (TDM). Note:

this field is only available if TDM is included in

the LCMS license purchase.
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5. Click the Developer tab to select one or more Developers who can work on the

activity.

6. Enter the following information in the data entry fields under the Course Publish

Settings tab:

Information Fields Meaning

Navigation

Direction

Select Forward Only or Any. Determines the

direction users will be able to navigate when

viewing the activity.

Navigation on

Question

Select the checkbox to require users to answer

each question before navigating away from the

screen when viewing the activity.

Passmark % Disabled for Independent Study Activities.

Activity Type Select lesson.

Maximum

Attempts

Select the maximum number of times users can

attempt the activity.

Instructor

Authentication

Select the checkbox to require instructors to

enter their credentials before users can launch

the activity.

Show Scrollbar Select the checkbox to display a scrollbar in

the interface when viewing the activity.



Navigation Tree (Content Repository) 319

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

Information Fields Meaning

Window Width Enter a width for the activity interface.

Overrides the interface settings.

Window Height Enter a height for the activity interface.

Overrides the interface settings.

URL Parameters Enter any custom URL parameters required. 

Interface Select an interface to use when viewing the

activity.

Glossary Select a glossary to include with the activity.

SCORM Version Select CMI-5, 2004 4th, 2004 3rd or 1.2.

7. Once all the information is captured, click the Submit button. A screen will appear

indicating that the new activity has been created. The activity profile information is

displayed. Verify that the activity profile information is correct.

6.7.5.1.2  Test

All test questions are developed using Question Bank and added to the test. To create a

Test Activity:

1. Click the down arrow button beside a folder from the Navigation Tree.

2. Select Test from the drop-down list.
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3. A New Test screen will appear. Enter the following information in the data entry

fields under the Activity Profile tab:

Information Fields Meaning

Activity Title Type the name of the test.

Language If Multilingual Support is enabled for the project,

select the language of the activity.
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Information Fields Meaning

Description Provide a brief description of the test.

Activity Development

Phase

Select the phase of development from the drop-down

list.

Activity Production

Status

Production status of test. Read-only at time of

creation.

Version Type the version of the test (e.g. 0.1).

Display questions

randomly?

Select Yes if you wish to have the test questions

randomly displayed each time the test is launched.

Select No if you wish to have questions displayed in

the same sequence each time the test is launched.

Display multiple choice

options randomly?

Select Yes if you wish to have the multiple choice

question options randomly displayed each time the

test is launched. Select No if you wish to have

multiple choice question options displayed in the

same sequence each time the test is launched.

Show Subset Select to show a subset of questions when taking

the test. Read-only at time of creation.

Classification The test classification is set to "Unclassified" by

default. The security classification level changes

based on the content within the test. Read-only at

time of creation.

Controlled Goods The Controlled Goods category is set to "CAT 4 - Not

applicable - No Technical Content" by default. The

category changes based on the content within the

test. Read-only at time of creation.
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4. Enter the following information in the data entry fields under the Additional

Details tab:

Information Fields Meaning

Introductory Text Type any introductory text (e.g. exam instructions)

that must be seen by the user to begin answering

the questions.

Tags Enter and separate tags with a comma. Tags must be

representative of the activity’s content for accurate

search capability.

Cost/Details Select “Yes” or “No” from the drop-down list,

depending on whether or not the activity is available

on a pay-per-use basis. Provide a brief description of

the cost details.

Copyright/Details Select “Yes” or “No” from the drop-down list,

depending on whether or not there is a restriction on

the specific activity. Provide a brief description of

the copyright details.

TDM Integration The test can be linked to a training document and

enabling objective from the Training Development

Manager (TDM). Note: this field is only available if

TDM is included in the LCMS license purchase.

5. After you have completed the information fields on the Profile and Additional

Details tabs, click the Developer tab to select a Developer to be assigned to the

test.
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6. Enter the following information in the data entry fields under the Course Publish

Settings tab: 

Information Fields Meaning

Navigation Direction Select Forward Only or Any. Determines the

direction users will be able to navigate when viewing

the activity.

Navigation on

Question

Select the checkbox to require users to answer each

question before navigating away from the screen

when viewing the activity.

Passmark % Enter the percentage of questions users must answer

correctly to pass the test.

Activity Type Select quiz, exam, ec or pc.

Maximum Attempts Select the maximum number of times users can

attempt the test.

Instructor

Authentication

Select the checkbox to require instructors to enter

their credentials before users can launch the activity.

Show Scrollbar Select the checkbox to display a scrollbar in the

interface when viewing the activity.

Window Width Enter a width for the activity interface. Overrides the

interface settings.
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Information Fields Meaning

Window Height Enter a height for the activity interface. Overrides

the interface settings.

URL Parameters Enter any custom URL parameters required. 

Interface Select an interface to use when viewing the activity.

Glossary Select a glossary to include with the activity.

SCORM Version Select CMI-5, 2004 4th, 2004 3rd or 1.2.

7. When the information is added, click Submit.

8. A screen will appear indicating that the new test has been created. The test profile

information is displayed. Verify that the test profile information is correct.

Note: To add questions to a test, you have two options:

Add each question manually.

Acquire questions by automation. 
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6.7.5.1.3  Instructor Led Lesson

Instructor  Led  Lessons  are  identical  to  Independent  Study  Activities,  except  that  all

instruction screens contain  an additional field  called  Add Instructor Notes.  Navigation

Settings cannot be configured for Instructor Led Lessons.

6.7.5.1.4  Survey

The Survey is an add-on feature that is now available as an Instruction Screen Style.

6.7.5.1.5  Import (Activity)

1. From the Project Menu, click the drop down arrow and select Import for the

project.

2. Click the Browse button and select the zip file you wish to import and click the
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Upload button. Note: Clicking the Remove buttons clears the field. 

  

3. Select the Ignore previously imported Questions checkbox to skip importing

questions that already exist in the project's Question Bank. If this checkbox is not

selected, existing questions will be imported as duplicates. 

4. Once the file has successfully uploaded and unzipped to the server, click the 

Submit button to complete the import.

Note: If multilingual support is enabled, a prompt will appear asking what language the

imported activity is. The selected language will be assigned to the activity upon import.

Otherwise, the language will be set as the current primary language. 

6.7.5.1.5.1  Importing to Project

When importing an activity to another project on the current (same) LCMS, current

project users may need to be assigned their respective roles. A warning message displays,

listing which users require role assignments. See Assign Users to a Project for more

information.
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When importing an activity to a project on a different LCMS, current project users may

need to be assigned their respective roles during the activity import. Note: Review types

are not included in the import and also need to be assigned.

1. Select the desired individual from the drop-down menu for the Developer,

Reviewer, Review Manager, Review Monitor and Approval Authority fields. At

least one user must be assigned to the activity. Note: User information is included

in the import file to attempt to match users. Matching a user is done via the email

address, which takes precedence over the selection from the individual drop-down

fields.

2.  Select the review type from the Review Type drop-down menu to assign a review

type to the reviews included in the import. 

3. Click the Submit button to complete the import.
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6.7.5.2 Folder Functions

6.7.5.2.1  Edit Folder

1. Click the down arrow button beside a folder name you wish to edit from the

Content Repository navigation tree and select Edit.

2. The Edit Activity Folder screen will appear. Modify the assigned folder name.

3. Click Submit. The revised folder name will show on the Content Repository

navigation tree.

6.7.5.2.2  Cut and Paste

1. Click the down arrow button beside the desired folder from the Content

Repository navigation tree and select Cut. Note: The Paste option becomes
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available once Cut has been selected from the list of options. 

2. On the Content Repository navigation tree, navigate to the desired folder (where

you want to paste) and click the down arrow button.

3. Select Paste from the option list to paste the cut folder in the desired location.

Note: All the activities in the folder including the subfolders will be cut/paste to the

new location on the Content Repository navigation tree.

6.7.5.2.3  Delete Folder

1. On the Content Repository, click the down arrow beside the desired folder and

click Delete. 
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2. On the Delete Folder window, click the Yes button to remove the folder. Note: All

activities within the folder will move to the Trash. This also includes the locked

activities.
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6.7.5.2.4  Add Subfolder (Nested)

New folders are created in the navigation tree of the Content Repository. Administrators

and Managers have this privilege, but not Developers.

1. To create a new folder nested within an existing folder, you must click the down

arrow button to the right of the parent folder and select the Add Subfolder option

from the drop-down menu that appears.

2. The New Activity Folder screen will appear with an Activity Folder Name field.

Enter the name you wish to assign to the new activity folder in the field.



Navigation Tree (Content Repository) 333

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

3. Click the Submit button. The assigned folder will now appear on the Content

Repository navigation tree. 

6.7.5.2.5  Make an Alternate Language Copy

With Multilingual Support enabled, you may create a copy of an activity in the alternate

language selected, by following these steps:

1. Click the copy icon beside the test in the tree menu to copy the activity.

2. Select Paste Activity from the Folder Menu for the folder where you want to

paste the activity.
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3. You will see a dialogue box asking if you would like this to be an alternate language

copy of the activity. Click the checkbox if the answer is yes. The LCMS will search for

the translated version of the question screen when making the copy.

Note: Once you paste the activity after selecting the checkbox saying you want to

make this an alternate language version, you will not be allowed to paste another

alternate language version. The LCMS will only allow for a "regular copy" to be pasted.

6.7.5.3 Folder Activities

6.7.5.3.1  Find & Replace

The Find & Replace function may be used by the Administrator, Manager, or Senior

Developer to find and replace content within folder.

1. Click the down arrow button beside the desired folder from the Content Repository

navigation tree and select Find & Replace.
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2.   See Find & Replace for more information.

6.7.5.3.2  Activities Word Count

The Activities Word Count function may be used by the Administrator, Manager, or

Senior Developer to calculate the word count within the folder.

1. Click the down arrow button beside the desired folder from the Content Repository

navigation tree and select Activities Word Count.
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2.On the Activities Word Count window, click the check box beside Include Sub-

Folders to include the content of the corresponding subfolders. 

3. Click the Submit button to calculate the word count.

6.7.5.3.3  Lock All/Unlock All

1. Click the down arrow button beside a folder you wish to delete from the Content

Repository navigation tree. 
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2. Select Lock All to prevent all of the activities within a folder from being changed.

3. Select Unlock All to restore the ability to change the folder's contents.

4. Locked activities are indicated by a closed-padlock symbol which appears beside

them in the navigation tree.

6.7.5.3.4  Batch Submit for Review

After activities have been submitted that  form part  of a pending  batch,  an Administrator

or Manager can use the Batch Submit for Review feature to process the batch, thereby

initiating the review process and sending out notifications.  The activities to include in the

batch can be selected at this stage.

1.  A Developer or Manager first submits the activity/activities for batch processing.
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2.  Once some Activities have been submitted by Developers or Managers for inclusion

in a batch, click on the Batch Submit for Review option in the Folder Menu. 

The Submit for Batch Processing: Submit Reviews screen will be displayed,

containing a list of all pending review requests for Activities within the folder (or its

subfolders) that have been submitted for inclusion in a batch process.
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3.  Click the Expand/Collapse icon to the left of each review request to see more

information on the review, such as the Developer, Review Manager, Review

Monitor, Interface, and Glossary selected.  Alternatively, click the Expand All/

Collapse All button at the top of the screen to toggle between expanded and

collapsed views for all requested reviews listed.

4.  Click the Retract Review button beside any review requests that you wish to

retract and thereby remove from the batch.

5.  Click the Select All checkboxes beside individual review requests to confirm which

ones you want to submit for review as part of the batch. Alternatively, click the

checkbox at the top to toggle between select all and deselect all.

6.  Select the Due Date for the whole batch using the calendar input at the top of

the screen.

7.  Click the Submit Selected button to submit the selected reviews as a batch.  

8.  A confirmation dialogue box will be displayed, asking "Are you sure you want to

submit these Activities for review?" Click OK to continue or Cancel to exit without

submitting. If you choose to submit the batch, you will see a screen showing a brief

summary of the Activities submitted for review.

6.7.5.3.5  Batch Export

Administrators and Managers can package more than one lesson into a batch for export.
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1.  Select Batch Export from the Folder Menu.

2.  Click the  checkbox beside  Do you want  to  include  and Review History  if  exists?,

and then select  the review types from the Include Review Types drop-down menu to

include the corresponding review for each activity in the list  (if  required). Note:  If  the

project only has one review type, the Include Review Types drop-down menu will not

display. 

3.  Verify  the  lessons  to  be  exported  are  included  in  the  Activity  list,  then click Batch

Export Listed Activities button to export the batch.
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Once  the  process  is  finished,  the  user  receives  an  email  confirmation  with  links  to

download the .zip files.

6.7.5.3.6  Add to Batch for Translation

Administrators and Managers can package more than one lesson into a batch to export  for

translation.

1.  Select Add to Batch for Translation from the Folder Menu.
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2.  Verify that all activities listed are to be submitted for batch translation. If you wish to

also include activities in sub-folders, click this checkbox. Click Yes. 

The  activity  Status  field  in  each  activity  now  states  SUBMITTED  TO  BATCH  FOR

TRANSLATION. 
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6.7.5.3.7  Submit Translation Batch

Administrators and Managers can submit a translation batch for export.

1. Select Submit Translation Batch from the Folder Menu.

2. Click the check-box for the listed activities that you wish to submit  for translation, then

click Submit Selected.
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3. In  the  Translation Options  window,  deselect  any  fields  you do  not  want  translated.

Click Submit.

4. After export  is complete (files saved and zipped), click the Download button (if  your are

using  IE,  right-click and  select  Save  Target  As  to  download)  to  download  the  HTML

files for translation. 
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6.7.5.3.8  Batch Assign Developer

The Batch Assign Developer function may be used by the Administrator, Manager, or

Senior Developer to assign a developer to all of the Activities within the folder.

1. Click the down arrow button beside the desired folder from the Content Repository

navigation tree and select Batch Assign Developer.

2.On the Batch Assign Developer window, click the checkbox beside Include Sub-

Folders, Include Activities with Developer already assigned and/or Include locked

Activities to select the Activities that will be batch assigned to the developer.

3. Click the Submit button.
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4.On the Batch Assign Developer screen for the chosen folder, select the desired

developer from the Developer drop-down menu. Note: The Activities being assigned to

the developer will display in the list with a checkmark. Note: You may deselect an

Activity by clicking the checkbox . Deselected Activities will not be assigned to the

developer.

5. Click the Submit button to save the selection.

6.On the Confirm Continue window, click Yes to complete the batch assignment or

click No to return to the previous screen. Note: Activities within the folder that are in

review during the batch assignment will also be updated with the newly assigned

developer.
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7 Topic List (Activity Screen)

Instructor Led  and  Independent  Study  Activities  are  divided  into  topics,  which  must  be

created in the LCMS before the text and media content can be defined. 

To access the Topic List or Screen No.:

1. Select the folder that the activity belongs to from the navigation tree in the 

Content Repository. Select the lesson activity title in the navigation tree.

2. The Activity Screen with the Topic List appears once the activity title is selected.

 

3.  When a Test Activity is selected, the Activity Screen includes Total Points and

the estimated time to complete (Est. Time), if these values have been entered in

their corresponding fields and the Enforce Time Limit is enabled. 
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4.When the Enforce Time Limit is enabled and the time is exceeded, a banner

message displays on the Activity Screen to notify the user.

5.Upon completion of the test, the user is presented with a Summary screen. This

screen provides the test outcomes such as; passing score, pass/fail status and

number of correctly answered questions, etc,. 
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7.1 New Topic

1. Click the New Topic button.

2. The New Topic screen appears. The lesson activity title that you are adding the

topic to shows at the top of the screen. Add the required information in the data

entry fields.

Data Entry Fields Meaning

Topic Title Type the name of the topic (maximum 200

characters).

Hide topic from

presentation

Click the checkbox to hide the screen from the

Activity preview (this is a show/hide feature).

Tags Click to select tags. 

3. Click the Submit button. This returns you to the Topic List screen, where the topic

you created is now listed.

4. Repeat steps 1 to 3 to create as many topics as you require for each lesson. The

number of topics created shows on the Topic screen in the courseware.
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7.2 Re-Order Topics

You can re-order lesson topics at any time by performing the following steps:

1. On the Activity screen, click the Re-Order Topics button.

2. A Sort Activity Content screen appears, with the title of your activity displayed

at the top and a list of your topics below. 
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3. Click the drag handles of the topic you wish to re-order and drag it to the desired

order.

4. Once the topics are in the correct order, click the Submit button. The topic or

topics that you have rearranged show in the new order on the Topic List screen.

Note: You can also rearrange screens within topics and move screens from one topic to

another at this time by clicking the “+” symbol to the left of each topic name. The screen

names appear below their topic and can be dragged to their new positions.

7.3 Preview Activity

This feature allows you to preview an entire activity, which is useful throughout the
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development and revision process. To preview an activity: 

1. Click Preview Activity from the top of the Activity screen. To change the

interface, click the drop-down arrow and click Interface to open a dialogue box

with a list of interface selections available to you. The activity opens in a new

browser window using the selected interface, glossary (if one was selected), and

emulation (device type). Note: Click Tag Filtering to include/exclude screens with

specifics tags. A checkmark displays when tags are selected.

2. If you have never chosen an interface for a specific type of activity (Instructor

Led, Independent Study, etc.) you will be prompted to choose one in the Preview

Settings dialogue box. Note: All new projects have the Default Interface

automatically available. Other interfaces can be assigned by an Administrator in the

Interface Management section.  

3. Click the checkbox for Use as default Interface for Instructor Led Lesson

Activity types to enable this function. Note: Leave this unchecked if you do not

want all Instructor Led Activity types to have the same interface.

4. To change the Glossary, click the drop-down arrow and select the desired

Glossary from the list.

5. The Emulation field is used to define the preview screen size for the device

types: Desktop, Tablet, Phone (Portrait) and Phone (Landscape). To change

the screen size, click the drop-down arrow and select the desired Emulation:

Desktop, Tablet, Phone (Portrait), Phone (Landscape). Note: Desktop is the

default setting.

5. Click the Include screens with Tags checkbox, choose the tags from the Select

Tags window and then click the Submit button (if required). 

6. Click the Exclude screens with Tags checkbox, choose the tags from the Select

Tags window and then click the Submit button (if required). 
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7. Click the Submit button to save the changes or the Cancel button to return to

the Activity screen.

Tip: To see the media size and file name at the top of the media area in Preview,

click anywhere onscreen, then use the keyboard shortcut CTRL+Alt+Shift+S.

7.4 Responsibility, Security & Screens

1. Hover the mouse over the Responsibility icon in the Activity Screen to see a list

of users assigned to the Developer, Reviewer, Review Manager, Review Monitor and

Approval Authority roles for the current activity, along with their organization

names. Note: Reviewers, Review Monitors and Approval Authorities are only

assigned responsibility for an Activity once it has been submitted for review or

approval.
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2. Hover over the Security icon on the Activity Screen to see the Classification and

Controlled Goods category that are applied to the lesson.

3.  The  total  screen  count  for  the  activity  is  shown  next  to  Responsibility  and

Security. 

7.5 Profile

You can change a topic’s profile information at any time.

1. Click the Profile icon located beside a topic title in the Topic List.

2. Change any required information in the Topic Title or Tags fields.

3. Click the Submit button.

7.6 Cut/Copy/Paste Topic

Topics created for other lessons may be cut or copied and used within the same lesson or
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within a new lesson activity. To cut or copy an existing topic:

Note: A Topic cannot be cut or copied if it is in a locked state.

1. Click the Cut Topic icon beside the topic you want to cut.

2. Alternatively, if you wish to copy a topic, click the Copy Topic icon. 

3. Navigate to where you want to place the cut or copied topic (could be within the

same activity or another one of the same type) and click the Paste Topic button

at the top of the topic list. This example shows the topic copied to the same

activity. 
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4. If this is the first time this topic has been copied, the copied topic will have the

original topic name and the number (2) beside it. Click the copied topic’s Profile

icon to enter a different topic name. 

5. Click the Submit button.

6. To remove the topic from the clipboard, select the green checkmark (over the Cut

or Copy Topic icons). 

Note: When Topics (as well as Activities) are copied or cut, an icon appears to the right

of the LCMS Menu. This allows you to clear the clipboard as required.

7.7 Link to Topic

Topics created for other lessons may be used to create a new lesson. Revisions to linked

topics can only be made in the activity in which they were created. Therefore, any

revisions made in the originating topic are reflected in your linked topic. To link to an

existing topic:

1. Click the Link to Topic icon beside the topic you want to link. The link icon
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changes to a clipboard.

2. Navigate to where you want to insert the linked topic (could be within the same

activity or another one of the same type) and open the activity.

3. Click the Insert Topic Link button at the top of the screen to insert the linked

topic. 

4. The new topic appears at the bottom of the Topic List. It has an icon to the left

of its topic number to indicate that it is actually a linked topic.

5. To change the name of the linked topic, click the Profile link to open a pop-up

box. 



Topic List (Activity Screen) 359

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

6. The Master Topic Details pop-up contains a field for New Topic Name, along

with details about the master topic. Click the Master Topic link to view and edit

the master screens.

7. Click the Submit button.

8. Note: If you click on the title of a linked topic from the Topic List screen, you will

be taken to its Screen List, where you will see a link to its master topic at the top

of the screen. This link reads: "Click to edit the master topic screens."

9. At the top of the Screen List screen of the master topic, you will see a message

box warning that the topic is referenced in other Activities and that changes made

will also affect those Activities. There is a "click here" link that opens a window

with details of one or more linked topics associated with the current master topic.
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7.8 Delete (Topic)

You can delete a lesson topic at any time, unless there are screens within it that are

linked elsewhere.

1. Click the Delete icon to the right of the topic name in the Topic List. A dialogue

pop-up window verifies that you wish to continue.

2. Click OK to remove the topic from the Topic List or Cancel to keep the topic.

Note: If the topic has an alternate language version in another activity, a dialogue

pop-up window will prompt you with this information. You will have the option to go to

the other topic to view it and to also delete the alternate language version of this

topic. 

Note: If the topic is linked from another location (from a master topic), the master

topic cannot be deleted.
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7.9 Additional Options Menu (Drop-Down)

The Activity menu is titled Additional Options and contains the following options:

This menu is available on the Topic List screen once an activity has been selected.

Depending on the rights you have been assigned, you may have access to some or all of

the LCMS Additional Options management functions for managing activities. Those

assigned LCMS management rights control access to all lesson and test activities. This is

an important feature in configuration management since it restricts any unauthorized

personnel from changing content during the courseware review or client approval

processes.

7.9.1 Go to Alternate Language

If the activity has been translated, the LCMS allows you to toggle to the translated

activity. 

1. Click Go to <Language> from the Additional Options menu.
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The activity will automatically switch to the alternate language.

7.9.2 Disconnect/Connect Alternate Language

If there is a translated activity that is linked to the original activity, the LCMS allows you

to disconnect the alternate language activity. 

1. Click Disconnect <Language> Version from the Additional Options menu.
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2. A pop-up box will appear, asking if you are sure you want to break the relationship

between this activity and its alternate language copy. Click Yes to break this

relationship.

Note: If you do disconnect from the alternate language activity, you can reconnect to

it from the Additional Options menu by selecting Connect to <Language> Copy

and then choosing your activity from the list.
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7.9.3 Activity Profile

When an activity is created, the Activity Profile information is entered. This information

may also be edited or viewed at any time. Your rights to edit will depend on the LCMS

rights you have been assigned. 

To edit or view an activity profile, click Activity Profile from the Additional Options

menu.

7.9.3.1 Profile Tab

1. Click the Profile tab from the Activity Profile screen. Note: Depending on the

activity type, the fields available to edit may vary.
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2. Edit or view the required fields.

3. The activity's auto generated code will be populated in the Activity Code field. If

desired, a new value may be entered in this field. Activity codes must be unique

and must only contain letters, numbers, dashes and underscores.

4. The Activity Type radio buttons allow an Administrator or Manager to switch the

activity type from Independent Study to Instructor Led. When the activity type is

switched to Independent Study from Instructor Led, the Instructor Notes will move

to the Review Instructions field if the field is empty. Note: If the Review

Instructions field is not empty, the Instructor Notes will not copy over. They will

continue to exist and will display when the activity type is switched back to

Instructor Led. When the activity type is switched from Instructor Led to

Independent Study, the Review Instructions will move to the Instructor Notes field

if the field is empty. Note: If the Instructor Notes field is not empty, the Review

Instructions will not copy over. They will continue to exist and will display when the

activity type is switched back to Independent Study. 

5. When the Activity Production Status is set to Parked (on hold), a drop-down

menu will be displayed, from which you can select the Parked Status.  

Note: When an Activity is parked it is also automatically locked, and the Lock
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activity checkbox is disabled. An activity can only be unlocked when the Activity

Production Status is set to "in-production".

6. Click Cancel to close or click Submit to save any changes.

7.9.3.1.1  Activity Development Phase

The Activity Development Phase can be set  using the drop-down menu in the Activity

Profile.

The options available are set by clicking Activity Development Phase in the main menu.
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Note: An activity can only be unlocked when the Activity Production Status is set

to "in-production".

7.9.3.1.2  Lock or Unlock Activity

Access to activities is controlled by “locking” an activity after it has been developed. To

lock an activity:

1. Select the activity that you wish to lock from the Content Repository screen. 

2. On the Topic List screen, click Activity Profile from the Additional Options

menu.

3. The Activity screen will appear.

4. Add a checkmark by clicking the box beside the words Lock activity.
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5. Click the Submit button.

6. The activity will now be locked and unavailable for editing purposes.

7. To unlock an activity, repeat steps 1-3 above and then click the Lock activity box

to remove the checkmark. Click Submit to unlock the activity. 

Note: An activity can only be unlocked when the Activity Production Status is set

to "in-production".

7.9.3.1.3  Version

Activity versions are controlled by changing the entry in the Version field. When an

activity is originally created, the default entry in the Version field on the Activity Profile

screen appears as Draft. Depending on your configuration management policy, the word

“Draft” may be replaced with a version number at the time the activity is created. (e.g.

1.0).

Note: Caution is required when changing the version number of an activity as this will
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automatically archive the current version and create a new one. 

When a new version of an activity is created, the current version is archived.

1. Under Additional Options, click Activity Profile on the Topic List screen.

2. Enter the new version in the Version field.

3. Revise any Activity Profile fields required for the new version that is being

created. Note: If the Activity is in a locked state, a warning message displays.

Remove the checkmark in the Lock this activity? field to unlock the activity prior

to clicking the Submit button. Note: An activity can only be unlocked when the

Activity Production Status is set to "in-production".

4. If desired, enter a comment in the Enter Comment for this Activity Archive field.

5. Click the Submit button.

6. An Activity Archive screen will appear, identifying the activity version that will be

archived. The Activity Code and the Activity Archive Version are also displayed.

A screen will appear stating that the activity has been successfully archived. Click
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the Finish button to go to the new activity.

7. The new version will be displayed on the Topic List screen.

7.9.3.1.4  Configure Subset Settings

Test  activities  can be  configured  so  that  a  subset  of  questions  is  displayed  when  the

activity is launched. For example, a test  containing 100 questions could display  a  subset

of 25 random questions.  Any  critical,  mandatory  or mandatory  critical  questions  are

automatically included in the subset.

To configure a test's subset settings:

1. Under Additional Options, click Activity Profile on the Topic List screen.

2. Select the Show subset checkbox.

3. Enter the number of questions to display in the Show subset field.

4. If desired, select the When re-taking the Exam, display questions not
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previously shown? checkbox to display questions not previously shown when

users re-take the test.

5. Click the Submit button.

7.9.3.2 Additional Details Tab

1. Click the Additional Details tab from the Activity Profile screen. Note: depending

on the activity type, the fields available to edit may vary.

2. Edit or view the required fields.

3. Click Cancel to close or click Submit to save any changes.

7.9.3.3 Developer Tab

Admins  and  Managers  can  define  a  pool  of  developers  for  each  Activity.   The  current

developer can then re-assign the Activity to one of the other members  of  the  developer

pool.

1.  Click the Developer tab on the Activity Profile screen.  Note: You must be

logged in as a Manager or Admin to access the Developer Pool.



Learninglogics® LCMS 4.31 User Guide372

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2.  Select one or more developers from the drop-down menu for the Developer Pool.

 Note: The developers available depend on the settings in the Project

Preferences area.

3.  Select one developer from the pool in the Developer drop-down menu.

4.  Click Submit to save changes.

The  developer  will  now  be  able  to  re-assign  the  lesson  to  another  member  of  the

Developer Pool by using the Developer drop-down on the Activity Profile screen.

Note: Only one developer at a time can be assigned to an Activity.

7.9.3.4 Course Publish Settings Tab

Administrators, Managers and Developers assigned to that activity can make changes to
the information in the Course Publish Settings tab.

1. Click the Course Publish Settings tab on the Activity Profile screen. Note: The

Feedback checkbox, Enforce Time Limit checkbox, Total Points field, and the

Time Limit field only display when the Test Activity type is chosen.
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2.Make any necessary changes to these fields.

3. Click Submit to save changes.

7.9.4 Activity Word Count

The LCMS allows you to access a word count for any lesson or test activity. This is often

used for translation purposes. The word count is the total number of words displayed on

all screens in an activity.

1. Select the lesson or test activity from the Content Repository screen. The Topic

List screen will appear.

2. Click Word Count from the Additional Options menu.
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3. A pop-up window will appear, indicating the activity name and the word count. 

4. When you are finished viewing the word count, click the Close button to close the

window.

7.9.5 Version History

When more than one version of an activity exists, the version displayed to all users -

which is referred to as the Master Version - may be controlled by the person assigned

LCMS Administrator rights.  Note: The Version History screen is available when an

Activity is locked, but it is read-only.

1. Click Version History from the Additional Options menu.
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2. The Archived Versions screen will appear, displaying the current version title and

all archived versions of the activity. Here you have the options Create New

Version or Select Master Version.

7.9.5.1 Select Master Version

To make a version of an activity the master version, follow these steps:

1. Click Select Master Version from the activity's Archived Versions screen.
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2. In the Select Master Version window, click the button beside the master version

you wish to be displayed to all LCMS users. Note: Except for those assigned

Administrator rights, this is the only version that will be available to all LCMS users.

3. Click the Submit button.

4. The activity selected as the Master Version will be displayed. The VERSION

number at the top of the Activity screen will reflect which version is being used as

the master.
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7.9.5.2 Create New Version

To create a new version of an activity, follow these steps:

1. Click Create New Version from the activity's Archived Versions screen.

2. In the Create New Version window, type in the new version number. 
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3. Click the Submit button.

4. The VERSION number at the top of the Activity screen will reflect the version

change.

7.9.5.3 Preview a Version of an Activity

You may choose to preview a specific version of an activity from the Archived Versions

window. Select the Preview link to the right of the version you wish to preview. 

Note: The activity will open for previewing in the interface that is currently selected on

the Topic List screen.
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7.9.6 Activity Log

Access the Activity Log feature from the Additional Options drop-down menu. 

The Activity Log tab lists all changes in an activity's Production Status, Version,

Development Phase, Parked Status and Parked Description, and Notes. It also

lists the date the change occurred and the user who made the change.

Click the CSV or PDF buttons to download this information in either format. Note: The
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Activity Log is also included in the activity export.

7.9.7 View Storyboard

The View Storyboard function allows the user to access an electronic version of the

storyboard. To access the storyboard:

1. Click View Storyboard from the Additional Options menu. A new browser window

opens, showing the elements that make up the storyboard. 

2. Select the boxes beside the elements you wish to see displayed in the storyboard. 

Note: You may want to exclude Developer Notes from some storyboards, for
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example.

3. Select specific topics to display by using your Ctrl key, if desired.  

4. Click the Include screens with Tags checkbox, choose the tags from the Select

Tags window, and then click the Submit button (if required). 

5. Click the Exclude screens with Tags checkbox, choose the tags from the Select

Tags window, and then click the Submit button (if required). 

6. Choose the Storyboard Format you wish to preview or print, by clicking the radio

button: Detailed (includes all lesson details; pop-ups, text, media, text options,

drop-down text, etc), Basic (text and media) or Basic Tabular (text only is a good

option for activities where the screens are primarily 100% text).

7. Click the Generate PDF button to export the storyboard to a PDF file, then the

View PDF button to open it in another browser window. The PDF can then be

saved if needed.

8. Alternatively, click the Preview button to display the storyboard content in HTML

format. 

9. When viewing the HTML storyboard in one window, make changes to the course as

normal in the main browser window, then click the Refresh button at the top of the

storyboard screen to update it with your changes. To print the HTML version of the

storyboard, use the Print button at the top of the screen. Note: The example

shown below is in Detailed storyboard format. 
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10. Click the Close button to return to the activity’s Topic List screen.

11. The Topic(s) table at the start of the storyboard resembles a table of contents

and contains hyperlinks to individual topics for ease of navigation. The topics in this

table are also collapsible, and when expanded reveal hyperlinks to the individual

screens.

12. The Load Screen icon is available at the top of each screen in the storyboard.

Click this icon to jump to that screen in the LCMS.

A description of the information that  can be selected for inclusion in the storyboard view

is provided in the following table:
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Item Description

Activity Profile

Project Title title of project under which the activity is

developed

Activity Title title of activity

Version version number

Status status of activity - e.g. in production, submitted

for review, review in progress, review complete -

needs rework, review complete – ready for

approval, approved, rejected, ready for training

SCO Type type of activity - e.g. instructor led lesson, self

paced lesson, self paced test, briefing

SCO Code code assigned to activity

Size of Activity summary of the number of topics and the number

of screens within each topic

Developer of Activity name of Developer assigned to develop the

activity

Reviewer(s) of Activity name of Reviewer(s) assigned to review the

activity - be aware that you may have to assign

more than one reviewer

Manager of Activity name of Manager assigned to manage the

activity

Approval Authority of name of Approval Authority assigned to approve
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Item Description

Activity the activity

Classification classification assigned to the activity - e.g.

unclassified, restricted, confidential, secret, top

secret

Controlled Goods controlled goods category assigned to the

activity - e.g. CAT 1, CAT 2, CAT 3,  CAT 4

Tags tags assigned to the activity 

Topic Summary

Topic Number(s) the number of each topic in the activity

Topic Title(s) the title of each topic within the activity

Number of Screens per

Topic

the number of screens within each topic of the

activity

References Summary

Reference Number(s) the number of the reference order

Reference Name(s) the given name of the reference

Reference File(s) the file name or location of the reference

Activity Screen Information

Topic Title number and title of topic
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Item Description

Screen Number number of screen within the topic - e.g. 1/3

Screen Style style of screen chosen from screen template

selection - e.g. 2.02

Main Screen Text the main screen text that will be displayed on

the screen - e.g. instruction screens, question

stem on question screen

Pop Up Content content which may include text or text and

graphics (including 3D states), made available in

addition to main screen text

Question Options possible distractors and correct answer(s) for

each question

Correct Answer correct answer for each question

Feedback feedback provided for student selection of

correct and incorrect answers

Question Category(ies) the categories to which lesson and quiz

questions are assigned in the database

Question Tags the tags assigned to each question in the

database

Question Level of Difficulty the level of difficulty assigned to each question -

e.g. low, medium, high

Instructor Notes notes developed for instructor use in instructor

led lessons
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Item Description

Prompt the navigation instructions for a user/instructor,

provided for each screen in an activity

Test Introduction test information provided to a user when the

test is launched

Media Filename(s) file names assigned to each media file (graphics,

movies, audio, etc.)

Media Description description of the media file required for

multimedia production

Audio Narration the narration written for narrator use during

audio sittings; used for production of audio files

Screen Identification

Number

identification number automatically assigned to a

screen

Tags tags assigned to a screen 

Review Instructions notes written to the Reviewer or Review

Manager 

Personal Notes notes written by the Developer during

development - e.g. reminders, questions for the

Subject Matter Expert, etc. 

Media Thumbnails activity thumbnails of media and plotter tool

data that have been developed and integrated

into the courseware (Note: Certain types of

media, such as videos, cannot be displayed in

thumbnail form)
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Item Description

Point Value point values assigned to each question; used to

help determine the final mark on a test when

partial scoring is enabled

Estimated Time estimated time it takes to complete a question;

used to determine total test time

7.9.8 View Lesson Outline

The View Lesson Outline function allows the user to access a report similar to the

storyboard but intended to provide a higher level overview of basic course design

information. 

To access the Lesson Outline:

1. Click Lesson Outline from the Additional Options menu. A new browser window

will open, displaying the Lesson Outline report. Note: The Lesson Outline report

includes hidden screens, which are identified by a red banner.

2. Click the View icon on the left of each screen to open the LCMS content screen in

a separate browser window. This makes it easy to navigate between content

screens and the Lesson Outline for editing purposes. 
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3. Click the Refresh button after making any edits to content in the main LCMS

window. The Lesson Outline will be updated with your changes.

4. Click the Summary View button to toggle the rows of the Lesson Outline

between expanded and collapsed states. Note: In the Summary View (collapsed

state), it is easier to view the overall structure of topics and screens in the course.

5. Click the Print button to print the report.

7.9.9 Print Test

The Print Test function provides the ability to print Test Activities (exams, final tests) to

paper. Note: Ensure the test content is printable before printing. Video, audio, and

SCORM media will not print.

1.  On the Test Activity, click Print Test from the Additional Options menu. 
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2. A new browser window opens, showing the test print options: Cover Page Options,

Custom Cover Page Inputs (date, user name, etc.,), Layout Options. 

3. Click the checkbox beside each Cover Page Options to be included on the Test

Activity cover page. Note: Each option chosen will be included in the printed version.

4. The Custom Cover Page Inputs are manually entered on the printed version of the

test. They include: Date, User Name, Signature. To add additional inputs, click the

Add button. To remove the input, click the Delete icon. Use the drag handles to

reorder the inputs.

5. Select the desired layout from the Layout Options. Note: You may change the layout

of side-by-side questions to a top/bottom layout. To print an answer key, do not reload

the page. Click the checkbox beside Show Answers. Answer Sheet will display

beneath the Test Activity name on the cover page, when printed.



Learninglogics® LCMS 4.31 User Guide390

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

6. If supplementary information is needed on the cover page, enter it in the Additional

Instruction field. 

7. Click the Print button. Note: The computer must be connected to a printer. 

8. If the test requires introduction text on the cover page, click Activity Profile from the

Additional Options menu. Select the Additional Details tab and enter the

introductory text in the corresponding field.
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7.9.10 Generate Handout

The Generate Handout function allows the user to create a handout such as student or

instructor guides based on the chosen content.

1. On the Activity screen, click Generate Handout from the Additional Options menu.

Note: This function is not available for a Test Activity. See Print Test for more

information.

2. A new browser window opens, showing the interface and content options: Main Text,

Instructor Notes, Review Instructions. To include the content in the generated

handout, click the corresponding checkbox. To give the generated handout the same

"look and feel" as the Activity (preview), select an interface from the drop-down

menu. Note: Video, audio and some media will not be generated in a handout. 

3. Click the checkbox beside Generate as grayscale to generate the handout without

colour (gray and white only).

4. Click the checkbox beside the desired page orientation (Landscape or Portrait).

4. Click the Generate PDF button. When the file is created, you will be prompted to

download.
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7.9.11 Export Activity to LCMS

The Activity Export feature is available to Managers and Administrators. 

To export an activity:

1. Click Export Activity to LCMS from the Additional Options menu.

2. Click the checkbox beside Validate Media to ensure media required for the activity

exists in the LCMS. Note: De-selecting this feature decreases the time it takes to

generate the export file.

3. Click the checkbox beside Include Review History to include previous reviews.

Select the review type(s) to include from the Include Review Type drop-down

menu.

4. Click the LCMS to LCMS button to begin the exporting process.



Topic List (Activity Screen) 393

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

5. After the export is complete, click on the zip Filename to download. You will now

see the Date Exported and the File Size. 

To export more than one activity at a time, there is also an option to Batch Export.

7.9.12 Export for Translation

The Export for Translation feature is available to Developers, Managers and

Administrators.  
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To export an activity, including a test activity for translation:

1. Click Export for Translation from the Additional Options menu.

2. On the Translation Options window, click the checkbox to deselect the desired

options. Note: The deselected options will not be included in the translation export.

3. Click the checkbox beside Include questions that have not been translated?

and/or Include questions already translated? to include these options in the

export.

4. Click the Submit button to export the activity for translation. Note: The activity

STATUS field now states SUBMITTED FOR TRANSLATION. 
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5. On the Export Complete window, click the Download button (if your are using IE,

right-click and select Save Target As to download) to download the HTML files for

translation. 

To export more than one activity at a time for translation, there is also an option to 

Export to Batch for Translation.

7.9.13 Export to Batch for Translation

The Export to Batch for Translation feature is available to Developers, Managers and

Administrators. 

To export an activity, including a test activity to batch for translation:

1. Click Export to Batch for Translation from the Additional Options menu.
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2.  The activity STATUS field now states SUBMITTED TO BATCH FOR TRANSLATION. 

7.9.14 Import Translated Actvity

The Import Translated HTML feature is available to Developers, Managers and

Administrators. 

To upload and import an HTML file containing the translated content of an activity:

1. Click Import Translated HTML from the Additional Options menu. Note: The

Activity Production Status must be set to SUBMITTED FOR TRANSLATION.
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2. Browse to find your translated HTML file, then click Submit.

Note: You will have the option to ignore questions, in case the question bank was

previously translated. 

Note: On import, if screens are missing, these details will display in a status report. If

the Import Status indicates Ready, check the items you wish to import and click 

Import Selected. 

Note: You should not navigate away from this screen during import. 



Learninglogics® LCMS 4.31 User Guide398

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

The Import Status column will change to a check mark once the activity is successfully

imported and the Production Status column will change to "submitted to translation". The

Activity Status will also be updated to "Translated", but the activity will remain locked. 

Once the import is complete, the repository tree will refresh to show the translated

content.

To import more than one translated activity at a time, there is also an option for 

Translation Batch Import.

7.9.15 Media Audit

The LCMS provides a media audit of all types of media (audio, graphics, movies, etc.) used

in an activity. This is valuable when assessing the status of multimedia development for

specific activities. To view the status of media files:

1. Click Media Audit from the Additional Options menu to view the Media Audit

screen.
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2. The Media Audit screen displays the activity name and code at the top, as well as

the date and time of the generated report. The Summary section indicates how

many media files have been specified (selected + requested but not selected), put

in place (selected) and missed (requested but not selected) for the entire activity. 

The Format Count details how many of each type of media are used in the activity,

and each type is grouped by the file extension.

The Overall Completion section gives a percentage of how many media files are in

place out of how many that were specified. All of the above details are also given for

each individual topic within the activity. 

3. Use the Expand All/Collapse All button for all topics, or the expand button

located before the topic name for each one, to open/close more details about the

media under the Details by Topic/Screen section. The media details for each

topic include: screen number, screen style, screen ID, and if available, main text,

requested filename and description (on mouse rollover of icon) and the selected

filename. The green checkmark beside all of the selected filenames indicates all of

the files that are in place.
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4. Click the Print button to print the Media Audit report.

5. Click the Return to Topic List to return to the Topic List screen.

7.9.16 Update Media Links

Note: You may leave off the file extensions on the requested filenames, as they will

ultimately be ignored and the files searched by name only within the Media Library when

using Update Media Links.

Once the multimedia files are developed and placed in the Media Library, you can

populate all empty media fields in an activity with the media requested in the Requested

Filename field. Note: Once you have added a filename to the Requested Filename field

and clicked Save, the filename will appear in the media filename field with "Requested

Filename -" in front of it.

1. Click Update Media Links from the Additional Options drop-down menu. 
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2. Click OK in the message window to continue or click Cancel to abort the update. 

3. A window will open showing all requested filenames and whether they were 

Updated, Skipped or Not Found.

Note: Once a media field is populated, the Update Media Links feature will not replace or

overwrite the file selected with any Requested Filename (if available). Update Media

Links will only populate empty media fields. Click the Clear button to clear the media

field, then click Update Media Links. Now the field will populate with the new Requested

Filename. 
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To learn about adding individual media to a screen, visit the Add Individual Media section.

7.9.17 Maintain References

Administrators, Managers, Developers and other users with the relevant privileges enabled

can manage references.

References may include URL links to websites, links to files such as MS Word and Adobe

Acrobat files, links to media assets, etc. They are made available to learners to help them

complete the activity (e.g. a procedure manual that must be referred to when completing

a Test, a web page that further explains concepts highlighted in an Instructor Led lesson,

etc.).

When an activity features the References functionality, you may access references in two

ways from within the activity:

1. By clicking hyperlink text on any screen to open a reference

2. By clicking the References button while on any screen

The References button will only be enabled when there is at least one “visible” reference

available. 

Note: For instructions on accessing hyperlink texts from a screen, see Hyperlink to

Reference. 

To add, edit or delete activity references, select the Maintain References link under the

Additional Options menu.
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7.9.17.
1

Add a URL Reference to an Activity

1. Click Maintain References from the Additional Options drop-down menu.

2. The Maintain References screen appears. Click the Add URL Reference button at

the top of the screen.

3. Type the name of the reference in the Reference Name field.

4. Type the URL address in the URL field.

5. Select Hidden or Visible from the Reference Visibility field. If the reference is to

be accessed on a specific screen only (not throughout the activity), select 

Hidden. If the reference may be accessed at any time throughout the activity (by

clicking the References button), select Visible.
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6. Click the Submit button. The URL reference will be shown on the Maintain

References screen.

7.9.17.
2

Add a File Reference to an Activity

1. Select Maintain References from the Additional Options menu.

2. The Maintain References screen appears. To add a file reference, click the Add

File Reference button.

3. Type the file address in the File field or click the Select button to locate the file. All

files must reside in the Media Library or be uploaded to the Media Library.

4. Type the name of the reference in the Reference Name field. This is the reference

name that the user sees in the activity. If you leave this field empty, the Media Title

displays as the reference name when previewed/published.  
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5. Select Hidden or Visible from the Reference Visibility field. If the reference is to

be accessed on a specific screen only (not throughout the activity), select 

Hidden. If the reference may be accessed at any time throughout the activity (by

clicking the References button), select Visible.

6. Click the Submit button. The reference file is displayed on the Maintain

References screen. Note: If the Reference Name field is blank and a Media Title

exists, a yellow icon appears beside the reference name on the Maintain

References screen with a tip indicating that the Media Title will be used. 

Note: If there is no Media Title and you do not enter a title in the Reference Name

field, the reference file name populates the Reference Name field when previewed/

published. 

Note: If the same reference is entered more than once, the LCMS accepts each one and

changes the file name by adding 1, 2, 3, etc. to the end of it.

7.9.17.
3

Edit an Activity Reference

1. Select Maintain References from the Additional Options menu.

2. The Maintain References screen appears. Select the reference you wish to edit.

3. The Edit File Reference screen appears. Edit the chosen field(s). The file

currently used is displayed in the File field. Click the Select button beside the File



Learninglogics® LCMS 4.31 User Guide406

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

field to select the revised file from the Media Library.

4. Select Hidden or Visible from the Reference Visibility field. If the reference is to

be accessed on a specific screen only (not throughout the activity), select 

Hidden. If the reference may be accessed at any time throughout the activity (by

clicking the References button), select Visible.

5. Click the Submit button. The revision is shown on the Maintain References

screen.

7.9.17.
4

Re-order Activity References

When there are two or more references on a References screen, the references may be

re-ordered. 

1. Select Maintain References from the Additional Options menu.

2. The Maintain References screen appears. Click the Re-Order button.

3. A Reference Re-Order screen appears. Use the drag handles beside the reference

names to re-order them. The order you choose is the order in which users see the
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list of references within the activity.

4. Click the Submit button. The order you selected is displayed on the Maintain

References screen.

7.9.17.
5

Copy an Activity Reference

1. Select Maintain References from the Additional Options menu.

2. The Maintain References screen appears. Click the Copy icon beside the

reference you wish to copy to the clipboard.

3. The Copy icon changes to a checkmark to indicate that the reference has been

copied to the clipboard. Buttons now appear at the top of the screen for Paste

References and Clear Clipboard. 
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4. Click Paste References to paste the selected reference(s) into the activity you are

currently in. Note: Hover your mouse over the Paste button to see which references

are on the clipboard.

5. Click Clear Clipboard to remove copied references from the clipboard.

7.9.17.
6

Delete an Activity Reference

1. Select Maintain References from the Additional Options menu.

2. The Maintain References screen appears. Click the Delete icon beside the

reference you wish to delete.

3. A window appears asking if you are sure you wish to delete the reference.

4. Click Yes to delete the reference from the Maintain References screen.
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7.9.18 Maintain Attachments

Attachments are documents that you can add to an activity so that they will be available

to all individuals involved in the development of that activity, such as Reviewers, Subject

Matter Experts and Clients. These documents can consist of standard document formats

for which the end user platform has a viewer (Word, Excel, PDF, etc.). Attachments are

specific to the activity they are added to. The list of attachments is shown for all versions

of an activity.

7.9.18.
1

Add an Attachment

1. Click Maintain Attachments from the Additional Options menu.

2. The Attachments screen will appear for the activity. Click the Add Attachment

button.

3. The Add Attachment screen will appear. Enter a name for the attachment in the

Description field.

4. Select the file location using the Browse button and add a description for the file.

5. Once you have located the file, click the Open button. The location will show in

the Attachment File field.
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6. Click the Submit button. The attachment will appear on the Attachments screen.

The list of attachments is shown for all versions of an activity.

Note: The number of attachments assigned to an activity will be displayed in brackets ( )

on the Additional Options menu.

7.9.18.
2

Open an Attachment

On the Maintain Attachments screen, click the link for the attachment you wish to

access under the Filename heading. The attachment will open.

7.9.18.
3

Delete an Attachment

1. Select Maintain Attachments from the Additional Options menu.

2. Click the Delete icon beside the attachment you wish to delete. The attachment

will be removed from the Attachments screen. 

3. The number of attachments assigned to an activity will be displayed on the

Additional Options menu.

7.9.19 Publish as Course

Courses can be published from within an activity by following the steps below.

1. Click Publish as Course from the Additional Options menu.
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2. The Course Designer opens, where you can add and edit course details and

structure. For more information see Course Designer. 

3. Click the Publish tab.

4. Select the desired interface from the Interface drop-down menu.

5. Select the desired glossary from the Glossary drop-down menu, if required.  

6. Select the desired package type SCORM or Offline. Note: When one of the

SCORM option is selected, click the Include Offline Download checkbox to include

the offline course in the SCORM package. This function wraps the course, making it

SCORM conformant for delivery via a SCORM conformant LMS. 

7. Click the On publish, set activity production status to 'Published' and lock the

activity checkbox, if required. Note: This will change the status of the activity to

published and lock the activity.

8. Click the Include Alternate Language checkbox, if required. Note: Multilingual

Supports must be enabled in Project Preferences for this checkbox to display.

9. Click the Include Content Viewer checkbox to include the content viewer, if

required.

10. Click the Include screens with Tags checkbox, choose the tags from the Select

Tags window and then click the Submit button (if required). 
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11. Click the Exclude screens with Tags checkbox, choose the tags from the Select

Tags windowand then click the Submit button (if required). 

12. Click the Create button to create your SCORM or Offline package. 

13. After a few minutes, the package will been created. 

14. Click the course link to download the SCORM package.

15. When the file is downloaded, save the file in the desired location.

16. Now that you have wrapped the desired course in a SCORM package and

downloaded it, it is available for import into the LMS. This import is done from within

the LMS.

17. Click Return to Activity when you have finished publishing your course.

7.9.20 Published Course History

Each time a course is published, an archived version of the course is saved so users can
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re-download it if needed.

1.  Click Published Course History  from the  Additional Options  menu.  If  there  are  no

published courses, this link will do nothing. The number of published courses is indicated

beside the link.

2.  For each published course listed, there are options for Administrators and Managers to:

o Indicate that the course has been pushed to an LMS - see Published to LMS Indication

for more details

o Indicate that the course is available as an offline course - see Offline Course Launcher

for more details

o Download the published course - see Download Published Course for more details

o Delete the published course - see Delete Published Course for more details

Note: Developers will see the list of courses, but will not have access to these options. 
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Note: Users can also access the list  of published courses through LCMS Menu/Content

Packaging/Published Courses.

7.9.21 Set Security Defaults

By  selecting  Set  Security  Defaults  under  the  Additional  Options  menu,  the

Classification  and  Controlled  Goods  levels  can  be  set  for  the  activity.  The  Current

Settings are displayed first, with the drop-down options to set new levels for the activity

(where possible).

7.9.22 Batch Tag Screens

On this screen, the user can apply or remove tags to Activity screens using the Screens

list.

1.  Click the desired radio button (Apply Tags or Remove Tags) to apply or remove  the

tags from screens.

2.  Click within the Tags field to select or deselect the tags populated on the Select Tags

screen,  or  use  the  Load  Tags  From  drop-down  menu  options  (Activity,  Topics,

Screens or Combined Activity, Topics & Screens). The tags assigned to the chosen

option will  populate  on the  Select  Tags  screen.  Select  or deselect  the  desired  tags.

Note: New tags can also be added in the Select  Tags  screen.  See  Add  Tag  for more

information.
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3.  Click Submit to save the selection(s).

4.  The  list  of  Activity  screens  can  be  refined  by  selecting  options  for  Screen  Type,

Difficulty,  and  Screen  Styles.  Note:  Only  the  selected  options  display  in  the  list.

Note: The Difficulty  options (Low, Medium and High) represent  the level of difficulty

for Questions. When the Instructional Screens option is selected, the  Difficulty  field

should remain set to ALL.

5.  Select the desired screen(s) to apply or remove the tag(s) by clicking the checkbox in

the last column. Select all the screens in the list  by clicking the checkbox at  the top of

the last  column. Note: The action to apply or remove the tag(s) will only apply to  the

selected screens.

6.  Click the Apply Action to Selection button to apply or remove the tag(s). When the

tags are applied to the selected screens, they will display in the list in the Tags column.

When the tags are removed from the selected screen, they will no longer display in the

list. 

7.9.23 TDM Integration

When  TDM  Integration  is  enabled,  users  can  manage  teaching  points  associations  to

screens at the topic and activity level. 
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1.  On the Activity screen, click TDM Integration from the Additional Options menu. 

2.  The TDM Integration screen will open. Note: If a training document  is associated with

the  Activity,  the  pertaining  information displays  in  the  Statements  associated  with

this  Activity  field.  If  no  training  document  has  been  associated,  the  Statements

associated with this Activity field is blank. 

7.9.23.
1

Link Activity to TDM

1.  On the Activity screen, click TDM Integration from the Additional Options menu. 

2.  When the TDM Integration screen opens, click the Link to TDM Course button.
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3.  Select  a Course from the  Courses  drop-down menu.  Note:  The  Courses  drop-down

menu displays the courses entered in TDM.

4.  Select  a  course  level to  associate  with  the  Activity  from the  Course  Levels  drop-

down menu. Note: The Course Levels are dependent on the course schema entered in

TDM.  The  course  schema  is  designed  using  statement  levels.  Course  Levels  may  be

performance  objective  (level 1),  enabling  objective  (level 2),  teaching  point  (level 3),

and sub-teaching point (level 4).

5.  Select the desired statement level from the drop-down menu. 

6.  Click the Submit button to save.

7.9.23.
2

Link Screens to Teaching Points

1.  Click the EO to access  the  screen where  you will  associate  the  teaching  points  with

activity screens. Click the Link Screens to Teaching Point(s) button.
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2.  For each teaching point, choose the desired screen(s) from the drop-down list that you

would like to associate it to. 

3.  Click the Submit button to save.

Note: You can also  access  the  Link Screens  to  Teaching Point(s)  window  by  clicking

the  Link  Screens  to  TDM  statements  button  at  the  top  of  the  topic  list  screens.

Unassigned screens list  at  the Activity level. To link a question screen to teaching points

see Link Question Screen to Teaching Points.
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7.9.24 Find & Replace

The Find & Replace function may be used by the Administrator, Manager, Senior

Developer to find and replace content within the activity. Developers can also use the 

Find & Replace function in an activity they created.

1. On the Activity screen, click Find & Replace or the expand icon from the Additional

Options menu to display the Find & Replace window. 
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2. On the Find & Replace window, enter the desired content to search for in the Search

For field. 

3. Select the desired search option (Word or Phrase, All Words) to refine the search.

4. If desired, click the checkbox beside Case-sensitive to further refine the search.

5. Enter the desired content in the Replace With field. Note: The content entered in the

Replace With field will replace the content entered in the Search for field.

6. Click the checkbox beside the desired fields to include in the search. Note: If media

related fields are chosen, the Pop-Ups option should also be chosen if the pop-up

media also needs to be included in the search. Click the Select All button to include all

of the options or the Select None button to exclude all of the options.
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7. Enter the desired screen style to include in the search in the Screen Styles field.

Note: Separate the entries by a comma (3.02, 3.10, 3.14).

8. Enter the desired screen ID(s) separated by a comma in the Screen ID field. Note:

When searching by screen ID no other inputs are valid.

9. Click the Find button to begin the search. Note: The search may take a few moments

to complete.

10. On the Search Status window, click the View Results button to display the list on

the Find & Replace screen or click the Search Again button to repeat the search. 

11. Click the Change icon beside the desired list item to review the requested change on

the Replace window or click the Replace All button. A confirmation window displays

when the Replace All button is clicked. Click the Continue button to execute the

replace all function for all occurrences listed or click the Cancel button to return to
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the Find & Replace screen. Note: Click the View icon to view the corresponding

screen.

12. On the Replace window, click the Replace button to replace the highlighted old text

with the highlighted new text. Note: Click the Previous or Next button to make

another selection. 

13. Click the Close button to return to the Find & Replace screen. Note: A check mark

displays beside the list item when the content has been replaced. 
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7.9.25 Course List

On the Activity screen, click Course List from the Additional Options menu to display

the Activity Course List screen. This screen displays a list of courses this activity is

found in. This includes courses in Course Packaging as well as direct published courses.

7.10 Review/Approval Menu (Drop-Down)

Depending on the role you have been assigned, you may have access to some or all of

the Review/Approval functionality for activities within the LCMS.

The Review/Approval drop-down options change depending on your role and where the

particular activity is in the review process. Each drop-down item is described on the

following pages.

Note: Reviewers, Review Managers and Approval Authorities may be required to review or

approve activities that were developed in the LCMS. Activities submitted for review or

approval may be accessed directly in the LCMS. You will open the activity, add required

comments, then notify the appropriate personnel that your review or approval is

complete. 
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7.10.1 Review Responsibilities

Managers and Admins have the ability to assign a pool of users to each of the Reviewer,

Review Manager, and Approval Authority roles. These users can be defined differently for

each Review Type. When a Developer then submits a lesson for review, they may choose

one or more Reviewers, Review Managers, and Approval Authorities from the pools chosen

by their Manager or Admin. This allows the Manager to  create  a  sub-set  list  of  users  so

that the Developer can then choose from the list who to send the review. 

1.Within an Activity select Review Responsibilities from the Review/Approval

menu.

2. You will then see the Review Responsibilities screen, where you may choose the

Review Type to configure for the current Activity, from the first drop-down menu.

Note: The available Review Types can be defined by the Admin or Manager in the

Review Types screen.
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3. The users who have been assigned to the Reviewer, Review Manager, Review

Monitor and Approval Authority roles in the Project Management screen, will appear

as options in the three remaining drop-down menus. Select one or more users for

each role.

4. Click Save Changes to save, or Cancel to exit without saving.

Note: Developers will then be able to choose one or more users for each role when

submitting Activities for Review or Approval. If you have only defined one possible

user for a role then they will automatically be selected when the Developer attempts

to submit the Activity for review or approval.

7.10.1.
1

Submit Activities for Review

Once an activity is developed and ready to enter the review process, it may be submitted

for review using the Submit for Review feature under Review/Approval. Normally this is

done by Developers, although Managers, Admins and custom roles may also have this

privilege. The assigned personnel are notified that the activity is ready for review and

comments that are made can later be retrieved using the Review Comments feature

under Review/Approval. Note: A Review Manager must be assigned under the Project

Management feature if Review Manager Required has been selected in Application

Preferences. Once the assignments have been made, a submission for review can be

sent. See Assign Users to a Project.
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Note: Review requests can also be held in a batch to be sent to reviewers at a later time.

See Submit for Batch Processing.

To submit an activity for review:

1. Select the activity from the Content Repository list on the left. Note: The

Manager or Admin should already have assigned one or more Reviewers and/or

Review Managers and Approval Authorities (if applicable) to the activity in Project

Preferences, and defined pools of users for these roles in the Review

Responsibilities screen.

2. Click Review/Approval and select Submit for Review from the drop-down menu. 

3. Select a Review Type from the drop-down menu. If your Manager has only set one

user to be available for a role, they will automatically be selected, otherwise you

will be presented with a drop-down menu from which you can select one or more

users for each role (Reviewer, Review Manager and Review Monitor). Note: There is

some input validation here, e.g. Reviewers cannot be the same person as Review

Managers.
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4. Select the Interface in which you wish the activity to be reviewed from the drop-

down list. Note: When submitting storyboards for review, you must select the

Storyboard interface, which will allow the Reviewer to view and comment upon a

storyboard of the activity, containing fields such as the Review Instructions and

Media Description. The Send button is disabled and a warning displays when the

Interface is not selected from the drop-down list.

5. Select the storyboard elements you wish to be displayed in the storyboard to be

reviewed.
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6. If a glossary review is required, select it from the drop-down list. The default

setting is "no glossary".

7. Click the Calendar icon to select a due date for review completion.

8. Ensure the Request for Review information is correct.

9. Click the Send button to complete your submission. Note: Once the form is sent,

the status of the activity is automatically changed to “submitted for review”. Under

the Activity Profile tab, the activity is locked and it will be made available for

review to the assigned Review Manager and Reviewer(s). An activity can only be

unlocked when its status is set to "in-production".

10. A notice is displayed saying that the xml documents for the activity have been

created and are now ready for review. 

Note: All personnel assigned to the review receive notification by email (a checkbox allows

you to choose whether or not to send the notification to Managers). The Notify
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Developer checkbox is deselected by default if the sender is the Developer and selected

by default if the sender is not the Developer. Once notification is received, the Review

Manager and/or Reviewer may log into the LCMS using their assigned username and

password. If a review is 24 hours or more overdue, a notification is sent to Reviewers/

Review Managers. Also, you can set an email reminder notification to be sent halfway

through a review time period. 

7.10.2 Change(s) Required

1.  Developers can access activity review comments (from Reviewers, Review

Managers and/or Approval Authorities) by clicking Change(s) Required from the

Review/Approval menu at the top of the screen. The number of comments

assigned to the activity is shown to the right. These comments are used to make

further content development changes. 

2.  The Change(s) Required screen opens in a new browser window, displaying a list

of comments. These are arranged according to the version number of the lesson to

which they refer. You can hide or show the following columns by selecting them

from the drop-down list.

3.  Check Include All Activity Versions to see changes from previous versions of the

activity. 

 

4.  In the Changes Required window, you will see all of the columns you chose from
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the drop-down list, along with a description of the Change required. Comments are

shown truncated, but can be expanded by clicking the Expand/Collapse

Comment and Response icon on the left of each row. 

5.  Click the link in the Scope column (e.g. T4/S4) to open that screen in the LCMS

viewer. Hover your mouse over the Scope values to see the Topic Name and

Screen Title (if enabled).

6. Click a comment in the Change column to open a separate window with details on

the change required. The information provided for each comment (made by the

Reviewer/Approver) includes: the Change ID, Author, Date, Scope, Screen, Style

ID, Screen No., Screen Title and Topic. Note: The Style ID, Screen Number,

Screen Title and Topic Title are only displayed in comments that were made for a

particular screen from within the activity. 

7. Enter a response to the comment in the Change Response field, then select a

value from the Modify Status drop-down (default is "Pending" but can be changed to

"Resolved", "Input Required" or "No Action"). You may also modify priority by selecting

Minor, Normal, Major or Critical from the Modify Priority drop-down, select or

deselect tags, and modify the category. Previous and Next buttons are provided at
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the top of the window to allow you to navigate through the comments. To save the

comment responses automatically, set the Save on nav toggle button to ON.

Note: Changes are only saved by clicking Submit. Using Previous or Next will not

save a change response or status modification. If you do not click Submit before

moving on, you will receive a prompt (see below). 

8. Click the Submit button to save changes.

Note: The Jump to Screen button takes you to the LCMS screen associated with

that comment. 
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9. If you selected Tracking from the drop-down list on the main Changes Required

screen, you will see an Update Tracking toggle ON/OFF button at the top of each

individual Changes Required window. Set Update Tracking to ON to enable tracking

checkmarks that can be toggled on and off by Developers to help them track which

changes have been dealt with. 

Note: These checkmarks only remain selected (green) for that session. Once you

close the Changes Required screen, they automatically become deselected.

Note: If there is an attachment to the review comment, it is indicated under the

attachment (paperclip) icon.

Note: Details of Changes Required for a specific screen are also available by clicking

the Changes Required button when editing the screen, or via the properties screen

of a question screen.

7.10.2.
1

Review Change Report

The Review Change Report will allow you to view all of the comments and responses in

full for all versions of the selected activity.

1. Click the Review Changes Report button from the top of the Change(s)

Required screen to view the report. The Changes Required report includes the

selected columns for the Select Columns to Hide/Show drop-down menu.
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2. Use the Print button at the top of the screen to print the report or save as a PDF.

7.10.3 Submit Activities for Approval

Once an Activity has been marked as ready for approval by the Review Manager, the

option to Submit for Review will be replaced with Submit for Approval in the Review/

Approval menu, available to Admins, Managers and Developers.

1. Click the Submit for Approval option in the Review/Approval menu.  The Submit

for Approval screen will be displayed.  Note: This is similar to the Submit for

Review screen.  

2. Complete the relevant fields.  Click the checkbox labeled Notify Manager(s) as

well, if you want a notification email to be sent to all Managers assigned to the
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project.

3.Modify the Subject line of the notification email, if required.

4. Select the Glossary to use.  Note: The Interface field will be set to the one used

in the preceding review process.

5. Set the Due Date using the calendar input.

6.Modify the body of the email notification, if required.

7. Click the Send button to send the Activity to the Approval Authority for approval.
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7.10.4 Submit for Batch Processing

Administrators, Managers, and Developers can submit  Activities for inclusion in  a  "batch",

which will be held until submitted for review by a Manager or Admin at  a later time rather

than being sent immediately for review. Note: Notification emails will not  be sent  out  until

the whole batch is submitted for review.

After  Activities  have  been  submitted  to  form  part  of  a  pending  batch,  an  Admin  or

Manager  can  use  the  Batch  Submit  for  Review  feature  to  process  the  batch,  thereby

initiating the review process, and sending out notifications.

1. Click the Submit for Batch Processing option from the Review/Approval menu. 

The Submit for Batch Processing screen will be displayed, which resembles the

normal Submit for Review screen, except that the Due Date is automatically

generated when the whole batch is submitted by the Admin or Manager.  You will

see a notice at the top of the screen that says "Upon Submitting, the review will be

placed in a Batch to be submitted by the Manager."

2. Complete the fields on the screen and click the Submit button to add the Activity

to a batch, which may be sent for review by a Manager or Admin at a later time. 

As soon as the Activity has been submitted for inclusion in the batch, its Status

will be updated to "Submitted to batch".
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7.10.5 Review History

The total number of times an activity has been submitted for review and/or approval is

displayed in the Review/Approval menu beside Review History. To view the details of

each activity review or approval submission, click Review History.



Topic List (Activity Screen) 437

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

At the top of the Review History window you will see the date the activity was

submitted, activity title, version number and development phase. The name of the

Developer, Reviewers and Review Manager are shown below this. There are also columns

for Type (review or approval), Review Type (Client, Content, Media, Peer, QC, SME or

SISD), Due (date the review/approval is/was due), Completed (date and time the

review/approval was completed, if applicable). At the bottom is a field for a Completion

Comment from a reviewer or approver on finalizing a review or approval. Once a review

has been completed, the icon at the top of the screen will change from a white arrow in

a yellow circle to a checkmark in a green circle. Note: The review history is sorted in

descending order of date submitted.  

7.10.6 Review Settings

The Review Settings option appears in the Review/Approval menu when a review has

been submitted.  Admins and Managers can use this feature to change the Interface,

Glossary, Reviewers, or Review Manager settings, and also to retract reviews. Developers

can view this information, but as read-only.

1. To review the settings, click Review Settings in the Review/Approval menu.
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2. The Review Settings window will be displayed.

3. Use the drop-down lists to change the interface and glossary for a particular

activity being reviewed or approved. 

4. You can also assign Reviewers or Review Monitors and can change the Review

Manager. Note: Click and hold down Shift or CTRL to select more than one

Reviewer or Review Monitor from the list. 

5. Click Submit if there is a change. A notice will be displayed saying that the xml

documents for the activity have been created and are now ready for review (or

approval).
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8 Screen List (Topic Screen)

When adding screens within a topic, Developers can choose from a series of standard

instruction and question screen style templates. The LCMS content development

templates allow the automated integration of text and media in a wide range of types and

formats. See Screen Styles (Question and Instruction Screens) for more specific

information.

Should it be required, the LCMS standard development screens can also be customized to

meet the specific and unique training needs and objectives of any enterprise.

Note: Most  instruction screen styles have in common the  basic  tabs  labeled  Main Text,

Audio, Media, Tags, Other Details, Security, Pop-Up Boxes, and Special Functions.

Some  screens  have  additional tabs  or different  fields  within  the  common  tabs.  Screens

within Instructor Led Lessons also contain the Instructor Notes tab.

8.1 Add Screen (Instruction Screen)

Once you select a topic, you can add instruction screens and question screens to the

topic. To add an instruction screen:

1. Click the Add Screen button in the Topic List. 

2. A screen appears showing all available instruction screen styles. Select the screen

style you wish to use. The screen style you select is displayed with all applicable

fields for content and media. 
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3. To save the screen at any time, click Save at the top of the screen. All

information entered in these screen fields is displayed in the activity storyboard.

The Screen Title field is displayed at the top of the content area in the viewer, in

a heading format. Note: In the Screen List, hidden screens are identified by an

information icon.

8.2 Add Question

All questions are developed in the LCMS Question Bank. Once the questions have been

developed, they can be added to lesson and test activities. Note: To add questions to a

test, you have two options: (1) add each question manually or (2) acquire questions by

automation.

Sometimes a Developer may decide to add a question when developing the content in a

topic. These types of “confirmation” questions are included in a lesson to assist with a

user’s retention of content knowledge, and to confirm that specific teaching points have

been fully understood before proceeding further with a topic. 
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Note: The functionality of a question within a lesson topic is different from that of a test

activity. In a lesson activity, the user has two attempts to answer a question. Feedback

is provided for each attempt. If the user does not answer the question correctly on the

second attempt, the correct answer and feedback are provided. In a test activity, all

questions are answered prior to clicking the Evaluate button.

The following steps outline how to add one or more questions from the Question Bank to

a lesson topic.

1. Click the Add Question button from the Topic screen.

2. The Question Bank screen will appear. Locate the question(s) you wish to add by

entering specific search Criteria. See the section on conducting searches in the

Question Bank for more details.
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3. Click the checkboxes to the right of each question returned in your search results

to select one or more for inclusion in the activity.

4. Click Add Selected Question(s) to append all your checked questions to the

Screen List of the current activity.

8.2.1 View Question List

1. Once one of the search options has been selected, a list of all matching questions

appears.

2. Before you select the question you wish to add, check the question usage in other

activities and preview the question. See View Question Usage. Note: If a question

that is used in other activities is revised, the same revision applies to all activities

in which the question is used.

3. Select one or more questions using the checkbox(es), then click the Add Selected

Question(s) icon.
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4. Select a prompt from the drop-down list. The prompt provides direction for the user

on how to use the screens in the courseware. The prompt that you select depends

on the screen style you developed and the activity you are adding the screen to.

All of the prompts are developed in the Prompt Manager, and therefore are

predefined for the Developer.

5. Click the Submit button. 

6. The question is added to your Screen List screen.

Note: You can also copy and paste questions from one Activity to another, or from

the Question Bank into a Topic of your choice. When making a copy, it duplicates the

question which is inserted upon pasting. Once a question is copied, an icon appears

to the right of the LCMS menu. This allows you to clear the clipboard as required.

8.2.2 View Question Usage

1. To see where a question has been used, click the Usage icon beside the desired
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question on the Matching Questions screen in the Question Bank. 

If the question is not used, the Usage icon does not appear. 

2. The Question Screen Usage window appears, indicating all of the activities that

use the question. The name of the Developer who developed the activity is also

shown. Do not edit a question that is used in more than one activity until you are

certain that the edit is acceptable for the other activities in which the question is

used.
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3. Click the Close button to close the window.

4. If you attempt to delete a question that is already placed in a lesson or test, the 

Question Screen Usage pop-up window appears to show you where it is located

before you can delete it.
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8.2.3 Automation

Before questions can be added to the test automatically, the automated rule must be

created using the Question Bank feature and the Test activity must be created. If no

automation rule has been created, a dialogue box will appear with the message "No

automation rules exist".

1. Select the test that you would like to automatically add questions to from the

activity folder on the Content Repository screen.

2. Click the Automation button.

3. A screen displaying the rule(s) will appear. If more than one rule is displayed, select

the rule you wish to apply to the test. 

4. Select a prompt from the drop-down list. The prompt provides direction for the user
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on how to use the screens in the courseware. The prompt that you select depends

on the screen style you developed and the activity you are adding the screen to.

All of the prompts are developed in the Prompt Manager, and therefore are pre-

defined for the developer.

5. Click the Submit button.

8.3 Access Question from Activity Screen

1.  To  access  a  question  from  an  Activity  screen,  select  the  question  from  the

Navigation tree. Note:  Information regarding  the  Question displays  under the  Details

and Remediation tabs. See Remediation Tab for more information.

2.  To  preview  or  edit  the  question,  click  the  Edit  button.  This  will  open  the  chosen

question from the Question Bank. 

3. Make any changes to the required fields, then click the Save button at  the top of the

screen.  Note:  Any  changes  you  make  will  be  made  to  the  question  saved  in  the

question bank.
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4. When the Activity is in the locked state, the question is not editable. The Edit button

changes to a View button.

5. Click the View button to preview the question. 

8.3.1 Edit Question

Questions are not unique to topics or activities. A single question may be used across

multiple tests or lessons. When editing a question, be aware that your changes may

impact other activities. 

1. Click the screen number link on the Screen List screen. 
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2. A form will display fields relevant to the question as it appears in the current

activity or topic. Changes made on this form will not affect other topics or

activities.

3. Select a prompt from the Prompt drop-down.

4. Enter a screen title in the Custom Title field. This will override the question screen

title.

5. Click the Submit button to save your changes.

6. To make changes to the question screen's contents, click the Edit button. This will

enable you to modify the question in the Question Bank.

If the question is used by other topics or activities, a Usage button will appear next to

the Edit button. Click the Usage button to view a report of all other locations the

questions appears.
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8.3.2 Remediation (Tab)

The  Remediation  tab  is  used  to  provide  additional  remediation  feedback  that  can  be

appended to existing feedback or can replace existing feedback. 

1.  On the Activity screen, select the question from the Navigation tree. 

2.  Click the Remediation tab to open the Feedback window.
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3.  Click  the  pencil  icon  to  open  the  Correct  Feedback,  Incorrect  Feedback  1  or

Incorrect Feedback 2 field.

4.  Enter the desired feedback in each field.

5.  Click the link icon to open the Link Properties window.

6.  Select Remediation Screen form the Type drop-down menu.

7.  Select the desired topic from the Topic drop-down menu.

8.  Select the desired screen from the Screen drop-down menu.

9.  Click the Select button.
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10. Click the radio beside Append To Feedback or Replace Feedback.

11. Click the Submit button to save.

8.3.3 Link Question Screen to Teaching Points

1.  On the Activity screen, click the desired Question from the Navigation tree.

2.  Click the Associate Teaching Point(s) button beside the TDM Integration field.

3.  On the Associate TDM statements  with this  question screen,  select  a  statement

from the drop-down menu.

4.  Click the checkbox beside the desired teaching points.
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5.  Click the Close button to return to  the  previous  screen.  Note:  To  link an instruction

screen to teaching points, see Link Teaching Points for more information.

8.3.4 Link Question to Remediation Screen (Test Activity)

In a Test activity, the Remediation Screens tab is used to provide remediation feedback

to a user. This remediation feedback is given to the user when the number of attempts to

answer a question correctly is exceeded. Note: After the failed attempts, the user may be

redirected to the content and asked to review. 

1.  To  link  a  question  to  a  remediation  screen,  select  the  desired  Activity  from  the

navigation tree.

2.  Select the desired topic within the activity.
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3.  On the  screen list,  select  the  desired  screen for the  remediation,  and  then click the

Link to Screen icon. Note: A hidden screen may be selected for remediation.

4.  Return to the Test activity, click the Remediation Screens tab to open the window.

5.  Click the Insert Screen Link button. Note: The linked activity screen now displays in

the Remediation Screens list with a link icon.

6.  Navigate  the  desired  Question  in  the  Test  activity,  and  click  the  Remediation

Screens tab.

7.  Enter the desired feedback (i.e. Please review XX content) in the Incorrect FeedBack

1 field. Note: Click within the Incorrect FeedBack 1 field to open the CKEditor.

8.  Highlight  the  desired  feedback,  and  then  click  the  Link  icon  to  open  the  Link

Properties window.



Screen List (Topic Screen) 455

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

9.  On the  Link Properties  window,  select  Remediation  Screen  from the  Type  drop-

down menu.

10. Select the desired screen from the Screen drop-down menu.

11. Click the Select button to save the selection.

8.4 Re-Order Screens

Sometimes when you are developing a topic, you may wish to re-order some of the

screens.

1. Click the Re-Order button from the Screen List screen of a chosen topic.



Learninglogics® LCMS 4.31 User Guide456

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2. A Sort Activity Content screen appears with the title of your activity displayed at

the top and a list of screens below the name of the chosen topic.

3. Select and drag the name of the screen you wish to re-order.

4. Once the screen has been moved to the correct position, click the Submit button.

The screen or screens you have rearranged show(s) in the new order on the 

Screen List screen. 

Note: You can also rearrange topics and move screens from one topic to another at this

time.

8.5 Link Teaching Points

If a training document from TDM has been associated with a specific LCMS activity, the 

Link Screens to TDM statements button is available at the top of the topic list screens.

To link a question screen to a teaching point see Link Question Screen to Teaching Points

for more information.

1.  Click the Link Screens to TDM statements button to access the teaching points.



Screen List (Topic Screen) 457

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

2.  For each teaching point in the Link Screens to Teaching Points window, choose the

desired screen(s) from the drop-down list that you wish to associate it to. 

3.  Click the Submit button to save.

4.  The TDM Integration tab is also available from each screen within the activity. 

5.  Select the desired statement from the TDM statements addressed by this screen

drop-down menu. Note: More than one statement can be selected.

6.  Click the checkbox beside the desired teaching points. Note: Click the Learning Steps

icon beside a teaching point to view child statements.
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8.6 Preview (Screen and Topic)

Once a screen has been saved, you can preview it in a separate browser window. Viewing

screens in the Preview window is the same as viewing screens in the actual courseware

(media appears in Preview once it has been uploaded and added to each screen. See Add

Media to Screen for more information). 

1. From the Topic screen, click the Preview icon beside the screen you wish to view.

Note: The Preview settings already selected at the Activity level are assigned to

the topic screens. The screen automatically launches when you click the Preview

Screen button on the Screen Details screen. Otherwise, a dialogue box appears

prompting you to select an interface. 

Note: On graphic screens where no graphic is available, the Media Description is

displayed in Preview.

2. When you have finished previewing a screen, click the browser's Close button.

Note:  When  previewing  individual  screens  using  the  Storyboard  Interface,  the

functioning screen is rendered in the browser rather than the storyboard layout used in

the  Storyboard  Report  or  when  the  whole  activity  is  opened  in  the  Storyboard

Interface.
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Tip: To see the media size and filename at the top of the media area in Preview, click

anywhere onscreen, then use the keyboard shortcut CTRL+Alt+Shift+S.

3. From the Screen List screen, click the Preview Topic button. Use the drop-down

arrow to customize the interface, glossary, and emulation setting for the topic. See

Preview Activity for more information.

8.7 Cut/Copy and Paste (Screen)

The Screen List screen contains a list of screens contained within that topic.

1. Click the Cut or Copy Screen icon to copy the selected screen to the clipboard (a

green checkmark appears). Clicking the green checkmark removes the screen from
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the clipboard.

2. To cut or copy all instructional screens in the topic, click the Select All Screens

for Copy (or Cut) icon in the header row. Click this icon again to toggle all screen

selections off.

3. A Paste Screen button appears at the top of the window (within the same or a

different topic). Click the button to add copies of the selected screen(s) to the end

of the screen list. The newly copied screens have the number (2) after the Screen

Title. To change the screen name, click the screen No. and type the new title in

the Screen Title field.

4. To change the order of screens, use the Re-Order Screens button, drag the

screens to the desired order and click Submit.

Note:  Changes  made  to  the  original screen or the  copy  are  totally  independent  of  one

another, unlike changes made to linked screens.

Note: When Screens (as well as Activities) are copied, an icon appears to the right  of the

LCMS menu. This allows you to clear the clipboard as required.

8.8 Link to Screen

On the Screen List screen, there is a list of screens that fall within the current topic. 

1. Click the Link Screen icon to select a screen you would like to link to (click this
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icon a second time to toggle the selection off).

2. You can select more than one screen at a time to link. Click the Select All Screens

for Link  icon  in  the  header  row  of  the  screen  list  to  automatically  select  all  the

screens  in  the  current  topic  (click this  icon a  second  time  to  toggle  the  selection

off).

3. In the Screen List for the same or other topics, a button labeled Insert Screen

Link appears at the top of the screen once a screen has been designated as a

"linked screen". Click this button to add links to the selected screen(s). The linked

screen appears at the end of the Screen List.

4. The  chain  icon appears  beside  the  new  screen  to  indicate  that  it  is  linked  to  an

existing screen.

5. A Usage icon appears next  to the original screen, indicating that  a  link to  it  exists

so changes made to it will have effects elsewhere.

6. The order of screens can be changed using the Re-Order button at  the top of  the

Screen List screen.

7. In  the  Screen  List,  you  can  click  a  linked  screen's  number  to  open  a  window

containing Activity information. 
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8. In the activity information window,  click the  Master Screen  hyperlink to  open the

screen from which the  linked  screen is  derived.  Note:  When the  linked  screen is  a

hidden screen, the message Master is a hidden screen displays beside the Master

Screen field. Click the checkbox beside Hide screen from presentation to hide the

linked screen.

9. The Prompt for the screen can also be configured on this screen.

Note: Changes made to the original screen are reflected in the linked screen, unlike with

screens created using the copy feature.

8.9 Delete (Screen)

1. On the Screen List screen, click the Delete icon beside the screen you wish to

remove.
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2. A pop-up confirmation window appears asking if you wish to delete this screen.

Click YES or NO.  

3. If the screen is linked elsewhere (it is a master screen), a prompt appears asking if

you wish to keep the instance of the screen in the linked location(s).

Note: If the screen has an alternate language version in another activity, a dialogue

pop-up window will prompt you with this information. You will have the option to

delete the alternate language version of this screen. 
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8.10 Usage (Master Screen)

Once you have inserted a linked screen, the Usage icon appears beside the originating/

master screen on the Screen List screen. This Usage icon appears beside the master

screen to give the location of all screens linking up to it. To view the usage details:

1. Click the Usage icon beside the desired master screen on the Screen List screen. 

The details include the location (by folder, activity, topic and screen number) of the

master screen at the top of the pop-up window and the location of the screen(s) linking

to it, below.
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2. Click the Close button when done viewing the usage details.

8.11 Edit Screen

1. Click the screen number link on the Screen List screen. For example, clicking

Screen 1 will take you directly to that screen. 

2. On the Screen screen, below the Screen Title, you will see the screen style,

activity and topic name, layout size drop-down menu and the time of you last

session save. You will also see various tabs, depending on the screen style chosen.

For a 3.02, you would see Main Text, Audio, Media, Tags, Other Details, Security,

Pop-up Boxes and TDM Integration. Make your changes to the screen then click

the Save button at the top of the screen.
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8.12 Edit Screen Prompt

1. To edit a Prompt in an Activity, first open the Topic screen (Screen List).

2. Click the Screen No. of the screen for which you would like to change the prompt.

3. Change the prompt by using the prompt drop down.
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9 Screen Styles (Question and Instruction Screens)

The  LCMS  has  a  number  of  template  screen  styles  for  both  instruction  screens  and

question screens.

Question screens  and  instruction screens  have  a  similar interface  but  are  accessed  and

edited slightly different from one another:

Question screens are typically accessed via the Question Bank, discussed in the

section entitled Add New Question.

Instruction screens are typically accessed via the Screen List, discussed in the

section entitled Add Screen (Instruction Screens).

This section contains some basic guidance that applies to editing both types of screens.

You can add multimedia such as graphics, audio and video files to both instruction and

question screens. The type of multimedia that may be used with a screen depends on the

screen style selected. 

Once media files are developed and uploaded to the Media Library, there are two ways

of populating media fields. These are:

1. Using the Update Media Links feature to add multiple media at once: This link

populates all empty media fields in an activity with the media requested in the 

Requested Filename field. If the field is already populated and a Requested

Filename is changed for that field, selecting Update Media Links will not update

the populated media field with the new file. The Clear button must be used to allow

the media field to be populated again with the new filename in the Requested

Filename field. See the section Update Media Links for more information.

2. Selecting individual media files: Click the Select button to locate the required file in

the Media Library. See the section Add Individual Media for more information. 

9.1 Instruction Screen Styles

The following pages contain a  list  of  the  standard  HTML-based  instruction screen styles

available,  followed  by  a  list  of  legacy  Flash-based  screen  styles.  Additional  details  are

provided  for the  interactive  screen styles,  explaining  how  to  edit  the  fields  that  define

each type of screen.
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Note: See the section titled Screen List  (Topic  Screen)  for more  general information on

adding Question and Instruction Screens.

Supported Files-Types

The following file formats are supported for inclusion in the screen styles available:

Graphic: jpg, png, gif

Video: flv, mp4, HTML5

Video plugin: mov, wmv, unity3d, html

Graphic zoom: Zoomify, Giga Image Viewer

9.1.1 Instruction Screen Style Descriptions

These are the main instruction screen styles available. They mainly  determine  the  layout

of HTML and media on the screen. Any type of supported media asset  can be inserted in

most screen styles. Interactive screen styles also make different  types of user interaction

available, as explained below.

Most screens have text/media layout options, which are accessed from a drop-down menu

at the top of the screen. 
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Basic Screen Styles

These screens have an area in which media assets can be displayed, which may be in the

following formats: static graphics (png, jpg, gif and pdf), Animate animations (HTML),

videos (mp4), large zoomable images (Giga and Zoomify) or 3D models (Unity 3D and

Modest 3D). Note: The media area may also be used to contain a second HTML pane if

the media filename is left blank, and the Caption field will expand to fill the whole space

normally available for media. You can also embed static graphics inline in HTML content

areas (but not other media types). Note: When a video (mp4) media is chosen in a screen

style that supports video, the Autoplay and Loop options will display. The Autoplay

enables the video to begin playing automatically when the screen is launched. The Loop

option enables the video to loop when it has finished playing. 

Thumbnail Description

3.02 HTML/Media. Allows selection between different  layouts: "No

Text,  100%  Media",  "40%  Text,  60%  Media",  "50%  Text,  50%

Media", "60% Text, 40% Media", "100% Text,  No  Media",  or "100%

Text,  Background  Media"  (all  media  types).  Note:  Default  layout

size is "40% Text, 60% Media".

3.04  Panoramic  Media  Above.  Split  vertically,  with  up  to  60%

HTML at the bottom, and at least 40% panoramic  media at  the top.

If less HTML content is present, the media area will become taller to

fill the available space (all media types).

3.06  Panoramic  Media  Below.  Split  vertically,  with  up  to  40%

HTML at the top, and at least 60% panoramic  media at  the bottom.

If less HTML content is present, the media area will become taller to

fill the available space (all media types).

Interactive Screen Styles

All of these screen styles have a basic layout resembling 3.02: split horizontally, with 40%

, 50% or 60% on the left for HTML Main Text and Text Options and 40%, 50% or 60%

media on the right. However, they also include various kinds of user interaction. Note:

Most of these screens can use any supported type of media asset, except 3.10 and 3.11,

which only support static images, 3.13 which only supports videos, and 3.14 which can

only use Giga and Zoomify Images, Unity 3D models, or Animate animations. Screen 3.17

allows the 100% text option selection.
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Thumbnail Description

3.10 Media with Highlights. Click Text  Options  or links  to  display

up  to  nine  corresponding  highlighted  areas  on  the  media  asset

(Static images only -  png, jpg, gif). Collapsible text  areas may also

be  included  beneath each Text  Option,  to  be  revealed  when they

are  clicked.  Allows  selection  between  these  layouts:  "40%  Text,

60% Media", "50% Text, 50% Media", "60% Text, 40% Media".

3.11  Media  with  Hotspots.  Click  Text  Options  or  corresponding

highlighted  hotspots  on  the  media  asset  to  reveal  an  additional

media  asset,  which  must  be  a  static  graphic,  either  in  a  pop-up

window  or  replacing  the  main  media  asset  (Static  images  only  -

png,  jpg,  gif).  This  screen  style  can  be  used  to  create  simple

interactive  control  panels.  Collapsible  text  areas  may  also  be

included beneath each Text  Option, to  be  revealed  when they  are

clicked.  Allows  selection between these  layouts:  "40% Text,  60%

Media",  "50% Text,  50% Media",  "60% Text,  40% Media",  or  "No

Text, 100% Media".

3.12 Tabbed Layout.  Displays  multiple  screens  of  different  styles

as navigable tabs, which are revealed when clicked.

3.13 Chaptered Video. Click HTML "chapters" to jump to  different

parts  of  the  video.  Chapters  are  highlighted  as  specified  time

markers  are  reached  during  playback.  Playback  can  either  be

continuous or set  to pause following each chapter.  Collapsible  text

areas  may  also  be  included  beneath  each  Text  Option,  to  be

revealed  when  they  are  clicked  (mp4).  Allows  selection  between

these  layouts:  "40% Text,  60% Media",  "50% Text,  50% Media",

"60% Text, 40% Media".

3.14 Interactive Media States. Click Text  Options  to  activate  up

to  nine  different  states  of  a  single  media  asset,  i.e.  changing

between  Giga  or  Zoomify  Image  or  Unity  3D  states,  or  playing

different  sections  of  an  Animate  animation.  Optionally,  collapsible

text underneath each Text Option can also be displayed when they

are selected (HTML, mp4, flv, Giga, Zoomify and Modest  3D). Allows

selection  between  these  layouts:  "40%  Text,  60%  Media",  "50%
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Text, 50% Media", "60% Text, 40% Media".

3.15 Slide Show. Click thumbnails or arrows at the top of the media

area or hyperlinks within the main text  area to navigate through up

to nine media in a  slide  show  format  (png,  jpg,  gif,  Giga,  Zoomify,

Unity3d, HTML, pdf). Text-only slides can be created by leaving the

media file name blank, and then the caption area will  expand  to  fill

the  whole  slide.  Allows  selection  between  these  layouts:  "40%

Text, 60% Media", "50% Text, 50% Media", "60% Text, 40% Media",

or "100% Text, No Media".

3.17 Swappable Media. Click on either Text  Options  or hyperlinks

to switch between up to 15 media assets. Media selected replaces

the default asset in the left-hand pane. If the filename is left  blank,

the  caption  text  will  fill  the  available  space  in  the  media  area.

Optionally, collapsible text underneath each Text Option can also be

displayed when they are selected. All media formats are supported.

The  Giga  Image,  Zoomify,  Unity  3D  and  Modest  Tree  states  only

supported on the default graphic.

3.18  Stacked  Layout.   Displays  multiple  text  blocks  and  media

(png, jpg, gif, mp4, Unity 3D, HTML) in two stacked columns. Allows

selection  between  these  layouts:  "40%  Text,  60%  Media",  "50%

Text, 50% Media" or "60% Text, 40% Media".

3.19 Build Slide. Click the arrows at  the top of the  media  area  to

navigate through up to 15 text and/or media options in a slide show

format  (png,  jpg,  gif,  Zoomify,  Unity3d,  HTML).  The  text  options

can be  appended  or replaced.  Text-only  slides  can be  created  by

leaving  the  media  file  name  blank,  and  then  the  caption  area  will

expand  to  fill  the  whole  slide.  Allows  selection  between  these

layouts:  "No  Text,  100%  Media",  "40%  Text,  60%  Media",  "50%

Text,  50%  Media",  "60%  Text,  40%  Media",  or  "100%  Text,  No

Media".  Note:  The  screen ratio  for this  screen-style  refers  to  the

percentage between the text options and media.

9.1.1.1 Interactive Screen Styles

The interactive screen styles allow you to interact  with the content  in a variety of ways

(i.e. adding multiple Text Options, Graphics  or sets  of  Plot  Coordinates).  All  of  these

screens, with the exception of 3.12,  have  a  drop-down menu at  the  top  of  the  screen,
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allowing the user to select  the layout. These screens are described in  more  detail  in  the

following pages.

9.1.1.1.1  Media w ith Highlights (3.10)

Thumbnail Description

3.10 Media with Highlights. Click Text Options or links to display

up to nine corresponding highlighted areas on the media asset.

Collapsible text areas may also be included beneath each Text

Option, to be revealed when they are clicked (static images only -

png, jpg, gif). Allows selection between these layouts: "100% Text,

No Media", "40% Text, 60% Media", "50% Text, 50% Media", "60%

Text, 40% Media", .

This screen style basically displays a list of bullet points with text on the left side of the

viewer, which the user can click to highlight different areas on an image on the right side

of the viewer. It is similar to 3.17 except that instead of multiple images, a single default

image is displayed with multiple areas on it which can be highlighted.

1. In addition to the standard fields, including Main Text, this screen has a Graphics

tab that contains a single Default Graphic field, which functions in the same way

as the Graphic fields in the basic graphic screen styles described earlier. However,

the images will be displayed on the right side of the viewer with yellow boxes

superimposed to highlight specific areas in response to user interaction. The

Graphic tab is disabled when the "100% Text, No Media" option is chosen. 

2. The Caption field holds HTML that will be displayed below the Default Graphic.

Note: Hyperlinks and inline images may also be entered in the Caption field using

the HTML editor. 

3. This screen style also has a Text Options tab with multiple numbered fields, which

is used to define the text displayed as interactive bullet points on the left side of

the viewer. Click the Add Text Option button at the bottom of the tab to add more

options, to a maximum of nine. HTML tags can be inserted into the Text Options

field to format text. To re-order Text Options fields, use the drag handles on the

top-left of the Text Option field. Note: If the Text Option has a plotted shape,

the shape will also be reordered. To remove a text option, click the Remove Text

Option icon. Note: If the Text Option has a plotted shape, the shape will also be

deleted.
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4. Click the Plotter Tool button to open the Plotter Tool window. Note: One or more

highlights can be plotted using this tool for each Text Option or Link in the Main

Text or Collapsible text area. Note: See The Plotter Tool for more information.

5. Click the Collapsible Text button to display an HTML editor field for optional

hidden text that will appear when the corresponding Text Option is clicked in the

viewer. 

6. Links to highlights on the image can be added to the Main Text area or to

Collapsible text. When the user clicks a Link, the plot area defined by the

corresponding Coordinates is highlighted on the image, in the style selected using

the Plotter Tool. See Add/Edit/Delete Hyperlinks for more information on this

feature.

7. Click the checkbox labeled Autoselect first option on load to display Text Option

1 with its corresponding Coordinate when the screen loads.  

8. When you preview this screen style, the Default Graphic displays on the right

with Main Text and Text Options on the left. When each Text Option is clicked,

its associated highlight is automatically displayed on the image. Highlights appear in

the order of the Text Options. For example, clicking Text Option 1 will bring up

Coordinate 1. Clicking another text option will hide the first coordinate and show

the one matching the currently selected text option. Coordinates associated with

Links will be displayed according to the Hotspot manually selected from the list of

available hotspots. See Hyperlink to Image Highlight (Hotspot) for more information

on this feature.

9.1.1.1.2  Media w ith Hotspots (3.11)

Thumbnail Description

3.11 Media with Hotspots. Click Text Options or corresponding

highlighted hotspots on the media asset to reveal an additional

media asset, which must be a static graphic, either in a pop-up

window or replacing the main media asset. This screen style can be
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used to create simple interactive control panels. Collapsible text

areas may also be included beneath each Text Option, to be

revealed when it is clicked. (Static images only- png, jpg, gif).

Allows selection between these layouts: "100% Text, No Media",

"40% Text, 60% Media", "50% Text, 50% Media", "60% Text, 40%

Media", or "No Text, 100% Media".

This screen style is basically a combination of 3.17 and 3.10. The user is shown a list of 

Text Options with the Default Graphic displayed to the right in the viewer. When they

click on a Text Option the corresponding area of the Default Graphic is highlighted and a

corresponding image is displayed in a pop-up screen. Alternatively, instead of being

opened in a pop-up, different graphics can replace the Default Graphic, which is useful if

you want to simulate an interactive control panel.

1. In addition to the standard fields, including Main Text, this screen has a Graphics

tab that contains a single Default Graphic field and multiple Graphic fields,

numbered one to fifteen. When the screen is launched, the Default Graphic is

displayed on the right and Text Options on the left. When a Text Option is

clicked, the associated graphic appears, either in a pop-up box or replacing the 

Default Graphic on the right. To reorder Graphic fields, use the drag-handles

(top-left of field). Be sure the Sync reorder with Text Options toggle is ON, if

you wish to reorder the associated text options at the same time. To remove a

graphic, click the Remove Graphic Icon. To add more graphics (to a maximum of

nine), click the Add Graphic button. Note: The Graphic tab is disabled when the

"100% Text, No Media" option is chosen.

2. Click the checkbox labeled Swap the Default Graphic with the graphics below to
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toggle between showing graphics in pop-ups or using them to replace the Default

Graphic in the right pane. Click the checkbox labeled Hide Hot Spots to hide

hotspots. The Caption field of the Default Graphic appears underneath it, and

the Captions for the other graphics will appear below them in the pop-up

windows. Note: Hyperlinks and inline images may also be entered in the Caption

field using the HTML editor. 

3. Click the Plotter Tool button to open the Plotter Tool in a new window. The

Plotter Tool button displays for every graphic added. Note: On the default graphic,

one or more hotspot can be plotted for each Text Option. Note: See The Plotter

Tool for more information on this feature.

4. Select a value for the Location drop-down for each graphic to choose where the

pop-up appears on the screen, relative to the hotspot that triggers it (Bottom,

Top, Left, Right), enter values for Offset X and Offset Y to control the exact

positioning. Note: These settings are not relevant if the Swap the Default

Graphic box is checked.

5. The Text Options tab is used to define the text displayed as interactive Text

Options on the left. These fields correspond with the Graphics fields of the same

number (i.e., Text Option 1 corresponds with Graphic 1).  Click the Add Text

Option button to add more Text Options, up to a maximum of nine. HTML tags can

be inserted into the Text Options field, to format text. To reorder Text Options

fields, use the drag-handles on the top-left of the Text Option field. To reorder the

associated media at the same time as the Text Options, be sure the Sync reorder

with Graphics toggle is ON.  To remove a text option, click the Remove Text

Option Icon. Note: Deleting a Text Option does not delete its corresponding

graphic. Graphics must be deleted separately.

6. Click the Collapsible Text button under each Text Option to display an HTML

editor field. Here you can add optional hidden text, to be displayed when the

corresponding Text Option is clicked in the viewer. You may also add links in

Collapsible Text to the hotspot coordinates on the image. See Hyperlink to Image

Highlight (Hotspot) for more information.
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7. On preview, Main Text appears on the left and the Default Graphic on the right.

Click Text Options or corresponding highlighted hotspots on the media asset to

reveal an additional graphic (in a pop-up window or replacing the main media

asset). The corresponding Graphic file is displayed in a pop-up window unless

Swap the Default Graphic with the graphics below is checked, in which case the

image in the right pane will change. Click the checkbox labeled Autoselect first

option on load to display Text Option 1 with its corresponding Coordinate when

the screen loads.  

Interactive Control Panel

To use this screen to simulate an interactive control panel, you will normally want to have

multiple versions of the same graphic, each showing a control panel with identical buttons

but different output on a display or gauges. By drawing hotspots over the buttons, you

can make them clickable. Note: It's important that the buttons are in the same location in

each graphic because the hotspots will always be in the same position. When the user

clicks a specific button the graphic can be swapped to show the same control panel in a

different state, e.g. with relevant output shown on its display.

9.1.1.1.3  Tabbed Layout (3.12)

Thumbnail Description

3.12 Tabbed Layout.  Displays  multiple  screens  of  different  styles

as navigable tabs, which are revealed when clicked.  The  tabs  may

be  displayed  at  the  top  of  the  screen  or  on  the  left  side  of  the
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screen.

The tabbed layout screen helps you organize related content into tabs within a single

screen. Any screen style can be used within a tab. The editing tool for this screen

functions differently from other screen styles.

1. Enter a title in the Screen Title field.

2. Select the tabs layout (Tabs Top or Tabs Left) from the LAYOUT drop-down

menu.

3.Click Main Text tab and select a prompt from the Prompt drop-down menu (if

prompts are set up for your project). Note: Alternatively, you may enter a prompt

by clicking the Main Text tab and entering a prompt in the Main Text field.

4. Click the Save button.

5. Click the Instructional Tab button or Question Tab button at the top of the

screen to add a new tab. See Add an Instructional Tab and Add a Question Tab for

more information.
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9.1.1.1.3.1  Add an Instructional Tab

To add an instructional tab:

1.On the Tab Screen, click the Add an Instructional Tab button.

2.On the Tab Title window, enter the desired title in the Title field.

3. Click the Submit button to bring up a screen showing various tab styles to choose

from. These are the same Screen Style options you see when adding a new screen

to a topic. Click the screen style you would like to use.

4. A Screen (New Tab) window will open. Add the Screen Title (to appear at the top

of the tab screen) and text to the Main Text field. Also, change screen Layout

Size if layout sizing is an option for the screen style. Note: You must add text to

the Main Text field in order to save the screen (you can use placeholder text).
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Click Return to Tab List when you are done editing this tab and are ready to add

another. Note: If the Main Text field is empty when you click Save, you will

receive a warning message stating that the Main Text field cannot be empty. Also,

you must save the screen once before the Change Screen Style button is

enabled. 

5. The newly-created tab is now displayed as part of the Tab List on the main Tab

Screen. You may continue to add as many tabs as you wish. Click the Re-Order

button to re-arrange the sequence of the tabs. To edit a tab, click the Tab

Number from the list on the left. This will open the normal edit screen for that

Screen Style. Note: The Tab Number and Tab Title will be displayed beside the

screen style number in the header of the edit screen. Click the Tab Title in the list

to rename a tab by editing the name inline.

6. Click the Delete icon to delete a tab.

7. To copy and paste within the same Tabbed Layout screen, or into another
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Tabbed Layout screen, click the Copy Tab icon, then click Paste Tab at the top

of the screen. The newly copied tab will have the same title as the original with the

number (2) after it. 

8. Enter a Tab Title and click the Save button. 

9. Screens from the same project folder may be copied and pasted as tabs. Click the 

Copy Screen icon beside the correct screen in the Screen List, then click Paste

Screen as Tab at the top of the tabbed layout screen.

10. Enter a Tab Title and click the Save button. 

9. Tabs from the same project folder may be copied and paste as screens. Click the 

Copy Tab icon beside the desired tab in the Tab List, then click Paste Tab As

Screen at the top of the desired Topic screen. The copied tab will paste as a new

screen in the Screen List.
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9.1.1.1.3.2  Add a Question Tab

To add a Question tab:

1.On the Tab Screen, click Question Tab and enter a title in the Title field and click

Submit to bring up the Question Bank screen. The Tab Title will appear as a label

at the top of the tab. 

2.On the Tab Title window, enter the desired title in the Title field.

3. Click the Submit button to bring up the Question Bank.
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4.Select a question from the Question Bank and click the Add the Selected

Question button or click the Create a New Question button. For more information

see the Create New Question section.

5. The newly-created tab is now displayed as part of the Tab List on the main Tab

Screen. You may continue to add as many tabs as you wish. Click the Reorder

button to re-arrange the sequence of the tabs. To edit a tab, click the Tab

Number from the list on the left. This will open the normal edit screen for that

Screen Style. Note: The Tab Number and Tab Title will be displayed beside the

screen style number in the header of the edit screen. Click the Tab Title in the list

to rename a tab by editing the name inline.

6. Click the Delete icon to delete a tab.

7. To copy and paste within the same Tabbed Layout screen, or into another

Tabbed Layout screen, click the Copy Tab icon, then click Paste Tab at the top

of the screen. The newly copied tab will have the same title as the original with the

number (2) after it. 
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7. Question Tabs from the same project folder can be copied and pasted as screens.

Click the Copy Tab icon beside the correct tab in the Tab List, then click Paste

Tab As Screen at the top of the desired Topic screen. The copied tab will paste

as a new screen in the Screen List.

9.1.1.1.4  Chaptered Video (3.13)

Thumbnail Description
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3.13  Chaptered  Video.  Click  on  HTML  "chapters"  to  jump  to

different  parts  of  the  video.  Chapters  are  highlighted  as  specified

time  markers  are  reached  during  playback.  Playback can either be

continuous  or  set  to  pause  following  each  chapter  (mp4  and  flv

only).  Collapsible  text  areas  may  also  be  included  beneath  each

Text Option, to be revealed when they are clicked.

The chaptered video screen style allows the developer to define a series of chapters,

consisting of HTML content, to be displayed beside an MP4 video and highlighted as

specific time markers are reached during playback.

1.  The Main Text area can be left blank. However, add content if you want text to

appear above or below the list of chapters. A blue line (text build) is used to

separate the above and below text within the Main Text field, as shown in the

screen capture below.

2.  Add the content for multiple chapters to the Chapter Text tab, containing HTML

content. Click Add Chapter to add a new chapter.

3.  Click the Delete button to remove a chapter.
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4.  Enter a value for the Chapter Start Time and End Time, in seconds. If no end

time is entered, it is assumed the end time is the same as the start time for the

next chapter. This is the time during playback at which the chapter will be

highlighted in the viewer. Decimal numbers can be used for fractions of a second. 

Note: This value must be unique. If the value is blank or zero, the chapter will be

highlighted immediately, as soon as playback begins. 

5.  You can drag chapters and rearrange their order, or click Resequence to sort

chapters into order according to the Chapter Start Time settings.

6.  Click the Delete icon in a Chapter area to delete the chapter.

7.  Click the Hide/Show Collapsible Text icon to edit collapsible text for the

chapter.

8.  Check the Pause between chapters checkbox to stop playback at the end of

each chapter. If unchecked, the video will play through without pausing.

9.1.1.1.5  Interactive Media States (3.14)

Thumbnai

l

Description

3.14 Interactive Media States. Click Text Options to activate up to nine

different states of a single media asset, such as:

Changing between Giga Image Viewer, Zoomify or Modest Tree 3D states

Playing different sections of Flash, Animate or MP4 media

Optionally, collapsible text under each text option can also be displayed when it

is selected. This screen style allows selection between these layouts: "100%

Text, No Media", "40% Text, 60% Media", "50% Text, 50% Media" or "60%

Text, 40% Media".

This screen style resembles 3.17, except that when the user clicks on a bulleted text

option, this action can change the state of a media asset. The types of media currently

supported are:

Giga Image Viewer files

Modest Tree files

MP4
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flv

html (published from Adobe Animate)

1. The Main Text field can contain HTML content that will be displayed either above

or below the collapsible sections. This is distinguished by using the Text Build

feature to insert a separating line. Any content above the line will be displayed at

the top, above the collapsible sections, and any content below the line will be

displayed at the bottom, below the collapsible sections. Note: Links can be added

above or below the line.

2. This screen also has a Media tab that contains a single Default Media field. When

the screen is launched, the default media will be displayed on the right side of the

bullets. The buttons on this tab function the same way as on other screen styles.

If Giga Image Viewer and Modest Tree media files are selected, a Settings button

appears allowing you to add/edit hotspots and states. See Media (Tab) for more

information. Note: The Media tab is disabled when the "100% Text, No Media"

option is chosen.

3. This screen style has a Text Options tab, with multiple fields numbered one to

nine, used to define the text displayed as interactive bullets. Click the Add Text

Options button to add more text options, to a maximum of nine. The Text Options

fields can be reordered by clicking on the drag handles on the top-left of the Text

Option field. To remove a text option, click the Remove Text Option icon. 
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4. Click the Collapsible Text button to display a HTML editor field to add optional

hidden text, to be displayed when the corresponding text option is clicked in the

viewer. Also, links can be added within the collapsible text. See Add New Hyperlink

for more information.

5. Click the checkbox labeled Autoselect first option on load to display Text Option

1 with its corresponding state when the screen loads.  

6. This screen also has a set of Action fields beside each text option. If a Giga Image

Viewer or Modest Tree file has been inserted, this area will display drop-down

menus from which you can select states to be activated when the corresponding

bullet points (text options) are clicked by the user in the interface. If a Flash or

Animate media file has been inserted then you will see text input fields here, which

can contain parameters for the Flash or Animate file. Entering a number here will

cause the Flash or Animate file to navigate to the corresponding frame number

when the user clicks the text option. For video files, entering a number will allow

the user to navigate to the indicated time stamp. Names of labels defined by media

developers can also be used here. Note: If an Animate file, or MP4 video has been

selected, you will also see radio buttons marked Go to and Play and Go to and

Stop underneath each Action field. These can be used to control whether

animations and videos play through or stop at the first frame.

 

Note: If a Unity 3D file has been selected, you will see radio buttons marked With

Transition and Without Transition. These can be used to control whether a

transition animation is displayed when switching between states.

7. If a Text Build has been used to divide the Main Text field, the text below the

Text Build will appear in the viewer below the Text Options and collapsible text.
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Note: Not every bullet point needs to activate a change in the state of the media.

Also, Text Options do not need to have Collapsible Text.

9.1.1.1.6  Slide Show  (3.15)

Thumbnail Description

3.15 Slide Show. Click thumbnails or arrows at the top of the media

area or hyperlinks within the Main Text area to navigate through up

to nine media in a  slide  show  format  (png,  jpg,  gif,  Giga,  Zoomify,

Unity3D,  html,  pdf  and  mp4).  Text-only  slides  can  be  created  by

leaving  the  media  file  name  blank,  and  then  the  caption  area  will

expand  to  fill  the  whole  slide.  This  screen  style  allows  selection

between these  layouts:  "40% Text,  60% Media",  "50% Text,  50%

Media", "60% Text, 40% Media", "100% Text, No Media", "Text, Max

1/2 Media Top", "Text, Max 2/3 Media  Top",  "Text,  Max 1/2 Media

Bottom", or "Text, Max 2/3 Media Bottom".

Click the Media tab on your screen to add or remove media to include in the slide show.

1.  Click Caption to open the Caption field. If you enter a caption, it  will be  displayed

beneath the slide. Hyperlinks  and  inline  images  may  also  be  entered  in  the  Caption

field using the HTML editor. Note:  If  no  graphic  is  selected  but  a  caption has  been

provided, the caption will expand to fill the whole available  slide  area,  allowing  users

to create text-only slides.
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2.  Click the Add Slide button in the bottom-right corner to add another Slide field (can

include up to nine).

3.  Click the Clear button to remove the media file name for a slide.

4.  Click the red Remove Slide icon to delete a slide. 

5.  Add  media  descriptions  using  the  Description  button  (click  to  open  a  separate

Description window).

6.  The Plotter Tool is available for each slide that  is a graphic  file type (png, jpg, gif).

Settings is available for slides  that  are  the  Unity3D file  type,  and  Default  State  is

available for slides that are the Animate type.

7.  Click the  Select  button to  add  available  media  from the  Media  Library.  For  more

information, go to Add Individual Media.

9.1.1.1.7  Sw appable Media (3.17)

Thumbnail Description

3.17 Swappable Media. Click on either Text  Options  or hyperlinks

to  switch  between  up  to  fifteen  media  assets.  Media  selected

replaces the default asset  in the left-hand pane. If the file name is

left  blank, the caption text  will fill the available space in the  media

area. Optionally, collapsible text  underneath each Text  Option can

also be displayed when it  is selected. (Giga Image is not  supported

on Default Graphic). 

This  screen  style  displays  a  list  of  Text  Options  which  the  user  can  click  to  display

corresponding media assets. There is also the option of adding Collapsible Text that  will

reveal beneath each Text Option when it is clicked.  

1. In addition to the standard fields, including Main Text, this screen has a Media tab

that contains Intro Media and multiple Media fields, numbered one to fifteen. To

reorder Media fields, use the drag-handles (top-left of field). Be sure the Sync

reorder with Text Options toggle is ON, if you wish to reorder the associated text

options at the same time. To remove a media asset, click the Remove Graphic

icon. To add more media (to a maximum of nine), click the Add Graphic button.

Note: The Media tab is disabled when the "100% Text, No Media" option is

chosen.
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Note:  The  Plotter Tool is  also  available  for  use  with  the  Default  Graphic.  See  The

Plotter Tool for more information.

2. These fields function in the same way as the Media fields in the basic screen

styles described earlier. However, the media will be displayed on the right-side of

the viewer and change based on user interaction.

3. This screen style also has a Text Options tab, with multiple numbered fields, which

is used to define the text displayed as interactive bullets on the left side of the

viewer. These fields correspond with the Media fields of the same number (i.e.,

Text Option 1 corresponds with Media 1). Note: The Media tab is disabled when

the 100% Text, No Media options is selected. You may also click the Audio icon

to enter an audio file in each Text Option field. The Text Option field may contain

both text and audio. If no text accompanies the audio file, the play button displays.

 Note: Click the Add Text Option button to add more Text Options, up to a

maximum of fifteen. HTML tags can be inserted into the Text Options field, to

format text. To reorder Text Options fields, use the drag-handles on the top-left

of the Text Option field. To reorder the associated media at the same time as the

Text Options, be sure the Sync reorder with Graphics toggle is ON. To remove a

text option, click the Remove Text Option Icon. Note: Deleting a Text Option

does not delete its corresponding graphic. Graphics must be deleted separately. 
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4. Click the Collapsible Text button to display an HTML editor field, which you can

use to add optional hidden text, to be displayed when the corresponding Text

Option is clicked. You can also create hyperlinks within Collapsible Text that

activate changes in the media (i.e., swapping out the current image for the linked

image). See Add New Hyperlink for more information. 

5. When previewing this screen style, Main Text and Text Options are on the left

and the Default Graphic is on the right. Clicking a Text Options swaps the media

on the right, replacing the Default Graphic with the graphic that corresponds to

the selected Text Option. Note: When "100% Text, No Media" is chosen as the

layout, the text will fill the screen.  

Note: Hyperlinks can also be added to the Main Text area to activate changes in

the media (e.g., swapping out the current image for the linked image). Click the 

Link icon at the top of the Main Text window and follow the same procedure.
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Note: Links to swap media is currently supported only in the 3.17. 

6. Choose an option from the Type drop-down menu in the Link Properties window.

See Add New Hyperlink for more information. 

9.1.1.1.8  Stacked Layout (3.18)

Thumbnail Description

3.18 Stacked Layout. Displays multiple text blocks and media (png,

jpg,  gif,  mp4,  Unity  3D,  html,  PDF  and  Zoomify)  in  two  stacked

columns. Allows selection between these layouts:  "40% Text,  60%

Media", "50% Text, 50% Media" or "60% Text, 40% Media".

This screen style displays Text field with corresponding media assets in stacked columns.

User clicks anywhere on the screen to reveal a new row of text and media.  

1. In addition to the standard fields, including Main Text, this screen has a Media tab

that contains multiple Media fields, numbered one to nine. To reorder Media fields,
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use the drag-handles (top-left of field). Be sure the Sync reorder with Text

Options toggle is ON, if you wish to reorder the associated text field at the same

time. To remove a media asset, click the Delete Media icon. To add more media

(to a maximum of nine), click the Add Graphic button. 

Note: The Plotter Tool is also available for use with each Media field. See The Plotter

Tool for more information.

2. These fields function in the same way as the Media fields in the basic screen

styles described earlier. However, the media will be displayed on the right-side of

the viewer and remain on screen when the next row displays.

3. This screen style also has a Text tab, with multiple fields numbered one to nine,

which is used to define the text displayed on the left side of the viewer. These

fields correspond with the Media fields of the same number (i.e., Text 1

corresponds with Media 1). You may also click the Audio icon to enter an audio file

in each Text field. The Text field may contain both text and audio. If no text

accompanies the audio file, the play button displays. Note: Click the Add Text

Option button to add more Text fields, up to a maximum of nine. HTML tags can be

inserted into the Text field to format text. To reorder Text fields, use the drag-

handles on the top-left of the Text field. To reorder the associated media at the

same time as the Text fields, be sure the Sync reorder with Graphics toggle is

ON. To remove a text field, click the Remove Text Option icon. Note: Deleting a

Text field does not delete its corresponding graphic. Graphics must be deleted

separately. Note: Enter a value in the Desired Row Height field to set the row

height (100–900). If no value is entered the row height will adjust automatically.
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4. When previewing this screen style, Main Text displays above the stacked rows. In

the rows, the Text fields are on the left and the graphics are on the right. The

Indicator icons on the top-left of the screen represent the number of rows left to

display.

9.1.1.1.9  Build Slide (3.19)

Thumbn

ail

Description

3.19 Build  Slide.  Click  the  arrows  at  the  top  of  the  media  area  to  navigate

through up to 100 text  and/or media  options  in  a  slide  show  format  (png,  jpg,

gif, mp4 and HTML). The  text  options  can be  appended  or replaced.  Text-only

slides can be created by leaving the media file name blank, and then the caption

area will expand to fill the whole slide. Allows selection between these  layouts:

100% Media  Bottom",  "40% Text,  60% Media",  "50% Text,  50% Media",  "60%

Text,  40% Media",  "100% Text,  No  Media",  "Text,  Max 1/2 Media  Top",  "Text,

Max 2/3 Media  Top",  "Text,  Max 1/2  Media  Bottom",  or  "Text,  Max  2/3  Media

Bottom". Note: The screen ratio  for this  screen-style  refers  to  the  percentage

between the text options and media.

This screen style displays main text with text fields and associated media assets in a slide

show format. User clicks arrows at the top of the screen to reveal new text and media.  

1. In addition to the standard fields, including Main Text, this screen has a Media tab

that contains multiple Media fields, numbered 1 to 100. To reorder Media fields,

use the drag-handles (top-left of field). Be sure the Sync reorder with Text

Options toggle is ON, if you wish to reorder the associated text field at the same

time. To remove a media asset, click the Delete Media icon. To add more media
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(to a maximum of 100), click the Add Graphic button. 

Note: The Plotter Tool is also available for use with each Media field. See The Plotter

Tool for more information.

2. These fields function in the same way as the Media fields in the basic screen

styles described earlier. However, the media will be displayed on the right-side of

the viewer and change based on user interaction.

3. This screen style also has a Text tab, with multiple fields numbered 1 to 100,

which is used to define the text displayed on the left side of the viewer. These

fields correspond with the Media fields of the same number (i.e., Text 1

corresponds with Media 1). You may also click the Audio icon to enter an audio

file in each Text field. The Text field may contain both text and audio. If no text

accompanies the audio file, the play button displays. Note: Click the Add Text

Option button to add more Text fields, up to a maximum of 100. HTML tags can be

inserted into the Text field to format text. To reorder Text fields, use the drag-

handles on the top-left of the Text field. To reorder the associated media at the

same time as the Text fields, be sure the Sync reorder with Graphics toggle is

ON. To remove a text field, click the Remove Text Option icon. Note: Deleting a

Text field does not delete its corresponding graphic. Graphics must be deleted

separately. 
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4. When previewing this screen style, Main Text displays above the stacked rows.

The Text fields are on the left and the graphics are on the right. 

9.1.1.1.10  Grid Layout (3.20)

Thumbn

ail

Description

3.20 Grid  Layout.  Displays  multiple  text  and/or media  (png,  jpg,  gif,  mp4,  and

HTML)  blocks  in  a  grid  (columns  and  rows  format).  Text  and  media  may  be

aligned horizontally left, right or center) and vertically (top, middle and bottom).

Rows and columns can be added, copied or removed.

The Grid layout screen style allows the developer to present  main text  with text  or media

blocks in  a  grid  (columns  and  rows)  format.  User clicks  each grid  to  reveal new  text  or

media.  

1. In addition to the standard fields, including Main Text, this screen has a Grid tab

that contains the Add Column and Add Row buttons to create the grid. The

columns and rows can be collapsed, expanded and resized as required. They can

also be reordered using the drag-handles (top-left of field). 
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2. Click the empty grid and select the Media or Text radio button in the Content

field. If Media is selected, only media will display. The media fields function in the

same way as the Media fields in the basic screen styles described earlier. Note:

The Plotter Tool is also available for use with each Media field. See The Plotter

Tool for more information. If Text is selected, only text will display. HTML tags can

be inserted into the Text field to format text. The media or text content can be

aligned horizontally (left, right or center). The content can also be aligned vertically

(top, bottom or middle).

3. Click the Submit button to save the changes.

4. To copy a row below an existing row, click the Copy Row icon for the desired row

and then the Paste Row button. Note: If you wish to copy a column beside an

existing column, click the desired Copy Column icon and then click the Paste

Column button. Note: The new column will display to the right of the existing

column.
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5. To delete a column or row, click the corresponding Delete icon.

6. To resize the row or column, click the Row/Column Sizing button to open the

Row/Column Sizing window. Enter the desired dimension in the Row Height and

Column field(s) or leave the fields empty. Note: You may enter a percentage or

pixels in these fields. By default the columns will distribute evenly up to 100% (i.e.

If there are 2 columns, each column will take up 50% of the screen). When these

fields are left empty, the viewer will evenly distribute the rows and columns.

9.1.2 List of Legacy Screen Styles

Note: These are legacy screen styles, which are in the process of being replaced. Most  of

them are Adobe Flash-based screens that have been replaced by HTML versions, although

the  last  section consists  of  HTML-based  screens,  which are  capable  of  displaying  Flash

media assets.  The  Flash-based  graphic  screen styles  also  accept  .swf  Flash video  files.

Where  indicated,  the  interface  for editing  these  screens  is  similar  to  the  corresponding

HTML screens.
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Flash Instruction-Screen Styles

Text-Only Screen Styles

Thumbnail Description

1.01

text (100%), like 3.01 above

Graphic (and SWF) Screen Styles

Thumbnail Description

1.02

text (60%), graphic or video (40%), like 3.02 above

1.03

text (40%), graphic or video (60%), like 3.03 above

1.04

text (50%), panoramic graphic or video (50%)

1.06

panoramic graphic or video (50%), text (50%)

1.07

graphic or video (100%), like 3.07 above

Rich-Media Screen Styles

Thumbnail Description
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1.05

text (60%), video area with controls (40%), like 3.05 above

1.08

text (60%), flash video with controls (40%), like 3.05 above

1.09

flash video with controls (100%), like 3.09 above

1.20

video (100%), like 3.09 above

1.21

text (40%), video (60%), like 3.08 above

Interactive Styles

Thumbnail Description

1.10

text  (top  15%),  graphic  (50%),  5  bullets  w/text/graphic  highlight

(50%), like 3.10 above

1.11

text  (top  15%),  graphic  w/5 hotspots  (50%),  5  bullets  w/text,  5

hotspots w/graphic in pop-up (50%), like 3.11 above

1.12

text  (40%),  graphic  zoomify  (60%)  -  not  currently  supported  as

HTML-based screen
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1.13

graphic  zoomify  (100%)  -  not  currently  supported  as  HTML-based

screen

1.15

graphic slider (100%), like 3.15 above

1.17

text (top 15%), graphic (50%), 5 bullets w/text/graphic  (50%), like

3.17 above

Rich-Media Screen Styles (HTML Based)

Thumbnail Description

3.05

HTML text (60%), rich media (40%)

3.08

HTML text (40%), rich media (60%)

3.09

rich media (100%)

Graphic Screen Styles (HTML Based)

Thumbnail Description

3.01 HTML Only. 100% plain HTML text; the simplest screen style. 
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3.03 60% Media. Split horizontally, with 40% HTML on the left  and

60% media on the right. (All media types.)

3.07  Full-Screen  Media.  100%  media,  with  no  HTML  area.  A

caption  including  text  may  also  be  displayed  below  the  media

asset. (All media types.)

9.2 Question Screen Styles

The following screens  contain  a  list  of  the  standard  HTML-based  question screen styles

available,  followed  by  a  list  of  legacy  Flash-based  screen  styles.  Additional  details  are

provided  for the  HTML screen styles,  explaining  how  to  edit  the  fields  that  define  each

type of screen.

Note:  Most  question screen styles  have  in  common  the  basic  tabs  labeled  Main  Text,

Audio,  Audio  Narration,  Text  Options,  Feedback,  Tags,  Other  Details,  Security,

Pop-Up  Boxes  and  TDM  Integration.  Some  screens  have  additional  tabs  or  different

fields within the common tabs. See the information on Basic  Multiple-Choice Screen Style

first,  as  this  contains  the  basic  functionality  found  in  other  question  types.  Question

screens can be copied and pasted for ease of reuse. 

Note: Some of these screens permit  adding  multiple  Text  Options,  Graphics  or sets  of

Plot Coordinates, up to a maximum of nine.

Supported Files-Types

Graphic: jpg, png, gif, Zoomify, Giga, Unity 3D

Video: mp4, HTML5

Flash: Animate (html)

9.2.1 List of HTML Screen Styles

HTML Question-Screen Styles

Most  of the question screens that  accept  media assets only display  static  images,  apart

from 2.52, which can display any supported media type, including  Giga  Images  and  Unity

3D models, videos and Animate animations.
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Basic Styles (Multiple-choice)

Thumbnail Description

2.52  Multiple-Choice  with  Media.  Creates  either  multiple-choice

single-response  or  multiple-response  style  questions,  with  60%

media pane on the  right  (all  media  types),  and  up  to  nine  options

(text  and/or  audio).  Allows  selection  between  different  layouts:

"40% Text, 60% Media", "50% Text,  50% Media",  "60% Text,  40%

Media", or "100% Text, No Media" . Note: Default layout size is 50%

Text, 50% Media. 

2.54  Multiple-Choice  with  Graphic  Options.  User  clicks  one  or

more media assets for single-response or multiple-response question

(static graphic only).

2.55  Multiple-Choice  with  Hotspots.  User  clicks  one  or  more

hotspots  superimposed  on  media  asset  for  single-response  or

multiple-response  question  (static  graphic  only).  Allows  selection

between  different  layouts:  "40%  Text,  60%  Media",  "50%  Text,

50% Media",  "60% Text,  40% Media",  "Text,  Auto  Media",  "Text,

Max 1/2 Media" or "Text, Max 2/3 Media". Note: Default  layout  size

is 40% Text, 60% Media. 

Drag and Drop Styles

Thumbnail Description

2.58  Sequencing  Drag  and  Drop.  Drag  list  items  for  single-

response  sequencing  question  types.  Up  to  nine  draggable  list

items/audio files. Allows  selection between different  layouts:  "40%

Text,  60% List",  "50% Text,  50% List"  or  "60% Text,  40% List".

Note: Default layout size is 40% Text, 60% List. 

4.52  Drag  and  Drop  to  Image.  Drag  graphic  options  or  text

options to specified drop zones on a media  asset  for either single-

response,  multiple-response,  matching  or  sequencing  question

types.  Up  to  nine  draggable  items  (text/audio)  and  drop  zones

(static  graphic  only).  Allows  selection  between  different  layouts:

"40% Text, 60% Media", "50% Text,  50% Media",  "60% Text,  40%
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Media", "Text, Auto Media", "Text, Max 1/2 Media" or "Text, Max 2/3

Media". Note: Default layout size is 40% Text, 60% Media. 

4.55 Drag and  Drop  to  Text  Boxes.  Drag  graphic  thumbnails  or

text  boxes  with  text  labels  for  either  single-response,  multiple-

response,  matching  or  sequencing  question  types.  Up  to  nine

draggable items and drop zones, with optional randomization (static

graphic only).

Other Styles

Thumbnail Description

2.56  Fill-in-the-Blank.  User  types  in  a  short  response  to  a

question in a text  input  field or or up to  nine  short  responses  with

embedded  fill-in-the-blank  fields.  Optional  mask  can  be  displayed

showing some characters but not others (no media).

2.59  Fill-in-the-Blank  Mathematical.  User  types  in  a  short

response to a mathematical equation in a text input field or or up to

nine  short  responses  with  embedded  fill-in-the-blank  fields  (no

media).

2.57  Matching  Drop-Downs.  Can  be  used  to  create  pairing,

categorizing  (including  true-false),  or  sequencing  question  types.

Up  to  nine  text  options  and  unlimited  drop-down  items,  with

optional randomization. 

2.60  Full  Screen  3rd  Party  SCORM  Media.  For  example,  a

Storyline-published  question  would  use  SCORM  to  send  data  and

the question would act  like an LMS  and  record  the  answer.  Allows

selection between different  layouts: "40% Text, 60% Media",  "50%

Text,  50%  Media",  "60%  Text,  40%  Media",  or  "No  Text,  100%

Media". Note: Default layout size is No Text, 100% Media. 
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9.2.2 List of Legacy Flash-based Screen Styles

Flash Question-Screen Styles

Note:  These  are  legacy  Adobe  Flash-based  screen  styles,  which  are  in  the  process  of

being replaced by the HTML versions.

Basic Styles

Thumbnail Description

2.01

text, multiple choice with 5 options, like 2.51 above

2.02

text, multiple choice with 5 options, graphic, like 2.52 above

2.03

text,  multiple  choice  with  5 options,  video  with  controls,  like  2.53

above

2.04

text, multiple choice with 3 options with graphics, like 2.54 above

2.05

text, multiple choice, graphic with 5 hotspots, like 2.55 above

2.07

text, multiple choice  with  5 options,  flash video  with  controls,  like

2.57 above

2.53

HTML text, HTML multiple choice with 5 options, rich media



Learninglogics® LCMS 4.31 User Guide506

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

Drag and Drop Styles

Thumbnail Description

4.02

text, drag & drop 5 text options, graphic  with 5 draggable graphics,

like 4.52 above

4.05

text,  drag  &  drop  5  text  options,  5  target  text,  graphic  with  5

draggable graphics, like 4.52 above

Fill-in-the-blank Style

Thumbnail Description

2.06

text, fill in the blank, like 2.56 above

9.2.3 List of Legacy HTML Screen Styles

These  screen styles  are  no  longer selectable  when creating  a  new  screen,  but  existing

screens in these styles may still be edited and included in courseware. 

Thumbnail Description

2.51  Multiple-Choice.  Creates  either  multiple-choice  single-

response  or multiple-response  style  questions,  with  text  only,  and

up to nine options (no media). It is recommended that  users update

screens in this style to the 2.52 screen style.
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9.2.4 Basic Multiple-Choice Screen Style

Several of  the  question screen styles  are  designed  to  display  multiple-choice  (single  or

multiple-response) in the viewer. The simplest is 2.52, which consists of HTML text  and up

to nine multiple choice options. 

Thumbnail Description

2.52  Multiple-choice.  Creates  either  multiple-choice  single-

response  or multiple-response  style  questions,  with  text  only,  and

up  to  nine  options.  Includes  media  pane  on  the  right  (all  media

types).

Other  question-screen  styles  build  on  this  basic  functionality  by  adding  support  for

graphics, rich media, hot spots, and different screen layouts.

Note: Screen style 2.52 allows selection between these layouts: "100% Text, No Media",

"40% Text, 60% Media", "50% Text, 50% Media", or "60% Text, 40% Media".

1. In the Text Options tab, you may enter multiple Text Option fields, numbered one

to nine, containing text and/or audio options for the user to choose between. 

Note: Five Text Options are displayed by default, click the Add Text Option button

to add another option, up to a maximum of nine. The Text Options fields can be

re-ordered by clicking on the drag-handles on the top-left of the Text Option

field. 

2. You may click the Media tab to enter an image. Click the Plotter Tool button to

open a pop-up containing the Default Media, in which you can plot up to nine

areas of the image, depending on how many Text Option fields have been added.

Note: See The Plotter Tool for more information on this feature.

3. You may click the Audio icon to enter an audio file in each Text Option field. The

Text Option field may contain both text and audio. If no text accompanies the

audio file, the play button displays. 

4. Individualized feedback may be entered for each Text Option. To provide more

tailored feedback for each incorrect question response, click the Feedback icon

and enter the corresponding feedback.
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5. You may click the Correct Answer(s) checkboxes beside the Text Option fields

to indicate one or more correct answers. (If you select only one answer, the

question is treated as multiple-choice single-response, otherwise it is treated as a

multiple-response type question.) 

In Test Activities, if partial scoring is enabled, a Weighted Value may also be

entered by clicking the Text Options tab. Partial scoring can be used to calculate

the final mark of a test. 
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6. In the Media tab, you may select a graphic or rich media to display on the right

side of the multiple choice question in the viewer.

7. In the Feedback tab, you may enter custom feedback for correct or incorrect

questions.

Note: The functioning of the Feedback fields depends on whether the user is in a  lesson

(Independent Study or Instructor Led Lesson) or a Test  activity and whether one or more

fields have been defined for Incorrect Feedback.

If the question is used in a lesson, the user typically has two opportunities to obtain the

correct answer. Complete the Correct Feedback field (user answers question correctly),

the Incorrect Feedback 1 field (user answers question incorrectly on the  first  try),  and

the  Incorrect  Feedback 2 field  (user answers  question incorrectly  on the  second  try).

Note:  The  Incorrect  Feedback 1  text  displays  if  individualized  feedback has  not  been

entered  in  the  Text  Options  field.  Should  additional  feedback  fields  be  required  (i.e.,

Incorrect Feedback 3, Incorrect Feedback 4), click the Add More  Feedback button.

Up to a maximum of nine Incorrect Feedback fields my be added. The Feedback fields can

be re-ordered by clicking on the drag-handles on the  top-left  of  the  Correct/Incorrect

fields.

If the question is  used  in  a  Test  only,  the  fields  that  are  completed  will  depend  on the

test  functionality  options  chosen  when  the  activity  is  exported  from  the  LCMS.  The

following options are available:

1. If the option to have users review the questions they answered incorrectly will be

selected, complete the Correct Feedback field only.

2. If the option to have users re-do the questions they answered incorrectly will be

selected, none of the fields must be completed.

Note: See the section titled Screen List  (Topic  Screen)  for more  general information on

adding Question Screens and Instruction Screens.

9.2.5 More Multiple-Choice Screen Styles

Several  question-screen  styles  are  based  on  the  basic  multiple-choice  question  (2.52)

style, but introduce graphics, video or an alternative layout. 
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Thumbnail Description

2.54 Multiple-choice with Graphic Options. User clicks on one or

more  media  assets  for  single-response  or  multiple-response

questions (static graphic only)

2.55 Multiple-choice  with Hotspots.  User clicks  on one  or  more

hotspots  superimposed  on  media  assets  for  single-response  or

multiple-response questions (static graphic only)

Screen style 2.54 is also similar to 2.52 except that it replaces the Text Options with a

Graphics tab. This enables the developer to select up to nine graphic files as possible

answers to the question. Users click an image to answer the question. Individualized

feedback may be entered for each Graphic. To provide more tailored feedback for each

question response, click the Feedback icon and enter the corresponding feedback. In

Test Activities, if partial scoring is enabled in the Other Details tab, weighted values

may be entered in the Weighted Value fields. Partial scoring can be used to calculate the

final mark of a test.

The  correct  answer  is  indicated  by  selecting  one  or  more  checkboxes  beside  the

corresponding Graphic fields.

Screen style  2.55 is  similar to  2.52 except  that  in  addition  to  the  Graphics  tab,  which

allows the developer to select  a single  Default  Graphic,  it  also  has  a  Plotter Tool tab.

This enables the developer to map plot areas for hot spots on the Default Graphic, which

the user can click on in the viewer in response to the question. One or more hot spots can

be  selected  by  selecting  the  Correct  Answer(s)  checkboxes.  The  user  can  select

multiple  hot  spots  in  the  viewer  by  clicking  on  them.  Allows  selection  between  these

layouts: "40% Text, 60% Media", "50% Text, 50% Media", "60% Text, 40% Media", "Text,
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Auto Media", "Text, Max 1/2 Media" or "Text, Max 2/3 Media".

1. Click the Plotter Tool tab to open a pop-up containing the Default Graphic, in

which you can plot up to nine areas of the image, depending on how many Text

Option fields have been added. Note: See The Plotter Tool for more information on

this feature.

2. Select the number of the set of coordinates (1-9) from the drop-down in the

control panel and drag the mouse to define a rectangular area on the Default

Graphic. 

3. When you click Save, the coordinates of areas plotted in this way will be

automatically saved into the corresponding Coordinates fields of the Plotter Tool

tab. If you do not wish for the plotted areas to be visible to users in the viewer,

ensure the Show Highlights toggle is OFF. By default, plotted areas will be

highlighted in the viewer.

4. Click the checklist buttons to the right of the Coordinates fields to indicate one or

more Correct Answer(s) for this question.

5. Click the Feedback icons to the right of the Coordinates fields to provide

individualized, tailored feedback for each incorrect response to the question.

6. Enter a value in the Weighted Value fields (Test Activity only), if required. Note:

Partial scoring must be enabled in Other Details tab.

9.2.6 Drag and Drop Screen Styles

There  are  two  drag  and  drop  question-screen  styles,  which  are  configured  in  a  similar

manner.  
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2.58  Sequencing  Drag  and  Drop.  Drag  list  items  for  single-

response  sequencing  question  types.  Up  to  nine  draggable  list

items/audio  files  (no  media).  Allows  selection  between  different

layouts: "40% Text, 60% List", "50% Text, 50% List" or "60% Text,

40% List". Note: Default layout size is 40% Text, 60% List. 

Thumbnail Description

4.52  Drag  and  Drop  to  Image.  Drag  graphic  options  or  text

options to specified drop zones on a media  asset  for either single-

response,  multiple-response,  matching  or  sequencing  question

types.  Up  to  nine  draggable  items  and  drop  zones  (static  graphic

only).

4.55 Drag and  Drop  to  Text  Boxes.  Drag  graphic  thumbnails  or

text into boxes with text  labels for either single-response, multiple-

response,  matching  or  sequencing  question  types.  Up  to  nine

draggable items and drop zones, with optional randomization (static

graphic only).

Screen Style 2.58

Note:  Screen style  2.58 allows  the  developer to  define  short  pieces  of  text  (words  or

phrases) and/or audio and their correct  order a  list.  Screen style  2.58 does  not  support

media.

Note: Screen style 2.58 allows  selection between these  layouts:  "40% Text,  60% List",

"50% Text, 50% List", "60% Text, 40% List".

Screen  2.58  includes  the  standard  question-screen  fields,  with  the  exception  of  the

Graphics and Text Option tabs.

1. The List Items tab has multiple List Item fields and corresponding Select Order

fields, numbered one to five (only two are shown here). You may click the Audio

icon to enter an audio file in each List Item field. The List Item field may contain

both text and audio. It cannot contain audio only. Note: Click the Add List Item

button to add more list items and select order fields, up to a maximum of nine. To

reorder List Item fields, use the drag-handles on the top-left of the field. To

remove a list item, click the Remove List item icon. Note: Enable Do not

randomize, use selected order by clicking the checkbox. Note: If randomization

is turned on, the Select Order fields do not display.
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2. You may also enter weighted values in the Weighted Value fields, if partial scoring

is enabled (Test Activity only).  

Screen Style 4.52

Note: Screen style 4.52 allows the  developer to  define  either  images  or short  pieces  of

text (words or phrases) and/or audio that can be dragged onto the target image.

Note: Screen style 4.52 allows selection between these layouts: "40% Text, 60% Media",

"50% Text,  50% Media",  "60% Text,  40% Media",  "Text,  Auto  Media",  "Text,  Max  1/2

Media" or "Text, Max 2/3 Media".

1. In addition to the standard question-screen fields, screen 4.52 has a Graphics tab

with a Default Graphic and multiple Graphic fields, numbered one to five. To

reorder Graphic fields, use the drag-handles (top-left of field). Be sure the Sync

reorder with Text Options toggle is ON, if you wish to reorder the associated text

options at the same time. To remove a graphic, click the Remove Graphic icon. To

add more graphics (to a maximum of nine), click the Add Graphic button. 
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2. Select a Default Graphic to display to the right of the viewer, which will be the

area into which the student drags and drops their responses.

3. The Graphic fields define the images that will be displayed on the left of the

viewer, which the student may drag and drop in order to answer the question. By

default, the Scaled to text option # checkbox is selected. Remember to deselect

the checkbox if you do not want the image to scale to the drop area. Select the 

Show Border checkbox to display a border around the graphic. By default, graphics

(including graphics with a transparent background) are displayed without a border.  

4. The question screen Text Options tab contains multiple Text Option fields,

numbered one to five, which correspond with the Graphic fields (i.e. Graphic 1 is

displayed beside Text Option 1 and should be dropped in the area defined by Plot

Coordinates 1 for a correct response). You may click the Audio icon to enter an

audio file in each Text Option field. The Text Option field may contain both text

and audio. If no text accompanies the audio file, the play button displays.

Individualized feedback may be entered for each Text Option. To provide more

tailored feedback for each incorrect question response, click the Feedback icon

and enter the corresponding feedback. You may also enter weighted values in the 

Weighted Value fields, if partial scoring is enabled (Test Activity only). Note: If

the Graphic fields are blank, the text in the Text Options fields will be rendered in

draggable boxes, allowing the user to drag text labels to the image. The audio file is

not draggable. Note: Click the Add Text Option button to add more Text Options,

to a maximum of nine. To reorder Text Options fields, use the drag-handles on the

top-left of the field. To reorder the associated media at the same time, be sure

the Sync reorder with Graphics toggle is ON. To remove a text option, click the

Remove Text Option icon. To highlight regions on the Default Graphic where

options may be dragged when the question is displayed in the viewer, ensure the 

Show Drop-Zones toggle is ON. Note: Deleting a Text Option does not delete its

corresponding graphic. Graphics must be deleted separately. Plot the coordinates

on the Default Graphic using the Plotter Tool at the top of the screen. See The

Plotter Tool for more information.
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5. The Correct Answer checkboxes are used to indicate whether the user is

expected to drop the corresponding graphic there or not.

Note: The Text Options on this screen are  displayed  beside  the  corresponding  graphics

to  be  dragged  and  remain  in  that  position  unless  the  Graphics  fields  are  left  blank,  in

which case the Text Options will appear as draggable text  labels. The audio file  entered

in Text Options is not draggable.

Note: This screen style can be used for matching type questions, but  it  can also be used

to create a multiple-choice type  question by  defining  the  plot  area  as  the  whole  of  the

Default Graphic and selecting one correct answer, which has to be dragged into it.

Screen Style 4.55

3. Screen style 4.55 is a drag and drop multiple-choice question similar to 4.52,

except that text or graphics are dragged into blank boxes with text labels. The 

Graphics tab does not have a Default Graphic field because the text or graphics

are dragged and dropped into boxes rather than onto a larger image. To reorder

Graphic fields, use the drag-handles (top-left of field). Be sure the Sync reorder

with Text Options toggle is ON if you wish to reorder the associated text options

at the same time. Select the Show Border checkbox to display a border around

the graphic. By default, graphics (including graphics with a transparent background)

are displayed without a border. To remove a graphic, click the Remove Graphic

icon. To add more graphics (to a maximum of nine), click the Add Graphic button. 
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4. The Text Options tab has multiple Text Option fields and corresponding Target

fields, numbered one to five (only two are shown here). You may click the Audio

icon to enter an audio file in each Text Option field. The Text Option field may

contain both text and audio. If no text accompanies the audio file, the play button

displays. Individualized feedback may be entered for each Text Option. To provide

more tailored feedback for each incorrect question response, click the Feedback

icon and enter the corresponding feedback. Note: Click the Add Text Option

button to add more text option and target fields, up to a maximum of nine. To

reorder Text Options fields, use the drag-handles on the top-left of the field. To

reorder the associated media at the same time, be sure the Sync reorder with

Graphics toggle is ON. To remove a text option, click the Remove Text Option

icon. Note: Deleting a Text Option does not delete its corresponding graphic.

Graphics must be deleted separately. 

5. The checkbox labelled "Randomize target text at run-time" allows the user to

toggle randomization on and off. Note: For questions that involve ordering

draggable items into a sequence, randomization will need to be turned off. For

instance, stages in a process into chronological order, or ranking items in order of

importance.
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6. The Text Option field on the left appears on the left-side of the viewer, beside the

corresponding Graphic to be dragged. Note: If no graphics are defined, the Text

Option text will be draggable. This allows the developer to enter words or phrases

that can be dragged and dropped onto the target image. The audio file entered in

Text Options is not draggable.

7. The Target for this Option field contains a drop-down that allows the developer to

select the correct response by indicating the Target Text, which the user should

drag the Text Option onto. Choose "No selection" from the drop-down to create a

distractor, a potential response which is not part of the correct answer. Note: This

allows a many-to-one relationship between draggable items and drop-zones. So

multiple items can be dropped in the same target, e.g. allowing the developer to

create sorting or categorizing questions in which multiple items are sorted into two

or three categories. Multiple true-false questions can be created this way by

defining Target 1 as "true" and Target 2 as "false", and placing statements in the

Target Options fields, which the user can categorize accordingly. You may also

enter weighted values in the Weighted Value fields, if partial scoring is enabled

(Test Activity only).

Examples 

One-to-one Matching (Pairing): For a simple one-to-one pairing exercise, create

a different Text Option item for each Target Text (4.55) or Plot Coordinate

(4.52). You may also want to add additional Text Options as distractors. 

Ordering or Sequencing: To create an ordering (or sequencing) type exercise

using screen style 4.55, simply create Target Text with names that represent the

order, such as "First", "Second" and "Third", or "Before", "During" and "After", etc. 
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Note: Make sure that randomization is turned off if you intend to create an ordering

type question. 

Many-to-one (Sorting): To create a sorting (or categorizing) type exercise, like

sorting multiple items into two columns, using screen style 4.55, simply create two 

Target Text items (such as "safe" and "unsafe" or "weekly" and "monthly"). There

can be a many-to-one relationship between Text Options and Target Text, i.e.

you can assign the same Text Option as the correct answer for more than one

Target Text. 

True or False: You can create "true" or "false" type questions in this way, as a

many-to-one type exercise, by creating two Target Text fields labeled "true" and

"false" and assigning them to up to five statements in the Text Options fields. You

can think of this as sorting the Text Options into two (or more) categories.

9.2.7 Fill-in-the-Blank Screen Styles

Question-screen  type  2.56,  fill-in-the-blank,  is  very  different  from  the  multiple-choice

ones. 

Thumbnail Description

2.56  Fill-in-the-blank.  User  types  in  a  short  response  to  a

question in a text  input  field or or up to  nine  short  responses  with

embedded  fill-in-the-blank  fields.  Optional  mask  can  be  displayed

showing some characters but not others (no media).

1. In addition to the standard question fields, it has a Fill in Blank field, which

contains fields entitled Expected Answer(s), Input Mask and Weighted Value

(Test Activity only). 
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2. The Expected Answer(s) field contains the word or phrase the user must enter to

have the question marked correct.

3. Multiple correct answers can be specified by separating them with the tilde (~)

character, e.g., there may be several acceptable ways to spell an answer such as

"gray" or "grey". 

4. The Input Mask field is optional and if left empty, the user will be allowed just to

enter free text as normal to submit their response in the viewer.

5. However, if you include an input mask in the format E*******h, the student will

be presented with an input control that already has the specified letters but

expects them to fill in the missing letters indicated by the mask character (*).

Note: If using an input mask, the number of characters must be identical to the number of

characters  in  the  Expected  Answer  field.  You  therefore  cannot  combine  multiple

expected answers of different lengths with a single input mask.

Up to nine Fill in Blank fields can be added to a question that  requires multiple answers.

To add more than one field:

1.  Click the Fill in Blank tab.

2.  Click the Add Additional Input button. A new Fill in Blank input will appear.

Note: inputs can be reordered by clicking and dragging an input's Drag Handle or

deleted by clicking the Remove Input icon next to the input.

3.  Enter the Expected Anwer(s) and Input Mask, if desired.

4.  Enter a value in the Weighted Value fields (Test Activity only), if desired. Note:

Partial scoring must be enabled in Other Details tab. 

5.  Click the Main Text tab.

6.  Click the text area. The text editor will open in a modal dialog.

7.  Place the cursor in the text where you wish to insert the input field and click the 

Insert Input button in the text editor toolbar.
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8.  Select a Fill in Blank input to insert from the drop-down.

9.  Click the Ok button.

Note: When inputs are reordered or removed in the Fill in Blank tab, the Main Text

inputs will be updated automatically to reflect the changes.

9.2.8 Fill-in-the-Blank Mathematical Screen Style

Question-screen  type  2.59,  fill-in-the-blank,  is  very  different  from  the  multiple-choice

ones. 

Thumbnail Description

2.59  Fill-in-the-blank.  User  types  in  a  short  response  to  a

mathematical  equation  in  a  text  input  field  or  up  to  nine  short

responses  with  embedded  fill-in-the-blank  fields  (no  media).  The
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inputs may be reordered or removed as requested.

1. In addition to the standard question tabs, this question style has a Formulas tab,

which contains fields entitled Parameters, and Answer Formula. Up to nine Fill in

Blank fields can be added to a mathematical question that requires multiple

answers. Note: When more than one formula is used, all responses must be correct

for the question to be correct.

2. On the Parameters pane, enter the desired parameter name in the Name field.

You may enter up 50 parameters. Note: The curly brackets do not need to be

entered in this field.

3. Enter the desired range of values in the Min and Max fields (i.e. If the desired

number range is between one and ten, enter 1 in the Min field and 10 in the Max

field. The numbers within this range of numbers will randomly be chosen when the

question is displayed in the browser.  

4. If the number range needs to include decimal numbers enter the desired decimal

placement in the Dec field (i.e. To have the number range [1–10] display with

decimal numbers [1.1 – 10.9], enter 1 in the Dec field). 

5. Click the Add Parameter button to add up to 50 parameters. The Parameters

fields can be re-ordered by clicking on the drag-handles on the top-left of the 

Parameter field.
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6. On the Answer Formulas pane, enter the desired mathematical equation that will

be used to generate the correct value. Note: The parameters must be entered in

curly brackets {a}{b}.

7. Enter the desired tip in the Input Tip field. Note: You can use this field to convey

additional information about the input. This text will appear when the question is

displayed in the browser.

8. Enter the desired tolerance (+/-) value in the T field, if required. 

9. Enter the desired decimal placement in the D field, if required.

10. Click the Add Formula button to add up to nine formulas. The Formula fields

can be re-ordered by clicking on the drag-handles on the top-left of the Formula

field.

11. Click the Save button to save the changes.

9.2.9 Matching Screen Style

The  matching  screen  style  (2.57)  is  very  versatile  because  it  allows  one-to-one  and

many-to-one matching, and can also be used for sequencing (ordering) type questions. 
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Thumbnail Description

2.57  Matching  Drop-downs.  Can  be  used  to  create  pairing,

categorizing (including true-false) or sequencing question types. Up

to  nine  text  options  and  unlimited  drop-down  items  with  optional

randomization (no media). 

1. In the Option Choices tab, you can configure the list of options that appear in the

drop-down menu in the viewer beside each Text Option. Note: Click the Add New

Choice button in the Option Choices tab to add more Option Choices, up to a

maximum of nine. The Choice fields can be re-ordered by clicking on the drag-

handles on the top-left of the Choice field.

2. Click the checkbox labeled Randomize Choices to toggle randomization on and

off, which will change the order the items are displayed in in the viewer's drop-

down list.

3. Click the Delete icon to remove any unwanted items from the list.
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4. In the Text Options tab, you may enter multiple Text Option fields, numbered one

to five, which will appear on the left of the viewer as text against which the

correct item from a drop-down must be matched. Note: Click the Add Text Option

button to add more Text Options, up to a maximum of nine. You may click the

Audio icon to enter an audio file in each Text Option field. The Text Option field

may contain both text and audio. If no text accompanies the audio file, the play

button displays. Individualized feedback may be entered for each Text Option. To

provide more tailored feedback for each incorrect question response, click the 

Feedback icon and enter the corresponding feedback. In Test Activities, if partial

scoring is enabled in the Other Details tab, weighted values may be entered in

the Weighted Value fields. Partial scoring can be used to calculate the final mark

of a test. The Text Options/Feedback fields can be re-ordered by clicking on the

drag-handles on the top-left of the Text Option/Correct/Incorrect fields.

5. The list items you defined in the Option Choices tab will appear in the drop-downs

in the Text Options tab, in the Correct Answer(s) column. Select the correct

answer for each Text Option.

6. Click the checkbox labeled Never Randomize to override any activity settings

than may cause text options to be randomized. This will cause text options to

always be displayed in the same order in the viewer.

Examples

One-to-one Matching (Pairing): For a simple one-to-one pairing exercise, create

a different Option Choice list item for each Text Option. You may also want to

add additional Option Choices as distractors. 

Ordering or Sequencing: To create an ordering (or sequencing) type exercise,

simply create Text Options with names that represent the order, such as "First",
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"Second" and "Third", or "Before", "During" and "After", etc. Note: Make sure that

randomization is turned off if you intend to create an ordering type question. 

Many-to-one (Sorting): To create a sorting (or categorizing) type exercise, like

sorting multiple items into two columns, simply create two Option Choices (such as

"safe" and "unsafe" or "weekly" and "monthly"). There can be a many-to-one

relationship between Text Options and Option Choices, i.e. you can assign the

same Option Choice as the correct answer for more than one Text Option. 

True or False: You can create "true" or "false" type questions in this way as a

many-to-one type exercise, by creating two Option Choices labeled "true" and

"false" and assigning them to up to nine statements in the Text Option fields. You

can think of this as sorting the Text Options into two (or more) categories.

9.2.10 3rd Party SCORM Media Screen Style

The full screen 3rd party SCORM media screen style (2.60) allows you to upload 3rd party

question content and have the results tracked and recorded using SCORM.

Thumbnail Description

2.60  Full  Screen  3rd  Party  SCORM  Media.  For  example,  a

Storyline published question would use SCORM to send data and the

question would act like an LMS and record the answer. There is also

the option for HTML text (up to 60%). 

The 2.60 Question Style has tabs for Audio, SCORM Media, Tags/Categories, Other

Details, Security and Pop-Up Boxes. 

1. In the SCORM Media tab, click Select to upload an available media file. If your

media is not complete yet, click Description and enter the filename in the

Requested Filename field. You may also wish to include the media description in

the Description field for review purposes. 

2. In the Answer field, add the SCORM values expected, based on cmi runtime data
elements. It will use values from cmi.completion_status (complete/incomplete) or
cmi.success_status. (passed/failed).
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3. Click Save.

9.3 Save (Screen)

Both Question and Instruction screens consist of multiple fields, divided across several

tabs. These fields can be completed all at once or you can return to screens later to

complete empty fields or revise existing field data.

9.3.1 Save Screen

1. To save a screen, click the Save button at the top of the screen. 



Screen Styles (Question and Instruction Screens) 527

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

Note: Each time a new instruction screen has been saved, it will be added to the bottom

of the Screen List screen. Question Screens are added to the Question Bank.

Note: If a screen is already being accessed by another user, you will receive a warning

message like the one below, telling you who accessed the lesson and at what time. You

will not be allowed to make any changes if the screen is already in use.
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9.3.2 Autosave Screen

Screens can be set  to save automatically in the background. This  feature  is  available  to

Developers only. 

1. Click the drop-down arrow beside the Save button at the top of the Screen

Details screen. You will see a checkbox with labeled Auto Save.

2. Check or uncheck the box to toggle the Auto Save function on or off. When Auto

Save is turned on, edits are saved at one-minute intervals. The button text will

change to indicate that Auto Save is currently turned on.

Note: The Auto Save feature will  only  save  fields  that  contain  valid  content.  If  certain

fields cannot be auto saved, a warning message will appear at  the top of the screen that
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says  "For  Your  Attention:  Changes  were  saved  with  the  exception  of  the  following

issues:", followed by a list of fields that could not be saved and the reasons.

9.3.3 Navigating Away from Unsaved Screen

The LCMS will try to prevent  users from losing content  by  navigating  away  from screens

containing unsaved work.

If  you  make  changes  to  a  screen  which  have  not  been  saved  and  click  on  a  link  to

navigate to another screen, a warning message will be displayed.

If  you click the  Yes  button  your  work  will  be  saved.  If  you  click  the  No  button  your

changes will be discarded. In either case, you will now navigate away from the screen to

the screen you selected. You may also click the small x or Close icon in the top-right  of

the dialogue box, if  you want  to cancel the  navigation and  return to  the  current  screen

without saving anything.

9.4 Preview (Screen)

Once a question or instruction screen has been saved, you will be able to preview it  in a

separate browser window, while you continue editing in the main window.  

1.Click the Preview Screen button at the top of the Screen Details screen.
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2. The current screen will open in a separate browser window using the selected

interface. If an interface has already been selected at the Activity level, it will

automatically launch when you click the Preview button on the Screen Details

screen. Otherwise, a dialogue box will appear asking you to select an interface. 

Click the checkbox to enable Use as default Interface for Instructor Led Lesson

Activity types. Note: Leave this unchecked if you do not want all Instructor Led

Activity types to have the same interface. 

3.  Click Tag Filtering to include/exclude screens with specifics tags.

Tip: To see the media size and filename at the top of the media area in Preview, click

anywhere onscreen, then use the keyboard shortcut CTRL+Alt+Shift+S.

9.5 Change Screen Style

Once you have saved an instruction or question screen, you have the option of changing

screen styles.  Note: Changing screen styles may  potentially  lead  to  the  loss  of  data  in

fields that are not supported in the target screen style. 

Also,  if  the  previous  screen  contained  links  that  do  not  function  with  the  new  screen

style, the link will show with a red box around it  (in the new screen) and you will see this

message:
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9.5.1 Change Instruction Screen Style

1. Click the Change Screen Style button.

2. From the Change Screen Style screen, select the screen style you wish to

change to by clicking on the thumbnail image.
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3. A window will appear asking if you are sure you want to change the screen style.

Click OK.

9.5.2 Change Question Screen Style

To access a question in order to change its screen style, you can go through the 

Question Bank or click the question from within an activity.

1. On the Question Bank screen, locate the question you wish to change using the
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Search function, then click the Edit icon (pencil) beside the question you wish to

change.

2.   Click a question within an activity to open the Question Details screen. Then,

click the Edit button.

3. The question content window appears. Click the Change Screen Style button to

access the screen style options.
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4. The Change Screen Style screen appears. Click a thumbnail to change the screen

style.

5. A window appears asking if you are sure you want to change the screen style.

Click OK or Cancel.

9.6 Copy Screen

Once  a  question or instruction screen has  been saved,  you will  be  able  to  copy  it  into

another topic or activity.

1.  Click the Copy Question button at the top of the Screen Details screen. A

clipboard icon will appear at the top of the Navigation Tree to the left.
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2.View the topic or activity where you wish to paste the copied screen.

3.  Click the Paste Screen button at the topic of the topic or screen list view.

9.7 Main Text (Tab)

1. Click in the Main Text field on the first tab below the Screen Title to open the

HTML editor.

2. Modify and edit the text using the toolbar located at the top of the editor. The

toolbar has standard rich-text editing features that will be familiar to anyone who

has used a word processing program like Microsoft Word.

3. Click the Save button at the top of the screen to save the information you enter in

screen fields.

Note: The Main Text area, like some other fields, uses an embedded HMTL editor

called CKEditor. See the section titled The HTML Editor for more information on

entering text and HTML content.
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9.7.1 Screen Title

If  the  LCMS  is  configured  to  enable  the  Screen Title  field,  Developers  and  other  users

who have the appropriate editing privileges to create screens will be able to edit the title. 

Note: If this setting is not  enabled, Screen Titles will be hidden and users will be unable

to edit them.

9.7.2 Screen Prompt

Note: Text Prompts are used for Independent Study activity type only. Both question

screens and instruction screens within Independent Study activities have prompts.

Text prompts provide directions for students using the screens in the courseware. The

prompt that you will select depends upon the screen style you have developed. For

example, if you have used a screen style that contains a movie, the standard prompt will

be: "Click the play arrow to watch the movie, then click the right arrow to continue." See 

Manage Screen Prompts for more information on creating, editing and deleting prompts.

All of the prompts are predefined in the Prompt Manager, so the selection process is

straightforward. To select text prompts:

1. Click the Prompt drop-down list and select the appropriate prompt.
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2. Click the Save button at the top of the screen when you have completed all

desired screen fields. The prompt now associated with this screen will be displayed

in the activity storyboard.

9.8 Audio (Tab)

Audio can be added to both instruction and question screens, depending on the screen

type. Note: See the sections on Question Screen Styles and Instruction Screen Styles for

more information.

To add audio files:

1. Select the desired screen, then click the Audio tab.
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2. To add a description of the media file required, click the Description button and a

window will appear. 

3. Enter a description for the required media and its filename in the Media

Description and Requested Filename fields. Click Submit to save, or Cancel to

exit without saving. Note: This information may be visible in the storyboard report.

4. You may also enter up to 2000 characters for Audio Narration in the field at

bottom of the Audio tab.

5. Click the Select button on the Audio tab to select a media file, if one is available.

This will open a pop-up window of the Media Library, where you can search for

and select media files. See the section titled Media Library files for more

information. 

9.9 Media (Tab)

Graphics can be added to both instruction and question screens, depending on the 

Screen Style. Note: See the sections titled Question Screen Styles and Instruction

Screen Styles for more information. Note: Graphics can also be added inline using the
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CKEditor toolbar buttons in most HTML fields.

Note: The number of fields in the Media tab will depend on the screen style selected. For

example, the 2.52 Multiple-Choice question style requires the use of three graphics,

while you can include up to nine graphic thumbnails and a default graphic for the 4.55

Drag and Drop question style.

To add graphic files:

1. Select the desired screen, then click the Media tab.

2. Click the Description and Caption buttons to make these fields visible. Note: If

content has been placed within a Description or Caption field, the corresponding

button will change appearance to include a pencil icon. Click the Caption button to

display the Caption field, where you can enter HTML which will appear under the

graphic in the viewer. Note: Hyperlinks and inline images may also be entered in

the Caption field using the HTML editor. 

3. The Description button brings up fields for Media Title, Requested Filename and

Description, where you can enter all required media information. Note: The Media

Title field is superimposed on the image when it is rendered in the viewer. Also,
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once you have entered a requested filename and clicked Save, this filename will

appear in the media filename field with the prefix "Requested Filename -". 

Tip: When previewing a screen, use the keyboard shortcut CTRL+Alt+Shift+S to

bring up the media filename at the top of the media area. Be sure to click the text

area on the left first.

 

4. Click inside the Description field to open a separate window for adding a media

description (used for review and media development). Click Submit once the

description is complete. Note: The Description will be displayed in the media area

onscreen if no media file is available.
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5. If the media you wish to add is already available, click the Select button on the

Media tab to open a pop-up window for the Media Library. Here you can search

for and select media files (see Media Library for more information). The name of the

selected file will appear in the field on this tab once selected. Click the Clear

button if you need to remove the filename from this field.

Note: If a Giga Image Viewer, Modest Tree or Zoomify file is selected from the Media

Library, a Settings button will be visible on the Media tab instead of the Plotter

Tool, which is available with graphic file types (jpg, png and gif). Click Settings to

display the settings screen and preview. Giga Image Viewer, Modest Tree 3D Explorer
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and Zoomify Settings are described in the following pages, along with the Plotter

Tool.

Note: When an HTML file is selected from the Media Library, you will have the ability

to enter Javascript and set a default state. Click the Custom Javascript button to

open this field. Select an option from the Default State drop-down menu to set the

default state. A hyperlink can be added in the  to display the media at a different

state (see Hyperlink to HTML Graphic) . 

Note: When a PDF file is selected from the Media Library, parameters can be set

using the PDF Parameters field. For example, you may specify a named destination

in the PDF or a numbered page. 

nameddest=name - specifies a named destination in the PDF.

page=pagenum - specifies a numbered page in the document, using an integer

value. The document’s first page has a pagenum value of 1. 
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9.9.1 Giga Image Viewer Settings

1. Click the Settings button in the Media tab to configure the states of a Giga Image

Viewer file for the current screen. The Giga Image Viewer states are configured

using the navigation buttons at the bottom of the preview and other controls.

2. Click the name of a state to select it from the drop-down labeled Select a State.

3. Click the Delete State button to remove a state.

4. Click the New State button to create a state.

5. Click the Edit Label button end enter a new value to change the name of a state.

6. Click the Default checkbox to toggle whether the currently-selected state is the
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one that will be shown first, by default, in the viewer.

7. Zoom in and out using the scroll wheel (if you have one) on your mouse, or click on

the magnifying glass icons to zoom in and out in stages.

8. Click and hold down the mouse-button on the arrow buttons to pan up, down, left,

or right.

9. Click the dot button to zoom as far out as possible, or the crosshair button to

zoom as far in as possible.

10. Click the mouse button and hold to drag the image around the viewport.

11. Double-click part of the image to center the viewport on it.

12. Click the thumbnail in the bottom-right corner of the preview, to move around the

viewport.

13. Click the Hotspot Editor button to open a new dialogue box in a pop-up window

that will allow you to edit hotspots and create states for hotspots in the Giga

Image Viewer.

14. Click the Save State button to save a state. Note: It's important to save a state

before switching to view another state or leaving this editing screen, otherwise you

may lose your changes.

15. Click the Save & Exit button to save your changes and return to the LCMS

screen editing screens or click the Close icon in the top-right of the browser

window to exit without saving.

Note: You can create hyperlinks that allow users to navigate between different Giga

Image Viewer states in the lesson. See Hyperlink to Giga Image State for more

information. 

This is an optional feature. For more information, please contact 

learninglogics-support@bluedrop.com. 

9.9.1.1 Giga Image Viewer Hotspots

1.Click on the Hotspot Editor button in the Giga Image Viewer Settings to open

the Hotspot Editor screen in a new pop-up window.

mailto:learninglogics-support@bluedrop.com
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2. Enter the name of a new hotspot in the Name field or select an existing one from

the drop-down menu, if available.

3. Set the Hotspot Location by clicking the Record Location button and then

panning and zooming to the required location in the Giga Image Viewer Settings

window. Click where you want the hotspot to appear and the X and Y fields will

automatically be populated with the coordinates. Click Stop Recording when you

have the correct coordinates. Note: Although you can type in X and Y values

manually it's unlikely you'd ever want to do this.

4. Enter the title you want to appear at the hotspot using the Label field.

5. Select the position of the Label of the hotspot (left, right, top, bottom, etc.) using

the Label Positioning drop-down menu. Note: The default is left.

6. Enter any content you want to appear at the hotspot using the Content field.

Note: As this field uses the HTML editor, you can embed an image, which will be

displayed within the Giga Image Viewer.

7. Select the position of the content relative to the Label of the hotspot (left, right,

top, bottom, etc.) using the Content Positioning drop-down menu.

8.Click Save Hotspot to save the hotspot or Remove Hotspot to delete it, or quit

without saving.
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9.9.2 Modest Tree 3D Explorer Settings

1. Click on the Settings button in the Media tab to configure the states of a Modest

Tree 3D Explorer file for the current screen. The 3D Explorer states are configured

using the navigation buttons at the bottom of the preview and other controls.
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2. Click on the name of a state to select it from the drop-down labeled Select a

State.

3. Click the Delete State button to remove a state.

4. Click the New State button to create a state.

5. Click the Edit Label button end enter a new value to change the name of a state.

6. Click the Default button to toggle whether the currently selected state is the one

that will be shown first, by default, in the viewer.

7. Zoom in and out using the scroll wheel (if you have one) on your mouse.

8. Click on a part of the model to select and highlight it, or click on its label in the list

on the left.

9. Double-click on part of the model to center the viewport on it.

10. Hold down the CTRL key on your keyboard and the mouse button simultaneously

to drag and drop a part of the model.



Learninglogics® LCMS 4.31 User Guide548

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

11. Click the X-Ray button to toggle x-ray view on and off for the whole model.

12. Click on the Labels button to toggle labels on and off for the whole model.

13. Click the Reset button to restore the state to its original configuration.

14. Click the Animation button to configure animation for the state. Animation

controls will be displayed, including a drop-down for the animation type, drop-down

for speed, drop-down for repeat-style (play once, loop, or ping-pong), Play button,

and scrub bar. Note: You must have pressed Play and be currently watching the

animation when you click Save State for the animation to be saved as the state.

15. Click the Expand button to configure expand for the state. An Expand Method

drop-down will be displayed and a scrub bar, which allows you to set the degree of

expansion.

16. Click the Custom button to configure custom states.

17. Right-click your mouse on the label for a component or group to display a context

menu with the options Focus, Isolate, Toggle X-Ray, Toggle Label, and Toggle

Visibility. These changes will be applied only to the selected component or group.

18. Click the Save State button to save a state. 

19. Click the Save & Exit button to save your changes and return to the LCMS

screen editing screens or click the Close icon in the top-right of the browser

window to exit without saving. Note: Modest Tree Unity media now uses the

browser local storage to save your editing session until you click Save & Exit. This

will allow you to reload the saved session, should a crash occur. When you re-open

the Settings window, you will be presented with a confirm dialog to load the

previous session. Click OK to load the states from your previous session.
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Note: You can create hyperlinks that allow users to navigate between different 3D

Explorer states in the lesson. See Hyperlink to 3D Explorer State for more information. 

This is an optional feature. For more information, please contact

learninglogics-support@bluedrop.com. 

9.9.3 The Plotter Tool

The Plotter Tool button is available within several screen styles and also within the Edit

Pop-Up Box window. The tool can be used to plot hotspots/highlights and labels on static

graphics, some of which can be linked to Text Options on the screen. 

The functionality of the Plotter Tool varies, depending on the screen style. For example:

3.02, 3.04, 3.06, 3.15, 3.18, 3.20:  Hotspots/highlights can be added, along with

text labels with arrows. Options are not associated with any of these elements.

2.52, 3.10, 3:17, 3.19,  Media with Highlights: Linking a highlight to a Text

Option or Link in the Main Text area means that the highlight will only become

visible when the student clicks on the Text Option or Link. Text labels with arrows

can also be added. 

3.11 Media with Hotspots: Linking a highlight to a Text Option means that

clicking on either the highlight or the Text Option will cause an associated pop-up

window to be displayed containing text and/or another image. (Alternatively, an

image may be used to replace the Default Graphic, which can be used to simulate

a basic control panel.)  Text labels with arrows can also be added.

2.55 Multiple-choice with Hotspots: Linking a highlight to a Text Option means

mailto:learninglogics-support@bluedrop.com
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that students will be able to click on one or more highlights to select them as

responses to the multiple-choice question.  This screen style cannot have text

labels or lines added.

4.52. Drag and drop to Image: Can add highlight but not text labels or lines. 

Note: The Plotter Tool button for this screen style is available with the graphic on

the Graphic tab and on the Text Options tab.

9.9.3.1 Draw Highlights/Hotspots

The Plotter Tool allows you to draw highlights/hotspots as rectangles, circles, ellipses,

polygons and lines (with or without arrows). 

Note: When you open the Plotter Tool for the first time, the cursor is in Draw mode

(cursor shows as a pen). If the cursor is showing as a hand, this means you are in Select

mode and you need to click the Draw button to change modes. After you have drawn a

shape, the mode changes automatically to Select. To draw another shape, click the Draw

button again.

The default shape selection is set to Rectangle. To change this, click the Shapes button

and choose the shape or line you wish to draw. The shape you select will be shown at  the

top of the screen. For example, Draw Shape: Polygon. 
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Before you begin to draw, you have the ability to set custom styling for the shape by

clicking the Style button. The style you set will be applied to all of the shapes you add to

the image. See Edit Highlights/Hotspots for more information on using the Shape Styles

window. You also have the ability to customize the placement of the shapes. See Settings

for more information.

When you are ready to draw a shape, select your preferred method from these two

options (at the top of the window): Press and drag mouse or Separate mouse clicks. 

1.  Press and drag mouse -  To create the following shapes with this method, follow the

instructions below:

Rectangle - Click once to plot one corner, move the mouse to plot the opposite

corner, then release.

Circle - Click once to plot the centre, move the mouse to plot the circumference,

then release.

Ellipse - Click once to plot the centre, move the mouse to plot the opposite side,

then release. 

Polygon - Cannot be drawn using this method.

Line - Click once to plot the start, move the mouse to plot the end, then release.
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2.  Separate mouse clicks -  To create the following shapes with this method, follow the

instructions below:

Rectangle - Click once to plot one corner, move the mouse to plot the opposite

corner, then click again.

Circle - Click once to plot the centre, move the mouse to plot the circumference,

then click again.

Ellipse - Click once to plot the centre, move the mouse to plot the opposite side,

then click again. 

Polygon - Click once to plot the first corner of the polygon, then again to plot the

next, and so on for each point. Press the Enter key to complete the shape.

Line - Click once to plot the start, move the mouse to plot the end, and then click

to complete the line.

To copy and paste shapes, click the shape you wish to copy. Use the keyboard short

cuts Ctrl+C (copy) and Ctrl+V (paste) or use the Copy and Paste buttons. Click the

up arrow and choose Copy All Shapes, and then Paste All Shapes to copy and paste

all the shapes.

Once created, you may rotate the shapes using the keyboard shortcuts Shift +  to

rotate counterclockwise and Shift +  to rotate clockwise. You may lock or constrain

the direction a shape moves (horizontally or vertically) by holding Shift on the keyboard

and using the mouse to drag the shape horizontally or vertically. The shape will only

move along the X (horizontal) or Y (vertical) axis. Note: Releasing the Shift key will

release the lock. 

You may also move multiple shapes together by holding Ctrl on the keyboard and using

the mouse to select, and then drag the desired shapes. Holding Shift + Ctrl and using

the mouse to select, and then drag the desired shapes will lock or constrain the direction

the shapes move (horizontally or vertically). Note: Releasing the Shift key will release

the lock.

9.9.3.2 Edit Highlights/Hotspots

The  following  steps  describe  how  to  edit  a  shape  once  it  has  been drawn,  and  how  to

associate it with a Text Option.
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1.  Click the Select button to change the mouse function to select (hand symbol).

2.  Click the shape you want to edit. You will see a black outline box appear on the

shape with black drag points in the corners and on the sides.

3.  To resize a shape, click the drag points and drag them to the desired size.

4.  To rotate a shape, click the white circle and move the mouse to rotate. Note: You

may also rotate a shape using the keyboard shortcuts Shift +  to rotate

counterclockwise and Shift +  to rotate clockwise.

5.  To copy and paste a selected shape, select CTRL+C to copy, then CTRL+V to

paste or use the Copy and Paste buttons.

6.  To associate the shape with a Text Option, first ensure the shape is selected

(click Select, then click the shape). Then, select a number from the Option drop-

down for the associated Text Option. Note: There can be a one-to-one or many-

to-one relationship between Text Options and shapes.

7.  To set the highlight for a shape to the style set for the viewer, click the arrow

beside the Style button and click Add Highlight Style. For each interface, there

are now predefined highlight styles to choose from based on project requirements.
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8.  To customize the highlight for a shape, click the Style button to open the Shape

Styles dialogue box. Here you will find fields for line Color, Thickness and Opacity

and background Color and Opacity. 

9.  Under Line settings, enter a hexadecimal value for the line Color, a value in pixels

for the Thickness of the line, and a decimal value from 0 to 1 for Opacity. Note:

The opacity of the line is usually less noticeable than the opacity of the background

fill. Enter the values in pixels for the Rounded Corners rx and ry fields. Note:
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These fields only apply to the rectangle shape.

10. Under Background settings, enter a hexadecimal value for the fill Color, and a

decimal value from 0 to 1 for the fill Opacity. Note: Opacity of 1 is totally opaque,

opacity of 0 is totally transparent, and anything between is partially opaque. A

value of roughly 0.2 (20% opacity) will allow you to highlight an area but still see

the image in the background. 

11. The Remove All button will remove any custom highlights and return the shape

to the highlight style set by the viewer (only if you have previously added a

highlight style by clicking Add Highlight Style). If you have not added a highlight

style (by clicking Add Highlight Style), then clicking Remove All will make the

shape solid and black.

12. Click the Apply button to save your settings or the Cancel button to exit without

saving. You will return to the previous screen in the Plotter Tool window.

13. Click the Arrange button to bring up a menu that will allow you to send a shape

backward/forward or to the front or back. 

14. Click the Link button to bring up a menu that will allow you to add a hyperlink to

a shape. You will also be able to view and/or remove the hyperlink.
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15. Click the Effect button to toggle a drop shadow on or off. To delete a selected

shape, click the Delete button.

16. When you have finished editing your shapes within the Plotter Tool window, click

the Save button to save your changes, Save & Exit button to save the changes

and exit the Plotter Tool, or close the window to exit without saving. Note: You

may also undo/redo (Ctrl+Z or Ctrl+Y), copy and paste the shape using the

Undo/Redo, Copy and Paste buttons. Click the corresponding up arrow beside the

delete, copy and paste buttons to delete, copy or paste all the shapes. You may

also move multiple shapes together by holding the left Ctrl key on the keyboard and

selecting the desired shapes to move.

17. With a shape selected, click the Properties button to open the Properties

window and display the shapes's (X, Y, Width, Height and Rotation) or (Line Plot

and Rotation) properties. Note: The properties displayed are shape specific (e.g,

Circles will display the X, Y and Radius properties).

18. Edit the desired property(ies), click the Apply button and then click the Done

button to save the changes. Note: The shape will change based on the newly

entered properties.
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9.9.3.3 Plot Labels

The Plotter Tool also allows text labels to be superimposed on static graphic media assets

on the following screen styles:

3.02 Media and Text 

3.04 Panoramic Media Above 

3.06 Panoramic Media Below 

3.10 Media with Highlights 

3.11 Media with Hotspots 

3.15 Slide Show 

3.17 Swappable Media 

3.18 Media and Text Stacked
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3.19 Media and Text Build

3.20 Media and Text Grid

2.52 Multiple-choice with Media

To add a label, follow these steps:

1.Click the Draw button, then click the New Label button at the bottom of the

Plotter Tool. The Label window will open.

2. Click the radio button beside This is just text to create text for text that you can

style manually or choose the radio button beside Label (styled by viewer) for text

that will appear within a pre-styled box, with an arrow attached. Note: If the

Label (styled by viewer) option is selected, you will also be able to select the

desired arrow position (Top, Right, Left or Bottom) from the Select the arrow

position drop-down menu.

3. Enter the text in the HTML editor field. Note: For plain text, you can style using

bold, italics, underline, font colors, font style and font size. However, for pre-styled

labels, these toolbar buttons will not be available. See Configure Plotter Tool for

more information about the Plotter Tool labels.

4. Click Apply to apply your changes and close the window or Cancel to exit without

applying changes. If you apply the changes, the label will be superimposed on your

graphic. Note: When labels are added to an image using the plotter tool an

identifier (lesson, quiz or instructor led) is also added. However, if the screen can

belong to various activity types the identifiers are no longer valid.



Screen Styles (Question and Instruction Screens) 559

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

5.Click the Select button at the bottom of the Plotter Tool and then click on the

text label to drag and position it on the graphic.

6. Click the arrow (the line, not the arrowhead) and drag points will appear at either

end of the line. You can drag these to reposition both ends of the arrow.
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7.Click the Arrange button to bring up a menu that will allow you to send a label

backward/forward or to the front or back. 

8. Click the Effect button to toggle a drop shadow on or off.

9.9.3.4 Settings

The  Plotter Tool  Settings  panel  provides  additional  functionality  for  the  placement  of

shapes  or labels.  Click the  desired  checkbox  to  enable  the  setting,  and  then  click  the

Done button. 
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The settings include:

Snap to grid: This setting provides the ability to snap shapes or labels to a desired

grid location. Note: The top-left  corner of the shape or label snaps to the top-left-

corner of the desired grid. 

Show grid: This setting shows or hides a grid overlay that is based on the Grid size

value. Note: Users may have Show grid enabled and Snap to grid disabled or vice

versa. 

Show arrows on select: This  setting  is  specific  to  the  Line  End Arrow and  Line

Both Arrow shape.  Note:  When enabled,  the  arrowhead  shape  will  always  remain

visible. 

Grid size: This setting provides the ability to customize the size of the grid in pixels

for more precise snapping to grid. It  also  provides  for a  more  precise  placement  of

shapes or labels.

9.9.4 Zoomify

1. Click the Settings button in the Media tab to configure the states, and set the

zoom and position of a Zoomify file for the current screen. 

2. Configure the Zoomify states using the buttons at the top of the window, along
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with the navigation arrows at the bottom.

3. Click the Default checkbox to toggle whether the currently selected state is the

one that will be shown first, by default, in the viewer.

4. Click New State to create a state.

5. Click Delete State to remove a state.

6. Click Edit Name to change the name of a state.

7. To edit a previously-created state: 

Select the name from the Select a State drop-down menu.

If required: Zoom and pan to the desired view of the graphic and click Set
Position and Zoom (zoom in and out using the mouse scroll wheel, the scroll
bar to zoom in and out in stages, or by entering a value in the Set Zoom field.
The Zoom Level field displays the current zoom level of the Zoomify file. You
can also click and hold the navigation arrows to pan up, down, left or right).
Note: Click the Clear Position & Zoom button to remove the values in the
State Position & Zoom field.

If required: Add any labels or highlights (further discussed in Annotations Panel
in this section).

Click Apply to save a state. Note: It is important to save a state before
switching to view another state or leaving this editing screen, otherwise you
may lose your changes. 

Click the Apply & Exit button to save your changes and return to the LCMS
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screen editing screens, or click the Close icon in the top-right of the browser
window to exit without saving.

8. Click the Copy All and Paste and Replace All buttons to copy, paste, and replace
all the settings from one zoomify to another zoomify on a different screen.

This is an optional feature. For more information, please contact

learninglogics-support@bluedrop.com.

9.9.4.1 Overlay

When a Zoomify file is added to a screen, the tool gives you the option to add an overlay

(graphic(s) that  appear over layers). As long as the file is formatted with a transparency

(.png), you can add an overlay to the default image. Overlays can be used to add details,

icons or other components. 

With  the  overlay  populated,  the  preview  shows  the  default  image  with  the  overlay

option(s) along the bottom left. Once an option is clicked, that  overlay appears over top

of the default image (see examples below). Note: Overlay buttons are toggles -  they can

be  turned  on  and  off  so  multiple  overlays  can  be  viewed  simultaneously.  A  green

checkmark indicates that this overlays is currently "on". 

mailto:learninglogics-support@bluedrop.com
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9.9.4.2 Annotations Panel

The  Zoomify  Annotations  Panel  allows  you  to  customize  each  state  with  labels  and

captions.
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1.  Click the  +  button at  the  bottom of  the  panel to  enable  the  following  label options:

Image  Navigation,  Toggle  Color  Palette,  Freehand  Drawings,  Text  Labels,  Icon

Labels, Rectangle Labels, Polygon Labels and Measurements.

2.  To add a text label, click anywhere on the image to make the label appear. Click in the

Caption  field  to  edit  the  text  within  the  label.  Note:  Creating  text  labels  at  various

zoom levels results in varying sizes of text  labels. When text  labels  all  need  to  appear

the  same  size,  select  the  desired  zoom level,  and  then create  the  text  labels.  When

adding text labels to an existing zoomify, verify the zoom level and then create the text

label.

3.  For shapes and drawings, you can customize the way you would like them to appear on

the image. You can also customize the caption and use the drop-down menu to choose

the position in relation to the shape.

4.Once you are satisfied with your label or highlight, click the Save button at  the bottom

right of the panel.

9.10 Tags/Categories (Tab)

Both instruction screens and question screens have tabs for assigning tags; however, the

question screen types also include an interface for assigning question categories on this
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tab.

Assigning keywords or tags to a question makes it easier to find screens you are looking

for via the Question Bank search function. A question screen must have at least one

category selected. The categories are required in order to use the Automation Rules

functionality. Note: Some viewers may allow students to search for screens by tags.

1. Click the Tags tab, called Tags/Categories on questions screens.

2. Type the assigned keywords in the Tags field, each separated by a comma, or by

pressing the enter key. Note: When you press the enter key or navigate away from

the field, each keyword will be turned into a separate tag, which can be deleted by

clicking the x beside it.

3. In question screens, to assign a category, click the checkbox beside one or more

categories. Note: The Default category will always be selected automatically for

new screens.

4. Click the Save button at the top of the screen to save your changes. The tags

and/or categories will now be associated with the screen, and will be displayed in

the activity storyboard.

9.11 Other Details (Tab)

Instruction and question screens both have an Other Details tab, but the fields are

slightly different. Instruction screens have fields titled Review Instructions and Personal

Notes in the Other Details tab. Question screens have these fields and also Level of

Difficulty, Answer Constraint, Point Value, and Est. (Estimated) Time. 

1. Click the Other Details tab.
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2. For question screens, select the level of difficulty from the drop-down menu: low,

medium, or high. Note: To use the automated rule feature for assigning questions

to a test, the level of difficulty for each question must be assigned. 

3. For question screens, assign a Point Value (0-999) (if required) and an estimated

time to complete the question in seconds Est. Time (if required). Select the answer

constraint from the drop-down menu: None, Mandatory, Mandatory Critical, or

Critical. If desired, click the Enable Partial Scoring box to enable the weighted

value inputs on the Text Options tab. Note: The estimated time to complete a

question will help to calculate the overall time it takes to complete a quiz when a

time limit is imposed.

4. As required, enter some comments for the Review Instructions. This area

functions like the Main Text field and has the same rich-text/HTML toolbar. Note:

You may want to enter questions for the Subject Matter Expert (SME) here, as this

information is displayed in storyboard reports.
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5. As required, enter some comments for Personal Notes. This area is never

published to the storyboard or lesson. Note: Only users with access to the LCMS

can see the contents of this field, which usually includes all of the Developers,

Managers and the Administrators.

9.12 Security (Tab)

Instruction and question screens both have a Security tab, which contains information

about the security required for the screen. You can choose information from drop-down

lists for:

1. Classification

2. Controlled Goods
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Note: If these options appear disabled on the screen, it is because there is screen

content dictating the lowest classification level that can be assigned.

9.13 Pop-Up Boxes (Tab)

Pop-Up Boxes can be added to both instruction and question screens. In the viewer,

pop-up boxes are launched by clicking hyperlinked text or inline images. Pop-up windows

may contain text and/or media (graphics, animations, audio, video, zoomify and pdfs).

They may be either browser pop-ups, which open in a new window and can be resized or

moved around, or inline (modal) windows, which open inside the same window and cannot

be resized or moved.

9.13.1 Create Pop-Up

Pop-ups can contain text and/or media. In addition to normal graphic files, pop-ups can

also include Animate (HTML) files, Unity 3D files, audio/video (mp3/mp4) files and pdf files.

Note: Once a pop-up is created, you will need to create a hyperlink to it from the Main

Text area. See Hyperlink to Pop-Up for more information.

1. Select the desired question/instruction screen.

2. Click the Pop-Up Boxes tab.

3. To add a new pop-up, click the New Pop-Up button. The Add Pop-Up window will
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appear, where you will specify the requirements for the pop-up box.

4. Enter a Pop-Up Name, if required. This will appear beside the pop-up in the Pop-

Up Boxes tab and in the Link Properties dialogue for easier identification. If you

also wish to have this name as the pop-up window title, select the "Use Pop-Up

Name As Window Title" checkbox. Note: The Pop-Up Name will only appear in

the storyboard when this checkbox is selected.

5. Select either New Window for a browser pop-up that will open in a new window

that can be resized and moved around, or Inline for a modal window, which cannot

be resized or moved and will appear inside the current browser window. 

6. Choose the layout for your pop-up. Choices include: Text Top - Media Bottom,

Media Top - Text Bottom, Text Left - Media Right, Media Left - Text Right. The

default layout is set to Media Top - Text Bottom. Note: If only Media or Text is

being used, that content will fill the window. Note: When a video (mp4) media is

chosen, the Autoplay and Loop options will display. Click Autoplay to enable the

video to begin playing automatically. Click the Loop option to enable the video to

loop when it has finished playing. 
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7. Enter the text for the pop-up box in the Main Text field, which contains rich-text

and a toolbar identical to the Main Text field of the main screen.

8. Type the window Width and Height in the corresponding fields. The size you

choose is dependent on the interface features, the screen resolution for the design

and the amount of content shown in the window. Note: If an Inline (modal) pop-

up style is selected, these fields will appear under the media file name as Media

Size. Aspect ratio of the image will be maintained. 

9. If you wish to include media (graphic, Flash, Unity 3D, pdf or audio/video), either

select a file from the Media Library or type the file name you want assigned to the

file by the Multimedia Developer (for example, graphic_01.jpg) in the Requested

Filename field. Note: For information on how to populate the media Filename field

once the media is developed, see Media (Tab).

10. Add a Media Title or a Caption, if required. Add a media description to the

Description field. Like other media descriptions, this will be used to describe the

media for review and development. Note: The Plotter Tool is available for use

within pop-ups. See The Plotter Tool for more information. When a Unity file is

selected the default state of the pop-up image can be selected from the Default

State drop-down menu.

11. If you change the height or width of images used in inline pop-ups, they will

update automatically to constrain proportions. To increase the values, click the 

Reset to original size icon (green arrows) first to retrieve the maximum size of the

image. Click the Clear size icon to clear the Width and Height fields. The image

will automatically resize.
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12. Click the Submit button to submit your pop-up information.

Note: The Pop-Up Name(s), if available, will be displayed beside the pop-up number

in the Pop-Up Boxes tab.

The Pop-Up Name(s) will now be listed in the Link Properties window. See Hyperlink to

Pop-Up for more information on how to link to pop-ups.
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9.13.2 Edit Pop-Up

1. Select the desired question/instruction screen.

2. Click the Pop-Up Boxes tab.

3. Select the pop-up box you wish to edit from the list.

4. Make the necessary changes in the Edit Pop-Up Box window.

5. Click the Submit button. 

9.13.3 Copy Pop-Up

1. Select the desired question/instruction screen.
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2. Click the Pop-Up Boxes tab.

3. Select the Copy Pop-up to clipboard icon to copy a pop-up box.

4. Click Paste Pop-Up(s) to paste, or Clear Clipboard to clear the copied pop-up

from the clipboard.

 

9.13.4 Delete Pop-Up

1. Select the desired question/instruction screen.

2. Click the Pop-Up Boxes tab.

3. Click the Delete icon beside the pop-up box you wish to remove.
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4. A confirmation dialogue box will appear. Click OK to confirm deletion of the pop-up

or Cancel if you do not wish to delete it.

9.14 Special Functions (Tab)

All Instruction screen styles have the Special Functions tab. This tab enables hidden

screens and pop-out screens using buttons. Note: The Pop-out Screen via Button

using feature is only available if the Activity interface has Pop-out Content Buttons

defined. These customized quick launch buttons display on the Activity interface. When

clicked, these buttons will launch a desired screen from the activity such as (Lesson

Summary, Lesson Overview etc).

To hide a screen:

1.  Click the checkbox beside the Hide screen from presentation field. Note: The

screen will not display in the presentation.
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To set a desired screen as a Pop-up Screen via Button using:

1.  Select the desired option from the Pop-out Screen via Button using drop-down

menu (Not Enabled, Button 1, Button 2, Button 3, Button 4, or Button 5). 

9.15 TDM Integration (Tab)

If a training document from TDM has been associated with a specific LCMS activity, the 

TDM Integration tab is available from each screen within the activity. From here, you can

use the checkbox to indicate the teaching points that are addressed by this screen. See 

TDM Integration for more information.

9.16 Instructor Notes (Tab)

Instructor  Notes  can  be  added  to  instruction  screens  within  Instructor  Led  Lesson

type activities, not within Independent Study activities.

1. Click the Instructor Notes tab to open the Instructor Notes editor window. 
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2. Enter information here for the instructor to view while presenting the lesson.

9.17 Add/Edit/Delete Hyperlinks

Adding, editing and deleting hyperlinks to text or images, for pop-ups, URLs, emails, media

states, and references on question and instruction screens follows the same steps. 

9.17.1 Add New Hyperlink

Hyperlinks can be added to text or images within the Main Text area or within collapsible

text. Note: Images that have hyperlinks attached to them will display a small, grey arrow-

icon in the top-right corner.

1. Select an area of text or an image you wish to associate the hyperlink with.

2. Click the Insert Link button in the editor toolbar. 

3. A dialogue box will appear from which you may choose the type of link and set

other properties.

Note: See the following sections for specific instructions on creating the most common

types of links. More types of links are available in the instruction screens than in the

question screens.
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9.17.1.
1

Hyperlink to 3D Model State

Note: To link to a 3D Model state, you will first need to create one. See the section

titled Modest Tree 3D Explorer Settings for more information.

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. A window will appear that allows you to select the type of link and the desired 3D

Model state. Select 3D State from the Type drop-down list and the desired state

from the State drop-down list (remember that states must first be defined in order

to appear in this list).

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Hyperlinks to 3D Explorer States can be added in 3.02, 3.04, 3.06, 3.14 and 3.17
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screens.

9.17.1.
2

Hyperlink to Email Address

To create a clickable hyperlink in the main screen text area that links to an e-mail

address, follow the steps below. 

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. Select E-mail from the Type drop-down list and then enter the e-mail address you

want to link to with the subject heading.
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4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Once you click the hyperlink text inside an activity in preview mode, it will open up

your e-mail inbox with the appropriate e-mail address and subject heading. Enter the

message and send. 

9.17.1.
3

Hyperlink to Flash Media Label

To create a clickable hyperlink in the main screen text area that links to Flash media,

follow the steps below. 

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. A window will appear that allows you to select the type of link as Flash Media and

the desired Frame No. 
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4. Use the radio buttons to select Go to and Play or Go to and Stop.

5. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Hyperlinks to Flash media can be added in 3.02, 3.04, 3.06, 3.14 and 3.17 screens.

9.17.1.
4

Hyperlink to Adobe Animate Media

To create a clickable hyperlink in the main screen text area that links to Adobe Animate

media, follow the steps below. 

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.
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3. A window will appear that allows you to select the type of link as Adobe Animate

Media and the desired Frame No. 

4. Use the radio buttons to select Go to and Play or Go to and Stop.

5. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Hyperlinks to Animate media can be added in 3.02, 3.04, 3.06, 3.14 and 3.17

screens.

9.17.1.
5

Hyperlink to Swap Graphic

Note: Hyperlinks that swap out media are currently only available in 3.17 screens.
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To hyperlink to a graphic (from Main Text or Collapsible text), follow these steps:

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. In the Link Properties window, select Graphic from the Type drop-down list, then

choose the desired media from the Graphic drop-down list (shows all available

graphics). 

3. Click the Select button to insert the hyperlink or Cancel to exit without saving.

The hyperlink information now associated with this screen will be displayed in the activity

storyboard.
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9.17.1.
6

Hyperlink to Slide

Note: Hyperlinks that link to slides are only available in 3.15 screens.

To hyperlink to a slide, follow these steps:

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. In the Link Properties window, select Slide from the Type drop-down list and

choose the desired slide from the Graphic drop-down list (shows all available

slides). 

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

The hyperlink information now associated with this screen will be displayed in the activity
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storyboard.

9.17.1.
7

Hyperlink to Image Highlight (Hotspot)

Note: Links to highlights/hotspots can be added to Main Screen text as well as

Collapsible Text in 3.10 and 3.11 screens.

To link to a highlight (hotspot) you will first need to create a hotspot on your image using

the Plotter Tool. See the section titled The Plotter Tool for more information. Once your

highlights/hotspots have been created, follow these steps to set your links:

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. In the Link Properties window, select Hotspots from the Type drop-down list and

the desired hotspot from the Hotspot drop-down list.
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4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

The highlight/hotspot information now associated with this screen will be displayed in the

activity storyboard.

9.17.1.
8

Hyperlink to URL (HTTP)

Access to a URL is achieved by clicking a hyperlink in the main screen text of an activity. 

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. Select HTTP from the Type drop-down list and type in the desired URL address.
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4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Once you click the hyperlink text inside an activity in preview mode, the URL

address will open in a new browser window.

9.17.1.
9

Hyperlink to Pop-Up

Note: To link to a pop-up you will first need to create one. See the section titled Create

Pop-Up for more information. Note: Pop-ups can either be browser pop-ups, which open in

a new window, or modal windows, which open inline, in the same window.

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. The Link Properties window will appear. From the Type drop-down list, select

Pop-Up. From the Select a message Pop-Up box drop-down list, select the pop-

up you wish to link to.

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.
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The pop-up box information now associated with this screen will be displayed in the

activity storyboard. Note: The Pop-Up Name will only be displayed in the storyboard if you

have selected the checkbox for Use Pop-Up Name As Window Title.

9.17.1.
10

Hyperlink to Reference

Access to a reference (listed as visible under the Maintain References feature) is achieved

by clicking a hyperlink in the main screen text of an activity.

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the editor toolbar.

3. Select Reference from the Type drop-down list and then select the reference you

want to link to from the Select a reference drop-down list. Note: When a PDF file

is selected, parameters can be set using the PDF Parameters field. For example,

you may specify a named destination in the PDF or a numbered page. 
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nameddest=name - specifies a named destination in the PDF.

page=pagenum - specifies a numbered page in the document, using an integer

value. The document’s first page has a pagenum value of 1. 

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Once you click the hyperlink text inside an activity in preview mode, it will open up

your reference file in a new window. 

9.17.1.
11

Hyperlink to Screen

Access to another screen within an activity is achieved by clicking a hyperlink in the main

screen text of an activity. Note: This type of link can only be created in instruction

screens, not question screens.

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.
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3. Select Screen from the Type drop-down list and then choose the topic and screen

number you want to link to from the associated drop-down lists.

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Once you click the hyperlink inside an activity in preview mode, it will take you to

the screen you previously selected from the drop-down lists. Use the index button to

return to the initial screen.

9.17.1.
12

Hyperlink to Video

To create a clickable hyperlink in the main screen text area that links to an .mp4 video,

follow the steps below. Note: Hyperlinks to videos can be added in 2.52, 3.02, 3.04, 3.06,

3.13 and 3.14 screens.
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1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. Select Video from the Type drop-down list and input the desired starting Time

(seconds). Remember that an .mp4 video must first be selected for this screen in

order for Video to appear in this list). 

4. Use the radio buttons to select Go to and Play or Go to and Stop.

5. Click the Select button to insert the hyperlink or Cancel to exit without saving.

Note: Once you click the hyperlink inside an activity in preview mode, it will play the

selected video, starting/stopping at the time indicated.
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9.17.1.
13

Hyperlink to Unity Model Viewer

Note: Links to the Unity Model Viewer can be added to Main Screen text as well as

Collapsible Text in 3.14 and 3.17 screens.

1. Select the HTML content (text or image), to which you want to anchor the

hyperlink.

2. Click the Insert Link button on the toolbar.

3. A window will appear that allows you to select the type of link and the desired

state. Select Unity Model Viewer from the Type drop-down list and the desired

state from the State drop-down list.

4. Click the Select button to insert the hyperlink or Cancel to exit without saving.
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Note: Hyperlinks to Unity Model Viewer can be added in 3.02, 3.04, 3.06, 3.12, 3.14, 3.15

and 3.17 screens.

9.17.2 Edit Hyperlink

1. Select the desired question or instruction screen.

2. Double click on an existing hyperlink (text or image) or right-click on it and select 

Edit Link.

3. Edit the Link Properties fields.

4. Click Select to save changes or Cancel to close without saving.

9.17.3 Delete Hyperlink

To delete a hyperlink, follow these steps:

1. Select the desired question or instruction screen.

2. Right-click the hyperlink text or image.

3. Select Unlink.
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10 Reviewer Screen

Activities submitted for review or approval may be accessed directly in the LCMS through 

a special Reviewer Screen. This is visible only to Reviewers, Review Monitors, Review

Managers and Approval Authorities. 

This screen consists of several features that enable reviewing and approval of Activities

within the LCMS. Each is described in the following screens.

10.1 Review Inbox

From the Review Inbox, you may launch the activity (enter comments), view the

changes required, finalize your review or approval for submission and view the Storyboard.

Note: Reviews in the Inbox are sorted by Date Due, followed by Date Submitted, then

Activity Name.
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When logged in as a Reviewer or Approval Authority, the Review Inbox will list:

Name and version of the activity being reviewed or approved, with the folder it

resides in listed underneath

Date the review was submitted

Date the review/approval is due

Interface selected for viewing

Name of the Developer who created the activity

Activity development phase (only if this feature is enabled in Application

Preferences)

Review type

Activity status

When logged in as a Review Manager, you will also see a list of Reviewers’ names between

the Developer and activity status.

10.1.1 Launch (Activity)/Add Comments

1.Click the  Launch button to  open the  activity  within  the  interface  that  was  selected



Learninglogics® LCMS 4.31 User Guide596

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

when the review was submitted. 

2.Once  the  activity  launches,  an  Add  Comment  button  displays  at  the  top  of  each

screen. Click the Add Comment button to open the Change Required window.

3.On the Change Required window, enter a comment in the State change required

below field. Also, select a radio button to indicate if the comment is at the Screen,

Activity or Project level. Choose a priority for the comment from the Priority drop-

down menu Critical, Major, Normal or Minor. To add an attachment (i.e., a screen

shot), click the Choose File button. 
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4.Click within the Tags field to open the Select Tags screen. 

5. Click the desired tag from the list to select or deselect it. Search for the desired tag by

entering the name in the Filter field and/or select the desired category from the

Category drop-down menu.

6.Click the Submit button to select or deselect the tag(s) or the Close button to exit

without saving.
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7.Click Submit to save the new comment or Cancel to exit without saving. Note: Saved

comments will display on the Previous Changes Required pane, if this feature is

enabled for the review type. See Add Review Type for more information. When enabled,

this pane will display your comments as well as the comments from other reviewers.

See Viewing Other Reviewer Comments and for more information.
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10.1.1.
1

Viewing Other Reviewer Comments

1.Click the  Launch button to  open the  activity  within  the  interface  that  was  selected

when the review was submitted. 
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2.On  the  launched  screen,  click  the  Add  Comment  button  to  open  the  Change

Required window.

3.On the  Change  Required  screen,  all  comments  from previous  reviewers  are  listed  on

the Previous Changes Required pane, if  this feature  is  enabled  for the  review  type.

See Add Review Type for more information.

4. Click the  Select  Comment  Details  button to  open the  Select  Comment  Details  to

Hide/Show window.

5.On the  Select  Comment  Details  to  Hide/Show  window,  show  or  hide  the  desired

comment  details  (Icon,  Comment#,  Comment  Made  By,  Comment  Date,  Days

Ago,  Activity  Version  and  Response)  by  selecting  or deselecting  the  corresponding

checkbox.  Note:  You may  also  show  or  hide  all  the  comment  details  by  clicking  the

Select All button. 

6. Click the Apply button to save the selection(s).
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A list of possible icons is shown in the following image:

7.Click  the  Hide/Show  Comments  button  to  show  or  hide  the  Previous  Changes

Required pane.
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10.1.2 Changes Required

1. In  the  Reviewer/Approval Inbox,  click the  Changes  Required button  to  open  the

Changes Required screen. Note: The number of comments made is indicated here. 

2. The Changes Required screen lists any comments you have made under the columns:

ID, Priority, Scope (Activity, Project or Topic/Screen), Review Type, Change, Author

Name,  Date  and  Status.  Comments  are  shown  truncated,  but  can  be  expanded  by

clicking the Expand/Collapse Comment and Response icon on the left  of each row.

The  Expand  All/Collapse  All  button  also  toggles  between  expanded  and  collapsed

view  for all  comments.  Note:  The  expand/collapse  states  are  remembered  when  you

navigate away and return. 

3. To launch the screen to which a comment  pertains, click its link in the  Scope  column.

The screen launches in the selected viewer.

4. To edit  a comment,  click the  comment  itself  in  the  Change  column.  Note:  Reviewers

are  able  to  edit  or delete  their  own  comments.  Reviewers  are  also  able  to  view  the

comments  of  other Reviewers  assigned  to  the  same  review  request,  if  this  feature  is

enabled  for  the  review  type.  See  Add  Review  Type  for  more  information.  Review

Managers are able to view, edit or delete their own comments, as well as the comments

of  other Reviewers  assigned  to  the  same  review  request.  If  a  Review  Manager  edits

another Reviewer’s comment,  the  author (Reviewer)  of  the  original comment  does  not

change. See Viewing Other Reviewer Comments for more information.
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From  the  Change(s)  Required  screen  for  each  individual  comment,  you  can  toggle

Update  Tracking  ON/OFF.  If  set  to  ON,  this  means  that  the  tracking  checkmark

automatically updates when navigating Previous and Next through the comments. You can

also toggle Save on nav ON/OFF. If set  to ON, you will automatically save changes while

navigating Previous and Next  between the comments. You can also  modify  the  comment

priority (Minor, Normal, Major, Critical) and tags from this window. 

5. Click the Add Comment button at the top of the screen to add activity or project  wide

comments.  Note:  Activity  or  Project  comments  entered  here  will  also  display  in  the

Previous Changes Required pane.

6. Click  the  Launch  button  at  the  top  of  the  screen  to  open  the  activity  within  the

interface that was selected when the review was submitted. 

7. Click the Review Change Report button at  the top of the screen to open the Review

Change Report window. Also, there is an Include Previous Review Comments check

box if  you wish to include all previous review comments. Note: This  report  is  designed

to be suitable for printing.
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10.1.2.
1

Delete Comments

1. There are two ways to delete a review comment. 

a. In the Change(s) Required screen, click the Delete icon beside the review

comment you wish to delete. A window appears asking if you are sure you wish to

delete the comment. Note: This feature is only available within the Manager role.

b.  In an individual comment screen, the Review Manager can also delete a comment

by clicking the Delete button at the bottom. Once the comment is deleted, the

next comment is shown in sequence.

2. Click OK to delete, or Cancel to abort. Upon deletion, the comment is removed



Reviewer Screen 605

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

from the screen and the number of comments assigned to the activity is updated

on the Review/Approval menu. 

Note: Comments cannot be deleted once a review/approval has been finalized.

10.1.3 Finalize Review/Approval

An activity must first be reviewed, finalized and assigned before it can be submitted for

approval by the Submit for Approval feature under Review/Approval. The assigned

personnel are notified that the activity is ready for approval and comments that are made

can later be retrieved using the Review Comments feature under Review/Approval.

Ensure that an Approval Authority has been assigned to the project under the Project

Management feature. The user e-mail addresses must also be entered. See Assign Users

to a Project.  Note: To unlock an activity after approval, it must be set to in-production

status.

1. Click the Finalize Review button from the Reviewer Inbox.

2. On the Finalize Review screen, add comments if necessary and then click the

Submit button. In the new window, click OK to finalize the review or Cancel to

return to the review. 
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The activity is removed from the Review Inbox or Approval Inbox screen and placed on

the Completed Reviews or Completed Approvals screen. The numbers in brackets ( )

updates to correspond. 

3. The activity must then be finalized by a Review Manager. Select Rejected,

Approved or Approved with comments and enter comments, if desired. To opt in

to the notification email, Review Managers click the Send me a copy of the

notification e-mail checkbox. Note: The names of users who will receive email

notifications (or be cc'd in) appear on this screen. Click the Submit button, then in

the new window, click OK to finalize the review or Cancel to return to the review. 

Note: When the Review Manager feature is turned on, notification of a Reviewer’s
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completed review is sent to the Review Manager and copied to the Reviewer. Notification

of a Review Manager’s completed review is sent to the Manager and copied to the

Developer and Approval Authority.

10.1.3.
1

Address Comments

Once  a  review  is  finalized,  it  is  the  task  of  the  Developer  to  address  comments.  See

Review/Approval Menu (Drop-Down) for more information.

10.1.4 View Storyboard

1. On the Review Inbox or Approval Inbox screen, click the View Storyboard link.

Note: This link is not available if the review was submitted using a storyboard

interface. 

2. The storyboard window appears. Select the elements and topics you wish to have

displayed in the storyboard. Note: The Review Instructions field can be used for

correspondence between the Developer and personnel assigned to the review/

approval, to ensure all information associated with the activity is documented in the

storyboard.
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3. Click the Submit button. The storyboard is displayed. 

4. Use the icons at the top of the screen to print or save the storyboard.

10.2 Completed Reviews/Approvals

The Completed Reviews screen shows a history of completed reviews/approvals.

1. Click the Completed Reviews/Approvals link on the Reviewer Screen.  

You will see a Completed Reviews report, showing the total number of completed

reviews at the top in parentheses. When logged in as a Reviewer or Approval

Authority, the report shows the name and version of the Activity that was reviewed/

approved, the folder it resides in, Date Finalized, Date Submitted, Developer,

Reviewer(s), Activity Development Phase, Review Type and Activity Production

Status. 

2. Click the Launch button beside a completed review to launch the version of the
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reviewed activity in the viewer.

3. Click the Changes Required button beside a completed review to see the

Changes Required report for that review. Note: These comments, including the

scope of comments (Screen, Activity, Project), cannot be edited or deleted once a

review/approval has been finalized. But any previous comments that have a status

of Input Required or Resolved (set by the Developer) will have the required statuses

(Accepted or Needs Rework) to choose from and a field available for the Reviewer/

Approver to respond to the Developer.

4. Click the View Storyboard button beside a completed review to see the

Storyboard for that review.
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Note: Reviews that were retracted are indicated by the word "RETRACTED" in red.

10.3 Document Management

To view documents added into the LCMS:

1. Click the Document Manager link on the Reviewer Screen. A list of documents

divided into different Categories will be displayed.

2. Click the desired document name link. The document will open for viewing.

3. Click the Close icon X in the top right corner to close.

10.4 My Responsibilities

To view only a list of your assigned activities for the previously selected project:

1. Click the My Responsibilities link on the Reviewer Screen. All assigned activities

will be listed. 

2. Use the search feature to find a specific activity that has been assigned. You can

search by: Folder, Activity, Status, Type, Version, Activity Development
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Phase, or Review Type.

3. Click Submit to search or Clear to reset the form.  You'll see a list of Activities,

divided up by folder, showing the Activity name, Activity Development Phase,

Status, Type, Version, Developer, Reviewers and Approval Authority.
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11 Miscellaneous Topics

This  section  consists  of  various  additional  topics  that  do  not  fall  under  one  of  the

preceding headings.

11.1 Clearing your Browser Cache

When you visit  a website, in order to make it  work, your web browser downloads  various

files from a server, containing HTML, JavaScript, CSS, images, etc. Some of these files are

normally  saved  locally,  on  your  computer's  hard  drive,  in  a  form of  temporary  storage

called the browser cache. The next  time you visit  the same site, your browser can speed

things  up  by  loading  files  quickly  from its  local  cache  rather  than  waiting  for  them to

download  over  the  internet  again.  However,  when  a  web  application,  like  the

Learninglogics® LCMS,  is  updated,  that  can  mean  that  you're  not  running  the  current

version, but rather an older version that's been stored in the cache. 

Sometimes it will therefore be necessary to delete your cache in order to make sure you're

accessing  the  latest  version  of  the  LCMS.  The  instructions  for  doing  this  are  virtually

identical on all  major web  browsers.  You  can  reach  the  relevant  settings  through  your

browser's menu system. However, the easiest  way to do so is by simultaneously pressing

a hotkey  combination consisting  of  the  control,  shift,  and  delete  buttons  (CTRL+SHIFT

+DEL).  This  is  a  standard  shortcut  across  all  browsers.  Note:  Be  careful  not  to  press

CTRL+ALT+DEL,  which  interrupts  the  current  program  to  invoke  Windows  Security,  a

dialogue screen allowing you to log out, shutdown, switch users, etc. 

Google's Chrome Browser

The  shortcut  opens  the  "Clear  browsing  data"  dialogue.  From  the  drop-down  labeled

"Obliterate the following items from:" select  the option "the beginning of time". Make sure

that  only  the  box labeled  "Cached  images  and  files"  is  checked,  and  all  the  others  are

unchecked. Press the "Clear browsing data" button and wait.

Official Chrome Documentation

https://support.google.com/chrome/answer/95589
https://support.google.com/chrome/answer/95589
https://support.google.com/chrome/answer/95589
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Microsoft's Internet Explorer and Edge Browsers

IE9 and Above

The shortcut  opens the "Delete Browsing  History" dialogue.  Make  sure  that  only  the  box

labeled "Temporary Internet Files" is checked, and all the others are unchecked. Press the

"Delete" button and wait.

Official Internet Explorer Documentation

http://windows.microsoft.com/en-ca/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
http://windows.microsoft.com/en-ca/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
http://windows.microsoft.com/en-ca/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
http://windows.microsoft.com/en-ca/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
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Edge

The  shortcut  opens  the  "Clear  browsing  data"  dialogue.  Make  sure  that  only  the  box

labeled "Cached data and files" is  checked,  and  all  the  others  are  unchecked.  Press  the

"Clear" button and wait.

Official Edge Documentation

http://windows.microsoft.com/en-ca/windows-10/view-or-delete-browsing-history-in-microsoft-edge#v1h=tab01
http://windows.microsoft.com/en-ca/windows-10/view-or-delete-browsing-history-in-microsoft-edge#v1h=tab01
http://windows.microsoft.com/en-ca/windows-10/view-or-delete-browsing-history-in-microsoft-edge#v1h=tab01
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Mozilla's Firefox Browser

The shortcut opens the "Clear Recent History" dialogue. From the drop-down labeled "Time

range  to  clear:"  select  the  option  "everything".  Make  sure  that  only  the  box  labeled

"Cache" is checked, and all the others are unchecked.  Press  the  "Clear now" button and

wait.

Official Firefox Documentation

https://support.mozilla.org/en-US/kb/delete-browsing-search-download-history-firefox
https://support.mozilla.org/en-US/kb/delete-browsing-search-download-history-firefox
https://support.mozilla.org/en-US/kb/delete-browsing-search-download-history-firefox
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Note: Please be patient -  if  you have not  cleared your cache for a long time then it  may

take your computer several minutes to complete this process.

11.2 Offline Course Launcher

After creating  an off-line  course  package,  you may  download  and  unzip  the  course.  To

create an off-line package see Create Off-Line Package for more information.

1. To download the course, click on the  link (course  name)  and  save  the  .zip  file  to  the

desired location.  

2.Unzip the file.

3. Click the Start Course file. Note: You will be prompted to chose the application to open

the file with. Select a web browser. (IE, Chrome).
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11.3 What's New

Version 4.31 - Jan, 2024

New Features & Enhancements:

3.10 screen style now supports plotted shapes reordering or deleting with their text

option

3.11 screen style now supports up to 15 text/media options

3.12 screen style now supports the tabs on the left side of the screen layout

3.20 screen style: Grid layout  customizable columns and rows with text  or media  in

each grid 

Advance search capabilities are now available for the Media Library 

Snap to  grid,  grid  sizing,  label arrow  alignment,  shape  rotation,  and  multiple  shape

select capabilities are now available in the Plotter Tool 

Shape properties are now editable in the Plotter Tool

Plotter tool label is now a configurable option under the  Project  Preferences  Plotter

Tool tab
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Viewing and removing links is now available in the Link menu of the Plotter tool

New status options now available when finalizing a review

Assigning a developer to all Activities within a  folder now  available  using  the  Batch

Assign Developer function

Developers can now be excluded from review  email  when submitting  an activity  for

review

Forgot password feature is now a new option 

Administrators and Managers now have the ability to configure the viewer interfaces

3rd  Party  Content  is  now  a  configurable  option  under  the  Application  Preferences

Security tab

Security Classification and Controlled Goods list  descriptions are now  editable  under

the Application Preferences and Project Preferences Security tab

Reviewers are now able to see other reviewers comments

SCORM 2004 sequencing enhanced

Version 4.30.1 - Aug, 2023

New Features & Enhancements: 

3.19 now supports up to 100 builds

Course publishing now includes security levels for media

Managers  and  Administrators  now  have  the  ability  to  switch  between  the  Activity

Type Independent Study and Instructor Led Lessons in Activity Profile

Administrators can now unlock or disable user accounts  from the  User Management

Details screen

Application Preferences now includes the option to enable strict  HTML validation for

enhanced security
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Vulnerable attributes are now encoded

XSS vulnerable points for batch submissions are now encoded

Application Timeout is now a new option in Application Preferences Logins

With the introduction of the Application Timeout  field, the Session Timeout  field has

been redefined to capture a proper session timeout

Version 4.30 - July, 2023

New Features & Enhancements:

Media metadata no longer shows the full file path. It  has been replaced with the File

ID.

3.18 and 3.19 screen styles now support PDF and Zoomify media

Interface  Pop-out  Content  Buttons,  button  text  increased  to  allow  up  to  40

characters

Password character limit increased from 20 to 64

Saving  a  user record  with  the  status  "unlocked"  will  now  also  clear  any  incorrect

password timeout that may have occurred

Enhanced user password security

Version 4.29 - Jan, 2023

New Features & Enhancements:

Single Sign On (SSO) now available through ADFS for ColdFusion 2021 installations

3.15 screen now supports showing media above and below the text

Version 4.28 - Dec, 2022

New Features & Enhancements:

Support email address on the LCMS Home page now customizable



Learninglogics® LCMS 4.31 User Guide620

© 2024 BLUEDROP TRAINING & SIMULATION INC. All rights reserved

Review Instructions field is now a translation option on the Translation Options

window, when exporting the activity for translation

Text options support pop-up links

Review type now included in email template  

Deleting folders with subfolders in the Content Repository is now enabled

Media caption now support hyperlinks and embedded media

Version 4.27 - September, 2022

New Features & Enhancements:

Find & Replace capabilities enhanced to include more options 

Active Directory (LDAP) and Hybrid login features now available

Enforce strong password capabilities 

Version 4.26.1 - May, 2022

New Features & Enhancements:

Batch Tags

Version 4.26 - May, 2022

New Features & Enhancements:

Activity Export now includes Review history

Activity Import includes importing to a difference LCMS

Review History imports now includes reviewer details

Version 4.25 - April, 2022

New Features & Enhancements:
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Course Designer enhancements.

Offline courses can be included in the published SCORM package.

Version 4.24 - November, 2021

New Features & Enhancements:

3.19 screen style: Slide show build to navigate through up to 15 text and/or media

options in a slide show format:

o Main text remains onscreen 

o Text options can be appended or replaced

Enhanced 3.02 screen style: Now includes a new layout option "100% Text,

Background Media" where a background image can be placed behind main text

Enhanced tag management:

o When publishing an activity or topic, you can now apply tag filters for screens to

include/exclude from the published SCORM package. 

o When previewing an activity or topic, you can now apply  tag  filters  for screens

to include/exclude from the preview.

o When viewing a storyboard, you can now apply tag filters for screens to include/

exclude from the output.

o You can now hide instructional screens from presentation by selecting an option

in the screen editor.

o You can now  hide  topics  from presentation by  selecting  an option in  the  topic

edit screen.

Special Functions tab to hide screens from a presentation

Activity logs are now included in activity exports

Version 4.23 - August, 2021
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New Features & Enhancements:

Enhanced CKEditor to create/copy Snippets

Enhanced tag management

Enhanced LCMS Menu

New Configuration and Preferences menu (sprocket)
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12 Frequently Asked Questions (FAQs)

1. Overview of FAQs

2. Answers 1

3. Answers 2

12.1 Overview of FAQs

1. How do I edit a question in an activity?

2. How do I update (add a new version of) a media asset?

3. How do I change a screen prompt?

4. Why can’t I edit any screens in my activity?

5. Why can I only edit some screens in my activity?

6. How do I add a reviewer to an activity?

7. How can I see review comments?

8. How do I change the pass mark for a test?

9. How can I ensure the user completes each activity in sequence?
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12.2 Answers 1

12.3 Answers 2
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13 Optional Features

The features outlined in this section are optional features of the Learninglogics® Learning

Content Management System (LCMS). Check your license to see which features are

included in your version of the LCMS.

13.1 API

This section provides an outline for working with the Learninglogics® LCMS API. To view

the most recent version of the API at any time, visit the following URL of your LCMS

installation.

ll_lcms/api/test.html 

13.1.1 Prerequisites

In order to use the API, each request must contain a valid API Token. This token is

defined in the LCMS Application Preferences and can only be updated and activated by an

LCMS Administrator.

13.1.2 API Requests

The following requests are supported by the LCMS API: 

userInfo

userAdd

userEdit

userActivate

userDeactivate

userRoleAdd

userRoleRemove

roleNames

projectCodes
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13.1.3 API Endpoints

This section lists the available API endpoints.

13.1.3.
1

userInfo

Returns JSON data about a single user.

URL

ll_lcms/api/userInfo

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string value, max length 200, accepts alphanumeric and underscores]

Success Response:

Error Response
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Sample Call (GET)

ll_lcms/api/userInfo/?token=xxx&username=abc 

Note: Rather than listing each individual possible error message, only one example is

shown above. The “detail” value will only appear if a coding error is detected, i.e.

database error.

13.1.3.
2

userAdd

Adds a user to the LCMS. When Active Directory Authentication (LDAP) is the selected

authentication method, the userAdd API cannot be used to create users. See Active

Directory Authentication (LDAP) for more information. When Hybrid Supporting Both is

the selected method, the userAdd API will create Internal Authentication users. See 

Hybrid Supporting Both for more information.

URL

ll_lcms/api/userAdd

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences] 

firstname=[string, max length 110] 

lastname=[string, max length 110] 

username=[string, max length 200, accepts alphanumeric and underscores] 

password=[string, requirements based on application preferences (See Login

Preferences for more information)] 

email=[string, max length 510] 

organization_name=[string, max length 400] 
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classification_id [numeric, max length 1, valid entries = 0 thru 4, defaults to 0]

controlled_goods_id [numeric, max length 1, valid entries = 1 thru 4, defaults to

4]

role=[optional, valid role name or names separated by commas *See /roleNames] 

project_code=[optional, only required if adding role(s) other than Administrator 

*See /projectCodes]

Success Response:

Error Response

Sample Call (GET)

ll_lcms/api/userAdd/?token=xxx&firstname=Joe&lastname=Smith…

Note: When adding user to a Role, a project must be specified. You can also update

user Roles at a later time via userRoleAdd or userRoleRemove. Rather than listing each

individual possible error message, only one example is shown above. The "detail" value

will only appear if a coding error is detected, i.e. database error. If Enforce Strong

Passwords is enabled in the Application Settings screen, user passwords must

contain at least three of the following: at least one number, at least one uppercase

character, at least one lowercase character or at least one special character.

13.1.3.
3

userEdit

Updates the record of an LCMS user.

URL
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ll_lcms/api/userEdit

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string value, max length 200, accepts alphanumeric and underscores]

Optional:

firstname=[string, max length 110]

lastname=[string, max length 110]

new_username=[string, max length 200, accepts alphanumeric and underscores]

password=[string, requirements based on application preferences (See Login

Preferences for more information)]

email=[string, max length 510]

classification_id=[numeric, max length 1, valid entries = 0 thru 4]

organization_name=[string, max length 400]

controlled_goods_id=[numeric, max length 1, valid entries = 1 thru 4]

account_disabled=[0=false, 1=true]

If a user is linked to an active directory account (See Active Directory

Authentication (LDAP) for more information), only the following fields may be modified

  using the userEdit endpoint:

classification_id=[numeric, max length 1, valid entries = 0 thru 4]

controlled_goods_id=[numeric, max length 1, valid entries = 1 thru 4]

organization_name=[string, max length 400]

o Success Response:

Error Response
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Sample Call (GET)

ll_lcms/api/userEdit/?token=xxx&username=jsmith&password=mynewpassword

Note: Rather than listing each individual possible error message, only one example is

shown above. The “detail” value will only appear if a coding error is detected, i.e.

database error. If Enforce Strong Passwords is enabled in the Application Settings

screen, user passwords must contain at least three of the following: at least one

number, at least one uppercase character, at least one lowercase character or at

least one special character.

13.1.3.
4

userActivate

Activate an LCMS user so they can access the system.

URL

ll_lcms/api/userActivate

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string value, max length 200, accepts alphanumeric and underscores]

Success Response:
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Error Response

Sample Call (GET)

ll_lcms/api/userActivate/?token=xxx&username=jsmith 

Note: Rather than listing each individual possible error message, only one example is

shown above. The “detail” value will only appear if a coding error is detected, i.e.

database error.

13.1.3.
5

userDeactivate

Deactivate an LCMS user to disallow entry into the LCMS.

URL

ll_lcms/api/userDeactivate

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string value, max length 200, accepts alphanumeric and underscores]

Success Response:
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Error Response

Sample Call (GET)

ll_lcms/api/userDeactivate/?token=xxx&username=jsmith

Note: The LCMS does not  physically delete users from the  system, but  makes them

inactive or active in order to maintain referential integrity of stored data. Rather than

listing each individual possible error message, only one example is shown above. The

"detail" value will only appear if a coding error is detected, i.e. database error.

13.1.3.
6

userRoleAdd

Adds an LCMS user to a given role or roles, in a project.

URL

ll_lcms/api/userRoleAdd

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string, max length 200, accepts alphanumeric and underscores]

role=[comma delimited string list of one or more valid roles *See /roleNames]

project_code=[project code user to be assigned to *See /projectCodes]

Success Response:
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Error Response

Sample Call (GET)

ll_lcms/api/userRoleAdd/?
token=xxx&username=jsmith&role=Developer&project_code=XYZ

Note: Both a role name and project code must be specified. Role name can be a list

of roles separated by commas. Rather than listing each individual possible error

message, only one example is shown above. The "detail" value will only appear if a

coding error is detected, i.e. database error.

13.1.3.
7

userRoleRemove

Removes an LCMS user from a given role or roles, in a project.

URL

ll_lcms/api/userRoleRemove

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

username=[string, max length 200, accepts alphanumeric and underscores]
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role=[comma delimited string list of one or more valid roles *See /roleNames]

project_code=[project code user to be assigned to *See /projectCodes]

Success Response:

Error Response

Sample Call (GET)

ll_lcms/api/userRoleRemove/?
token=xxx&username=jsmith&role=Developer&project_code=XYZ

Note: Both a role name and project code must be specified. Role name can be a list

of roles separated by commas. Rather than listing each individual possible error

message, only one example is shown above. The "detail" value will only appear if a

coding error is detected, i.e. database error.

13.1.3.
8

roleNames

Returns a list of valid Role Names used by the LCMS.

URL

ll_lcms/api/roleNames

Method

GET / POST or JSON

URL Parameters
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Required:

token=[string as defined in LCMS Application Preferences]

Success Response:
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Error Response
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Sample Call (GET)

ll_lcms/api/roleNames/?token=xxx 

Note: Rather than listing each individual possible error message, only one example is

shown above. The "detail" value will only appear if a coding error is detected, i.e.

database error.

13.1.3.
9

projectCodes

Returns a list of LCMS Projects.

URL

ll_lcms/api/projectCodes

Method

GET / POST or JSON

URL Parameters

Required:

token=[string as defined in LCMS Application Preferences]

Success Response:
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Error Response

Sample Call (GET)

ll_lcms/api/projectCodes/?token=xxx 

Note: Rather than listing each individual possible error message, only one example is

shown above. The "detail" value will only appear if a coding error is detected, i.e.

database error.

13.2 TDM Integration

Learninglogics Training Document  Manager (TDM) is  a  product  in  the  Learninglogics  suite

that can be used in conjunction with the LCMS. TDM enables Subject Matter Experts (SMEs)

to create  schemas and document templates such as: Qualification Standards and  Plans  (QSPs)  or

Qualification  Standards  (QSs)  and  Training  Plans  (TPs)  to  support  competency  and  skills

documentation. 

See TDM Integration and TDM Integration (Tab) for more information. 
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To configure TDM Integration see TDM Integration for more information.
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